BrainVision Analyzer

User Manual

as of Software Version 2.0.4
valid as of September 30, 2013*

* Valid until publication of a new version of the manual

Blank page

Imprint
Any trademarks mentioned in this User Manual are the protected property of their rightful owners.
All rights reserved, including the right to translate the document.
The content of the manual is the intellectual property of Brain Products GmbH. No part of the
manual may be reproduced or distributed in any form (by printing, photocopying or any other
method) without the express written permission of Brain Products GmbH.
Subject to change without notice.
© 2013 Brain Products GmbH

4 Blank page

v

Content

Content .......................................................................................................................................................v
List of figures ........................................................................................................................................... xiii
List of tables ...........................................................................................................................................xxxi

About this manual ................................................................................................................................. 33
The structure of the user manual............................................................................................................... 33
Who is the manual intended for?............................................................................................................... 34
Conventions used in the manual ............................................................................................................... 34
Revision history........................................................................................................................................ 35
Reporting errors and support .................................................................................................................... 35

Preface ................................................................................................................................................... 37
The Analyzer and its functions .................................................................................................................. 37
Intended use ............................................................................................................................................ 38
Correct use............................................................................................................................................... 38
Use together with other products and components.................................................................................... 39

Chapter 1

Chapter 2

Installation ............................................................................................................................................ 41
1.1

Installing the Analyzer under Windows® XP ................................................................................ 41

1.2

Installing the Analyzer under Windows® Vista and Windows® 7 ................................................. 42

1.3

Installing the Analyzer under Windows® 8 .................................................................................. 53

1.4

How can I find updates for the Analyzer? ..................................................................................... 58

1.5

Information about your dongle .................................................................................................... 59

1.6

Updating obsolete dongle firmware ............................................................................................ 61

Getting started and handling the program ......................................................................................... 63
2.1

Basic principles .......................................................................................................................... 63

2.1.1

Managing EEG files in Analyzer workspaces ................................................................................. 63

2.1.2

EEG file display in the history tree................................................................................................ 66

BrainVision Analyzer User Manual | Software version 2.0.4 | September 30, 2013

vi Content

Chapter 3

Chapter 4

2.1.3

Opening and viewing EEG files..................................................................................................... 67

2.2

Case example: processing steps applied to an EEG ..................................................................... 70

2.3

The Analyzer interface ................................................................................................................ 73

2.3.1

Structure of the interface............................................................................................................. 73

2.3.2

Ribbon........................................................................................................................................ 74

2.3.3

Quick Access Toolbar and Analyzer button................................................................................... 75

2.3.4

Navigating in the EEG .................................................................................................................. 76

2.3.5

Controls in the toolbar................................................................................................................. 78

2.3.6

Using and configuring the status bar ........................................................................................... 80

2.3.7

Further information on workspaces.............................................................................................. 82

2.4

Displaying and processing history trees ...................................................................................... 83

2.4.1

The History Explorer .................................................................................................................... 83

2.4.2

Context menus in the history tree ................................................................................................ 86

2.4.3

Restoring deleted child nodes ..................................................................................................... 90

2.4.4

Displaying a sorted list of history nodes....................................................................................... 92

2.5

Special graphical tools ............................................................................................................... 94

Advanced concepts ............................................................................................................................... 97
3.1

Segmentation ............................................................................................................................. 97

3.2

Primary and secondary history files ............................................................................................. 99

3.3

Analyzer program components: transforms, exports and add-ins ............................................... 100

3.4

Automation using history templates .......................................................................................... 102

EEG views ............................................................................................................................................. 109
4.1

Basic principles ........................................................................................................................ 109

4.1.1

Views and view categories......................................................................................................... 109

4.1.2

Opening and using views .......................................................................................................... 110

4.1.3

Displaying information on EEG views ......................................................................................... 111

4.1.4

Selecting data ranges................................................................................................................ 112

4.1.5

Highlighting and selecting channels .......................................................................................... 115

4.2

The EEG views in detail ............................................................................................................. 118

4.2.1

The butterfly view...................................................................................................................... 118

4.2.2

The grid view............................................................................................................................. 119

Content vii

Chapter 5

Chapter 6

4.2.3

The head view ........................................................................................................................... 121

4.2.4

The mapping view ..................................................................................................................... 124

4.2.5

The standard view ..................................................................................................................... 126

4.2.6

The 3D head view ...................................................................................................................... 127

4.2.7

The time-frequency view............................................................................................................ 128

4.3

Overlaying EEG graphs .............................................................................................................. 132

4.4

Additional view functions ......................................................................................................... 136

4.5

View tools ................................................................................................................................ 140

4.5.1

Channel Selection ..................................................................................................................... 140

4.5.2

Delta Tool ................................................................................................................................. 143

4.5.3

Magnifier .................................................................................................................................. 146

4.5.4

Map Legend .............................................................................................................................. 146

4.5.5

Mapping ................................................................................................................................... 147

4.5.6

Scaling Bar ............................................................................................................................... 149

4.5.7

Text Box .................................................................................................................................... 150

4.5.8

Value Graphics.......................................................................................................................... 152

4.6

Configuring settings for EEG views ............................................................................................ 154

4.6.1

Category-related view settings................................................................................................... 155

4.6.2

Node-specific view settings ....................................................................................................... 156

4.6.3

The view settings in detail ......................................................................................................... 159

Montages ............................................................................................................................................. 175
5.1

Creating and editing a new montage ......................................................................................... 175

5.2

Modifying an existing montage ................................................................................................. 182

5.3

Displaying montages ................................................................................................................ 183

Customizing program settings .......................................................................................................... 187
6.1

Configuring your preferences in the Analyzer ............................................................................. 187

6.1.1

Selecting EEG views for data sets............................................................................................... 187

6.1.2

Configuring scaling ................................................................................................................... 189

6.1.3

Assigning colors to transforms .................................................................................................. 190

6.1.4

Outputting graphics .................................................................................................................. 191

6.1.5

Electrode coordinates ............................................................................................................... 192

viii Content

Chapter 7

6.1.6

General settings........................................................................................................................ 192

6.2

Customizing the graphical user interface .................................................................................. 194

6.2.1

Skins ........................................................................................................................................ 194

6.2.2

Docking .................................................................................................................................... 194

6.3

Global settings for EEG views .................................................................................................... 201

6.4

Administrative settings ............................................................................................................. 202

Primary and secondary transforms ................................................................................................... 207
7.1

Transforms in the "Dataset Preprocessing" group ...................................................................... 207

7.1.1

New Reference .......................................................................................................................... 207

7.1.2

Pooling ..................................................................................................................................... 210

7.1.3

RMS/GFP (Root Mean Square/Global Field Power)...................................................................... 211

7.1.4

CSD Interpolation (Current Source Density) ................................................................................ 213

7.1.5

Rectify ...................................................................................................................................... 215

7.1.6

Edit Channels............................................................................................................................ 216

7.1.7

Level Trigger.............................................................................................................................. 221

7.1.8

Linear Derivation....................................................................................................................... 222

7.1.9

Formula Evaluator ..................................................................................................................... 224

7.1.10 Change Sampling Rate .............................................................................................................. 226
7.1.11 Topographic Interpolation ......................................................................................................... 227
7.1.12 Add Channels ........................................................................................................................... 230
7.2

Transforms in the Artifact Rejection/Reduction group ................................................................ 244

7.2.1

Complex Demodulation ............................................................................................................. 244

7.2.2

IIR Filters................................................................................................................................... 245

7.2.3

Band Rejection.......................................................................................................................... 247

7.2.4

Artifact Rejection....................................................................................................................... 249

7.2.5

Raw Data Inspection.................................................................................................................. 262

7.2.6

Ocular Correction ICA ................................................................................................................ 272

7.2.7

Ocular Correction ...................................................................................................................... 293

7.3

Transforms in the Frequency and Component Analysis group ..................................................... 296

7.3.1

ICA (Independent Component Analysis) ..................................................................................... 296

7.3.2

Inverse ICA................................................................................................................................ 312

7.3.3

FFT Analysis .............................................................................................................................. 314

Content ix

7.3.4

FFT Inverse ................................................................................................................................ 320

7.3.5

Wavelets................................................................................................................................... 323

7.3.6

Wavelet Extraction .................................................................................................................... 339

7.3.7

PCA (Principal Component Analysis) .......................................................................................... 340

7.4

Transforms in the Segment Analysis Functions group ................................................................ 356

7.4.1

Peak Detection.......................................................................................................................... 356

7.4.2

LRP (Lateralized Readiness Potential) ........................................................................................ 363

7.4.3

ERS/ERD (Event-Related Synchronization/Desynchronization).................................................... 367

7.4.4

Grand Average .......................................................................................................................... 369

7.4.5

Segmentation ........................................................................................................................... 371

7.4.6

Grand Segmentation ................................................................................................................. 383

7.4.7

Average .................................................................................................................................... 385

7.4.8

Baseline Correction ................................................................................................................... 387

7.4.9

DC Detrend ............................................................................................................................... 389

7.5

Transforms in the Comparison and Statistics group ................................................................... 391

7.5.1

t-Test ........................................................................................................................................ 391

7.5.2

Cross Correlation....................................................................................................................... 394

7.5.3

Data Comparison ...................................................................................................................... 396

7.5.4

Covariance................................................................................................................................ 403

7.5.5

Coherence ................................................................................................................................ 405

7.6

Transforms in the Special Signal Processing group .................................................................... 408

7.6.1

LORETA ..................................................................................................................................... 408

7.6.2

MR Correction ........................................................................................................................... 416

7.6.3

CB Correction ............................................................................................................................ 432

7.7

Transforms in the Others group ................................................................................................. 447

7.7.1

Data Cache ............................................................................................................................... 447

7.7.2

Edit Markers.............................................................................................................................. 449

7.7.3

Import Markers ......................................................................................................................... 457

7.7.4

MATLAB® ................................................................................................................................. 461

7.7.5

Edit User Properties................................................................................................................... 480

x Content

Chapter 8

Chapter 9

Chapter 10

Transient transforms .......................................................................................................................... 483
8.1

3D head view ........................................................................................................................... 485

8.2

Band mapping view .................................................................................................................. 486

8.3

CSD map .................................................................................................................................. 488

8.4

LORETA .................................................................................................................................... 490

8.5

FFT ........................................................................................................................................... 495

8.6

Mapping view ........................................................................................................................... 496

8.7

Zoom view ................................................................................................................................ 497

Add-ins ................................................................................................................................................. 499
9.1

Marker Navigation .................................................................................................................... 499

9.2

Analyzer Video ......................................................................................................................... 500

9.3

Generic Data Header ................................................................................................................. 502

9.4

LORETA .................................................................................................................................... 504

Export components ............................................................................................................................. 505
10.1

Simple export components ....................................................................................................... 507

10.1.1 Besa Export............................................................................................................................... 507
10.1.2 EDF Export................................................................................................................................. 508
10.1.3 Export Markers.......................................................................................................................... 510
10.1.4 Generic Data Export................................................................................................................... 511
10.1.5 Create New Dataset ................................................................................................................... 517
10.2

Multiple export components ..................................................................................................... 518

10.2.1 Area Information Export............................................................................................................. 518
10.2.2 Peak Information Export ............................................................................................................ 519
10.3

Other export components ......................................................................................................... 521

10.3.1 Loreta Export............................................................................................................................. 521
10.3.2 Export ICA Matrices ................................................................................................................... 522

Chapter 11

Importing data, positions and markers ............................................................................................ 525
11.1

Importing data ......................................................................................................................... 525

11.1.1 Besa format .............................................................................................................................. 525

Content xi

11.1.2 Generic Data Reader.................................................................................................................. 526
11.2

Importing markers and channel positions ................................................................................. 527

Chapter 12

Printout ................................................................................................................................................ 529

Chapter 13

Exporting graphics.............................................................................................................................. 533

Chapter 14

Appending multiple raw data sets .................................................................................................... 535

Chapter 15

Macros ................................................................................................................................................. 539

Chapter 16

Solutions.............................................................................................................................................. 543

Chapter 17

Analyzer help system ......................................................................................................................... 547

Appendix A

17.1

Support Info ............................................................................................................................. 548

17.2

Update Manager ....................................................................................................................... 549

Product identification information .................................................................................................... 559

Appendix B Raw data on removable media ........................................................................................................... 561
Appendix C

Electrode coordinate system ............................................................................................................. 563

Appendix D Markers (time markers) ...................................................................................................................... 565
Appendix E

Keyboard shortcuts ............................................................................................................................ 567

Appendix F

Installing a network license (USB) .................................................................................................... 569
Introduction and installation .................................................................................................................. 569
Problems with dongles and error messages............................................................................................. 573

Appendix G Installing sub-licenses ....................................................................................................................... 575
Appendix H Command-line parameters ................................................................................................................. 579
Appendix I

Shortcuts to raw data ......................................................................................................................... 581

xii Content

Appendix J

BrainVision electrode files ................................................................................................................. 583

Appendix K

Segmentation using advanced Boolean expressions ...................................................................... 585
The purpose of ABE ................................................................................................................................ 585
Using ABE .............................................................................................................................................. 585
Overview of the ABE syntax ..................................................................................................................... 586
Detailed description of the ABE syntax .................................................................................................... 589
Rules for individual comparisons ............................................................................................................ 591
Old and new ABE syntax ......................................................................................................................... 593

Appendix L

DirectX 9 for 3D head view and Analyzer Video ............................................................................... 595

Appendix M File formats for Generic Data Reader and Generic Data Export....................................................... 599
GDR-compatible header file in text format (.vhdr) .................................................................................... 599
GDR-compatible marker file in text format (.vmrk).................................................................................... 605
GDR-compatible header file in XML format (.xhdr).................................................................................... 606
GDR-compatible marker file in XML format (.xmrk) ................................................................................... 614
List of abbreviations............................................................................................................................... 617
Glossary ................................................................................................................................................ 619
Subject index ......................................................................................................................................... 623

xiii

List of figures

Chapter 1

Chapter 2

Installation
1-1

"AutoPlay" dialog box 42

1-2

Executing the Autorun file manually under Windows® 7 (A) 43

1-3

Executing the Autorun file manually under Windows® 7 (B) 44

1-4

Selecting the software to be installed 44

1-5

Installing Analyzer 2 45

1-6

Message output if .NET Framework 4.0 is not present 46

1-7

Interruption of the installation routine 47

1-8

Installing .NET Framework 4.0 48

1-9

Confirming installation of .NET Framework 4.0 (User Account Control facility) 48

1-10

Accepting the .NET Framework 4.0 license agreement 49

1-11

Restarting the computer to terminate installation of .NET Framework 4.0 49

1-12

Setup Wizard 50

1-13

Analyzer License Agreement 51

1-14

Selecting the program folder 52

1-15

Dongle with obsolete firmware 53

1-16

Windows® 8, control panel for autoplay 54

1-17

Windows® 8, menu for autoplay 54

1-18

Menu item used to list all apps 55

1-19

"BrainVision" section in the list of all apps 56

1-20

Choosing the default program for PDF documents 57

1-21

Menu in which you select the default program for PDF documents 57

1-22

Installing updates from the BrainVision program DVD 58

1-23

Displaying dongle information 60

1-24

Warning before a dongle expires 60

Getting started and handling the program
2-1

Empty user interface 63

2-2

Analyzer button and main menu of the application 64

2-3

Setting up a new workspace 65

BrainVision Analyzer User Manual | Software Version 2.0.4 | September 30, 2013

xiv List of figures

2-4

EEG files displayed as book icons 65

2-5

Loading an existing workspace 66

2-6

History tree, processing steps 67

2-7

Opened EEG file 68

2-8

The Analyzer with loaded EEG 68

2-9

EEG data in tabs 69

2-10

Title bar 69

2-11

Scrolling in the tab bar 69

2-12

Transforms in the user interface 70

2-13

Calling the Filter dialog 70

2-14

Filter settings 71

2-15

Result node in the history tree 71

2-16

Overview of the Analyzer interface 73

2-17

Section of ribbon, tab 74

2-18

Group 74

2-19

Entries in a group 74

2-20

Ribbon hidden 75

2-21

Tooltip 75

2-22

Calling the Quick Access Toolbar 76

2-23

Adding controls to the Quick Access Toolbar 76

2-24

Quick Access Toolbar with controls added 76

2-25

Navigation bar (section), marker bar and slider bar 77

2-26

Showing and hiding markers 77

2-27

Toolbar (section) 78

2-28

Status bar (section) 80

2-29

Configuring the status bar 81

2-30

Managing workspaces using the ribbon 82

2-31

History Explorer with primary and secondary history files and History Node List 84

2-32

Creating a history tree by means of drag-and-drop 85

List of figures xv

Chapter 3

Chapter 4

2-33

Functions in a history file's context menu 86

2-34

Functions in the context menu of a secondary history file 87

2-35

Functions in a raw data node's context menu 88

2-36

Functions in a history node's context menu 89

2-37

Restoring deleted nodes 91

2-38

History Node List 92

2-39

View Toolbox 94

2-40

Mapping tool applied to an EEG graph 95

Advanced concepts
3-1

Marker bar, displaying segment boundaries 97

3-2

Secondary history files 99

3-3

Template editor 102

3-4

Transferring processing steps by means of drag-and-drop 103

3-5

Example history template 103

3-6

Applying history templates 105

EEG views
4-1

Red cross (mouse cursor) 111

4-2

"Channel Information" display 112

4-3

Single-point highlighting 113

4-4

Range highlighting with arrows for changing the size 113

4-5

"Area Settings" dialog box 114

4-6

Selected channel with blue highlighting 115

4-7

Selecting multiple channels simultaneously 116

4-8

Dashed box indicating the active channel 116

4-9

Butterfly view, averaged EEG 118

4-10

Butterfly view, channel highlighting 119

4-11

Grid view 120

4-12

Grid view, Overlaying of two channels by means of drag-and-drop 120

xvi List of figures

4-13

Grid view, Overlaying of channels Fp1 and F7 121

4-14

Head view 122

4-15

Head view, Changing the position of an active window (channel) 122

4-16

Head view, Resetting channel positions 123

4-17

Head view, Overlaying of channels Fp1 and Fpz 124

4-18

Mapping view 125

4-19

Mapping view, Manual scaling 125

4-20

Standard view 126

4-21

3D head view 127

4-22

Time-frequency view 129

4-23

Time-frequency view, linear color scale 129

4-24

Time-frequency view, overlays 130

4-25

Time-frequency view, grid view 130

4-26

Time-frequency view, head view 131

4-27

Selecting a data set for use as an overlay 132

4-28

Data set overlay 133

4-29

Hiding an overlay temporarily 134

4-30

"Overlay Information" display 135

4-31

Additional view functions in the ribbon 136

4-32

View context menu 136

4-33

Head view for time data 138

4-34

Head view for frequency data 139

4-35

The butterfly view is not available for frequency data 139

4-36

Channel Selection 141

4-37

Delta Tool 144

4-38

Magnifier 146

4-39

Map Legend 147

4-40

Mapping 148

4-41

Scaling Bar tool 149

List of figures xvii

Chapter 5

4-42

Scaling Bar tool, settings 150

4-43

Text Box 151

4-44

Text Box tool, settings 152

4-45

Value Graphics, curve 153

4-46

Value Graphics tool, settings 153

4-47

Hierarchy of view settings using the example of a node with segmented data 155

4-48

Category-related view settings, settings editor 156

4-49

Displaying the node-specific view settings 157

4-50

Node-specific view settings based on the example of the standard view 157

4-51

Restoring the category-related view settings for the active history node 158

4-52

Settings in the "Display" tab 159

4-53

Horizontal lines for voltage display 160

4-54

Display of global markers 160

4-55

Markers displayed below the graph 161

4-56

Markers displayed on the graph 161

4-57

Settings for frequency data 162

4-58

Settings for time-frequency data 163

4-59

Settings for color scales with separate color steps 164

4-60

Settings for axes 165

4-61

Settings for frequency bands 166

4-62

Settings for overlays 167

4-63

Frequency band display using monochrome lines 167

4-64

Settings for maps (topographies) 168

4-65

Settings for the head view 171

4-66

Fonts and lines 172

4-67

Settings for the 3D head view 173

Montages
5-1

Creating a new montage 175

5-2

Montage editor, head view 177

xviii List of figures

Chapter 6

5-3

Montage editor, list view 178

5-4

Montage editor with grid on the right 179

5-5

Color highlighting of channels 180

5-6

Montage editor for the "Laplacian" reference type (section) 181

5-7

Montage editor for the "Bipolar" reference type, list view with grid on the right 181

5-8

Montage editor for the "Bipolar" reference type, head view 182

5-9

Displaying created montages in the ribbon 183

5-10

Assigning keyboard shortcuts to montages 184

5-11

Selecting the initial (default) montage in the "Preferences" dialog box 185

Customizing program settings
6-1

Selecting EEG views 188

6-2

Configuring scaling 189

6-3

Separate scaling for individual channels 190

6-4

Assigning colors to transforms, color selection dialog box 191

6-5

Defining electrode coordinates 192

6-6

General settings 193

6-7

Selecting a skin 194

6-8

Maximized data view 195

6-9

Maximized productivity 195

6-10

Floating docking window 196

6-11

Title bar of a docking window 197

6-12

Pinned and hidden docking window 197

6-13

Display of landing zones for docking windows 198

6-14

Docking windows grouped as a tab 199

6-15

Arranging windows as in Analyzer 1 200

6-16

Opening and closing docking windows 200

6-17

Configuring view settings 201

6-18

Specifying search paths 202

6-19

Configuring user profiles 203

List of figures xix

6-20

Chapter 7

Specifying component search paths 204

Primary and secondary transforms
7-1

Transform groups 207

7-2

New Reference, page 1 of the dialog box 208

7-3

New Reference, page 2 of the dialog box 209

7-4

New Reference, page 3 of the dialog box 210

7-5

Pooling, dialog box 211

7-6

RMS/GFP, dialog box 212

7-7

CSD, dialog box 213

7-8

CSD, Mapping view settings 215

7-9

Rectify, dialog box 216

7-10

Edit Channels, dialog box 217

7-11

Edit Channels, warning for missing values 218

7-12

Edit Channels, warning message Edit Channels Parameters in case of duplicate channel names
220

7-13

Edit Channels, Changing the user-defined channel properties 220

7-14

Level Trigger, dialog box 221

7-15

Linear Derivation, dialog box 223

7-16

Formula Evaluator, dialog box 224

7-17

Change Sampling Rate, dialog box 226

7-18

Topographic Interpolation, dialog box 227

7-19

Topographic Interpolation, Map for coordinate selection 229

7-20

Add channels, experimental setup 233

7-21

Add channels, before clock offset correction 234

7-22

Add channels, result of clock offset correction 235

7-23

Add channels, result of clock drift correction 235

7-24

Add channels, external data as additional channels 236

7-25

Add Channels, dialog page 1, File parameters 237

7-26

Add Channels, dialog page 2, Synchronization parameters 238

xx List of figures

7-27

Add Channels, dialog page 3, Histogram 240

7-28

Add Channels, dialog page 4, Channel selection and import 241

7-29

Add Channels, dialog page 5, Selecting and importing external events 242

7-30

Add Channels, dialog page 6, Importing additional header information 243

7-31

Complex Demodulation, dialog box 244

7-32

IIR Filters, dialog box 246

7-33

Band Rejection, dialog page 1, Defining the filters 248

7-34

Band Rejection, dialog page 2, Selecting the channels 249

7-35

Artifact Rejection, segment selection methods 250

7-36

Artifact Rejection, manual segment selection without the Mark bad segments instead of removing them function 251

7-37

Artifact Rejection, manual segment selection, Mark bad segments instead of removing them
function 253

7-38

Artifact Rejection, selecting channels 255

7-39

Artifact Rejection, gradient criterion 256

7-40

Artifact Rejection, min-max criterion 257

7-41

Artifact Rejection, amplitude criterion 258

7-42

Artifact Rejection, low activity criterion 259

7-43

Artifact Rejection, intervals criterion 260

7-44

Artifact Rejection, semiautomatic segment selection, interactive view 261

7-45

Raw Data Inspection, selecting the inspection method 263

7-46

Raw Data Inspection, manual inspection, interactive view 264

7-47

Raw Data Inspection, selecting the channels 266

7-48

Raw Data Inspection, gradient criterion 267

7-49

Raw Data Inspection, max-min criterion 268

7-50

Raw Data Inspection, amplitude criterion 269

7-51

Raw Data Inspection, low activity criterion 270

7-52

Raw Data Inspection, semiautomatic inspection, interactive view 271

7-53

Ocular Correction ICA, dialog page 1, Ocular Correction ICA settings 273

7-54

Ocular Correction ICA, dialog page 2, Use Existing Markers, selecting blink markers 275

List of figures xxi

7-55

Ocular Correction ICA, interval markers 276

7-56

Ocular Correction ICA, start and end markers 276

7-57

Ocular Correction ICA, dialog page 2, New Markers, algorithm for blink detection 277

7-58

Ocular Correction ICA, dialog page 3, ICA-based Correction, eye activity 279

7-59

Ocular Correction ICA, dialog page 4, selecting the channels 280

7-60

Ocular Correction ICA, dialog page 5, selecting the ICA method 281

7-61

Ocular Correction ICA, automated interval selection 282

7-62

Ocular Correction ICA, dialog page 6, defining the artifact-related ICA components 284

7-63

Ocular Correction ICA, dialog page 7, export options 286

7-64

Ocular Correction ICA, dialog page 3, Marker Placement (no ICA), eye activity 287

7-65

Ocular Correction ICA, semiautomatic mode, ICA components 288

7-66

Ocular Correction ICA, blink inspection 290

7-67

Ocular Correction ICA, blink markers displayed in different colors 291

7-68

Ocular Correction ICA, dialog page 1, Recalculate 292

7-69

Ocular Correction, dialog box 294

7-70

ICA, dialog page 1, export options 298

7-71

ICA, dialog page 2, channels and components 299

7-72

ICA, dialog page 3, data used to calculate the ICA matrix 301

7-73

ICA, automated interval selection 302

7-74

ICA, dialog page 4, selecting the ICA method 304

7-75

ICA, semiautomatic mode with interactive view 306

7-76

ICA, semiautomatic mode, entering comments 307

7-77

ICA, semiautomatic mode, Correction 308

7-78

ICA, semiautomatic mode, Topographies 308

7-79

ICA, display of the ICA components from the unselected channels 309

7-80

ICA, User Properties 310

7-81

Inverse ICA, sample branch for inverse ICA 312

7-82

Inverse ICA, dialog box 313

7-83

Inverse ICA, semiautomatic mode 314

xxii List of figures

7-84

FFT, dialog box 315

7-85

FFT, window function w(t). For these three cases a = b = 0.5. 319

7-86

FFT, parameter settings for the inverse FFT 321

7-87

FFT Inverse, dialog box 322

7-88

Wavelets, frequency layers and time-frequency points 323

7-89

Wavelets, selection of method 325

7-90

Wavelets, Continuous Wavelet Transform, parameter settings 325

7-91

Wavelets, Morlet Complex Wavelet, output value settings 328

7-92

Wavelets, Morlet Wavelet, output value settings 329

7-93

Wavelets, Invertible Discrete Wavelet and Discrete Wavelet, parameter settings 330

7-94

Wavelets, Invertible Discrete Wavelet and Discrete Wavelet, window function 331

7-95

Wavelets, Discrete Wavelet, output value settings 332

7-96

Wavelets, Inverse Wavelets Transform 333

7-97

Wavelets, Continuous Wavelet. A) Complex Morlet, B) Morlet C) Mexican Hat 335

7-98

Wavelets, Morlet Complex Wavelet, time-frequency trade-off 336

7-99

Wavelets, Discrete grid in the time-frequency domain 337

7-100

Wavelet Extraction, dialog box for selecting a layer 340

7-101

PCA, dialog page 1, General settings 342

7-102

PCA, dialog page 2, Selecting the history files 344

7-103

PCA, dialog page 3, Selecting the history nodes 345

7-104

PCA, dialog page 4, Selecting the channels 346

7-105

PCA, dialog page 5, Calculating the eigenvalue 347

7-106

PCA, display of the components as graphs when Variables at Channels is selected 348

7-107

PCA, display of the loadings as head topographies when Variables at Channels is selected 349

7-108

PCA, display of the components as head topographies when Variables at Time Points is selected
349

7-109

PCA, display of the loadings as graphs when Variables at Time Points is selected 350

7-110

PCA, displaying a single map 351

7-111

PCA, properties of a node of the type "Components" (containing the data set of the type "Loadings"
in the form of User Properties) 352

List of figures xxiii

7-112

PCA, properties of a node of the type "Loadings" (containing the data set of the type "Components"
in the form of User Properties) 353

7-113

PCA, marker names 354

7-114

PCA, User-defined marker properties (User Properties) 354

7-115

Peak Detection, first page of the dialog box 357

7-116

Peak Detection, dialog page 2, Separate Search for Every Channel option 359

7-117

Peak Detection, dialog page 2, Search Peak in a Reference Channel option 360

7-118

Peak Detection, dialog page 3, selecting channels 361

7-119

Peak Detection, Semiautomatic peak detection, Separate Search for Every Channel option 362

7-120

Peak Detection, Semiautomatic peak detection, Search Peak in a Reference Channel option 363

7-121

LRP, preliminary processing of the data 364

7-122

LRP, selection dialog box for the second data set 365

7-123

LRP, channel selection dialog box 366

7-124

ERS/ERD, dialog box 368

7-125

Grand Average, dialog box 370

7-126

Segmentation, dialog page 1, Segmentation type and storage options 372

7-127

Segmentation, dialog page 2, marker-based segmentation 374

7-128

Segmentation, dialog page 3, marker-based segmentation 375

7-129

Segmentation, dialog page 2, time-based segmentation 376

7-130

Segmentation, dialog page 3, time-based segmentation 377

7-131

Segmentation, dialog page 2, setting segments manually 377

7-132

Segmentation, dialog page 3, setting segments manually 378

7-133

Segmentation, dialog page 2, selecting the delimiting segment markers 379

7-134

Segmentation, dialog page 3, segmentation based on start and end markers 380

7-135

Segmentation, Segmentation node, creating the cache data again 381

7-136

Selecting the cache folder in the "Administration" dialog box 382

7-137

Grand Segmentation, dialog box 384

7-138

Average, dialog box 386

7-139

Baseline Correction, dialog box 388

7-140

DC Detrend, Global DC trend correction 389

xxiv List of figures

7-141

DC Detrend, Local DC trend correction 390

7-142

t-Test, first page of the dialog 392

7-143

t-Test, Selecting the t-Test type of the second data set 394

7-144

Cross Correlation, dialog box 395

7-145

Data Comparison, first page of the dialog 397

7-146

Data Comparison, comparing channels or data sets 398

7-147

Data Comparison, comparing channels 399

7-148

Data Comparison, comparing data sets 400

7-149

Data Comparison, standard view (data set overlay) 401

7-150

Data Comparison, grid view (channel overlay) 402

7-151

Data Comparison, Displaying static overlays 402

7-152

Covariance, dialog box 404

7-153

Coherence, dialog box 406

7-154

Coherence, Output of coherence data in the paired channel view 407

7-155

LORETA, dialog box 409

7-156

LORETA, Creating a new ROI 410

7-157

LORETA, Adding lobes to the ROI 411

7-158

LORETA, Adding a specific position to the ROI 412

7-159

LORETA, Adding a block to the ROI 413

7-160

LORETA, Components of the "Frontal" ROI 414

7-161

LORETA, Deleting Loreta streams 415

7-162

MR Correction, dialog page 1, Artifact detection method 420

7-163

MR Correction, histogram 422

7-164

MR Correction, dialog page 2, Artifact type and interval length 423

7-165

MR Correction, dialog page 3, Baseline and averaging 424

7-166

MR Correction, dialog page 4, Selecting the channels 428

7-167

MR Correction, dialog page 5, Sampling rate and filters 429

7-168

MR Correction, dialog page 6, Storage options 431

7-169

CB Correction, dialog page 1, Artifact detection method 433

List of figures xxv

7-170

CB Correction, Pulse template with the markers TSTART, TPEAK and TEND 434

7-171

CB Correction, Pulse template in semiautomatic mode 435

7-172

CB Correction, dialog page 2, Time delay and channel selection 436

7-173

CB Correction, dialog page 3, Storage options 438

7-174

CB Correction, markers in semiautomatic mode 439

7-175

CB Correction, interactive view 441

7-176

CB Correction, Correlation trigger (green line) and local minimum correlation 442

7-177

CB Correction, Minimum (pink) and maximum (blue) amplitude triggers 443

7-178

CB Correction, Amplitude trigger and correlation trigger 444

7-179

CB Correction, Colors of the overlays in the interactive view 445

7-180

CB Correction, Moving the pulse template 445

7-181

CB Correction, making changes to settings 446

7-182

Data Cache, dialog box 448

7-183

Edit Markers, first page of the dialog 449

7-184

Edit Markers, automatic mode 450

7-185

Edit Markers, "User Properties" dialog box 451

7-186

Edit Markers, manual (table) mode 452

7-187

Edit Markers, graphical mode with interactive view 454

7-188

Edit Markers, Setting markers with more than one point 455

7-189

Edit Markers, Changing marker positions 455

7-190

Edit Markers, Channel marker with positioning handle 455

7-191

Edit Markers, Global marker with positioning handle 456

7-192

Edit Markers, Editing marker properties 456

7-193

Import Markers, first page of the dialog 458

7-194

Import Markers, Importing markers from a file 459

7-195

Import Markers, Importing markers from history nodes 460

7-196

MATLAB®, Message window 463

7-197

MATLAB®, first page of the dialog with the Calculate Data on Creation of Node option selected
464

7-198

MATLAB®, first page of the dialog with the Calculate Data on Request option selected 465

xxvi List of figures

Chapter 8

7-199

MATLAB®, dialog page 2, Export options 466

7-200

MATLAB®, Data in simple matrix format 467

7-201

MATLAB®, Properties variable 468

7-202

MATLAB®, Channel properties 468

7-203

MATLAB®, Markers variable 469

7-204

MATLAB®, Variables with information on the node and the Analyzer environment 470

7-205

MATLAB®, Data in EEGLAB format 472

7-206

MATLAB®, Interactive EEGLAB user interface 473

7-207

MATLAB®, Selecting a reference node 474

7-208

MATLAB®, Selecting channels for export 475

7-209

MATLAB®, Example, Simple plot 1 476

7-210

MATLAB®, MATLAB® plot of the EEG data 477

7-211

MATLAB®, Example, Simple plot 2 478

7-212

MATLAB®, Example of the creation of an FIR filter 479

7-213

Edit User Properties, dialog box 480

7-214

Edit User Properties, Viewing modified User Properties in the history node 481

Transient transforms
8-1

Selecting a transient transform 483

8-2

Transient transforms in the view context menu 484

8-3

3D-Head-View, 3D head view as a transient transform 485

8-4

Band mapping view 486

8-5

CSD map, Selecting the interpolation method in the view settings 488

8-6

CSD map, CSD map as a transient transform 489

8-7

LORETA, LORETA as a transient transform 490

8-8

LORETA, Display of the mouse pointer in the cross-section 491

8-9

LORETA, Settings in the LORETA window 492

8-10

LORETA, Settings dialog box 493

8-11

LORETA, Display of horizontal cross-sections 494

8-12

LORETA, Deleting Loreta streams 494

List of figures xxvii

Chapter 9

Chapter 10

8-13

FFT, FFT as a transient transform 495

8-14

Mapping view, Map as a transient transform 496

8-15

Zoom view 497

Add-ins
9-1

Marker Navigation 499

9-2

Combined EEG/video playback 501

9-3

Generic Data Header, dialog box 502

9-4

Renaming channels 503

9-5

Displayed EEG 504

Export components
10-1

Specifying the export folder 506

10-2

Export file specifications after completion of input 507

10-3

Besa Export, dialog box 508

10-4

EDF Export, dialog box 509

10-5

Export Markers, dialog box 510

10-6

Generic Data Export, dialog page 1, General settings 511

10-7

Generic Data Export, dialog page 2, Format of the data file 513

10-8

Generic Data Export, Settings for text format 514

10-9

Generic Data Export, Settings for binary format 515

10-10

Generic Data Export, dialog page 4, Channel selection 516

10-11

Create New Dataset, dialog box 517

10-12

Create New Dataset, information 517

10-13

Area Information Export, dialog box 518

10-14

Peak Information Export, dialog box 520

10-15

Loreta Export, dialog box 521

10-16

Export ICA Matrices, dialog box 522

xxviii List of figures

Chapter 12

Chapter 13

Chapter 14

Chapter 15

Chapter 16

Chapter 17

Printout
12-1

Print function in the view context menu 529

12-2

Printer settings 530

12-3

Defining headers and footers 531

Exporting graphics
13-1

Export function in the view context menu 533

13-2

Exporting to the clipboard 534

Appending multiple raw data sets
14-1

"Append File" function in a history file's context menu 535

14-2

Message warning of the loss of processing steps 535

14-3

Selecting the history file to be appended 536

14-4

Bookstack icon 537

14-5

Information on the initial data set and the appended data sets 537

Macros
15-1

Macro editing window 540

15-2

Intermediate result of the macro example 541

15-3

Macro Manager 541

15-4

Macros in the ribbon 542

Solutions
16-1

Defining the base folder for solutions 544

16-2

Subfolder containing the "EKG Markers" solution 545

16-3

Structure of the "Solutions" tab 545

16-4

Solutions Help Explorer 546

Analyzer help system
17-1

Analyzer help system 547

17-2

List of installed program components 547

List of figures xxix

Appendix C

17-3

Support Info, dialog box 548

17-4

Update Manager, selecting the installation source 550

17-5

Installing updates from the website 551

17-6

Installing updates immediately 551

17-7

No new updates found 552

17-8

Choosing the source for the update 553

17-9

Installing updates offline 553

17-10

Selecting updates for installation 554

17-11

Information on data-relevant changes 554

17-12

Important information message elicited for data-related changes 555

17-13

Results of the installation process 556

17-14

Installing additional updates 557

Electrode coordinate system
C-1

Appendix F

Installing a network license (USB)
F-1

Appendix G

Appendix K

Coordinate system for electrodes 564

Example of an error message from the Analyzer in the event of a problem with the USB network dongle 573

Installing sub-licenses
G-1

Data entry form for product registration 575

G-2

Login form 576

G-3

Download area for sub-license files 576

G-4

Installing sub-licenses 577

G-5

Running the sub-license file as administrator (Windows® Vista/7) 577

G-6

Displaying sub-licenses in the Analyzer 578

Segmentation using advanced Boolean expressions
K-1

Marker-based segmentation, dialog page 2, text box for ABE 586

xxx List of figures

Appendix L

DirectX 9 for 3D head view and Analyzer Video
L-1

.NET Framework 3.5, installing under Windows® 8 596

xxxi

List of tables

Chapter 4

Chapter 12

EEG views
4-1

Placeholders available for use in the text box of the Channel Selection tool 141

4-2

Variables in formulae 142

4-3

Quantifiers in formulae 143

4-4

Placeholders available for use in the text box of the Delta Tool 144

4-5

Variables in formulae 145

4-6

Placeholders available for naming overlays 168

Printout
12-1

Appendix A

Product identification information
A-1

Appendix D

Predefined marker types 565

Keyboard shortcuts
E-1

Appendix M

559

Markers (time markers)
D-1

Appendix E

Placeholders and their meaning 532

Keyboard shortcuts and their functions 567

File formats for Generic Data Reader and Generic Data Export
M-1

"Common Infos" section of the header file 600

M-2

"ASCII Infos" section 602

M-3

"Binary Infos" section 602

M-4

"User Infos" section 603

M-5

"Channel Infos" section 603

M-6

"Coordinates" section 604

M-7

"Channel User Infos" section 604

M-8

"Common Infos" section of the marker file 605

M-9

"Marker Infos" section 605

M-10

"Marker User Infos" section 606

BrainVision Analyzer User Manual | Software Version 2.0.4 | September 30, 2013

xxxii List of tables

M-11

Top-level entries in the header file 608

M-12

Properties of the data set 609

M-13

Entries relating to binary format 611

M-14

Entries relating to text format 612

M-15

Channel information 612

M-16

Information on reference markers 613

M-17

Information on peak reference channels 613

M-18

User-defined properties 614

M-19

Top-level entries in the marker file 615

M-20

Marker entries 616

33

About this manual

This User Manual describes the BrainVision Analyzer Version 2.0.4. It is part of the software
product. It is essential to follow the instructions in the manual in order to use the software
correctly and as intended.
Please note that the extensive functions for navigating in the user manual may not be available if you use a program other than Adobe Reader.
For more detailed information on
working in Windows® 8, see Section 1.3 as of page 56.
No part of this User Manual may be reproduced or distributed in any form (by printing, photocopying or any other method) without the express written permission of Brain Products
GmbH. You can find the most recent version of this manual on our website: http://
www.brainproducts.com/downloads.php?kid=5

The structure of the user manual
The manual comprises a total of 17 chapters:
 Chapter 1 contains the installation instructions as well as information on the update

function and the dongle.
 In Chapter 2, you will learn about how the Analyzer handles EEG files and how you use

the program.
 In Chapter 3, we explain advanced concepts that are fundamental to the Analyzer, such

as segmentation, transforms, history files and history templates.
 In Chapter 4, you will find out about the versatile capabilities offered by the Analyzer for

the display of EEG data.
 Chapter 5 describes the use of montages.
 Chapter 6 provides you with information about configuring the Analyzer's program set-

tings.
 Chapter 7 and Chapter 8 contain all the primary, secondary and transient transforms

available for the Analyzer.
 Chapter 9 describes all the add-ins.
 Chapter 10 explains how data sets, markers etc. are exported for external further pro-

cessing.
 Chapter 11 describes how you can import user-defined formats into the Analyzer.
 Chapter 12 and Chapter 13 contain information on printing as well as on how to export

graphics.
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 In Chapter 14 you will learn how to combine multiple raw data sets to form a single data

set.
 Chapter 15 explains the use of macros.
 Chapter 16 contains instructions on using solutions.
 Chapter 17 provides you with information on using the Analyzer's Help function.

Who is the manual intended for?
The user has to ensure that the guidelines given by the manufacturer regarding the intended
use and the correct use are fully observed and implemented.
The software BrainVision Analyzer is permitted to be operated by users in the psychological
and neurophysiological research area.
BrainVision Analyzer is not permitted to be used by unqualified persons (e.g. laymen).

Conventions used in the manual
The manual uses the following typographical conventions:
italic

Italic text is used to identify menus, menu commands, dialog boxes, options, and the names of files and folders. Italic font is also used to highlight
portions of running text.

underscore

Underscored text indicates a cross-reference or a web address.

monospaced

A monospaced font is used to indicate text or characters to be entered at
the keyboard, such as source code and programming examples.



The blue dot indicates the end of a chapter.

The manual also uses the following symbols to help you find your way around:
The Stop symbol indicates that you should not carry out a particular action.
A note draws your attention to important (technical) information.
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A cross-reference refers to a section of the manual or an external document that has a bearing on the running text at this point.
A tip gives you advice, recommends a particular approach or draws your
attention to an interesting aspect.
The New symbol indicates that new material has been added at this point.

Revision history
Page . . . . Status . . . . . . Subject
Title page. new . . . . . . . . Remove of CE mark
40 . . . . . . modified . . . . Intended use
40 . . . . . . new . . . . . . . . Correct use
41 . . . . . . new . . . . . . . . Use together with other products and components
561 . . . . . new . . . . . . . . Change of classification
561 . . . . . new . . . . . . . . Remove of CE mark

Reporting errors and support
You can search for updates of this manual on our website using the following link: http://
www.brainproducts.com/downloads.php?kid=5&tab=2.
If you require support or if you discover a mistake in the manual, the software or during operation, please contact:
Brain Products GmbH
Zeppelinstraße 7
D-82205 Gilching
Phone: +49 8105 73384 – 0
Fax: +49 8105 73384 – 505
Website: http://www.brainproducts.com
Email: support@brainproducts.com
On request, the support team will also send you a form to assist in clarifying faults and problems.
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Preface

The Analyzer and its functions
The first version of BrainVision Analyzer was released in 1997 for the analysis of EEG data.
Since then, numerous modules and calculation methods have been added to the program.
In the light of technological advances and the growing user demands resulting from these,
Brain Products launched Analyzer 2 in 2008. Fully redesigned and based on the latest software technologies, Analyzer 2 offers a wide range of new functionality in addition to the features already present in the previous version. This includes:
The Analyzer is able to read and process the EEG data of numerous EEG amplifiers from wellknown manufacturers.
History trees log every single operation applied to the EEG data. Templates can be created
based on these operations, allowing further trees to be created automatically. The parameters of operations can be modified subsequently, and subsequent operations are adjusted
automatically.
As a result of the implementation of OLE Automation and Microsoft .NET interfaces, the
Analyzer can be controlled by other programs.
The Analyzer has a modular structure. A distinction is made between reader, transform, montage, export, display and add-in components. By adding new components it is possible to dynamically expand the Analyzer's functionality. Brain Products works to develop new
components on an ongoing basis. All interfaces are open, which gives expert users the opportunity to develop their own components. Alternatively, users can have such components
developed for them. The integrated BASIC interpreter and the fact that transforms and addins can be written in any .NET language make it possible to program these applications
quickly and with great flexibility.
The view concept based on the XML description language also offers flexibility, allowing user
interfaces to be customized. These user interfaces can also be used in users' own modules.
A direct interface to MATLAB® ensures efficient, problem-free data interchange between the
Analyzer and MATLAB®/EEGLAB. MATLAB® scripts can be used in history trees and added
to templates. (A valid MATLAB® license is required on the computer for this function, which
is not part of the Analyzer.) We particularly want to thank all the scientists and developers
involved in EEGLAB for their constructive and valuable collaboration.
The LORETA module is used for source localization. It offers a graphical display and allows
virtual channels to be calculated based on what are known as "regions of interest" and further processed using the methods offered by the Analyzer.
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Intended use
As of September 30th, 2013 BrainVision Analyzer is not a medical device anymore and may
be used in the context of non-medical applications in order to carry out fundamental or applied research on the basis of neurophysiological methodology and data.
The Analyzer is used to analyze ExG1 signals (including raw EEGs, spontaneous EEG analyses
and evoked potentials) and sensor data on a computer. The ExG signals and sensor data are
recorded using separate programs (BrainVision Recorder, for example) and stored in the user's file system.
Use for diagnosis, therapy, and monitoring of vital physiological processes (for instance
such as cardiovascular functions etc.) or other medical, diagnostic or therapeutic purposes
is expressly forbidden.
The user is solely liable for any risks if the device is not used in accordance with the correct
use as described in chapter "Correct use". Brain Products GmbH provides no guarantee and
accepts no liability for the results obtained with BrainVision Analyzer.

Correct use
The user has to ensure that the guidelines given by the manufacturer regarding the intended
use and the correct use are fully observed and implemented.
The software BrainVision Analyzer is permitted to be operated by users in the psychological
and neurophysiological research area as well as physicians and medical experts.
BrainVision Analyzer is not permitted to be used by
 unqualified persons (e.g. laymen),
 people who personally cannot read or understand the User Manual (e.g. due to insuffi-

cient language knowledge, due to blindness).
BrainVision Analyzer can be used to process neuro-/electrophysiological signals from
healthy and sick adults, children and animals.
All versions of BrainVision Analyzer that have been released into the market as medical products do remain medical products. Brain Products will continue to treat them as medical products (i.e. to perform post market surveillance), for example until the end of their service life.
The user should be aware that if a former BrainVision Analyzer version that was a medical
product is replaced by a newer version that is not a medical product anymore, the terms and
conditions of the new BrainVision Analyzer version are effective only from then on.
1. EEG, EOG, ECG, EMG, EDA, etc.
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Use together with other products and components
BrainVision Analyzer is intended for off-line data analysis only. Thus, it must be considered
as a stand-alone product, that has not any physical or functional connection to other products.
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Chapter 1 Installation

Under normal conditions, the Analyzer does not impact on any programs already installed.
Brain Products, however, only guarantees that programs will interact without problems if the
programs concerned have been tested for compatibility. This applies to the Microsoft operating systems Windows® XP, Windows® Vista, Windows® 7 and Windows® 8 provided that
no modifications to the configuration of the operating system as delivered have been undertaken (including official service packs and updates).
The following hardware and software requirements must be fullfilled:
 Operating system: Windows® XP Service Pack 3, Windows® Vista Service Pack 1,

Windows® 7, Windows® 8
 Minimum configuration: Intel Pentium IV or higher, 512 MB of RAM, 8 GB hard disk,

graphics adapter with 64 MB of RAM
 At least 256 MB of free RAM, possibly more, depending on the volume of data processed
 We recommend that a monitor with a screen diagonal of at least 17" is used. For more

than 32 channels, you should use a 21" monitor.

1.1

Installing the Analyzer under Windows® XP

Proceed as follows to install the Analyzer under Windows® XP:
1

Start Windows® XP.

2

Insert the supplied BrainVision program DVD into your CD-ROM drive.

3

If your computer is set up to autostart a CD-ROM, the menu that guides you through the
installation will appear after a short time. If your computer is not set up to autostart CDROMs, you will have to run the installation file manually. Proceed as follows:
a

From the taskbar, choose Start > Run.

b

Click the Browse... button.

c

In the Browse dialog box, select the CD-ROM drive and double-click the Autorun.exe
file to open it.

4

Follow the instructions displayed.
The installation process that follows (steps 5 to
16) is described in Section 1.2 as of page 44.

5

After you have completed installation of the Analyzer, you should install all software updates that may be available.
For details, refer to Section 1.4 on page 58.
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You should also note that the Analyzer program components 3D head view and Analyzer
Video require DirectX 9 and the Managed DirectX 1.1 libraries.
For detailed information, refer to Appendix L as of page 595.

1.2

Installing the Analyzer under Windows® Vista and
Windows® 7

Proceed as follows to install the Analyzer under Windows® Vista/Windows® 7:
1

Start Windows® Vista/Windows® 7.

2

Insert the supplied BrainVision program DVD into your CD-ROM drive.

3

If your computer is set up to autostart a CD-ROM, then the AutoPlay dialog box opens automatically after a short period. Click Run Autorun.exe (see Figure 1-1).
Skip step 4 and proceed directly to step 5 on page 44 of these installation instructions.

Figure 1-1. "AutoPlay" dialog box
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4

If your computer is not set up to autostart CD-ROMs, you will have to run the installation
file manually. Proceed as follows:
a

Click the Start
button on the taskbar and then choose All Programs > Accessories
> Run (see Figure 1-2).

b

In the Run dialog box, click Browse... and select the CD-ROM drive.

c

Double-click the file Autorun.exe to open it.

d

Click OK in the Run dialog box (see Figure 1-3).

Figure 1-2. Executing the Autorun file manually under Windows® 7 (A)
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Figure 1-3. Executing the Autorun file manually under Windows® 7 (B)

5

When the installation file is run, the Welcome to BrainVision Installation dialog box is
shown. Click Install BrainVision Analyzer 2 (see Figure 1-4).

Figure 1-4. Selecting the software to be installed

6

The second page of the installation dialog is opened. Here also, click Install BrainVision
Analyzer 2 (see Figure 1-5).
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Figure 1-5. Installing Analyzer 2

7

The Analyzer requires the runtime environment Microsoft .NET Framework Version 4.0 (or
higher). If .NET Framework 4.0 is not present on your system, then a message is displayed
(see Figure 1-6). Click Finish to interrupt the installation routine (see Figure 1-7).
If .NET Framework 4.0 is present on your system then the installation routine is continued. In this case, go straight to step 11 of the installation instructions on page 50.

Microsoft .NET Framework 4.0
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Figure 1-6. Message output if .NET Framework 4.0 is not present
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Figure 1-7. Interruption of the installation routine

8

To subsequently install the runtime environment, click Install .NET 4 on the second page
of the installation dialog (see Figure 1-8). If the system's User Account Control facility
asks whether you want to authorize installation of .NET Framework 4.0, confirm that you
do (see Figure 1-9).
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Figure 1-8. Installing .NET Framework 4.0

Figure 1-9. Confirming installation of .NET Framework 4.0 (User Account Control facility)

9

You must accept the applicable license agreement before you can continue with the installation of .NET Framework 4.0. Next, click Install in the Microsoft .NET Framework 4 –
Setup dialog box (see Figure 1-10).
If requested to do so (see Figure 1-11), restart your computer.

Installing the Analyzer under Windows® Vista and Windows® 7 49

Figure 1-10. Accepting the .NET Framework 4.0 license agreement

Figure 1-11. Restarting the computer to terminate installation of .NET Framework 4.0

10 Go to the second page of the installation dialog and choose Install BrainVision Analyzer
2 (see Figure 1-5 on page 45).
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11 The Setup Wizard opens. Click Next to continue with the installation (see Figure 1-12).
Figure 1-12. Setup Wizard

12 Accept the Analyzer License Agreement (see Figure 1-13).

Installing the Analyzer under Windows® Vista and Windows® 7 51

Figure 1-13. Analyzer License Agreement

13 Select the program folder for the Analyzer (see Figure 1-14). If the system's User Account
Control facility asks whether you want to authorize installation, confirm that you do.
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Figure 1-14. Selecting the program folder

14 Follow the instructions which are now displayed until installation is completed.
15 Connect the supplied dongle to one of the USB ports of your computer before you start
the Analyzer.
16 Make sure that the most recent dongle drivers are installed on your computer. You can
check this by entering the address http://localhost:1947 in your browser to call the
Sentinel Admin Control Center. If you cannot open the Sentinel Admin Control Center
then the drivers are obsolete and have to be updated.
You will find the drivers on the BrainVision program DVD and in the download area of our
website at http://brainproducts.com/downloads.php?kid=9&tab=4.
In the Sentinel Admin Control Center, choose the menu item Sentinel Keys to check
whether your dongle possesses the current firmware. If the comment "Sentinel key version not supported" is displayed next to your dongle (see Figure 1-15) then you must update the dongle firmware as described in Section 1.6 on page 61.
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Figure 1-15. Dongle with obsolete firmware

17 You can start the Analyzer by double-clicking the Analyzer icon
that appears on your
desktop following successful completion of the installation. Alternatively, you can start
the program by choosing BrainVision Analyzer 2.0 under All Programs > BrainVision in
the Windows® start menu.
18 After you have completed installation of the Analyzer, you should install all software updates that may be available.
For details, refer to Section 1.4 on page 58.
You should also note that the Analyzer program components 3D head view and Analyzer Video require DirectX 9 and the Managed DirectX 1.1 libraries.
For detailed information, refer
to Appendix L as of page 595.

1.3

Installing the Analyzer under Windows® 8

Proceed as follows to install the Analyzer under Windows® 8:
1

Start Windows® 8.

2

Insert the supplied BrainVision program DVD into your CD-ROM drive.

3

If your computer is set up to autostart a CD-ROM, then a control panel opens automatically after a short period. Proceed as follows:
a

Click in the control panel using the mouse (see Figure 1-16).
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Figure 1-16. Windows® 8, control panel for autoplay

b

In the menu that now opens, click Run Autorun.exe (see Figure 1-17).

Figure 1-17. Windows® 8, menu for autoplay

If your computer is not set up to autostart CD-ROMs, you will have to run the installation
file manually. Proceed as follows:

4

a

Press the keyboard shortcut Windows key-<R>. This opens the Run dialog box.

b

Click the Browse... button.

c

In the Browse dialog box, select the CD-ROM drive and double-click the Autorun.exe
file to open it.

Follow the instructions displayed.
in Section 1.2 as of page 44.

The installation process that follows is described
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5

You can start the Analyzer by clicking the Analyzer icon
that appears on the Windows® start screen following successful completion of the installation. Alternatively,
you can start the Analyzer by pressing the shortcut Windows key-<D> to switch to the
desktop and double-clicking the Analyzer icon.
If you right-click in the Windows® start screen, a menu containing the entry All apps is
displayed at the bottom of the screen (see Figure 1-18). Click on this entry to open the
list.

Figure 1-18. Menu item used to list all apps

The list of all the apps contains a section entitled BrainVision which contains links to the
Analyzer, the Update Manager and the user manuals (see Figure 1-19).
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Figure 1-19. "BrainVision" section in the list of all apps

6

To conclude, you should also install any software updates that are present.
tails, refer to Section 1.4 on page 58.

For de-

You should also note that the Analyzer program components 3D head view and Analyzer
Video require DirectX 9 and the Managed DirectX 1.1 libraries.
For detailed information, refer to Appendix L as of page 595.
To ensure that you can use all the functions available for navigating in the User Manual, we
recommend that you use Adobe Reader instead of the Reader app that is integrated in Windows® 8. Adobe Reader is available free of charge on the Adobe website.
Please also note that even after installation of Adobe Reader, the integrated Reader app continues to be the default program used to read PDF documents. Proceed as follows to define
Adobe Reader as the default program:
1

Install Adobe Reader.

2

Press the keyboard shortcut Windows key-<D> to switch to the desktop.

3

Start Windows® Explorer by clicking the folder icon in the task bar and then nativate to
the Analyzer program folder.

4

Right-click the User Manual and select Open with > Choose default program... from the
context menu (see Figure 1-20).
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Figure 1-20. Choosing the default program for PDF documents

5

This opens a menu in which you can select Adobe Reader (see Figure 1-21). Make sure
that the box Use this app for all .pdf files is checked.

Figure 1-21. Menu in which you select the default program for PDF documents
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1.4

How can I find updates for the Analyzer?

After you have completed installation of the Analyzer, you should install all additional software updates that may be available. There are various ways of searching for updates:
 The Analyzer possesses a built-in update function known as the Update Manager.

For detailed information, please refer to Section 17.2 on page 549.
Alternatively, you can start the Update Manager by choosing BrainVision Analyzer Update Manager in the Windows® start menu under All Programs > BrainVision.
 The most recent updates for the Analyzer can also be found on our website at http://

www.brainproducts.com/downloads.php?kid=9&tab=2.
 If you want to search for updates via the BrainVision program DVD, you can do this by

clicking Install New Analyzer 2 Modules on the second page of the installation dialog
(see Figure 1-22).
Figure 1-22. Installing updates from the BrainVision program DVD
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1.5

Information about your dongle

The Analyzer uses a dongle-based licensing model. As of version 2.0.3, the Analyzer supports both HASP HL dongles and the new Sentinel HASP dongles. Unlike in the case of HASP
HL dongles, licenses for optional program components are stored directly in the Sentinel
HASP dongle, with the result that you no longer need any separate sub-license files.
You can convert your HASP HL dongle into a Sentinel HASP dongle by running an upgrade file
on your computer. If you would like to upgrade your dongle, please check the information
available on our website at http://www.brainproducts.com/analyzer203.php
You can view the following information about your dongle by choosing Help > Help > About
Analyzer in the ribbon (see Figure 1-23):
 Dongle type (HASP HL or Sentinel HASP)
 IP address and host name of the network license server (only for Sentinel HASP network

dongles)
 Label printed on the dongle (only for Sentinel HASP)
 Dongle ID or internal serial number
 Expiry date
 Add-on licenses

60 Chapter 1 Installation

Figure 1-23. Displaying dongle information

If the remaining validity period of your dongle is less than 30 days, a warning is displayed
when you start the Analyzer (see Figure 1-24).
Figure 1-24. Warning before a dongle expires
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You can also view information about your dongle from outside of the Analyzer by opening the
Sentinel Admin Control Center. To do this, start your browser and enter the address http://
localhost:1947. This provides you with information about the Sentinel HASP dongles both on
the local computer and in the network.
Use the Sentinel Keys command to check what dongles are available. The information that is
displayed differs depending on the dongle type. If you are using a Sentinel HASP dongle as
a network dongle, you can, for example, click the Sessions button to see which computers
are currently connected to the dongle.
The Sentinel Admin Control Center contains a separate help page with a detailed explanation of the individual specifications present on each screen page. The link to the help page
is located in the bottom right section of the browser window.
Please note that the Sentinel Admin Control Center is not supplied by Brain Products but is
a part of the dongle driver package provided by Aladdin/SafeNet. Consequently, the terminology used in the specifications it contains may differ from that used in the Analyzer. Thus,
for example, it displays "feature" numbers rather than the names of the Analyzer program
components that are controlled via these "feature" numbers. However, you can use the Sentinel Admin Control Center to obtain an overview of the dongles that are present, whereas in
the Analyzer you can only obtain information about the dongle to which the Analyzer is connected.

1.6

Updating obsolete dongle firmware

Analyzer as of version 2.0.3 can be operated with two different types of dongle: Either with
the HASP HL dongle or with the new Sentinel HASP dongle. If you are using a HASP HL dongle
then it is possible that the firmware may be obsolete. Usually, this will only be the case if you
have been using your HASP HL dongle for several years and have not updated the dongle
firmware.
If the firmware of the HASP HL dongle is obsolete then it is not possible to start Analyzer as
of version 2.0.3.
On page 52 you can find information on how to check whether your dongle firmware is up-to-date.
If the firmware installed on your dongle is obsolete, you can update the firmware by executing the program FirmwareUpdate.exe on your computer. This program is located in the Dongle folder of the BrainVision program DVD or can be obtained from the download area of our
website at http://brainproducts.com/downloads.php?kid=9&tab=4.
Before running the dongle firmware update program, insert your dongle in a free USB port on
your computer. When you do this, make sure that no other Brain Products dongle or any don-

Using the Sentinel Admin Control Center
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gle from another software publisher is inserted in your computer. Follow the instructions displayed.
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Chapter 2 Getting started and handling the program

2.1

Basic principles

2.1.1

Managing EEG files in Analyzer workspaces

When you open the Analyzer for the first time, you will see an empty user interface (see
Figure 2-1).
Figure 2-1. Empty user interface

Before you can read EEG files into the program, you must first enter certain information, including the storage location of the files. The Analyzer saves this information in a configuration file. In the following, we refer to these configuration files as "workspace". A workspace
file always has the extension .wksp2.
Only one workspace may be open in the Analyzer at any one time. However, each workspace
may contain multiple EEG files. In addition, the workspace contains all the processing steps
that you have applied to your files as well as the name of the folder that is the destination for
files that you export from the Analyzer.
Please note that the Analyzer never makes changes to your recorded EEG files. All processing
steps are managed separately from the EEG data and are usually stored in a separate folder.
Start the Analyzer. Click the Analyzer button , in the top left corner of the user interface.
This opens the application's main menu. Here you should click New (see Figure 2-2).
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Creating a new workspace

64 Chapter 2 Getting started and handling the program

Figure 2-2. Analyzer button and main menu of the application

The New Workspace dialog box appears (see Figure 2-3). This allows you to specify the following folders which you can either enter manually or select by using the Browse… button.
 Raw Files. You specify the folder containing your raw data here.
 History Files. Here you specify the folder in which the Analyzer is to save the processing

steps applied to the raw data.
We recommend that you specify a folder which does not as yet contain any files. If the
folder you have selected does not yet exist, the Analyzer creates it automatically when
you close the dialog box.
To ensure a clear organizational structure, we also recommend that you create a separate
history file folder for each workspace and group these individual history file folders in a
common parent folder.
 Export Files. Here you specify the folder in which the Analyzer is to save the files that you

want to export as the result of the analyses you perform. You can then, for example, further process the exported files in other programs.
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Figure 2-3. Setting up a new workspace

Once you have made your settings, press the <Enter> key or click OK. This opens a Save dialog
box. Here, you enter a name for the workspace and save the workspace file.
The Analyzer now checks the files present in the raw data folder and displays each detected
raw data file in the form of a book icon (see Figure 2-4).
Figure 2-4. EEG files displayed as book icons

Normally, you will work with a number of different workspaces. If you want to switch between
the individual workspaces, click Open in the application's main menu. This opens a File dialog box in which you can select the required workspace (see Figure 2-5).

Loading an existing workspace

66 Chapter 2 Getting started and handling the program

Figure 2-5. Loading an existing workspace

Editing the workspace

You can use the Edit command to modify the current workspace after it has been set up. The
Edit Workspace dialog box appears. You can then make the required changes to the directories.

2.1.2

EEG file display in the history tree

The Analyzer depicts the processing steps you apply to your EEG files in a tree structure. We
refer to this structure as a "history tree" in the following. Figure 2-6 depicts a history tree that
contains a large number of processing steps.
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Figure 2-6. History tree, processing steps

Your EEG files are displayed as book icons in the history tree. Every book icon contains the
raw data node "Raw Data". If you apply processing steps to your EEG files, these are appended as child nodes below the Raw Data node.
Each processing step generates a further child node. We refer to these child nodes as "history nodes". You can open and view each of these nodes as a separate EEG in the main window.
We define the term "history file" as, on the one hand, to the file containing all the processing
steps which is saved in the history file folder and, on the other, to the EEG file that is displayed as a book icon in the history tree.
You can rename or delete the history nodes. In contrast, you cannot make any changes to raw
data nodes since these are a fixed component of the EEG file.

2.1.3

Opening and viewing EEG files

When you create a new workspace, the Analyzer initially only displays the book icons for the
EEG files in the history tree (see Figure 2-4 on page 65). To open an EEG file, click the in
front of the book icon. The Analyzer then loads the EEG file and displays the opened file as a
"Raw Data" node in the history tree (see Figure 2-7).

The processing steps that
you can apply to your EEG
files are described in detail
in Chapter 7 as of page 207
and at other points in the
manual.
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Figure 2-7. Opened EEG file

To open the required raw data node, double-click it. Your EEG data is now displayed in the
Analyzer's main window (see Figure 2-8). Alternatively, you can click the node once to select
it and then press the <Enter> key to display the EEG.
Figure 2-8. The Analyzer with loaded EEG

You can then navigate in the EEG and show and hide markers.
You will find detailed information on the functions available in the user interface in Section 2.3 as of page 73.
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Opened nodes are displayed as tabs. These allow you to switch between different opened
nodes quickly and easily. Clicking a tab displays the associated node in the foreground. The
tabs are located at the top of the main window (see Figure 2-9).
Figure 2-9. EEG data in tabs

The name of the currently active node is also shown in the Analyzer's title bar (see Figure 210).
Figure 2-10. Title bar

If you have opened more tabs than can be accommodated in the tab bar, arrows are displayed at the end of the bar. You can use these arrows to scroll through the tab bar (see
Figure 2-11).
Figure 2-11. Scrolling in the tab bar

To close a tab, click the cross in the corresponding tab.
Alternatively, you can select the tab that you want to close and click the cross at the end of
the tab bar.
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2.2

Case example: processing steps applied to an EEG

In this section, we use the example of a simple filter transform to illustrate how you can apply
processing steps to an EEG. Processing steps always apply to the currently active node. Now,
open a history file and double-click the raw data node.
You will find detailed explanations of the individual
transforms in Chapter 7 as
of page 207.

In the user interface, the filter transform can be found under Transformations (see Figure 212).
Figure 2-12. Transforms in the user interface

In the Transformations tab, select Data Filtering > IIR Filters in the Artifact Rejection/Reduction group (see Figure 2-13).
Figure 2-13. Calling the Filter dialog

Whenever you select a transform, a dialog box opens in which you can make the settings required for the associated transform. In our example, the IIR Filters dialog box appears (see
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Figure 2-14). Here, you can set the filter frequency and also make other settings. Click OK to
complete your input and continue with processing.
Figure 2-14. Filter settings

A new window containing the resulting data set appears. A data set with the name Filters is
added to the history tree (see Figure 2-15).
Figure 2-15. Result node in the history tree
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Note that the "Raw Data" node is still open. Your unchanged raw data is available to you at
all times.
Further processing steps increase the size of your history file. You can create multiple
branches in the history tree from a data set.
You can view your filter settings again by right-clicking the Filters node and selecting
Operation Infos... from the context menu.
If you are not happy with the selected filter settings, you can choose Edit Parameters/
Reprocess in the Filters node's context menu. This opens the Filters dialog box in which you
can edit the selected parameters. This operation generates a new node which replaces the
original Filters node. When you do this, any child nodes of the Filters node are recalculated.
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2.3

The Analyzer interface

Following the explanation of how to open, manage and view EEG data in the Analyzer presented in Section 2.1, the following section describes everything else you need to know
about the program interface.
You can configure very many aspects of the Analyzer program interface yourself. You can use
docking techniques to arrange the various interface elements, such as windows and bars, on
the fly. In this section, we describe the structure of the interface before any adaptations have
been made.

2.3.1

Structure of the interface

As described in Section 2.1.2 and Section 2.1.3 above, the Analyzer displays your data in the
history tree and in the main window. Above the main window, you can find the ribbon, toolbar and Quick Access Toolbar. Below it, you can find the navigation bar and status bar (see
Figure 2-16).
Figure 2-16. Overview of the Analyzer interface

The ribbon has a hierarchical structure and can be used to access a large number of program
functions. The toolbar and navigation bar provide you with a quick way to display your data

In Section 6.2.2 as of
page 194, you will learn

how to use docking techniques to modify the Analyzer interface.
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and navigate in the EEG. The status bar displays information about the current position in the
EEG together with selected EEG values.

2.3.2

Ribbon

The ribbon contains all the menu functions. It is subdivided into tabs (see Figure 2-17). The
tabs consist of groups (see Figure 2-18). A group contains a number of entries (see Figure 219).
Figure 2-17. Section of ribbon, tab

Figure 2-18. Group

Figure 2-19. Entries in a group
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You can hide or show the ribbon by double-clicking a tab (see Figure 2-20).
Figure 2-20. Ribbon hidden

When you move the mouse pointer over a control, a small box appears, containing a brief description of the control (see Figure 2-21).
Figure 2-21. Tooltip

2.3.3

Quick Access Toolbar and Analyzer button

The Analyzer button
and Quick Access Toolbar are located above the ribbon. You can use
both of these control elements to access the most frequently used program functions quickly
and easily.
Clicking the Analyzer button opens the application's main menu.
You can assign the most frequently used functionsto the Quick Access Toolbar. Until you
have assigned at least one function to the Quick Access Toolbar, you will simply see a control
allowing you to call the Quick Access Toolbar next to the Analyzer button (see Figure 2-22).
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Figure 2-22. Calling the Quick Access Toolbar

To add functions to the Quick Access Toolbar, right-click the required control and then
choose Add to Quick Access Toolbar from the context menu (see Figure 2-23). You can remove controls that you have previously added by choosing Remove from Quick Access Toolbar in the context menu.
Figure 2-23. Adding controls to the Quick Access Toolbar

Figure 2-24. Quick Access Toolbar with controls added

If you prefer, you can display the Quick Access Toolbar below the ribbon by choosing the
Show Quick Access Toolbar Below the Ribbon command.

2.3.4

Navigating in the EEG

The navigation bar along the bottom of the interface allows you to navigate in the EEG (see
Figure 2-25).
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Figure 2-25. Navigation bar (section), marker bar and slider bar

At the left of the navigation bar there are four buttons which you can use to move backwards
and forwards along the EEG's time axis: The
and
buttons allow you to move one second forward or backward or 100 ms forward or backward in the case of intervals  1 s. The
buttons
and
allow you to go forward or back by the interval displayed minus one second. This means that the successive intervals displayed will overlap by one second.
The marker bar to the right of the buttons displays all the markers set in the EEG. Markers are
time-related indicators such as stimuli, responses, comments, segment boundaries, DC corrections, etc. You can right-click the marker bar to open a context menu (see Figure 2-26). By
deactivating entries here, you can either hide all the markers (Show Markers box not
checked) or hide certain specific marker types.
Figure 2-26. Showing and hiding markers

You will find detailed information on markers in the
Analyzer in Appendix D as of
page 565.
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The slider bar is located below the marker bar. The width of the slider in the bar represents
the currently displayed section of the EEG, and the slider bar represents the entire EEG. The
position of the slider can be changed using the mouse. The EEG extract represented by the
slider is then displayed in the main window.
If you click any point on the marker or slider bar, the corresponding section of the EEG is displayed.

2.3.5

Controls in the toolbar

The toolbar is located below the ribbon (see Figure 2-27); it allows you, for example, to set
the displayed interval or the simultaneously displayed number of channels.
Figure 2-27. Toolbar (section)

Buttons on the toolbar

The toolbar provides the following functions (
Appendix E as of page 567):
Copy

see also the table of keyboard shortcuts in

copies the current EEG view to the clipboard.

Overlay Data Set
page 132).

allows you to overlay different data sets (

Increase Interval

increases the displayed time interval.

Decrease Interval

see also Section 4.3 as of

decreases the displayed time interval.

Set Displayed Interval
is used to set the time scale.
If you single-click on
then you can dock the window.
In the Interval [s] text box, you specify the displayed interval in seconds. When you click Apply, your entry is
applied to the data.
The slider allows you to modify the scaling continously.
You can use the various buttons
to apply scaling
value to the data.
Reset Interval

resets the displayed interval to the default value.

The Analyzer interface 79

Fit Segment

adapts the display in such a way that precisely one segment is represented.

Decrease Channels

decreases the number of channels displayed.

Increase Channels

increases the number of channels displayed.

Next Group
switches to the next channel group. This function is only available if the number of channels has previously been reduced.
Previous Group
switches to the previous channel group. This function is only available if
the number of channels has previously been reduced.
Scale Up
Scale Down

increases the scale (sensitivity).
reduces the scale (sensitivity).

De/Activate the Baseline Correction
Set Scaling Range
If you single-click on

switches the baseline on and off.

allows you to scale the voltage.
then you can dock the window.

In the Range [μV] text box, you specify the scaling
range in microvolts. When you click Apply, your entry is
applied to the data.
The Min and Max text boxes allow you to enter the minimum and maximum value to be displayed separately.
In this way, you can shift the zero line of the EEG shown
up or down in the display. If you shift the EEG in this way, the De/Activate the Baseline Correction
function is automatically switched off when you click Apply.
If you select the Scale All option, all the channels are scaled. Scale EEG scales only the EEG
channels, while Scale EXG exclusively scales all non-EEG channels. (EEG channels and nonEEG channels are distinguished on the basis of whether or not they have coordinates.) Scale
Selected only scales previously selected channels (
for information on selecting channels, refer to Section 4.1.5 as of page 115).
The slider allows you to modify the scaling continously. You can use the various buttons
to apply the associated scaling value to the data.
Reset Scaling Range
Marker Edit Mode

resets the scaling to the original value.
calls the interactive marker editor (

see also Section 7.7.2 as of

page 449).
Bookmark Menu
Zoom To Selection

allows you to insert or remove bookmarks.
enlarges the selected range.

Undo Zoom from Selection

undoes the last zoom operation on a selected range.
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Windows
permits the flexible display and
arrangement of the various windows and other
items in the interface; if there is a check mark next
to the item, it means this item will be displayed.
Close All closes all the tabs and/or windows open
in the main window.
Reset Panel Layout returns the windows to their
original layout.
The Analyzer's docking
function is described in

Section 6.2.2 as of page 194.

All the fixed, integrated docking windows are listed below this. Click a name to activate or
deactivate the corresponding window. All the opened nodes are listed at the very bottom of
the menu. A check mark indicates the node that is currently active.
Use Tabbed Windows
allows you to display the data sets that are open in the Analyzer as
tabs or windows. If you decide to display the data sets as windows, you can use the following
buttons to determine how these windows are arranged:
Cascade Windows
Tile Horizontal
Tile Vertical

2.3.6

cascades all the open windows one after another.
arranges the windows one below the other.

arranges the windows next to each other.

Using and configuring the status bar

The status bar contains, for example, information about the montage, the interval displayed,
the mouse position and the current workspace (see Figure 2-28).
Figure 2-28. Status bar (section)

You can right-click the bar to open a context menu in which you can choose the information
that is to be displayed. To restore the status bar to the factory settings, select Reset Status
Bar (see Figure 2-29).
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Figure 2-29. Configuring the status bar

The status bar contains the following sections:
Messages displays status information output by macros.
ros in the Analyzer, refer to Chapter 15 as of page 539.
Montage indicates the employed montage type.
tages, refer to Chapter 5 as of page 175.

For information on using mac-

For more detailed information on mon-

Real-Time Of First Visible Point indicates the real time of the beginning of the EEG interval
displayed.
EEG-Time of First Visible Point indicates the time position of the interval displayed in the
EEG.
Segment indicates the current segment number at the beginning of the EEG interval displayed.
For information on segmentation, refer to Section 3.1 as of page 97 and
Section 7.4.5 as of page 371.
Channel displays the name of the channel on which the mouse is located.
Voltage indicates the voltage applied at this point.
Position relative to Visible Area indicates the time position on which the mouse is positioned, relative to the beginning of the EEG interval displayed or relative to a "Time Zero"
marker, if one has been set.
Workspace indicates the name of the active workspace.
Real Time indicates the real time on which the mouse pointer is positioned.
Data Point indicates the data point on which the mouse pointer is positioned.
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EEG Time indicates the time position on which the mouse pointer is positioned, relative to
the whole EEG.

2.3.7

Further information on workspaces

The workspace management functions in the application's main menu, which you can access by clicking the Analyzer button, are also available in the ribbon. Here, you can create,
load and edit workspaces.
Figure 2-30. Managing workspaces using the ribbon

The additional Refresh function is useful if you want to add further raw data to an existing
workspace without having to close the EEG files that are already present. To do this, first copy
the new raw files to the workspace's raw data folder. Then click Refresh to read the files into
the workspace. When you do this, the data sets that are currently displayed remain open so
that you do not have to interrupt your work.

Displaying and processing history trees 83

2.4

Displaying and processing history trees

2.4.1

The History Explorer

In Section 2.1.2, we described how the Analyzer manages data in the form of history trees.
The history trees are displayed in a dockable window at the left-hand edge of the interface.
This is known as the "History Explorer" (see Figure 2-31). The History Explorer enables you to
process raw data nodes and existing history nodes.
The History Explorer consists of three tabs which display the available nodes in different
ways. The Primary and Secondary tabs display history trees for primary and secondary history files, respectively. Your raw data is always present in the Primary tab. Secondary history
files are created as the result of certain processing steps which we examine in detail in
Section 3.2 as of page 99. The History tab contains a list of all the opened history nodes, the
"History Node List" (
see also Section 2.4.4 as of page 92).
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Figure 2-31. History Explorer with primary and secondary history files and History Node List

In the History Explorer, a book icon
is assigned to every history file. If the book icon does
not appear, this is either because the specified raw data folder is empty or because the
Analyzer is not (yet) able to read the format of the EEGs stored in this location. If the latter
explanation applies, please contact our support team for information on all the EEG readers
that are currently available. You will find the contact details on page 35.
To open a history file, click the cross in front of the book icon. You can double-click the
Raw Data icon
to open the associated EEG. To close the history file again, click on . At
the same time, this closes all the nodes assigned to the file.
If you want to transfer processing steps (transforms) to another history file, open the required history file. Position the mouse pointer on the icon of the transform to be transferred,
and then press the left mouse button. Hold down the mouse button to drag the icon to
the Raw Data icon of the second history file, and then release the mouse button to drop it
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there. The Analyzer then automatically creates the corresponding history tree (see Figure 232).
Figure 2-32. Creating a history tree by means of drag-and-drop

You can drag sections of the history tree not only to the raw data node but also to history
nodes. In addition, it is also possible to save sections of the history tree in a file so that you
can subsequently apply the same processing steps.
For detailed information, refer to
Section 3.4 as of page 102.
You can rename existing history nodes by clicking on the text corresponding to the name of
the selected node. To delete a history node, select the relevant node and press the <Del> key.
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2.4.2

Context menus in the history tree

Additional functions available for the individual nodes in the history tree can be accessed
via context menus. Since history files, raw data nodes and history nodes have different functions, their context menus also differ.

Context menu for history files

If you right-click a history file, the following context menu appears (see Figure 2-33):
Figure 2-33. Functions in a history file's context menu

Open/Close opens or closes the history file.
Expand All expands all the nodes belonging to the history file and consequently displays the
corresponding history tree.
Reload Raw File… removes all the history nodes and reloads the raw data set.
Compress History File reduces the space occupied by the history file on the hard disk. If you
frequently delete larger files (e.g. FFT) then empty spaces are often left in the history file due
to performance reasons. These empty spaces are gradually re-used. However, in the meantime, they are not released as usable storage. This phenomenon should not be confused with
the nodes that are left in the file in order to make it possible to restore deleted nodes.
Purge All Deleted Nodes permanently removes all the deleted nodes from the entire data set.
For more detailed information on handling deleted nodes, refer to Section 2.4.3 as of
page 90.
Append File… appends a raw EEG to the data set. When you choose this command, the first
history file is modified and the second one deleted. At the same time, the book icon is
changed into a an icon representing a stack of books.
You will find further information on
appending multiple data sets in Chapter 14 as of page 535.
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List Appended File(s)… allows you to call up the list of raw EEGs appended to the data set.
You can use Subject Infos to call up information relating to the test subject that was recorded
with the EEG.
Secondary history files, which are listed in the Secondary tab in the History Explorer, differ
in certain details from the history nodes listed in the Primary tab. Due to these differences,
the context menu displayed for secondary history files differs from that used for primary history files (see Figure 2-34).

For more detailed information on secondary history
files, refer to Section 3.2 as
of page 99.

Figure 2-34. Functions in the context menu of a secondary history file

The entries Append File... and Reload Raw File... are not present.
You can rename the secondary history file using Rename History File.
Delete History File... allows you to permanently delete the secondary history file.
If you right-click a raw data node, the following context menu appears (see Figure 2-35):

Context menu for raw data
nodes
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Figure 2-35. Functions in a raw data node's context menu

Open/Close opens or closes the raw data node.
Expand All From Here expands all the child nodes below the raw data node.
Collapse All From Here collapses all the child nodes below the raw data node.
Undelete Subnode(s) restores deleted nodes. To permanently remove (purge) all deleted
child nodes, choose Purge Deleted Nodes.
Both of these functions are explained in
Section 2.4.3 as of page 90.
Reset View Settings deletes all node-specific view settings.
tings are explained in Section 4.6.2 as of page 156.

The node-specific view set-

Properties… displays a window containing an overview of the data properties, such as the
length of the data set and the sampling interval.
Markers… displays a window containing an overview of the markers in the data set together
with their properties.
Comment adds a comment which you can then call up using this function.
Recording Infos… displays any information captured in the data set during the recording of
the EEG.
Remove Loreta Streams deletes the internal data of the (primary and transient) LORETA
transform.
The LORETA transform is described in detail in Section 7.6.1 as of page 408
and in Section 8.4 as of page 490.

Context menu for history
nodes

If you right-click a history node, the following context menu appears (see Figure 2-36):
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Figure 2-36. Functions in a history node's context menu

Open/Close opens or closes the node (window or tab).
Expand All From Here expands all the child nodes below the node.
Collapse All From Here collapses all the child nodes below the node.
Comment adds a comment which you can then call up using this function.
Rename allows you to rename the node. Alternatively, you can click the node to select it and
then press the <F2> key or click the node name text a second time after a few seconds. You
can now edit the text. This function is the same as the function in Windows® Explorer.
Delete deletes the node. Alternatively, you can press the <Del> key.
Undelete Subnode(s) restores deleted nodes. To permanently remove (purge) all deleted
child nodes, choose Purge Deleted Nodes.
Both of these functions are explained in
Section 2.4.3 as of page 90.
Reset View Settings deletes all node-specific view settings.
tings are explained in Section 4.6.2 as of page 156.

The node-specific view set-

Operation Infos… indicates the parameters used to execute the relevant processing step
(transform).
Properties… displays a window containing an overview of the data properties, such as the
length of the data set and the sampling interval.
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Markers… displays a window containing an overview of the markers in the data set together
with their properties.
Edit Parameters/Reprocess allows you to modify the parameters of the associated processing step (transform). The original node is removed and replaced. Edit Parameters/Copy allows you to modify parameters. The original node is retained. When you use either of these
functions, a Parameters dialog box is opened in which you can make the required changes.
The problems that may occur when executing a history template are discussed
in Section 3.3 as of
page 106.

Depending on the parameters selected, it may not be possible to restore all child nodes. In
such cases, what happens is similar to what happens in the case of a history template that
cannot be executed any further for any given reason.
If the parent node uses an interactive view for parameter editing, its child nodes are saved
hidden and not restored until the transform is completed. This also happens when the interactive view is interrupted with Suspend (a corresponding message appears).
If you use the Edit Parameters/Reprocess function, a backup copy of the original history
node and its child nodes is created. If you want to restore this backup copy, choose the Undelete Subnode(s) function in the parent node of the original history node.
If a node that is modified using Edit Parameters/Reprocess contains a subnode whose data
is not available (e.g. a node with an interactive view that was closed using Suspend), then
this node is not taken over. It can be restored from the backup copy if necessary.
Remove Loreta Streams deletes the internal data of the (primary and transient) LORETA
transform.
The LORETA transform is described in detail in Section 7.6.1 as of page 408
and in Section 8.4 as of page 490.

2.4.3

Restoring deleted child nodes

If you delete child nodes in the History Explorer, these nodes are not initially permanently removed. The "deleted" nodes are simply marked as deleted and continue to be present, but
invisible, in the history file. You can subsequently permanently remove these nodes or restore them and use them again as normal.
Deleted nodes always contain all their child nodes. This means that you can restore the entire deleted section of the history tree in a single operation. You should note, however, that
nodes that are present but invisible continue to occupy storage space in your history file.
There are a number of ways of permanently removing deleted nodes from the history file:
 In a history node's context menu, you can select Purge Deleted Nodes to remove all the

deleted child nodes of this history node. This action does not affect deleted nodes present in child nodes of the current node.
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 In a history file's context menu, you can select Purge All Deleted Nodes to remove all the

deleted nodes from all this file's child nodes.
 You can configure the Analyzer in such a way that it automatically removes (purges) all

deleted nodes after a few days.
Section 6.1.6 as of page 192.

For information on configuring this function, refer to

If you want to restore nodes that have not yet been permanently removed, choose Undelete
Subnode(s) in the context menu. This command is available in the context menus of raw data
nodes and history nodes.
If you choose this command, the Undelete Subnode(s) dialog box appears (see Figure 2-37).
This dialog box contains all the nodes below the current node that have been deleted with
the Delete function. To restore deleted nodes, check the box in front of the node(s) you wish
to undelete.
Figure 2-37. Restoring deleted nodes

Full Path shows the currently active node (highlighted in blue).
The Name and Delete Date buttons allow you to list the deleted child nodes sorted by name
or deletion date. You can also use the Ascending and Descending buttons to list the nodes
in ascending or descending order.
If you restore a deleted node which contains child nodes then the entire branch of the history
tree that was deleted during the corresponding delete operation is restored. Nodes restored
in this way therefore have no separate checkbox in the tree view in the dialog box.
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Nodes below the deleted node that had already been deleted separately at the time the node
was deleted are, on the other hand, not restored. Nodes such as these do, however, have a
separate checkbox and can therefore be restored using this function. If a node that is located
within a deleted subtree is marked for restoration, all the deleted nodes above the node are
also automatically marked for restoration.

2.4.4

Displaying a sorted list of history nodes

The History Node List lists all the history nodes currently open and is used to sort the nodes
(see Figure 2-38). The history nodes in the list are marked in the same color as the corresponding transform. Raw data is marked white.
Figure 2-38. History Node List

The History Node List has the following selection and display functions:
If you double-click an item in the list, the corresponding node is activated.
The

button to the right of each item closes the corresponding node.
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The

button minimizes the node or hides it temporarily.

The

button maximizes the node or displays it again.

<Shift> + a mouse click allows you to select either a range of items or all of them.
<Ctrl> + a mouse click allows you to select multiple items.
If you right-click one or more selected items, a context menu appears that allows you to close
the selected nodes (Close Selected Nodes command), hide them (Hide Selected Nodes command) or display them (Show Selected Nodes command).
When a large number of nodes are open, the following functions allow you to arrange them
and maintain the best possible overview:
 The Group drop-down list allows you to group the nodes in four different ways:
 None means that the nodes are not grouped.
 File groups them by file name.
 Status groups them based on whether the node is open (i.e. it has the status

Displayed) or closed (it has the status Hidden).
 Type groups them by transform type.
 The Sort drop-down list allows you to sort the nodes based on three criteria:
 Natural sorts the nodes in the sequence in which you opened them.
 Depth sorts the nodes by node depth. For the grouping criterion Type, for example,

FFT nodes of the same depth appear one after the other.
 Recursive sorts the nodes by path components (i.e. by the components separated by

a forward slash). The file is ignored, and the paths are compared component by component from left to right until there is a difference or the end of the path is reached.
In this case, the shorter of the paths is listed first. Consequently, the parent node is
listed first in a file followed by its child nodes.
 The History Node List also offers a search and filter function:
 The search function allows you to find a specific node quickly. To do this, click

Search. This opens a text box in which you can enter the desired search term. The
search is incremental (the function progressively finds a match for the search term as
you enter each character). When you press the <Enter> key, all the search results are
displayed.
 The filter function allows you to preselect nodes in order to limit the nodes displayed.

Click Filter. This opens a text box in which you can enter the desired filter. The search
is incremental (the function progressively finds a match for the search term as you enter each character). When you press the <Enter> key, all the search results are dis-
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played. The <backspace> key broadens the selection again. You can, for example,
filter out all nodes that contain segmentation, select them and then close them all.

2.5
You will find a detailed
description of the individual graphical tools in
Section 4.5 as of page 140.

Special graphical tools

The View Toolbox at the right edge of the interface (see Figure 2-39) provides you with a
range of graphical tools, the "view tools". You can use these view tools to add further elements to the displayed EEG.
Figure 2-39. View Toolbox

To use the individual tools, drag them onto the EEG using the mouse. This is only possible if
the current EEG view actually supports the relevant tool. For example, you can extend an EEG
graph by adding a map which indicates the voltage distribution at the selected point in time
(see Figure 2-40).
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Figure 2-40. Mapping tool applied to an EEG graph

Settings options are available for each of the graphical tools. You access these by clicking
the button to open the corresponding context menu. Each of the tools can also be closed
using the Close Tool function.
The Channel Selection highlights a selected section of the channel. The tool also provides a
text box which is connected to the highlighting by a line. You can use the text box to enter a
comment or formula, for example for the calculation of the average value of the selected
channel section.
The Delta Tool is for indicating differences in voltage and time values. The reference points
used for the determination of the difference are highlighted by a distance line in the EEG. The
difference values are displayed in a text box which you can position as you wish in the EEG.
The Magnifier magnifies an EEG channel. The magnified image is displayed in a positionable
frame next to the selected EEG range.
The Map Legend tool is used in conjunction with the Mapping tool in order to display the color key for the maps.
The Mapping tool allows you to display maps at any position in the EEG. The map is displayed
in a positionable frame next to the selected EEG range.
The Scaling Bar tool consists of a scale that displays the time or voltage and can be positioned wherever required in the EEG.
Text Box is used to add text at any required position in the EEG.
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The Value Graphics tool allows you to add simple drawing objects such as lines, circles or
curves, to the EEG. The drawing objects are not bound to the EEG but can be positioned as
required.


97

Chapter 3 Advanced concepts

In this chapter, we explain a number of concepts which are of fundamental importance when
working with the Analyzer and which are referred to frequently in the chapters that follow.

3.1

Segmentation

For the purposes of the Analyzer, segmentation refers to the subdivision of the EEG into different segments (epochs). Segmentation can be based on a number of different criteria.
This manual uses the term segmentation in the following cases:
 As a preliminary stage in the analysis of evoked potentials. Epochs of the same length

are generated relative to a reference marker (a stimulus, for example). This results in a
data set consisting of a sequence of segments or epochs. Thanks to the extensive segmentation options offered by the Analyzer, it is also possible to calculate averages based
on complex stimulus conditions (behavior-dependent conditions, for example).
 To prepare separate processing steps in different sections of an EEG, for example for the

analysis of different stages before and after medication. In this case, sections are selected either manually or based on a fixed time scale and converted to new data sets in the
history file. These can then be analyzed separately.
In the Analyzer, the subdivision of data sets into segments is taken into account in very many
processing steps as well as for display purposes. When you open a segmented data set, the
boundaries between segments are displayed as vertical green lines in the marker bar (see
Figure 3-1).
Figure 3-1. Marker bar, displaying segment boundaries

You can use the
and
buttons in the navigation bar to move backwards and forwards
segment-by-segment through the segmented data set. If you use the
and
buttons in
the toolbar to change the displayed time interval, then any subsequent navigation is based
on the time interval and not on the segments. You can then use the
button to reset the
time interval to one segment and navigate segment-by-segment again.
In the Analyzer, it is possible to set the zero point of the time axis anywhere within a segment.
If you perform segmentation based on stimulus markers then you can set the zero point to
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the stimulus marker. The zero point of the time axis is taken into account, for example, when
the time position of the mouse pointer is displayed in the status bar.
Depending on whether you are looking at a data set before or after segmentation, you can
configure your preferences concerning initial settings for montages and views (EEG display
modes) when new data sets are opened.
For information on how to modify the Analyzer's initial settings for montages and views, refer
to Section 6.1.1 as of page 187.
Views and montages are described in detail in Chapter 4 as of page 109 and Chapter 5 as of
page 175.
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3.2

Primary and secondary history files

An Analyzer workspace usually contains a number of history files each of which represents a
raw file in the Analyzer's raw data folder. In addition, by performing processing steps which
involve multiple history files, it is possible in the Analyzer to generate new data sets which
do not have a unique link to any individual raw file. An example of a processing step that involves multiple history files is the Grand Average (
see also Section 7.4.4 as of
page 369).
In the History Explorer, history files are assigned to different tabs depending on whether they
represent EEG raw files. Primary history files are listed in the Primary tab. These represent
raw files including the processing steps applied to them.
Secondary history files are listed in the Secondary tab (see Figure 3-2). These represent data
that has been collated from multiple history files as a result of the processing steps applied
to them. Secondary history files therefore no longer have a unique link to any specific raw
file.
Figure 3-2. Secondary history files

Because they are the result of a processing step, secondary history files resemble history
nodes in the history tree in certain respects. It is, for example, possible to rename or permanently delete secondary history files (
see also Section 2.4.2 as of page 87). This is not
possible in the case of primary history files because the Analyzer does not modify raw files.
Accordingly, secondary history files cannot be reset in the same way as is possible for primary history files via the Reload Raw File... context menu command.
You can apply further processing steps to secondary history files without restriction. To make
it possible to address primary and secondary history files in the same way, secondary history
files also always possess a Raw Data node. If you rename a secondary history file, this only
affects the name of the file itself but does not modify the Raw Data node.

You will find detailed information on the Analyzer interface in Section 2.3 as of
page 73.
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3.3

Analyzer program components: transforms, exports and
add-ins

The Analyzer permits the use of numerous components in the form of modules which extend
the main program. Some of these components are only used for technical tasks or display
purposes. Others, however, are called by the user in order to perform specific operations.
One typical use of Analyzer program components is the application of transforms as processing steps in the history tree.
The components that are available to users can be called in the program interface, for example via the entries in the ribbon. To view a list of currently installed components, choose Installed Components... in the Help tab on the ribbon.
New processing steps and methods can be added to the Analyzer by running an update operation to install the relevant program components.
You will find detailed information on
Analyzer updates in Section 1.4 on page 58 and Section 17.2 on page 549.
All components that are applied in the form of processing steps to an existing data set in the
history tree always use the data set that is active in the main window as the initial data set
for processing. If the open data sets are displayed in tabs then the active tab is highlighted.
In addition, the name of the active node is displayed in the Analyzer's title bar.
The following types of program components are of particular interest to users:
Primary transforms are processing steps which are applied to an existing data set in a history file. This leads to the creation of a new data set below the original data set. You can find
primary transforms in the Transformations tab on the ribbon.
For more detailed information on primary transforms, refer to Chapter 7 as of page 207.
Secondary transforms are processing steps which read data sets from different history files
and use these to create a new history file. The resulting history files are listed in the Secondary tab in the History Explorer. You can find secondary transforms in the Transformations tab
on the ribbon. The secondary transforms include, for example, Grand Average and PCA.
For more detailed information on secondary transforms, refer to Chapter 7 as of page 207.
Transient transforms are processing steps which are only used for visualization purposes.
They are applied within the EEG displayed in the main window and do not generate any new
history nodes. Transient transforms become available in the context menu as soon as you
use the mouse to select a point or range in the EEG display. The transient transform displays
its result in a dockable window in the main window. One example is the transient FFT which
displays the frequency spectrum of the selected EEG range in its result window. If you move
the selection in the EEG then the transient transform is updated.
For more detailed information on transient transforms, refer to Chapter 8 as of page 483.
Simple export components are applied to an existing data set and write EEG data or information about the EEG to a file. Simple export components create a history node below the existing data set. This history node contains information about the export but no EEG data. You
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can find simple export components in the Node Export and Others groups in the Export tab
on the ribbon.
For more detailed information on simple export components, refer to
Section 10.1 as of page 507 and Section 10.3 as of page 521.
Multiple export components write information taken from multiple history nodes to a file.
Multiple export components do not create new history nodes. You can find multiple export
components in the Multiple Export group in the Export tab on the ribbon.
For more detailed information on multiple export components, refer to Section 10.2 as of page 518.
Add-ins are additional components used for a variety of tasks. Add-ins can also be created
by users themselves and are freely programmable. The add-ins supplied with the product primarily take the form of tools or navigation aids (e.g. the "Marker Navigation" add-in). However, it is also possible to create add-ins that act as primary or secondary transforms.
For
more detailed information on add-ins, refer to Chapter 9 as of page 499.
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3.4

Automation using history templates

An Analyzer workspace may often contain a large number of history files to which the same
processing steps are to be applied in the form of history trees. To avoid having to make the
settings for these processing steps manually for each separate EEG, it is possible to automate the repetition of processing steps that have already been performed at new locations.
As mentioned in Section 2.4.1, you can use the mouse to drag parts of the history tree to data
sets and execute the processing steps again. As an extension to this function, you can also
save sections of the history tree in a file which is referred to as a "history template". You can
automatically apply the processing steps in a history template to selected history files or to
all the history files in the workspace.

Creating a history template

To create a new history template, choose New from the History Template tab on the ribbon.
The New Template tab appears. This contains the Root node. This node acts as the starting
point for the history template. You can position as many child nodes as you want below Root
in order to construct your processing tree. To do this, open a history file in which you have
already executed one or more processing steps (see Figure 3-3).
Figure 3-3. Template editor

Use the mouse to drag a data set from the history file to the Root node of the history template
(see Figure 3-4). This data set and the data sets derived from it are added to the history template (see Figure 3-5). During this operation, only the parameter settings for the processing
steps are transferred to the template but not, however, the data itself.
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Figure 3-4. Transferring processing steps by means of drag-and-drop

Figure 3-5. Example history template

In the template editor, the processing steps in the template are displayed as a tree. You can
edit this history tree in the same way as you do in the History Explorer. The processing steps
in the template possess context menus which contain all the applicable functions, such as
deleting and renaming.
Since the processing steps in the template do not contain any data, you cannot apply transforms directly to nodes in the template. You can, however, edit the template's tree structure
by dragging nodes from the History Explorer to any required node in the template. You can
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copy nodes within the template by dragging them with the mouse. This is particularly useful
because these processing steps take effect immediately and you do not have to wait for the
sometimes time-intensive calculation of the data.
Example: Let us assume that you have made an EEG recording with various stimulus markers
and applied preprocessing steps to the raw data. Next, you perform segmentation for each
of the stimulus markers and plan to apply the same processing steps for analysis after each
segmentation operation. In this case, you only need to apply the processing steps to the first
Segmentation node. You can then use drag-and-drop to create a history template containing
the entire processing tree in the template editor. You can apply this template to the raw data
to create additional branches.
You can drag any node from the template to the History Explorer in order to execute the processing steps below this node directly. If you drag the Root node from a history template to
a node in the History Explorer, all the child nodes of Root are executed and become child
nodes of the target node. If you drag another node from the template to the History Explorer
then this node is inserted as a child node of the target node.
You can use the template editor to combine multiple changes to the history tree which you
would otherwise have to perform at different times in time-consuming processing steps. If
you drag multiple parallel branches of the history tree under the same parent node in the History Explorer to the target node one-by-one, you have to wait for each branch to be processed. If, instead of this, you "park" the branches in the template editor then you can drag
the Root node with all its parallel branches to the target node in the History Explorer in a single step.
You can save a history template in a file in order to be able to edit it again in the History Explorer at a later date. In the ribbon, choose History Template > History Template > Save or
Save As… to save the history template. You can choose Open… to open a saved history template.
The Copy from History File function copies all the completed nodes of a history file to the active template editor without it being necessary for you to open the history file. A dialog box
appears in which you can select the required file.

Applying history templates

The Apply to History File(s) function allows you to apply a history template to an entire set of
history files in the workspace. The Apply a History Template to History Files dialog box appears (see Figure 3-6).
This dialog box always uses a history template that is stored in a file. If a template editor is
active, you are prompted to save current changes in the editor. The active template is then
displayed in the dialog box as the template to be executed. If you are not editing a template
or if you do not want to save the current changes made in the editor, you must use the
Browse... button in the dialog box to select an existing file.
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Figure 3-6. Applying history templates

In this dialog box, you can make settings that control how the history template is to be used.
In the Starting Position in History Files group, you specify whether the template is to be applied to the history file's raw data node (Root (“Raw Data”) option) or to a child node (Choose
Data Set (History Node) option).
If you select the Choose Data Set (History Node) option, you can specify the name of the data
set to which the template is to be applied in the Data Set text box. Note that if there are several data sets with the same name in a history file, the history template is only applied to the
first one found.
If you check the Use Logfile box, all the messages usually output in a dialog are written to a
log file. This is intended to prevent automatic processing from being interrupted while the
Analyzer waits for input. If you use this function, all Yes/No queries in messages are automatically answered with Yes. The log file is displayed on completion of processing.
Under Select History File(s), you select the history files to which the history template is to be
applied. You can check the Primary History Files Only box to restrict the selection to primary
history files.
If you want to take account of all the history files in the workspace, choose Use Whole
Workspace. If, instead, you select the Select Individual History Files option, you can select
specific files.
In the Selection Filter text box, you can enter a filter expression to filter the available files on
name criteria. In this text box, you can use an asterisk (*) to represent one or more characters, and a period (.) to represent a single character. If the workspace contains the files
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"Test1H2", "Test2G" and "Rest5", for example, " the string "Test*" filters out the files
"Test1H" and "Test2G" (i.e. makes them available). The filter expression "est" would accept
all three files. When you have edited the filter expression, click Refresh to refresh the selection of available files.
When you click OK, the history template is transferred to the selected history files. If a history
file already contains nodes from the template then these nodes are not recreated. Only the
nodes that have not yet been calculated are added. If a check is performed to determine
whether nodes already exist then not only the name of the node is taken into account. Instead, nodes from the template replace existing nodes of the same name which have been
calculated using different parameters.

Canceling the execution of
history templates

When you execute a history template, you see a progress bar which shows you how far processing has advanced. You can cancel the execution of the template by clicking Cancel.
If you are using the Apply to History File(s) function to apply a template automatically to multiple history files, then you can choose whether the application of the template is to be canceled for the current history file only. If you choose this option, the history template
continues to be applied to the remaining history files. Alternatively, you may decide to cancel
the overall application of the template.

Errors in and interruptions to
the history template

A number of circumstances may cause the execution of a history template to be interrupted:
 Many processing steps output queries in message windows. A typical example is the

question of whether an existing file should be overwritten. In this case, execution of the
template is continued once you have responded to the corresponding question.
 A processing step cannot be applied to its parent nodes and the attempt to do so results

in an error message being output in a message window. This can occur, for example, if
you apply a marker-based segmentation to a node which does not contain any reference
markers. In this case, the sub-tree below the node that could not be created is rejected.
The remainder of the template is then executed once you have closed the message window.
 A processing step uses an interactive view to accept user input. In this case, execution of

the template continues if you exit the interactive view by clicking OK. If you exit the interactive view by clicking Cancel, the execution of the history template is aborted. If you exit
the interactive view by clicking Suspend, the execution of the history template is continued. Processing of the sub-tree below the interrupted node is not continued until you
subsequently open the interrupted node again and exit the interactive view with OK.
You should note that the execution of history templates is not interrupted by message windows if you use Apply to History File(s) to apply the template and check the Use Logfile box.
In this case, execution can only be interrupted by interactive views.
If you have checked the Use Logfile box, a message window containing all the suppressed
messages is displayed when processing is complete. This window is always output irrespec-
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tive of whether the template was executed in full or was interrupted by the user. The message
window is also displayed whenever processing is interrupted by an interactive view.
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Chapter 4 EEG views

4.1

Basic principles

EEG views are Analyzer program components that are used to display EEG data. When you
open a data set in the main window, this generates an EEG view that prepares the data and
displays it on the screen. The employed view determines all aspects of the display from the
arrangement of the channels in the window through to details such as the font used for the
channel names.
You can control the display of the EEG data very simply by selecting the required view. The
following views are frequently used:
 Standard view. The standard view corresponds to the EEG on paper. The curves or EEG

channels are shown one after (below) another. The standard view is typically used for
spontaneous EEG analyses.
 Grid view. The grid view is usually used for the display of segmented data. The curves or

EEG channels are shown in a rectangular grid.
 Head view. The head view displays the EEG channels in topographic head positions.
 Mapping view. The mapping view shows the voltage distribution around the head in color

in the form of a topographic map.
Please note that the data displayed was originally digitized. The accuracy of the display in
the Analyzer depends on the digitization rate and is therefore always subject to limitations.
Similarly, the display is also influenced by the screen resolution and window size.

4.1.1

Views and view categories

The way a data set is displayed is, to a large extent, determined by its data type. For example,
data in the time domain has to be displayed differently from data in the time-frequency domain. The user is not able to influence this aspect of the display since it is predetermined on
the basis of the data set to be displayed. At the same time, data of a given data type can be
displayed in different ways; for example, time domain data can be displayed in a grid or mapping view. The user is generally free to decide on this aspect of the display.
Due to this distinction between predetermined and configurable aspects in the choice of the
display, the views available in the Analyzer are subdivided into view categories. The view category designates the freely configurable aspect of the display. For example, a view belonging
to the grid view category always arranges the channels in a grid in the main window. Whenever you select a view in the Analyzer (e.g. using the File > Views > Additional View function),
you always select a view category.

BrainVision Analyzer User Manual | Software Version 2.0.4 | September 30, 2013

110 Chapter 4 EEG views

Within the view category, the Analyzer automatically makes a choice based on the data type
of the data set that is to be displayed. Consequently, the time grid view or frequency grid view
may be used as required. As a result, in the following we always use the term "grid view" to
refer to all the views in the grid view category. You can generally ignore the fact that a specific
view is selected within a view category since the main purpose of view categories is to keep
selection menus and other items clear and concise.
The Analyzer provides users with a number of general view categories such as the standard
view, grid view, head view and mapping view. These views can be used to display any required data, for example in the time and frequency domains. In addition, the Analyzer has
numerous specialized view categories for displaying particular kinds of EEGs.

4.1.2

Opening and using views

When you open a data set in the History Explorer, an EEG view is generated and displayed in
the main window. In the program settings, you can predefine the type of display that is to be
used in such cases. These settings include the scaling of the EEG, the visible time interval
and the employed montage (
see also Section 6.1.1 as of page 187).
Open views are displayed in tabs above the EEG. This gives you a simple way of switching
between open view windows (
see also Section 2.1.3 as of page 67).
The navigation bar and toolbar are used with all views.
You will find a description of these
interface elements in Section 2.3.4 as of page 76 and Section 2.3.5 as of page 78.
In addition, every EEG view possesses a context menu which provides you with more advanced functions. For example, you can change the type of display in an existing window
without having to close the view to do so (
see the description of the "Switch View" function in Section 4.4 on page 138 ff.).
Multiple views of an EEG can be displayed simultaneously (
"Additional View" function in Section 4.4 on page 136).

see the description of the

Views can be linked to each other in different ways. For example, in views based on data of
the same type, the EEG graphs can be overlaid.
For more detailed information on overlays, refer to Section 4.3 as of page 132.
In addition, you can also select montage connections of the channels in the EEG for each
view (
see also Chapter 5 as of page 175).
A fundamental function of EEG views is to display EEG channels in the form of a graph. This
capability is associated with functions such as channel selection, range selection and the
display of status information on the EEG graph.
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The way you use the individual views is similar and you can therefore always call these functions in the same way. This applies, in particular, to the frequently used view categories:
standard view and grid view.
The most important functions that are integrated directly in the views are explained in the following sections.

4.1.3

Displaying information on EEG views

When you move the mouse pointer over the EEG graph in a view, a red cross appears at the
nearest point on the graph (see Figure 4-1), and the corresponding details of its position are
displayed on the status bar.
Figure 4-1. Red cross (mouse cursor)

This function is also available in views that to not display any EEG graphs. For example, the
voltage value and current mouse position are displayed in mapping views.
If you right-click a channel name, marker or overlay label in a view then an additional command appears in the context menu, for example Show Channel Information.... Choosing this
command opens a dialog box which contains information about the relevant object (channel, marker, overlay) (see Figure 4-2).
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Figure 4-2. "Channel Information" display

4.1.4

Selecting data ranges

To select a data point in the EEG, click a channel. This creates a light-blue single-point highlighting (see Figure 4-3). The black line in the middle of the highlighting indicates the precise
position of the point.
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Figure 4-3. Single-point highlighting

To select a range in the EEG, click in the view and hold the mouse button down while dragging
the mouse to the left or right (see Figure 4-4).
To highlight the visible area in the view, press <Ctrl-A>.
Figure 4-4. Range highlighting with arrows for changing the size

To move the highlighting of a point or a range, click the highlighting and hold the mouse button down while dragging the mouse in the required direction. Alternatively, you can use the
<left arrow> and <right arrow> keys to move the highlighting.
In the case of the grid view and the head view, the highlighting is only ever displayed for one
channel. You can move it across channels to a different channel by clicking it, holding down
the mouse button and moving the mouse pointer to the desired channel.
Note that the context menu for the selection of the transient transform opens when you create a new highlighting. Click Cancel here to close the menu without running a transient transform. (
For more detailed information on transient transforms, refer to Chapter 8 as of
page 483.)
You change the width of the highlighting by moving the mouse pointer over it. Two blue arrows appear on its edges. Grab an arrow, and drag the mouse pointer in the required direction.
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To remove the highlighting from the EEG, press the <Esc> key. If a transient view is open when
you do this, it will now be closed.
You can open the dialog box containing specifications for the selected range from the view's
context menu provided that you have highlighted a point or range in the EEG. The dialog box
is used in the same form wherever selected ranges are employed. If you are using graphical
tools (
see also Section 4.5 as of page 140) which apply to a selected range, the command View Tool: Selected Area Settings... or similar appears in the tool's context menu. You
can use this command to configure the range selected by the tool (see Figure 4-5).
Figure 4-5. "Area Settings" dialog box

If you clear the Mouse Sizing Allowed box, you can no longer use the mouse to change the
size of the highlighting in the view. In this way, you can avoid making accidental changes to
the defined width when you move the highlighting.
If you choose the Always Draw as Range option, the highlighting is still displayed as a normal range even if it is only one point wide.
If you choose the Automatically switch to Single Point Mode option, the highlighting is displayed as single-point highlighting if it is only one point wide.
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In the text boxes in the lower part of the dialog box, you can change the position (Location,
End) and length (Length) of the highlighting. Note that the times you specify are rounded to
the nearest data point.

4.1.5

Highlighting and selecting channels

You can select one or more channels of the EEG in order to be able to display these channels
separately, for example. If you use the Next Group
or Previous Group
button in the
toolbar to show different channels of the EEG, your selection is retained. If you use the Decrease Channels
or Increase Channels
shown, your selection is reset.

button to change the number of channels

To select a channel, click the corresponding channel name. A selected channel is highlighted
in blue (see Figure 4-6). If you click a channel again, the channel is deselected. To prevent
the second mouse click from being interpreted as a double-click, wait about a second before
clicking for a second time.
Figure 4-6. Selected channel with blue highlighting

By double-clicking a channel name you can display this channel separately. If you doubleclick the channel name again, the display returns to how it was before.
To display a selection of channels, click these channels to select them (see Figure 4-7). If you
double-click the channel name selected last, the channels are displayed separately. If you
double-click the channel name again, the display returns to how it was before.

Selecting channel groups
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Figure 4-7. Selecting multiple channels simultaneously

The most recently selected channel is "active". A dashed box around the channel name indicates the currently active channel (see Figure 4-8).
Press <Shift> and click a channel name to select all the channels between the active channel
and the channel you click.
Figure 4-8. Dashed box indicating the active channel

Keyboard shortcuts

To invert selection of the currently active channel, press the <Spacebar>.
Press the <Tab> key to move the dashed box to the next channel. By doing this, you activate
the channel immediately following the active channel. If the last channel is active, the box
moves to the first channel.
In the same way, press <Shift> + <Tab> to move the box one channel back.
These functions allow you to run through all the channels and select them using the <Spacebar> as you require.
You can press <Shift> + <Spacebar> to select all visible channels. If you have already selected
any visible channels, the selection is canceled instead.
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You use <Ctrl> + <Spacebar> to select all channels in the data set. If you have already selected
any channels, the selection is canceled instead.
If you type the name of a channel via the keyboard then this channel is activated (i.e. it is
highlighted by means of a dashed box). However, this is only possible if the corresponding
channel is visible. If you press the <Tab> key or the <Spacebar>, the characters you have already typed are canceled, allowing you to search for a new channel.
We recommend that you always press the <Tab> key or the <Spacebar> before you perform a
channel search in order to ensure that no unwanted characters are included in the channel
search.
If you are only viewing a small number of channels simultaneously, you can use the <Ctrl> key
and the numbers on the numeric keypad to select one of the first ten channels directly.
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4.2

The EEG views in detail

4.2.1

The butterfly view

The butterfly view displays all the EEG channels overlaid over each other. The view allows
you, for example, to estimate peaks after averaging. This makes it easy to identify the places
at which there is activity in the EEG (see Figure 4-9).
Figure 4-9. Butterfly view, averaged EEG

The channel names are listed in the upper part of the view.
If you move the mouse pointer over a channel graph, it is highlighted in orange. At the same
time, a small box appears around the channel name at the top of the view to indicate which
channel is currently under the mouse pointer. Boxes and orange highlighting also appear
when you move the mouse pointer over a channel name in the list (see Figure 4-10).
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Figure 4-10. Butterfly view, channel highlighting

When you click a channel name, the corresponding channel is deactivated or activated. Alternatively you can <Shift> and click to deactivate the channel currently selected using the
mouse. The name of a deactivated channel is struck through.
Range highlighting in the butterfly view works as described in Section 4.1.4 as of page 112.

4.2.2

The grid view

The grid view arranges the channels in a grid (see Figure 4-11). The display of the EEG in the
grid view depends on the montage selected. In the case of the standard montage, the channels of the data set are distributed automatically to the rows and columns of the grid. In userdefined montages, you can specify which channels are to appear in which grid cells or which
grid cells are to remain free.
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Figure 4-11. Grid view

For detailed information on
overlays, refer to
Section 4.3 as of page 132.

The grid view also allows you to drag cells from different channels on top of one another with
the mouse to create overlays.
To do this, you can get hold of the channels by clicking the channel name or a point in the
corresponding grid cell that is sufficiently far away from the graph. If you are able to grab the
channel, the mouse pointer will take the form of a hand or an arrow depending on the position in the cell. Press and hold down the left mouse button. A black frame appears to indicate
that you can now move the channel. Drag the frame to the desired channel. When the color
of the frame changes to red, you can release the mouse button (see Figure 4-12). You will see
two overlaid channels. The moved channel continues to remain in its original position (see
Figure 4-13). You can repeat this procedure as often as you like with different channels.
Figure 4-12. Grid view, Overlaying of two channels by means of drag-and-drop
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Figure 4-13. Grid view, Overlaying of channels Fp1 and F7

When you have created an overlay, the Clear Overlays button is added to the view. You can
use this button to remove the overlays again. You can also combine the overlaid channels
with complete data set overlays as you wish.

4.2.3

The head view

The head view displays the channels in separate windows arranged in the shape of a head.
The windows are located at the coordinate position of the associated channel (see Figure 414).
Channels that do not have any valid head coordinates, or have coordinates that are not visible on the head, are listed along the left-hand border of the view. If you used the 10-10 or
10-20 system when recording the EEG, the program should have this information. If you used
other channel names, you can use the Edit Channels transform to enter the correct coordinates.
You will find detailed information on editing channel properties in Section 7.1.6
as of page 216.
You can change the head's direction of view in the Direction group located in the Head View
tab of the View Settings dialog box (
see also the explanations in Section 4.6.3 on
page 168 ff).

You will find information on
the coordinate system used
in Appendix C on page 563.
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Figure 4-14. Head view

If you click the channel name or a point in the window that is far enough away from the graph,
the relevant window is activated. You can move the window by holding down the mouse button (see Figure 4-15). To do this, grab the window at the channel name or in the corresponding grid cell at a sufficient distance from the graph. If you are able to grab the channel, the
mouse pointer will take the form of a hand or an arrow depending on the position in the cell.
An active window has eight handles (small rectangles) on its borders that you can use to resize the window. If you hold down the <Shift> key while you resize a window, the resizing is
also applied to the other windows when you release the mouse button.
Figure 4-15. Head view, Changing the position of an active window (channel)
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If you have changed the position of a number of channels and then want to return them to
their original positions, right-click any point in the view and choose the Reset All Channel Positions command from the context menu. The Reset Position of Active Channel command returns only the active channel to its original position (see Figure 4-16). Both of these
functions apply only to the position but not to the size of the windows.
Figure 4-16. Head view, Resetting channel positions

If you have resized the channel windows, the windows will no longer be centered exactly over
the associated electrodes. You should use the Reset All Channel Positions command to correct this.
If you select one or more channels by clicking their names followed by a double-click, these
channels are displayed in a grid.
You can create an overlay by dragging one channel over another channel. To do this, grab the
required channel either at the channel name or at a sufficient distance from the graph. If you
are able to grab the channel, the mouse pointer will take the form of a hand or an arrow depending on the position in the channel window. Press and hold down the left mouse button.
A black frame appears to indicate that you can now move the channel. Drag the frame to the
desired channel. When the color of the frame changes to red, you can release the mouse button (see Figure 4-17).

For detailed information on
overlays, refer to
Section 4.3 as of page 132.
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Figure 4-17. Head view, Overlaying of channels Fp1 and Fpz

When you have created an overlay, the Clear Overlays button is added to the view. You can
use this button to remove the overlays again. You can also combine the overlaid channels
with complete data set overlays as you wish.

4.2.4

The mapping view

The mapping view creates topographic maps that display the voltage distribution on the
head in the time or frequency domain. In the view, the maps are displayed arranged in a grid
(see Figure 4-18). Each map possesses a separate time range display.
You can use the view settings to configure the display of the mapping view and modify the
employed methods and algorithms. For example, for a time range, you can display the head
from a number of different directions of view.
For more detailed information on these settings, refer to Section 4.6.3 as of page 168.
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Figure 4-18. Mapping view

At the lower border of the mapping view there is a scale that applies to all maps. If you have
chosen manual scaling of the view in the view settings then you can set the end points of the
scale directly with the mouse. Interactive controls are displayed as long as the mouse is positioned over the scale. Two buttons allowing you to halve or double the length of the scale
are available. You can also grab and drag an end point of the scale with the mouse. The current position of the end point is then displayed in small characters next to the scale.
You can also grab and drag an end point of the scale with the mouse. The current position of
the end point is then displayed in small characters next to the scale (see Figure 4-19).
Figure 4-19. Mapping view, Manual scaling
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You will find information on
the coordinate system used
in Appendix C on page 563.

In order to generate the map, the program requires information about the position of the
electrodes. If you used the 10-10 or 10-20 system when recording the EEG, the program
should have this information. If you used other channel names, you can use the Edit Channels transform to enter the correct coordinates.
You will find detailed information on editing channel properties in Section 7.1.6 as of page 216.

4.2.5

The standard view

The standard view corresponds to the classic way of viewing EEGs on paper (see Figure 4-20).
The standard view offers you all the basic interactive options. These include the highlighting
and selection of channels, display of separate channels or a selection of channels, highlighting of data ranges (single-point highlighting and range highlighting), as well as resizing and
repositioning of highlighting. You can use many different graphical tools in the standard
view.
You will find a detailed description of these tools in Section 4.5 as of page 140.
Figure 4-20. Standard view
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4.2.6

The 3D head view

You can use the 3D head view instead of the mapping view. The 3D head view projects the
map onto a three-dimensional model of a head (see Figure 4-21).
To use the 3D head view, you need DirectX 9c and the Managed DirectX 1.1 libraries.
detailed information on installing DirectX, refer to Appendix L as of page 595.

For

The possible settings for the 3D head view are the same as for the mapping view (
see also
Section 4.2.4 as of page 124). In addition, you can rotate the head as you require. To do this,
position the mouse over the head, hold down the left mouse button, and move the mouse
pointer. The head rotates.
To change the size of the heads, click in the view and move the mouse wheel up and down.
In the view settings of the 3D head view, you can also select the head displayed from several
head definitions.
Figure 4-21. 3D head view

At the lower border of the 3D head view there is a scale that applies to all the displayed
heads. If you have chosen manual scaling of the view in the view settings then you can set
the end points of the scale directly with the mouse. Interactive controls are displayed as long
as the mouse is positioned over the scale. Two buttons allowing you to halve or double the
length of the scale are available. You can also grab and drag an end point of the scale with
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the mouse. The current position of the end point is then displayed in small characters next
to the scale.

4.2.7

The time-frequency view

In the Analyzer, the time-frequency view associates a value (typically spectral amplitude or
spectral power) to every point in the time-frequency plane. These values are represented by
colors according to a linear scale. Time-frequency data is represented in the form of discrete
frequency layers, which are stacked on top of each other (see Figure 4-22). The time is plotted along the horizontal axis and the frequency along the vertical axis. The linear color scale
is located at the bottom of the view. The time-frequency view is available in the standard,
grid and head view categories. In all these categories, the time-frequency view has the same
design and basic functions.
By clicking the left button of the mouse over a given time-frequency point, the two coordinate
lines of this point are visualized in green. These lines define two cross-sections running in
parallel to the time and the frequency axes. Correspondingly, two adjacent graphs are displayed at the bottom and at the right side of the time-frequency domain. These graphs display the output values in the time and frequency domains separately. The graph at the
bottom displays the output values over time [ms] for a given frequency, while the graph at
the right side displays the spectral distribution of output values across all frequency layers
[Hz] for a specified time point.
If only one channel is displayed, then an additional topographic map is provided in the bottom-right corner of the view. This map shows the distribution over all electrodes of the output
values for a specified time and frequency.
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Figure 4-22. Time-frequency view

If you move the mouse pointer over the time-frequency domain, the output values corresponding to the current pointer position are displayed in the status bar of the Analyzer.
If you click on the time-frequency domain, the coordinate lines jump to this position in all
displayed channels and the values in the cross-sections are displayed accordingly in the adjacent graphs. Similarly, if you hold the mouse button down and drag the mouse pointer
across the time-frequency plane, the graphs are redrawn accordingly. The topographic map
is also updated to the specific location of the time-frequency point.
The Scale Up
and Scale Down
buttons in the toolbar change the scaling of both adjacent graphs. The color scale remains unaffected. You can configure the color scale in the view
settings. In the Time-Frequency tab of the View Settings dialog you can choose between
Manual Scaling or Automatic Scaling.
For detailed information, refer to Section 4.6.3 as
of page 162.
Figure 4-23. Time-frequency view, linear color scale

If you choose Manual Scaling and the mouse pointer is placed over the color scale, additional control elements are displayed (see Figure 4-23). With the mouse pointer you can grab and
drag the end points (highlighted circles) of the color scale towards right or left. As a result,
the current position of the end points is displayed in small characters next to the scale. Once
the mouse button is released, the color scale is adjusted to the last displayed values.
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Additionally, two arrows buttons are displayed at the right side of the color scale. They allow
you to halve or double the range of the color scale.
Overlays of time-frequency data are shown in the adjacent graphs (see Figure 4-24).
Figure 4-24. Time-frequency view, overlays

Time-frequency grid view and
standard view

The time-frequency grid view and time-frequency standard view display the individual channels in a grid (see Figure 4-25). The display and functions for both time-frequency views are
the same as for the grid view (
see also Section 4.2.2 as of page 119).
Figure 4-25. Time-frequency view, grid view
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The display and functions of the time-frequency head view (see Figure 4-26) are the same as
for the head view (
see also Section 4.2.3 as of page 121).
Figure 4-26. Time-frequency view, head view

Time-frequency head view
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4.3

Overlaying EEG graphs

You can overlay and compare EEG graphs in views. In the sections devoted to the grid and
head views, we have described how you overlay individual channels in a given view. However, you can also create overlays of entire data sets. This is possible, for example, in the standard view, grid view and head view.
Once they have been generated, the way you use channel and data set overlays is broadly
similar. You can combine channel and data set overlays in any way you wish in the same
view.
Please note that it is not possible to create data set overlays unless both data sets are of the
same data type. Segmented data sets can only be overlaid if they have the same sampling
rate. However, the number of channels does not have to be identical since the channel
names are checked and only channels with the same names are overlaid.

Creating data set overlays

To create a data set overlay, click the button Overlay Data Set
a selection dialog (see Figure 4-27).

in the toolbar. This opens

Figure 4-27. Selecting a data set for use as an overlay

In this dialog box, you can select one or more data sets from the current workspace on the
basis of the following criteria:
 Parent displays the data set from which the current data set was calculated. If the current

data set represents the raw EEG, this option is not accessible.
 From Same History File displays all the data sets in the current history file.
 With Same Name lists all the data sets in the workspace that have the same name as the

current data set.
 From All Data Sets lists all the data sets in the current workspace.
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Click OK when you have selected one or more data sets. The channels in the selected data
sets are now displayed overlaid (see Figure 4-28). The Clear Overlays button is added to the
top left section of the view. You can use this button to remove the overlays again.
Figure 4-28. Data set overlay

You can also overlay data sets by dragging and dropping them. To do this, use the mouse to
select the required data set from the History Explorer, hold down the left mouse button, and
drag the data set to the view. Then release the left mouse button. The conditions described
in the previous paragraph again have to be met in order to create the overlay.
If you position an Average node over a node with the appropriate segments, the average is
shown in all the segments of the target node in the overlay view. This provides you with a simple way of comparing the average with the nodes from the same segmentation.
To make it possible to identify the source corresponding to a data set overlay, a text in the
same color as the overlay graph appears in the view. If you are using monochrome overlays,
the line pattern used for the overlay is displayed next to the label. You can modify the content
of this text using the overlay settings (
for more information, see the explanations in
Section 4.6.3 on page 166 ff).
To hide an overlay temporarily, press the <Shift> key and click the corresponding graph. Alternatively, you can click the overlay's label (see Figure 4-29). To show the graph once more,
click the overlay label again.

Using overlays in a view
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Figure 4-29. Hiding an overlay temporarily

To permanently remove an overlay, press the <Ctrl> key and click the corresponding graph. Alternatively, you can press the <Ctrl> key and click the overlay's label. This allows you to edit
overlays simply and quickly until you achieve the representation you want.
These edit options are also available to you for channel overlays in the grid view and head
view.
If you right-click an overlay label, the command Overlay Information... is added to the context menu. You can choose this to display information about the source of the overlay (see
Figure 4-30). If the overlay is a data set overlay, the dialog box will contain the Open Node
button which you can use to open the data set in the main window.
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Figure 4-30. "Overlay Information" display

If you open a node created using the Data Comparison transform, overlays with the parent
node and comparison node are displayed automatically. You can temporarily deactivate
these so-called static overlays in the view's context menu in order to create your own data
set or channel overlays in the Data Comparison node.

Static overlays
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4.4
Functions in the ribbon

Additional view functions

The Views group in the File tab on the ribbon contains the additional view functions Additional View and Client View (see Figure 4-31).
Figure 4-31. Additional view functions in the ribbon

Additional View allows you to display additional views for the active history node. The newly
selected view appears in an additional window or tab. The same node is thus displayed in
multiple windows or tabs.
Client View works in the same way as the Additional View except that here navigation in the
client view is linked to that of the original view, and navigation is only possible in the original
view. The toolbar and navigation bar are not accessible in the client view (grayed).

Functions in the view context
menu

To display the view context menu, right-click anywhere in the view (see Figure 4-32).
Figure 4-32. View context menu
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The context menu contains the following commands:
 View Settings… opens the node-specific view settings.

You will find detailed information on configuring these settings in Section 4.6.2 as of page 156.

 Selected Area Settings... is used to make precise settings for the selected range. This

command does not appear in the menu unless you have selected a range in the EEG (
see also Section 4.1.4 as of page 112).
 Select Visible Range highlights the entire range visible in the view. This command does

not appear in the menu unless you have selected a range in the EEG.
 The Channel Information..., Marker Information... and Overlay Information... com-

mands appear only when you right-click on the corresponding label. These commands
display information on the corresponding object.
 Save as File saves the view as a file. The graphics formats EMF, BMP, PNG and JPEG are

available to you.
 Print opens a dialog box which you allows you to print the open view.
 Save View Tools… saves all the graphical tools available in the view (view tools) in a file.
 Load View Tools… loads saved view tools from a file and displays them.
 Clear View Tools removes all view tools from a view.
 Navigate to Next Tool moves the screen section to the next view tool and activates the

tool.
 Navigate to Previous Tool moves the screen section to the previous view tool and acti-

vates the tool.
 The Display Static Overlays command only appears in nodes created using the Data

Comparison transform. If the option is checked, all the nodes involved in the comparison
are displayed as an overlay. If you clear the option, you can create your own channel or
data set overlays.
 Full Screen Mode temporarily displays the view in a separate window outside of the main

window so that it fills the entire screen. To return to the normal display, press the <Enter>
key, close the new window or use the context menu.
 Transient Views allows you to open an additional transient view. This command does not

appear in the menu unless you have selected a range in the EEG.
 Switch View allows you to switch between different views. Unlike the Additional View

function, this function opens no additional windows or tabs. Instead, the new view replaces the currently open view.
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Switching between view
categories

In Section 4.1.1, we mentioned that views are subdivided into categories in the Analyzer.
These view categories are also used for "category-related" configuration (
see
Section 4.6.1 as of page 155). The Switch View function switches between view categories.
When you use the Switch View function, a context menu opens in which you can select different view categories. These include the standard view, grid view and head view. The menu
groups together views that display nodes with different data types in the same way (e.g. frequency grid view and time grid view) in the same view category. If you use Switch View to select a view category, the program automatically determines the appropriate view in the
category for the data type of the node.
For example, the Switch View > Head View command in the standard view for time data displays the head view for time data in Figure 4-33.
Figure 4-33. Head view for time data

The Switch View > Head View command in the grid view for frequency data displays the head
view for frequency data in Figure 4-34.
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Figure 4-34. Head view for frequency data

View categories that do not have a view for the current data type are grayed out on the submenu of the Switch View context menu command. This applies, for example, to the butterfly
view and frequency data because this view category is available exclusively for data in the
time domain (see Figure 4-35).
Figure 4-35. The butterfly view is not available for frequency data

140 Chapter 4 EEG views

4.5

View tools

The View Toolbox at the right edge of the interface provides you with a range of graphical
tools, the "view tools". You can use these view tools to add further elements to the displayed
EEG.
Settings options are available for each of the tools. You access these by clicking the button to open the corresponding context menu. Each of the tools can also be closed using the
Close Tool function.
If you make any changes to a tool, these are automatically taken over for any other tools of
the same type that you drag into the view. This function provides you with an easy way of creating a number of tools with the same window size.
For example, if you intend to use several Mapping tools, you can start by dragging a single
Mapping tool into the view and configuring it. If you then drag further Mapping tools into the
view, these will automatically be of the same size and have a selected range of the same
length as the original tool.

4.5.1

Channel Selection

The Channel Selection tool highlights a selected section of the channel (see Figure 4-36). The
tool also provides a text box which is connected to the highlighting by a line. You can use the
text box to enter a comment or formula, for example for the calculation of the average value
of the selected channel section.
You can change the width of the highlighting by moving the mouse pointer over it. Two blue
arrows appear on its edges. Grab an arrow and drag it in the required direction.
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Figure 4-36. Channel Selection

The tool's context menu contains the following functions:
You can use the View Tool: Settings... command to access the settings for the text box. These
correspond to the settings for the Text Box tool (
see also Section 4.5.7 as of page 150).
In addition, you can use the Placeholder button in the dialog box to call up an overview of
the formula syntax.
View Tool: Selected Area Settings… opens the Area Settings dialog box (
Section 4.1.4 as of page 112).

see also

View Tool: Select Visible Range highlights the entire range that is visible in the view for the
view tool.
Lock Tool to Channel locks the tool onto the channel.
If you choose Pin Frame to Selection then the text box is also moved when you move the highlighting.
Draw Connection to Graph controls whether the line connecting the highlighting to the tool
is drawn.
You can use placeholders in the text box. The placeholders are replaced by the appropriate
values and are continuously updated as you move the range highlighted by the tool with the
mouse. The following placeholders are available:
Table 4-1. Placeholders available for use in the text box of the Channel Selection tool
Placeholder

Meaning

$sample

Sampling interval in ms or Hz

$mean

Mean of the values in the interval

$median

Median of the values in the interval
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Table 4-1. Placeholders available for use in the text box of the Channel Selection tool
Placeholder

Meaning

$stddev

Standard deviation in the interval

$min

Smallest value in the interval

$max

Largest value in the interval

$ux

Unit for x-axis

$uy

Unit for y-axis

If you enter a digit immediately after the placeholder then the numerical value is rounded to
the corresponding decimal place. For example, $mean2 is replaced by the mean rounded to
two decimal places.
In addition, the text box allows you to use general placeholders for specifications relating to
the data node. These placeholders ($c, $p, $n, $h, $ct) have the same function as the placeholders used for labeling data nodes in the Overlay tab of the view settings (
see also
Table 4-6 on page 168).

Formula syntax

You can also use formulae in the text box. The formulae are replaced by the appropriate values and are continuously updated as you move the range highlighted by the tool with the
mouse. Each text box can contain multiple formulae.
Formulae are enclosed in square brackets: [<Formula>]. You can use the notation
[<formula>|<digit>] to determine the number of decimal places to which the result is to be
rounded; thus, for example, [2*Asin(1)|5] is replaced by the numerical value of Pi rounded to
5 decimal places.
The formulae can contain the mathematical symbols + - * / as well as ^ for powers. You can
use parentheses and the usual abbreviations for mathematical functions (e.g. Sqrt for
square root).
You can use the following mathematical functions: Cos, Sin, Tan, ACos, ASin, ATan, Sinh,
Cosh, Tanh, Sqrt, Exp, Log, Log10, Abs, Floor, Ceiling, Sign, Max(a,b), Min(a,b), Pow(base,
exponent), Round(value, place). E and Pi are also predefined as constants.
You can use the following predefined variables in formulae:
Table 4-2. Variables in formulae
Variable

Meaning

Num

Number of values in the interval

Width

Width of the interval

Mean

Mean of the values in the interval

Median

Median of the values in the interval
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Table 4-2. Variables in formulae
Variable

Meaning

Sample

Sampling interval in ms or Hz

You can combine the above-mentioned formula elements with quantifiers in order to perform
calculations within the interval. The quantifiers allow you to evaluate a subformula for each
data point in the highlighted interval. The quantifier is then used to evaluate the formula values as a single value. For example, the quantifier Max determines the maximum of the formula values.
Each quantifier defines a free variable which you can use in the formula contained within the
quantifier. For each data point in the interval, the value of the EEG data is assigned to this
variable. You can use a letter of your choice for the free variable.
Example: The formula [Sum_x(x^2)] calculates the sum of the squares of all the data values.
This syntax broadly resembles the usual syntax for formulae, with Sum being used for the
sum character . The formula x^2 is the subformula in the quantifier and the variable x is the
free variable. As the example illustrates, the formula contained in the quantifier should always be enclosed in parentheses.
A formula may contain multiple quantifiers. The following quantifiers are available:
Table 4-3. Quantifiers in formulae
Quantifier

Meaning

Sum

Sum of the values of the internal formula

Min

Minimum of the values of the internal formula

Max

Maximum of the values of the internal formula

Med

Median of the values of the internal formula

Complex numbers are not supported during the evaluation of formulae. If you use the Channel Selection tool in a data set with complex numbers, only the absolute values can be displayed or used in formulae.

4.5.2

Delta Tool

The Delta Tool is for indicating differences in voltage and time values (see Figure 4-37).
When you drag the Delta Tool to a graph and release the mouse button there, the tool is fixed
in that position. The tool remains tied to the mouse pointer. You can then set the position of
the second point by moving the mouse pointer over the channels (not holding down the
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mouse button). The first point remains in its fixed position. You set the second fixed point by
clicking again.
Note that both of the tool's points are always on the same channel.
Figure 4-37. Delta Tool

You can pick up both end points of the Delta Tool by moving the mouse pointer over them.
The corresponding point is highlighted in green. Now single-click with the mouse and drag
the Delta Tool to the required position.
You can also position the tool points on overlays of the same channel. When you do this, it
is not necessary for the two points to lie on the same overlay, thus allowing you, for example,
to compare the values of the channel and the overlay at the same time position.
You can use the View Tool: Settings… command in the Delta Tool's context menu to configure
the associated text box. These settings correspond to the settings for the Text Box tool (
see also Section 4.5.7 as of page 150). In addition, you can use the Placeholder button in
the dialog box to call up an overview of the formula syntax.
You can use the following placeholders in the text box:
Table 4-4. Placeholders available for use in the text box of the Delta Tool
Placeholder

Meaning

$x

Difference in x-axis direction

$y

Difference in y-axis direction

$ux

Unit in x-axis direction

$uy

Unit in y-axis direction

You can append a digit to the placeholders $x and $y to specify the decimal place to which
the output is rounded (e.g. $y3).
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In addition, the text box allows you to use general placeholders for specifications relating to
the data node. These placeholders ($c, $p, $n, $h, $ct) have the same function as the placeholders used for labeling data nodes in the Overlay tab of the view settings (
see also
Table 4-6 on page 168). The placeholders also relate to the reference node if one or both of
the end points of the Delta Tool was positioned on an overlay.
If you append an l or r to these placeholders then they refer to the graph on which the left or
right end point of the tool is positioned: $lc, $lp, $ln, $lh, $lct for the left end point and $rc,
$rp, $rn, $rh, $rct for the right end point. If the corresponding end point is positioned on an
overlay, information on the overlay node is displayed. Thus, for example, $ln is replaced by
the name of the overlay node on which the left end point is positioned.
You can also use formulae in the text box. The formulae are replaced by the appropriate values and are continuously updated as you move the end points of the tool with the mouse.
Each text box can contain multiple formulae.
Formulae are enclosed in square brackets: [<Formula>]. You can use the notation
[<formula>|<digit>] to determine the number of decimal places to which the result is to be
rounded; thus, for example, [2*Asin(1)|5] is replaced by the numerical value of Pi rounded to
5 decimal places.
The formulae can contain the mathematical symbols + - * / as well as ^ for powers. You can
use parentheses and the usual abbreviations for mathematical functions (e.g. Sqrt for
square root).
You can use the following mathematical functions: Cos, Sin, Tan, ACos, ASin, ATan, Sinh,
Cosh, Tanh, Sqrt, Exp, Log, Log10, Abs, Floor, Ceiling, Sign, Max(a,b), Min(a,b), Pow(base,
exponent), Round(value, place). E and Pi are also predefined as constants.
You can use the following predefined variables in formulae:
Table 4-5. Variables in formulae
Variable

Meaning

Left

Value at left end point

Right

Value at right end point

Width

Distance between the end points in ms or Hz

Sample

Sampling interval in ms or Hz

Example: With [(Right + Left)/2] you can calculate the average of the data values at the left
and right end points.
Complex numbers are not supported during the evaluation of formulae. If you use the Delta
Tool in a data set with complex numbers, only the absolute values can be displayed or used
in formulae.

Formula syntax
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4.5.3

Magnifier

The Magnifier allows you to display an enlarged view of a channel (see Figure 4-38).
You can resize the tool by clicking it, grabbing one of its small handles (rectangles) and dragging it with the mouse. The gray arrows in the lower left corner of the tool are used to change
the vertical scaling.
Figure 4-38. Magnifier

The tool's context menu has the following functions:
You use View Tool: Settings… to open the Magnifier's display settings. These settings correspond to the settings for the standard view (
see also Section 4.2.5 as of page 126).
View Tool: Selected Area Settings… opens the Area Settings dialog box (
Section 4.1.4 as of page 112).

see also

View Tool: Select Visible Range highlights the entire range that is visible in the view for the
view tool.
Lock Tool to Channel locks the tool onto the channel.
If you choose Pin Frame to Selection then the Magnifier is also moved when you move the
highlighting.
Draw Connection to Graph controls whether the line connecting the highlighting to the tool
is drawn.

4.5.4

Map Legend

The Map Legend tool is used in conjunction with the Mapping tool in order to display the color key for the maps (see Figure 4-39).
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You can resize the tool by clicking it, grabbing one of its small handles (rectangles) and dragging it with the mouse.
Figure 4-39. Map Legend

The tool supports the same scaling settings as the Mapping tool. As with the Mapping tool,
the data range for automatic scaling extends across the entire EEG section displayed. The
scaling setting always applies to all the Map Legend and Mapping tools in the active view.
This ensures that the displays provided by multiple tools are consistent.
The tool's context menu has the following functions:
You use View Tool: Settings… to open the Map Legend tool's display settings.
View Tool: Selected Area Settings… opens the Area Settings dialog box (
Section 4.1.4 as of page 112).

see also

View Tool: Select Visible Range highlights the entire range that is visible in the view for the
view tool.
Lock Tool to Channel locks the tool onto the channel.
If you choose Pin Frame to Selection then the Map Legend is also moved when you move the
highlighting.
Draw Connection to Graph controls whether the line connecting the highlighting to the tool
is drawn.

4.5.5

Mapping

The Mapping tool allows you to display maps in any position (see Figure 4-40). The tool always displays the range selected for it across all the channels irrespective of the channels
that are currently visible in the view.
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You can resize the tool by clicking it, grabbing one of its small handles (rectangles) and dragging it with the mouse.
Figure 4-40. Mapping

If you use the Automatic Scaling option in the view settings, the scaling is based on the entire displayed EEG section. As a result, all visible Mapping tools use the same scale regardless of their positioning. The scaling setting always applies to all the Map Legend and
Mapping tools in the active view. This ensures that the displays provided by multiple tools
are consistent.
The tool's context menu has the following functions:
You use View Tool: Settings… to open the map's display settings. These settings correspond
to those of the mapping view except that the number of maps is always "1" (
see also the
explanations in Section 4.6.3 on page 168 ff).
View Tool: Selected Area Settings… opens the Area Settings dialog box (
Section 4.1.4 as of page 112).

see also

View Tool: Select Visible Range highlights the entire range that is visible in the view for the
view tool.
Lock Tool to Channel locks the tool onto the channel.
If you choose Pin Frame to Selection then the map is also moved when you move the highlighting.
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Draw Connection to Graph controls whether the line connecting the highlighting to the tool
is drawn.

4.5.6

Scaling Bar

The Scaling Bar tool consists of a scale that displays the time or voltage and can be positioned wherever required in the EEG (see Figure 4-41). The bar is always based on a specified
point.
You can resize the tool by clicking it, grabbing one of its small handles (rectangles) and dragging it with the mouse.
Figure 4-41. Scaling Bar tool

Choosing the View Tool: Settings… command in the tool's context menu opens the Bar
Settings dialog box (see Figure 4-42):
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Figure 4-42. Scaling Bar tool, settings

Under Direction you can specify the alignment of the Scaling Bar (horizontal or vertical).
Under Style you can choose between a simple bar with a length specification that is used as
the scale (Simple Bar) and a bar with a scale that indicates the channel values (Scaling Bar).
The bar always indicates the scale or the values for the channel on which it is located.
If you check the Lock Data Values box then the scaling bar is also resized during the scaling
operation. If the box is not checked then the bar keeps its original size during scaling.
If you check the Automatic Granularity box then the intervals between two divisions on the
scale are determined automatically. If this box is not checked then you can set the value
yourself in the Granularity text box.

4.5.7

Text Box

The Text Box tool allows you to enter comments (see Figure 4-43).
You can resize the tool by clicking it, grabbing one of its small handles (rectangles) and dragging it with the mouse.
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Figure 4-43. Text Box

Choosing the View Tool: Settings… command in the tool's context menu allows you to make
the following settings (see Figure 4-44):
If you check the Transparent box then the Text Box tool is displayed transparently.
If you check the Auto Size box, the size of the Text Box tool changes automatically to fit the
length of the text. Otherwise, you can change the size of Text Box tool as required.
Font… opens a dialog box in which you can select the font to be used.
You enter the required text in the Tool Text box.
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Figure 4-44. Text Box tool, settings

The tool's context menu has the following additional commands:
Lock Tool to Channel locks the tool onto the channel.
If you choose Pin Frame to Selection then the Text Box tool is also moved when you move the
highlighting.
Draw Connection to Graph controls whether the line connecting the highlighting to the tool
is drawn.

4.5.8

Value Graphics

The Value Graphics tool allows you to add simple drawing objects to the EEG (see Figure 445). When you drag the tool onto the graph, a context menu appears that allows you to select
an ellipse, a rectangle, a line or a curve. (The curve is a Bézier curve with four points.)
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You resize the drawing object by clicking it, grabbing one of its small handles (rectangles)
and dragging it until the tool is the right size.
Figure 4-45. Value Graphics, curve

Choosing the View Tool: Settings… command in the tool's context menu opens the Value
Graphic Settings dialog box (see Figure 4-46).
Figure 4-46. Value Graphics tool, settings

The Lock Data Values checkbox on the Data Values tab allows you to control the scaling of
the drawing object. If the box is checked, the drawing object is including in scaling. If you
clear the checkbox, the object retains its original size.
In the Colors and Lines tab, you can set the color and line width of the drawing object.
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4.6

Configuring settings for EEG views

The EEG views offer a variety of ways of displaying EEG data on the screen. You can configure
them using the "view settings" in order to display the EEG data how you want it. Views that
display the data in a similar way are subdivided into view categories to make configuration
easier. Thus, the grid views for time and frequency data belong to the same view category.
All the views in a category can be assigned the same default settings.
The view settings in the Analyzer are hierarchically organized. A distinction is made between
the factory settings of the views (Factory Settings), the category-related view settings (Default View Settings) and the node-specific view settings.
The factory settings cannot be altered. They differ from one view category to the next. Userdefined settings can easily be reset to the factory settings.
The category-related view settings can be changed by the user and apply throughout the program to all nodes displayed with views of a particular category, for example all standard
views or all grid views. You can display the category-related view settings by choosing File >
Configuration > View Settings (in the ribbon).
The node-specific view settings apply exclusively to the history node currently being processed. The settings are saved in the node and are available when you open the node again.
You display the node-specific settings by right-clicking any point in the current view and
choosing the Settings… command from the context menu.
If you make view settings at different levels then the more specific setting always takes priority over the more general one. This means that a category-related setting is used instead of
the factory setting and that a node-specific setting, if present, is used instead of the category-related setting.
This rule applies to each setting individually. For example, if you change a single view setting
in a node then the other settings for the display of the node will be taken from the categoryrelated settings. In this way, you can adapt certain details for the display of the node while
simultaneously managing the basic settings across the entire program.

Example

Figure 4-47 presents the behavior of various view settings using the example of a node with
segmented data observed in grid view. General settings are arranged in the diagram at the
top and the more specific settings presented below this. At the lower edge of the diagram,
you can see which settings values are actually used by the view.
At each level of the hierarchy, it is possible to see which value has been assigned to the relevant view setting. Boxes with dashed outlines indicate that no setting was made at this level.
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Figure 4-47. Hierarchy of view settings using the example of a node with segmented data

If, in this example, the user now creates a new Segmentation node, this will be displayed in
exactly the same way as the example node in the grid view with a visible baseline. However,
the node-specific settings for Show Border are not taken over for this new node, i.e. the
frame around the grid cells is visible.

4.6.1

Category-related view settings

To make category-related view settings, click View Settings in the Analyzer button. Alternatively, choose the File tab in the ribbon and select the View Settings command in the
Configuration group. The Default View Settings dialog box appears (see Figure 4-48). Here
you can make the default settings for all the views in a view category. These settings apply
throughout the program for the display of all nodes which do not possess specific settings
that override the defaults.
The dialog box groups together all views that display nodes with different data types in the
same way (e.g. frequency grid view and time grid view) in the same view category.

View categories are explained in more detail in

Section 4.1.1 as of page 109.
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You can see a list of the view categories in the left-hand section of the dialog box. When you
select a category, the settings editor for this category opens in the right-hand section of the
dialog box. The available tabs and settings differ from category to category. For example, the
editor for the mapping view category does not contain an Overlay tab because mapping
views themselves do not have any overlay function. Because this dialog box allows you to
make settings for the entire view category, it usually contains more tabs than are available
in the settings for individual nodes. For example, both the Display (FFT) and Time-Frequency
tabs are visible for the standard view category in order to cover the display options for both
these data types.
Figure 4-48. Category-related view settings, settings editor

You use the Apply button to apply the current settings in the settings editor to the selected
category. Open views belonging to this category are updated immediately.
The Reset All Settings from Selected View button resets the view settings of the currently selected view category to the factory settings for this category.

4.6.2

Node-specific view settings

You display the node-specific settings by right-clicking any point in the open view and choosing the Settings command from the context menu (see Figure 4-49).
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Figure 4-49. Displaying the node-specific view settings

The View Settings dialog box appears, which contains the node-specific settings for the view
in the form of tabs. In the case of the standard view with time data, these are the tabs Display, Overlay and Styles (see Figure 4-50).
Figure 4-50. Node-specific view settings based on the example of the standard view

When you create a new node, it initially takes the category-related view settings (default view
settings). The changes you subsequently make to the node's view settings always take pri-

For detailed information on
the standard view, refer to
Section 4.2.5 as of page 126.
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ority over changes to the category-related view settings. This rule applies to each setting individually. If you only change one setting here, the category-related view settings are
accessed to determine the remaining settings. In this way, you can adapt certain details for
the display of the node while simultaneously managing the basic settings across the entire
program.
The node-specific settings are saved in the node and are available when you open the node
again. The node-specific settings only apply to the active view. You can therefore display the
node in different views and use different settings for each of them.
If you click Apply in the dialog box for the node-specific view settings, the current settings
are applied to the view and the dialog box is not closed. The view is immediately displayed
with the new settings. You can use this function to test a number of different values for a setting.
To clear all the view settings made at node level, right-click to open the view context menu
and choose Reset Settings (see Figure 4-51). You can also use the Reset View Settings command in the history node's context menu to delete all the node-specific settings for all the
views that are saved in this node.
Figure 4-51. Restoring the category-related view settings for the active history node
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4.6.3

The view settings in detail

In this section, we describe the settings that you can make in the individual tabs in the settings editor. The editor is displayed as a part of the dialog boxes for category-related and
node-specific view settings.
Here we describe all the implemented settings. However, in real-life applications, it is frequently the case that not all the settings are available. Tabs that are not required are hidden
in the editor depending on the situation. If only some of the controls present on a tab are required in any given situation then the remaining controls are grayed (unavailable). If you note
that one of the settings described here is not available in the corresponding dialog box then
this means that the setting is not relevant for your current situation.
The Display tab comprises the general display settings for markers and EEG graphs (see
Figure 4-52).
Figure 4-52. Settings in the "Display" tab

If you check the Show Baseline box, the baseline is displayed.
If you check the Show Border box, the EEG graphs are truncated at the borders of the grid
cells or channel ranges. An additional border appears around the cell in grid or head views.
The Show Label checkbox allows you to show or hide the channel names.
Checking the Label on Left Side box causes the channel names to be displayed to the left of
each channel.

Markers and EEG graphs
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If you check the Align Labels to Fit All Data Channels box, the width of the channel names is
also influenced by channels that are not currently visible. If in a standard view, for example,
you are only viewing a few channels then sufficient space is left to prevent the channel
graphs from being shifted to the right when you scroll in the channel list.
If you check the Show Horizontal Level Lines box, lines are drawn at fixed intervals (see
Figure 4-53). The value Distance between Level Lines [μV] specifies the distance between the
lines in microvolts.
Figure 4-53. Horizontal lines for voltage display

If you check the Show Global Markers box then the markers that are common to all channels
(i.e. not limited to a particular channel) are displayed. You can choose whether the markers
are to be displayed below the graphs (Global Markers in Marker Bar) or directly on the channels (Global Markers in Channel).
Figure 4-54. Display of global markers
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Figure 4-55. Markers displayed below the graph

Figure 4-56. Markers displayed on the graph

If you check the Show Channel Markers box then the markers that only occur in individual
channels are displayed. These markers are always displayed on the graph corresponding to
these channels.
The Display (FFT) tab contains the settings that are relevant for data in the frequency domain
(see Figure 4-57).

Data in the frequency domain
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Figure 4-57. Settings for frequency data

You can specify whether the individual points are to be drawn as discrete blocks (Draw Data
as Block) or as a graph (Draw Data as Graph).
If you check the Draw Fill Colors box, the area under the graph is filled with colors. If you do
this, the frequency bands set on the Bands tab are used (
see also the explanations on
page 166 in this section).
If you check the Show Legend box then the correspondences between colors and frequency
bands are displayed at the lower border of the view.
If you check the Logarithmic Scaling box then the y-axis is subdivided logarithmically.
Under Display Range, you can specify the displayed frequency range in hertz. This setting determines what part of a data segment should in theory be displayed. In the view, you can navigate in this frequency range as usual using the
and
buttons. If you are looking at more
than one segment simultaneously, the selected frequency ranges are displayed appended to
one another without interruption.

Data in the time-frequency
domain

The Time-Frequency tab is used for views that display data in the time-frequency domain
(see Figure 4-58).
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Figure 4-58. Settings for time-frequency data

If you check the Logarithmic Scaling box in the Scaling group then the y-axis is subdivided
logarithmically.
If you choose the Automatic Scaling option then you can calculate the optimum scaling automatically. If the Symmetric Scaling box is also checked, scaling limits are selected that ensure that the value zero is always in the middle of the color scale.
If, on the other hand, you select the Manual Scaling option, you can specify scaling manually
by entering the voltage interval covered by the displayed color spectrum in the Maximum and
Minimum text boxes.
If you have selected Manual Scaling then you can modify the scaling directly in the view without having to open a settings editor. To do this you use the scale interactively.
You will
find notes on the scale in Section 4.2.4 on page 125.
In the Satellite Graphs group, you specify whether the satellite graphs are always displayed
(Show Always), never displayed (Show Never) or only displayed when there is enough space
for them (Show, if Size is Sufficient).
If you check the Show Mini Map for Single Channel box then a map indicating the voltage
distribution over the surface of the head at the selected time and frequency is displayed in
addition to the satellite graphs. This map is only displayed if you are viewing a single channel.
If you check the Interpolate Data box in the Colors group then the data in the time-frequency
domain is interpolated in order to achieve a continuous data display.
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You can choose between different types of color display:
 Standard Colors: The standard color scale (blue-green-red) is used.
 Grayscaling: A grayscale display is used instead of a color display.
 Discrete Colors: The colors are displayed in discrete color levels.

Clicking the Set Details… button displays the Discrete Color Settings dialog box (see
Figure 4-59). Here you can define the colors to be used for the positive and negative values.
In the Color Steps text box you specify the number of steps in the color scale.
Figure 4-59. Settings for color scales with separate color steps

You can choose between different types of color scales here. In the right of the dialog box,
you will see an example of the corresponding scale type using the selected colors. The display in the view itself may differ from this depending on the voltage values that are actually
present in the EEG. As a result, for example, the value zero is not always visible on the scales.
Lightest Color at Zero Values uses white for the value zero and black for the ends of the
scale. Between these zero and end points, a color gradient with the selected colors is used
for the positive and negative values.
In contrast, Darkest Color at Zero Values uses black for the value zero and white for the ends
of the scale.
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Symmetrical Color Distribution uses the color selected for the negative values for the value
zero and transforms this color into the color selected for positive values to create a symmetrical color scale. This means that the color scale in the positive and negative directions is the
same regardless of whether the two ends of the scale indicate the same value. If the ends of
the scale indicate different values then different colors will consequently be displayed there.
Uniform Color Distribution uses a uniform color scale between the selected colors.
If you check the Draw Contour Lines box, each color step gets a contour line.
You can configure the x- and y-axes in the Axes tab (see Figure 4-60).
Figure 4-60. Settings for axes

The Show Never, Show, if Size is Sufficient and Show Always options allow you to specify
whether the axis is not to be displayed, only to be displayed if there is enough space or always displayed.
Under Position, you can specify the position of the axis: The x-axis can be positioned on the
baseline (Baseline) or along the lower border of the EEG (Bottom). The y-axis can be positioned on the left (Left) or at the zero time point (Time 0).
Under Tickmarks you set the intervals for the subdivisions of the axis. You can either have
the intervals determined automatically (Set Automatic) or set them manually (Set Manual).
For the x-axis, you specify the interval in milliseconds; for the y-axis, you specify it in microvolts.

X- and y-axes
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In addition, you can specify the alignment of the scaling marks under Alignment: For the xaxis, you can specify alignment with the top (Top) or bottom (Bottom) and for the y-axis, you
can specify left alignment (Left) or right alignment (Right).
Under Tickmark Labels you use the Show Labels checkbox to specify whether and, if so, at
what intervals the subdivisions of the axis are to be labeled. For the x-axis, you specify the
interval in milliseconds; for the y-axis, you specify it in microvolts. The specified interval is
only used if you have chosen Set Manual as the setting for the division of the axis. Otherwise,
suitable intervals are automatically determined for the labels.

Frequency bands

You make settings for frequency bands on the Bands tab (see Figure 4-61).
Figure 4-61. Settings for frequency bands

In the table you can specify the color of a band, its name and where it starts and ends in
hertz.
You change the color for the band by repeatedly clicking on a color swatch in the Band Color
column. This opens the color selection dialog box.
The asterisk allows you to insert a new row in the table. You can press the <Del> key to delete
this again.
All frequency ranges that are not defined in the table are displayed in black.
When you edit category-related view settings, the Apply to all Views button is available. If
you click this, the current frequency band settings are applied to all the other view categories. The histogram view (MR Correction transform) is an exception to this because it does not
use the usual frequency bands.

Overlaid curves (overlays)

On the Overlay tab (see Figure 4-62), you can specify settings for overlaid EEG curves. The
settings affect how the curves are displayed and labeled. They are made separately for each
curve in a table.
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Figure 4-62. Settings for overlays

You can choose whether the curves are to be represented by different colors or different line
types (monochrome) (see Figure 4-63). To do this, you select either the Monochrome or Color
option. In the Line Width column you specify the width of the curves.
Figure 4-63. Frequency band display using monochrome lines
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For detailed information on
overlays, refer to
Section 4.3 as of page 132.

In the Reference Node and Overlays text boxes you enter the names of the reference channel
and the overlays. The entries in these text boxes are only used if data sets are overlaid.
You can also use placeholders to name the overlays. These are replaced with current values,
for example by the name of the relevant data set, when the curves are displayed. Table 4-6
lists all the available placeholders.
Table 4-6. Placeholders available for naming overlays
Placeholder

Meaning

$c

Channel name

$h

Name of the history file

$n

Name of the history node

$o

Ordinal number of the curve

$p

Full history path containing all the intermediate steps from the raw EEG
to the current data set

$ct

Comment on the history node. This can be edited by means of the
Comment command in the node's context menu.

The Apply to all Views button applies the current settings for overlays to all other view categories. The butterfly view and standard deviation view are exceptions to this because they
use special overlay settings.

Maps

You make settings for topographic maps on the Maps tab (see Figure 4-64).
Figure 4-64. Settings for maps (topographies)
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In the Number of Maps text box, you enter the number of maps to be displayed simultaneously.
In the Interval between Maps text box you enter the interval between two maps. For time data
you specify this in milliseconds, and for frequency data in hertz.
There are two ways to specify the number of maps:
 Directly, by entering a value in the Number of Maps text box and checking the Fix Number

of Maps box.
 Indirectly, by entering a value in the Interval between Maps text box and clearing the Fix

Number of Maps box.
Check the Fix Number of Maps box if you want to manually change the width of the total interval to be displayed in a mapping view. In this way, the number of maps displayed is kept
constant during scaling and the interval between them is adjusted accordingly. Otherwise,
the interval between the maps is kept constant and the number of maps is adjusted accordingly.
If you check the Use Average Value of Interval box, the average value of the selected interval
is used to calculate the maps. Otherwise, only the first point of the interval is used. The time
or frequency value below the individual maps is specified as a specific point in time or an
interval in accordance with this setting.
Use Preview allows you to create a preview before the map is actually calculated. This can
give a very quick impression of the map's color distribution.
The preview function is useful when the map image has to be navigated quickly. However,
you should not use this function if you want to programmatically record an animation consisting of map screenshots.
The following options allow you to select algorithms for calculating the data:
 Triangulation and Linear Interpolation
 Interpolation by Spherical Splines

If you decide on interpolation with splines, enter the spline order in the Order of Splines
text box and the maximum degree of the Legendre polynomial in the Max. Degree of
Legendre Polynomials text box.
If you check the Default Lambda box, the default value of 10-5 (1e-5) is used. If you want
to enter a different value in the Other Lambda text box, clear the checkbox.
If you choose the Automatic Scaling option then you can calculate the optimum scaling automatically. If the Symmetric Scaling box is also checked, scaling limits are selected that ensure that the value zero is always in the middle of the color scale.

For detailed information on
both of these algorithms,
refer to Section 7.1.11 as of
page 227.
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If, on the other hand, you select the Manual Scaling option, you can specify scaling manually
by entering the voltage interval covered by the displayed color spectrum in the Maximum and
Minimum text boxes.
If you have selected Manual Scaling then you can modify the scaling directly in the view without having to open a settings editor. To do this you use the scale interactively.
You will
find notes on the scale in Section 4.2.4 on page 125.
Under Direction, you can choose one or more different views of the map: Top (viewed from
the top), Front (viewed from the front), Back (viewed from the rear), Right (viewed from the
right) and Left (viewed from the left).
Alternatively, you can check the All in One Map box to display a single map depicting a configurable section of the head. All in One Map always displays the head from the top and cannot be combined with other maps. The Max Angle [degrees] text box allows you to specify
the section of the head that is visible in the map. Here, the angle corresponds to the theta
coordinate of the points that are projected onto the border of the map. You should select an
angle greater than 90 degrees here in order to include electrodes that are located below nasion or inion.
You can choose between different types of color display under Display:
 Standard Colors: The standard color scale (blue-green-red) is used.
 Grayscaling: A grayscale display is used instead of a color display.
 Discrete Colors: The colors are displayed in discrete color levels.

Clicking the Set Details… button displays the Discrete Color Settings dialog box.
For
a detailed description of the settings for color scales with separate color steps, refer to
page 164 in this section.
In Quick Graphics mode, not every pixel in the map is calculated. Instead, only the values of
the points of a rectangular grid with a specific resolution are calculated. Then each rectangle
in the grid gets the calculated color. This results in a map that has a lower resolution but can
be calculated much quicker.
If you check the Show Electrodes box, the electrodes appear as small circles on the map.

Head view

You can make settings for the way the head is displayed in the head view on the Head View
tab (see Figure 4-65).
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Figure 4-65. Settings for the head view

Under Direction, you can choose the direction from which the head is to be displayed: Top
(viewed from the top), Front (viewed from the front), Back (viewed from the rear), Right
(viewed from the right) and Left (viewed from the left).
Alternatively, you can check the All in One box to display a configurable section of the head.
All in One always displays the head viewed from the top. The Max Angle [degrees] text box
allows you to specify the section of the head that is visible in the head view. Here, the angle
corresponds to the theta coordinate of the points that are projected onto the border of the
display. You should select an angle greater than 90 degrees here in order to include channels
that are located below nasion or inion.
Under Channel Display, you can specify the channels that are visible in the head view. By
checking the box Show Channels Without Coordinates, you can also display channels that
do not have any coordinates. These channels are displayed to the left of the head at the edge
of the view. By checking the box Show Channels Hidden by Head, you can show channels
that are located behind and hidden by the head in the current display. These channels are
also displayed at the top-left edge of the view.
You can change the fonts used in the view in the Styles tab. You can also modify the colors
used in certain parts of the view and control the width and color used when drawing lines
(see Figure 4-66).

Fonts and line definitions
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Figure 4-66. Fonts and lines

The left section of the tab displays the view components that you are able to configure. These
are subdivided into
 Fonts: The individual fonts are combined into logical groups which may have different

meanings in the individual views. Thus the Large Labels font is used to display large labels in a view. This may therefore apply, for example, to the channel names in standard
views and the time ranges of maps in mapping views.
 Colors: The colors are used to fill predefined areas in the view. A typical example is the

background color set via View Background.
 Line definitions/pens: Here you can specify the width, color and line pattern used to draw

different items in the view. For example, you can control the appearance of the "Time Zero" marker in segmentations.
When you select a setting, a control enabling you to edit the properties appears in the righthand part of the tab. A help text explaining what the corresponding setting is used for is also
displayed.

The 3D head view

The settings for the 3D head view only appear for the 3D head view category. Here you can
make settings for the 3D maps (see Figure 4-67).
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Figure 4-67. Settings for the 3D head view

The Interpolation, Scaling and Display groups precisely correspond to the settings in the
Maps tab (
see also the explanations in Section 4.6.3 on page 168 ff).
The Direction group does not appear here because the head can be rotated freely.
In the Head File drop-down list box, you can choose the head to be displayed from the available head definitions.
The Vertical Angle and Horizontal Angle text boxes allow you to specify the angle of view for
the head.
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Montages enable channels to be reconnected on a software basis or new voltage reference
points to be assigned to the channels.
Montages allow you to optimize the display of data by, for example, grouping together frontal
electrodes in one montage and occipital electrodes in another. When one of these montages
is selected, only those channels that have been assigned to it are displayed. The sequence
of channels can also be changed in a montage so that channels which were originally apart
can be shown next to each other. A channel can also occur more than once in a montage.
Another useful characteristic of montages is that certain display parameters, such as the position and size of a channel, can be saved in a head view and then be called up again in a
subsequent working session.
Montages are used for visualization purposes only, i.e. the resulting data only exists temporarily and the original data is not changed.

5.1

Creating and editing a new montage

To create a montage, open the Display tab in the ribbon and choose Create Montage. This
opens the Create New Montage dialog box (see Figure 5-1).
Figure 5-1. Creating a new montage

Under Choose Reference, you choose the reference type to be used in the new montage. The
following options are available for this:
 Original. No new reference is calculated. This type of montage is only used to group

channels together or optimize their presentation.
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To begin with, we recommend that you take the easiest reference type, namely
the original reference.
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 Average. The average reference is calculated, i.e. the average of all selected channels is

used as the reference.
 Laplacian: Source derivation, as described by Hjorth, is carried out. This is a method de-

rived from the Laplace transform in which the reference is calculated from multiple neighboring electrodes of a channel.
In order to work out which are the neighboring electrodes, the program requires information about the position of the electrodes. If you used the 10-10 or 10-20 system when recording the EEG, the program should have this information. If you used other channel
names, you can use the Edit Channels transform to enter the correct coordinates.
You
will find detailed information on editing channel properties in Section 7.1.6 as of
page 216.
You can also specify a separate file containing default coordinates.
please refer to Section 6.1.5 as of page 192.

For information,

 Bipolar. Differences between channels are formed.

Once you have selected the reference type, click OK. The montage editor appears. The montage editor has the same basic functions for all four reference types. A number of additional
controls are displayed for the "Laplacian" and "Bipolar" reference types.
The montage editor contains the Head View and List View tabs. These tabs allow you to select the channels contained in the montage. The head view gives you an overview of the arrangement of the channels on the head. The list view function allows you to enter new
channels not displayed in the head view. You can additionally activate a grid display of the
montage.
For explanations concerning this view, see the section on "montage grids" on
page 178 of the current section.

Position of the channels on the
head (head view)

The head view shows you the position of the channels on the head (see Figure 5-2).
Channels whose position is not known are displayed to the left of the head. If you click the
name of a channel, it is added to the montage. If you click it again, it is removed from the
montage. Channels added to the montage are highlighted in black.
Insert current channels allows you to add all the existing channels to the montage. Remove
All removes all channels from the montage.
You can select multiple channels by clicking in a free area in the head display and dragging
the mouse.
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Figure 5-2. Montage editor, head view

The list view displays the list of channels in the order in which they appear in the montage
(see Figure 5-3). You can select multiple rows in the list and delete them. In the last row, you
can add new channels by choosing them from the drop-down lists or by entering them directly.
If you have entered a channel name manually then this name is added to the drop-down lists.

Order of channels in a montage
(list view)
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Figure 5-3. Montage editor, list view

Montage grid

A distinction is drawn between montages with and without grid information. Montages with
grid information specify how the channels are displayed when a grid view is used (size of the
grid in rows and columns, free cells). Montages without grid information are automatically
arranged in a grid view with no cells free.
You specify whether a montage has grid information by means of the Use Grid checkbox. If
you check the box, an additional button appears in the montage editor (see Figure 5-4).
In the grid, you can use the mouse to add channels and drag them to a different cell. If you
drag a channel to a cell occupied by another channel, the channels swap places.
The order in which the channels appear in the list view is always the same as the order in
which they occur in the grid on the right. Read from left to right and top to bottom. If you
change the position of a channel in the grid on the right, the list is adjusted accordingly.
Even if a montage is not to use any grid information, it can be a good idea to display the grid
on the right temporarily in order to make it easy to change the order of the channels.
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Figure 5-4. Montage editor with grid on the right

Under Grid Size, you specify the size of the grid in rows (Rows) and columns (Columns). The
Apply button applies your entries to the grid. If the grid is reduced in size, channels already
contained in the grid are rearranged in the new grid, reflecting the original layout as far as
possible.
The Set grid size to channel numbers button creates an approximately square grid containing the channels of the montage. If you add new channels on the Head View or List View tab,
they are added in the free cells. If necessary, the grid is extended.
If the mouse pointer is positioned over a cell in the grid, the corresponding channel is highlighted in color in the head view (see Figure 5-5).
In addition, you can also drag channels directly from the head view to a grid cell.
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Figure 5-5. Color highlighting of channels

Channel sets

You can use the Channels in Montage are Based on drop-down list to define the set of channels on which the head view is based. In the list view, you use the channel drop-down lists.
The following options are available for selection:
 Standard 10/20 Electrodes: The standard set from the 10-10 or 10-20 system is used.
 -NONE-. With the exception of any existing montage channels, there are no channels

available.
 Data Node Electrodes: The channels of the open data node are used.

Regardless of the underlying channel set, you can, of course, continue to enter channel
names of your choice in the list view.
The Load button allows you to load a separate configuration file for electrode coordinates in
the BrainVision Electrode file format.
This XML-based format is described in Appendix J
on page 583.
If you check the Make commonly used channels available in selection lists box, a selection
of frequently used channel names is added to the channel drop-down lists in the list view. If
you choose one of these channels from a drop-down list, it appears in the head view with
standard coordinates even if it is not contained in the selected channel set.

Peculiarity of the "Laplacian"
reference type

If you select the Laplacian reference type, the Number of Reference Electrodes text box appears in the montage editor, thus allowing you to specify the number of reference electrodes
(see Figure 5-6).
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Figure 5-6. Montage editor for the "Laplacian" reference type (section)

If you choose the Bipolar reference type, the list view contains two columns, i.e. one each for
channel (Channel) and reference channel (Ref Channel) (see Figure 5-7). The cells in the grid
indicate the difference between the channel and reference channel in each case.
Figure 5-7. Montage editor for the "Bipolar" reference type, list view with grid on the right

On the Head View tab, the channel and reference channel are shown connected by arrows
(see Figure 5-8). You can use the mouse to add a channel and drag it to its reference channel.

Peculiarities of the "Bipolar"
reference type
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Figure 5-8. Montage editor for the "Bipolar" reference type, head view

Saving a montage

You can use the Save and Save As… buttons to save the montage.

5.2

Modifying an existing montage

To modify an existing montage, open the Display tab in the ribbon and choose Edit Montage.
A dialog box appears that allows you to open an existing montage file.
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After you have edited the montage, the system prompts you to enter a name under which you
wish to save the montage. You can enter a new name in order to obtain a new montage from
an existing one.
You should, however, note that the reference type of an existing montage cannot be
changed.

5.3

Displaying montages

The Display Montage menu command allows you to display all your montages (see Figure 59).
Figure 5-9. Displaying created montages in the ribbon

To allow you to switch quickly between different montages, you can assign them keyboard
shortcuts. Pressing one of these keyboard shortcuts activates the associated montage.
You can choose Display > Montages > Options to assign the keyboard shortcuts <Ctrl-2> to
<Ctrl-0> to the existing montages as you wish (see Figure 5-10). Please note that the shortcut
<Ctrl-1> is reserved for the default montage.

Keyboard shortcuts for
montages
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Figure 5-10. Assigning keyboard shortcuts to montages

You can also select a montage that is to be activated when you open a new data window. To
do this, choose File > Configuration > Preferences in the ribbon. You can select the initial (default) montage for non-segmented and segmented data sets under Default Montage in the
Views tab of the Preferences dialog box (see Figure 5-11).
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Figure 5-11. Selecting the initial (default) montage in the "Preferences" dialog box

If you look at a view belonging to the head view category in the Analyzer's main window while
also using a montage, then the program stores additional information about the position and
size of the channel windows in the montage. The stored information is updated if you modify
the position or size of the channel windows using the mouse.
You can use this function to apply the channel window layout to the display of another data
set by using the same montage when displaying this second data set. Similarly, you can also
restore the layout of the channel windows in the display of the same data set either later
during the same session or in a new working session.
Because the information about the layout of the channel windows is stored in the montage
file, this function is not available when you use the default montage. However, you can specify a montage that is to be used when you open a new data set in the Preferences dialog.


Additional information in
montages
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A large number of program settings are available to help you control the Analyzer. For example, you can choose how the display of EEGs is to be scaled when you open a data set. You
can make settings that apply to the entire program in the Configuration group which is located on the File tab in the ribbon.
Your preferences include, for example, settings for the EEG views, scaling, the display of history nodes and transforms in the ribbon as well as the output of graphics.
User interface settings relate to the color of the main window and the arrangement of the
dockable sub-windows in the program.
EEG view settings control the way EEG data is displayed in the main window. These settings
allow you to determine the details of the individual EEG views such as grid view or mapping
view. In addition to the global program settings, you can also make separate settings for
each node and each EEG view.
The administration settings control whether the program settings are to be managed for
each user individually and allow you to define the default settings for new users. Here you
will also find technical settings such as the file paths used by the Analyzer.

6.1

Configuring your preferences in the Analyzer

To open the Preferences dialog box, click Preferences in the Analyzer button or choose File >
Configuration > Preferences in the ribbon.

6.1.1

Selecting EEG views for data sets

In the Views tab, you can specify how EEG data is to be displayed in newly opened windows
(see Figure 6-1). You can make separate specifications for non-segmented and segmented
data.
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All the views are described
in detail in Section 4.2 as of
page 118. You will find detailed information on configuring the view settings in
Section 4.6 as of page 154.
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Figure 6-1. Selecting EEG views

To do this, you can choose the EEG view and montage that are to be used from a drop-down
list (Default View and Default Montage). These settings are taken as the defaults to be used
if you do not explicitly specify another view, for example by means of the Additional View
command in the ribbon.
In the case of non-segmented data, you can specify the default length in seconds of the time
interval that is visible on the screen in the Default Display Time [s] text box. In the Overlap
Intervals [s] text box, you specify the number of seconds by which the intervals should overlap when you scroll in the EEG. If you select an interval of 10 seconds and an overlap of 1 second, then you will scroll through the EEG in steps of 9 seconds.
In addition, the Default Displayed Channels text box allows you to specify the number of
channels that should initially be visible in newly opened nodes.
You can define the width of the transient transform in the Relative to Window Width [%] text
box. This value specifies the proportion of the main window occupied by the transient transform when it is opened.
For more detailed information on transient transforms, refer to
Chapter 8 as of page 483.
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6.1.2

Configuring scaling

In the Scaling tab, you can specify how EEG data is to be scaled in newly opened windows
(see Figure 6-2). You can specify separate values for scaling in the time and frequency domains (Time Domain Scaling and Frequency Domain Scaling groups). Because averaged
EEG data often has a different amplitude to non-averaged data, you can also select separate
scaling values for before and after averaging.
Figure 6-2. Configuring scaling

You can specify the required default scaling for data sets before and after averaging in the
Before Averaging [μV] and After Averaging [μV] text boxes.
For the time domain, the Polarity Positive Down function sets the polarity of the signal in the
display. If this box is checked, the axis for positive signals points downwards.
If you check the Start with Start with Display Baseline Correction On box, the baseline correction function in the EEG view is activated when you open a new window.
If you check the Time Labels are Relative to Display Interval box, the time specifications in
views (in the labels of mapping views and 3D head views, for example) are displayed relative
to the EEG interval displayed. If the box is not checked, these times are displayed relative to
the beginning of the whole EEG. If the EEG has its own time scale defined by "Time Zero"
markers, this time specification is ignored and the time scale is used.
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The Set Individual Scaling Factors function allows you to specify different scaling factors for
selected channels (see Figure 6-3).
It makes sense, for example, to use a different scaling for ECG channels since otherwise they
encroach significantly on the curves of the EEG channels.
Figure 6-3. Separate scaling for individual channels

In the table, you can enter the channel names and the associated scaling factors by which
you want to reduce the scale of the signals. The attenuation only affects the display of the
data; it does not affect the data itself.

6.1.3

Assigning colors to transforms

The Transformation Colors tab allows you to assign colors to the individual transforms.
These are used for the transform icons in the History Explorer, the commands on the ribbon
and in the frames of the EEG windows (see Figure 6-4).
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Figure 6-4. Assigning colors to transforms, color selection dialog box

If you repeatedly click a color strip in the Color column, a color selection dialog appears.
In the Frame-Width text box, you can specify the width of the color frame around the corresponding EEG data window. This must be a value between 0 and 99.
When you click Set to Default, the transform is assigned the color value that was selected under <Default>. If you change the value <Default>, all transforms that have been assigned this
value are changed.
If you click Reset all Transformations to <Default>, the value <Default> is applied to all transforms.

6.1.4

Outputting graphics

The functions available on the Graphics Export/Output tab are described in Chapter 12 as of
page 529 and Chapter 13 as of page 533.
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6.1.5

Electrode coordinates

On the Electrodes tab, you can specify a separate configuration file for electrode coordinates
(see Figure 6-5). These coordinates are used if EEG data does not have coordinate specifications for its channels.
Figure 6-5. Defining electrode coordinates

By default, numerous electrode positions are predefined in the Analyzer. By specifying a separate configuration file, you can add to or replace these.
The format of this file is described in Appendix J on page 583.
Note that a file containing the specification "Defaults = False" entirely replaces the Analyzer's default coordinates. If a file does not contain this specification, the coordinates in the
file are added to the default coordinates.

6.1.6

General settings

You can make a number of settings that control Analyzer operation on the General tab (see
Figure 6-6). These settings control, for example, whether deleted nodes are automatically
purged or whether online information is displayed on program start.
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Figure 6-6. General settings

If you check the Automatically Purge Deleted Nodes box then deleted history nodes are automatically removed from the temporary storage location for deleted nodes after a specified
period. This function prevents deleted nodes from accumulating over time and taking up
large quantities of storage space.
The entry in Purge Nodes every xxx days specifies that the nodes are purged after this time
elapses, at the earliest. In normal usage, the nodes are often there for a little longer because
the automatic purging of the nodes is subject to additional checks.
The automatic purging of nodes is only carried out when you close the history file. This means
that deleted nodes in history files that you never open are not automatically purged.
The setting you make in Draw Idle-Background for Progress Bar specifies whether the main
window is displayed grayed in the background as long as a progress bar is active. This function is no longer required under Windows® Vista and Windows® 7 since the operating system performs this task itself. We recommend leaving this specification set to Auto. If
problems with the display of the grayed background occur in Windows® XP, you should
change this setting to Off.
In the Show Online Info at Startup box, you can specify when the online information page is
to be displayed on program start. If, for example, you choose Never here then the page is deactivated.

194 Chapter 6 Customizing program settings

6.2

Customizing the graphical user interface

6.2.1

Skins

The Analyzer provides you with a range of skins which you can use to change the appearance
of the user interface. To select a skin, click the corresponding icon on the Display tab in the
ribbon. To display the available skins in a drop-down list, click (see Figure 6-7).
Figure 6-7. Selecting a skin

6.2.2

Docking

You can use docking techniques to arrange the various Analyzer interface elements, such as
windows and bars, during your work. You can fix the docking windows in position at any point
in the application window and show or hide these dynamically.
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Figure 6-8. Maximized data view

Figure 6-9. Maximized productivity
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The names of docking windows are displayed in their title bars. Depending on the setting, the
windows may possess the following buttons which can be used to hide, enlarge, reduce and
close them:
anchors the docking window.
temporarily shows or hides the docking window.
maximizes the docking window.
minimizes the docking window.
closes the docking window.
Because of their horizontal orientation, the toolbar and navigation bar can only be docked
onto the upper or lower border.

Modes of the docking windows

Docking windows can be anchored in position or floating. In addition, anchored windows can
be pinned or unpinned.

Floating docking window

A floating docking window can be docked onto the outer or inner borders of the main window
and the other windows in the Analyzer user interface. You can resize it by dragging its borders. You can also move such windows outside of the main window, for example in order to
work with multiple monitors (see Figure 6-10).
Figure 6-10. Floating docking window

Docked windows

Docked windows have a "pin" button in the title bar (see Figure 6-11). When you click the pin,
it changes from vertical (pinned) to horizontal (unpinned) or vice versa.
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Figure 6-11. Title bar of a docking window

Horizontal pin: The docking window is pinned and is hidden when you move the mouse
pointer outside it. In addition, a bar containing a button for each open window appears next
to the window (see Figure 6-12). You display the hidden window again by positioning the

Pinned windows

mouse on the corresponding button on this bar. When you open the pinned window again, it
covers the main window behind it.
The position of a pinned window cannot be changed. In other words, it is not possible to
move the window using the mouse.
Figure 6-12. Pinned and hidden docking window

Vertical pin: The docking window is unpinned and remains open at all times. You can
change the position of an unpinned window in the main window by clicking in its title bar and
moving it to the required position with the mouse.

Unpinned windows

You can position a docking window relative to the outer or inner borders of the main window
and other docking windows by using landing zones.

Positioning by means of
landing zones

Note that a docking window can only be moved when it is unpinned (i.e. with a vertical pin
button:
).
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If, when you move a window, you position the mouse pointer on a landing zone, the position
that the window can occupy is highlighted in blue (see Figure 6-13).
Figure 6-13. Display of landing zones for docking windows

Grouping docking windows

If you wish, you can group docking windows together either as a tab (see Figure 6-14) or as
horizontal or vertical subdivisions of a window.
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Figure 6-14. Docking windows grouped as a tab

With horizontally arranged docking windows, you can, for example, arrange the windows for
the primary and secondary history files in the same way as in Analyzer 1 (see Figure 6-15).

200 Chapter 6 Customizing program settings

Figure 6-15. Arranging windows as in Analyzer 1

Opening and closing docking
windows

When you first start the program, the docking windows have the following positions: The
Primary Data, Secondary Data and History Node List windows are docked onto the left-hand
border of the application window, the View Toolbox window is docked onto the right-hand
border, and the navigation bar to the lower border.
To open or close the different windows, click Windows on the toolbar and activate or deactivate the corresponding menu option (see Figure 6-16).
Figure 6-16. Opening and closing docking windows

You can use Windows > Reset Panel Layout to reset the docking windows to their original positions.
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6.3

Global settings for EEG views

To make settings for the EEG views, click View Settings in the Analyzer button. Alternatively,
choose the File tab in the ribbon and select the View Settings command. The Default View
Settings dialog box appears (see Figure 6-17). Here you can make the default settings for all
the views in a view category. These settings apply throughout the program for the display of
all nodes which do not possess specific settings that override the defaults.
The concept of view categories and the distinction between views and view categories are explained in detail in Section 4.1 as of page 109.
Figure 6-17. Configuring view settings

You can see a list of the view categories in the left-hand section of the dialog box. When you
select a category, the settings editor for this category opens in the right-hand section of the
dialog box. The available tabs and settings differ from category to category. For example, the
editor for the mapping view category does not contain an Overlay tab because mapping
views themselves do not have any overlay function.
The view categories provide a large number of options which are explained in detail in
Section 4.6 as of page 154.
The Reset All Settings from Selected View button allows you to reset all the settings for the
selected view category to the factory settings.
Your changes take effect when you click OK to exit the dialog box or click Apply.
You can edit the settings for different view categories without having to close and re-open
the dialog box.
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6.4

Administrative settings

To make administrative settings, click Administration in the Analyzer button. Alternatively,
choose the File tab in the ribbon and select the Administration command. The Analyzer
Administration dialog box appears.

Specifying search paths

You can enter search paths in the Application Paths tab (see Figure 6-18):
 In the Installation Base Path text box, you specify the folder containing the application.
 In the Solutions Path text box, you specify the solutions folder.
 In the Workfiles Path text box, you specify the folders for workspace files, macros and

history templates.
You can select a folder for each of these entries by clicking the Browse... button.
Figure 6-18. Specifying search paths

Configuring user profiles

The Profiles tab allows you to manage user profiles (see Figure 6-19).
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Figure 6-19. Configuring user profiles

The user profiles determine where the settings made in the Analyzer using File > Configuration > Preferences and File > Configuration > View Settings are stored. The settings can either
be stored separately for each user or in a shared, global system file for all users.
If the Only the Administrator May Change These Settings box is checked, the rest of the dialog box can only be accessed by administrators.
If you check the Configuration Changes are Written to System Configuration File box, any
changes to the Analyzer settings are written to a global system file.
You can enter the name of the global system file in the System Configuration File text box. If
you do not enter anything here, a default name is used. If you specify only a file name, the
file is stored in a location determined by the system. If you specify a full path, the file is
stored in the location indicated by this path.
Note that you must have read and write access to this path in order to use the file.
If you check the Use Individual Profiles box, any changes made to the Analyzer settings are
written to a user-specific file.
You can enter a name for the user-specific file in the User Configuration File Template text
box. If you do not enter anything here, a default name is used. In the specified file name the
placeholder $u is replaced with the user name. If you specify only a file name, the user-specific files are stored in a location determined by the system. If you specify a full path, the files
are stored in the location indicated by this path.
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Note that all users must have read and write access to this path in order to use the file.
If the Configuration Changes are Written to System Configuration File box is not checked,
the Use Individual Profiles box is checked and cannot be cleared.
If you select settings files on the Profiles tab that do not yet exist, the files are created. Default values are used for the settings. If user profiles are selected although there is a global
system save file, users use the global system settings unless they have made personal settings that are different from those. In this way, the system-wide configuration file can be
used, for example, to determine the settings for a user starting the Analyzer for the first time.

Specifying user-defined
search paths

Additional components, modified components or components created by the user can subsequently be added to the Analyzer via the Component Search Paths tab. (see Figure 6-20).
Figure 6-20. Specifying component search paths

If the Only the Administrator May Change Search Paths box is checked, only the administrator has the right to change the path settings.
The table contains a list of the search paths taken into account by the Analyzer when searching for components. The Analyzer searches through all the DLL or VAEM files on these paths.
It also always searches through its installation folder.
The asterisk (*) functions as a placeholder in the same way as it does in files. In our example
of C:\Development\*\bin\Debug, the following folders would be found:
C:\Development\Project_1\bin\Debug and C:\Development\Project_2\bin\Debug.
You can select a folder by clicking the Browse... button.
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The Up and Down buttons allow you to change the order of the entries in the table. The order
in which the entries occur is the order in which they are searched. If a component occurs
more than once, the component listed first in the table is always used.
Note that the Analyzer installation folder is always searched after the entries in the table.
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Chapter 7 Primary and secondary transforms

This chapter describes all the primary and secondary transforms available in the Analyzer.
The transient transforms are described in Chapter 8 as of page 483.
You will find the primary and secondary transforms on the Transformations tab of the ribbon.
Primary transforms can only be executed if a data set is open and they always refer to the active data set window. In contrast to the secondary transforms, they can be used in history
templates.
The structure of this chapter reflects the structure of the ribbon. All the transform groups contained in the Transformations tab will be explained in order, from left to right.
Figure 7-1. Transform groups

7.1

Transforms in the "Dataset Preprocessing" group

7.1.1

New Reference

The New Reference transform allows you to form a new reference from the average of selected
channels.

Summary

No previous processing steps are required before the transform is used.

Procedure

To call the transform, choose Transformations > Dataset Preprocessing > Channel
Preprocessing > New Reference.
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On the first page of the dialog box, you can select those channels that are to be included in
the calculation of the reference (see Figure 7-2).
Figure 7-2. New Reference, page 1 of the dialog box

Use Select or Remove to select one or more channels or to remove them from the list of selected channels again.
Check the Include Implicit Reference into Calculation of the New Reference box to include
the original reference channel in the average calculation.
Page 2 of the dialog box allows you to select those channels that are to be re-referenced
(Selected Channels). In addition, by checking the Keep Remaining Channels box you can
specify that the non-referenced channels are retained (see Figure 7-3).
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Figure 7-3. New Reference, page 2 of the dialog box

Enter the name of the new reference channel under Name of New Reference Channel on page
3 of the dialog box (e.g. "Ears" for A1/A2 reference or "Avg" for Averaged Reference) (see
Figure 7-4).
If you check the Reuse Old Reference Channel (Negated New Reference) box, the old reference channel is reused as a normal data channel. An example of this would be a Cz reference
converted to an A1/A2 reference. In this case, the Cz channel can be used for further calculations.
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Figure 7-4. New Reference, page 3 of the dialog box

7.1.2

Pooling

Summary

The Pooling transform allows you to create new channels by pooling existing channels. The
new channels are calculated for each point in time from the average values of the selected
channels at this point in time.

Procedure

No previous processing steps are required before the transform is used.
To call the transform, choose Transformations > Dataset Preprocessing > Channel
Preprocessing > Pooling.
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Figure 7-5. Pooling, dialog box

If you check the Keep Old Channels box, the original channels are included in the new data
set. The new channels are therefore additional channels. If you do not check the box, the new
data set only contains the new channels.
Enter the required number of new channels in the Number of Pools text box.
Click Refresh to refresh the channel matrix.
When you click a cell in the table, its color changes between green and white. Green channels
are included in the calculation and white channels are not taken into account.

7.1.3

RMS/GFP (Root Mean Square/Global Field Power)

The RMS/GFP transform allows you to determine the overall activity of selected channels.

Summary

No previous processing steps are required before the transform is used.

Procedure

To call the transform, choose Transformations > Dataset Preprocessing > Data Preprocessing > RMS/GFP.
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Figure 7-6. RMS/GFP, dialog box

The dialog box allows you to select the channels for which you want to carry out the calculation (Enabled Channels). These channels and the new RMS channel then appear in the new
data set. If you check the Keep Unused Channels box, the channels that are not selected are
included in the new data set.
You can choose between two methods of calculation:
 RMS – Root Mean Square (referenced). For each point in time, the root is calculated from

the average of the squares of the individual values. The result is contained in an additional channel with the name "RMS".
 GFP – Global Field Power (reference free). In addition, before the values are squared, the

average of all channels at a fixed time is subtracted (Average Reference). The result is
contained in an additional channel with the name "GFP".
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7.1.4

CSD Interpolation (Current Source Density)

The CSD transform replaces the voltage values at electrodes that have valid head coordinates with the current source density at these points. Their unit is μV/m2. The channels generated in this way no longer have any specification with respect to the channel reference. The
channels can be further processed using other transforms.

Summary

The current source density is calculated by applying the spherical Laplace operator to the
voltage distribution on the surface of the head at a fixed point in time. Because the voltage
distribution is only known at the electrodes, the spherical spline interpolation method is
used to calculate the entire voltage distribution.
You will find a detailed mathematical
description of this method in [Per90].
No previous processing steps are required before the transform is used.
To call the transform, choose Transformations > Dataset Preprocessing > Data Preprocessing > CSD Interpolation.
Figure 7-7. CSD, dialog box

The following parameters are required in order to calculate the spherical splines:
 The order of the splines (Order of Splines), labeled "m" above

Procedure
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 The maximum degree of the Legendre polynomial (Maximum Degree of Legendre

Polynomials) to be included in the calculation
 The Lambda approximation parameter (Default Lambda)

If you check the Keep Remaining Channels box, then the channels (or electrodes) that do not
have any valid head coordinates are also included in the new data set. Please note that the
transform is not applied to these channels and that these channels continue to have voltage
values.
Depending on the values you enter for the spline order, the interpolation curve displayed will
be smoother or wavier. The higher the spline order, the smoother the curve. The basic principle is: The higher the electrode density is, the lower the value you specify for the spline order should be. Because the calculation of the spherical splines involves an infinite series of
polynomials, this series has to be discontinued at a certain degree. The basic principle is:
The higher the spline order, the lower the degree of the polynomial at which the calculation
can be stopped.
The Lambda approximation parameter determines the accuracy with which the spherical
splines are approximated to the data to be interpolated. A value that is either too high or too
low will, for different mathematical reasons, result in an inaccurate representation. Unless
you are using unusual methods that require a different value, you should use the default value of "1e-5".
Regardless of the above rules, you should not accept the results of the transform without
checking them. In the CSD method, different parameters can lead to satisfactory or unsatisfactory results for different data sets as a result of approximations and rounding inaccuracies. We therefore recommend that you proceed as follows:
For further information on
setting the mapping view,
refer to Section 4.2.4 as of
page 124 and Section 4.6.3
on page 168 ff.

1

Before the CSD calculation is carried out, check the parameters of the spherical splines
using the map. To do this, create a mapping view for the data set.

2

Open the Settings dialog box of the mapping view and select the option Interpolation by
Spherical Splines (see Figure 7-8).

3

Also enter the values you wish to use for the CSD calculation in the Order of Splines, Max.
Degree of Legendre Polynomials and Lambda text boxes.
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Figure 7-8. CSD, Mapping view settings

4

If necessary, check whether the spherical splines approximate to the voltage distribution
on the head surface adequately. Do this by carrying out a comparison with interpolation
by triangulation (Triangulation and Linear Interpolation option). If this is not the case,
select different parameters.

Carry out the CSD calculation with these parameters, and then use the mapping view to make
sure the result is correct.
[Per90] F. Perrin et al., Spherical splines for scalp potential and current density mapping.
Electroencephalography and clinical Neurophysiology, 72 (1990), 184-187, together with
the correction in Electroencephalography and clinical Neurophysiology, 76 (1990), 565.

7.1.5

References

Rectify

The Rectify transform rectifies EEG data. In other words, positive values remain the same,
while negative values are converted to positive.

Summary

No previous processing steps are required before the transform is used.

Procedure

To call the transform, choose Transformations > Dataset Preprocessing > Data Preprocessing > Rectify.
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Figure 7-9. Rectify, dialog box

The dialog box allows you to choose those channels that are to be rectified.
If you check the Keep Remaining Channels box, the channels that are not selected are included in the new data set unchanged. Otherwise, they are removed from the data set.

7.1.6
Summary

Edit Channels

The Edit Channels transform allows you to edit the information for the channels of a data set.
In addition to hiding channels you can edit the following information of each channel:
 channel order
 channel labels (and reference labels)
 channel positions
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 channel measurement units
 User Properties

No previous processing steps are required before the transform is used.
To call the transform, choose Transformations > Dataset Preprocessing > Edit Channels (see
Figure 7-10).
Figure 7-10. Edit Channels, dialog box

The dialog lists all channel information in a table. In detail, the table contains information on
the original channel order and original labels as well as channel positions [Radius, Theta,
Phi] and channel measurement units. User-defined channel properties can be accessed and
edited via the buttons in the column User Properties. With exception of the table columns
Orig. Order and Orig. Label, you can edit all entries in the table:
 Enabled: The channel is displayed if this box is checked. To hide a channel, clear the box.
 Chn (+): Channel name.
 Chn (-): Name of the reference channel. Please note that changing the name of the refer-

ence channel will not re-reference the data. It is provided for information purposes only.

Procedure
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For details on the electrode
coordinate system, refer to
Appendix C on page 563.

 Radius, Theta, Phi: Channel positions. The text box Radius must always contain a posi-

tive number or 0, the value range of the text boxes Theta and Phi ranges between -180
and 180.
 Data Unit: Measurement unit. You can change the preset unit (μV) via the drop-down list.
 Color: Channnel color. Clicking in the cell opens the color selection dialog box, where you

can assign a new color to the channel.
For details on User Properties, refer to „Additional Information: User Properties“
in this Section on page 220.

 User Properties: User-defined channel properties. Clicking the corresponding button

opens the User Properties dialog box.
You can edit the channel table by copying the values of single or multiple cells and pasting
these into other cells. To do this, right-click in the table and choose Copy or Paste from the
context menu. In case of missing values or incorrect table entries, an exclamation mark is
displayed in the respective cell. In this case, please make the required modifications (see
Figure 7-11).
Figure 7-11. Edit Channels, warning for missing values

Additionally, you can edit channel information using the options listed in the Selection, Positions and Order groups at the bottom of the dialog page.
In the Selection group you can click (De-)Select All in order to select or deselect all channels.
Invert Selection allows you to invert the channel selection.
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In the Positions group you can click Default Positions, which will reset all channel coordinates to the default positions, depending on the channel labels. Unrecognized channels are
set to position 0,0,0 (invalid position). Reset Positions resets the channel coordinates to the
initial values when the dialog box was opened.
Please note that after editing the channel positions and using either the function Edit Parameters/Reprocess or Edit Parameters/Copy from the context menu, the initial values will already be updated to the edited values.
When creating a history template or transferring the transform by means of drag-and-drop,
you can prevent individually measured channel positions from being changed by selecting
the Do Not Change Channel Positions checkbox. In this case, the options in the Positions
group are disabled.
You can click Save Positions to File in order to save the coordinates of the channels marked
as Enabled in the Brain Vision Electrode File format. Load Positions from File will load coordinates from a respective file. You will find detailed information on the file format in
Appendix J on page 583.
In the Order group you can edit the channel order using the Move Up and Move Down buttons. To do so, click a table cell and select the respective option. Please use the Reset Order
button in order to undo any changes. The channel order will then be reset to the initial order
when the dialog box was opened.
Please note that after editing the channel order and using the functions Edit Parameters/Reprocess or Edit Parameters/Copy from the context menu, the values in the table column
Orig. Order will not be listed in ascending order anymore. When creating a history template
or transferring the transform by means of drag-and-drop, you can prevent the channel order
from being changed with respect to the parent node by selecting the Do Not Change Channel
Order checkbox. In this case, the options in the Order group are disabled.
Additionally, you can click Load Order in order to load the channel order of any node of the
current history file.

We recommend avoiding duplicate or multiple identical channel names by all means. Analyzer checks the dialog table for duplicate channel names based on the entries in the columns Orig. Label and Labels, Chn (+). Channels that have been deselected (i.e. where the
Enabled checkbox has been unchecked) are included as well.
If you still decide to use the same name for multiple channels, the Order group is automatically disabled. This behavior prevents simultaneous changes of channel names and channel
order, which might lead to inconsistencies in the resulting data. In case you conclude the
transform dialog with OK, a warning message is displayed (see Figure 7-12). Click No in order
to return to the dialog and make the required modifications.

Additional Information: Duplicate Channel Names
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Figure 7-12. Edit Channels, warning message Edit Channels Parameters in case of duplicate
channel names

Additional Information: User
Properties

Clicking User Properties will open an additional dialog where you can define and edit userdefined channel properties (see Figure 7-13). To do so, please enter the name of the channel
property under Property Name. You can enter arbitrary names as long as one visible character is contained. Value shows the associated value. This value further has a data type for programming purposes, which can be selected from the Datatype drop-down list.
Figure 7-13. Edit Channels, Changing the user-defined channel properties

Show Original User Properties and Show Changed User Properties allow you to choose
whether the original User Properties of the channel or the properties you have changed are
to be displayed.
To delete the existing channel properties, choose the view of the changed User Properties,
select the relevant row of the table and press the <Del> key. The row turns red, and the data
type NULL appears in the Datatype column. Alternatively, you can specify the data type by
choosing NULL from the drop-down list. To undo this deletion, you can set a specific data
type for the row at any time.
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7.1.7

Level Trigger

The Level Trigger transform allows you to set threshold markers on one or more channels if
voltage limits are violated. These markers can be used as a basis for segmentation. One possible application of the transform would be for muscle activity to be used as a reference for
averaging. Another application would be for when an analog channel is used as a storage location for stimuli in recording systems that do not have digital inputs. Here, different stimuli
can be coded as different voltage levels.

Summary

No previous processing steps are required before the transform is used.

Procedure

To call the transform, choose Transformations > Dataset Preprocessing > Level Trigger.
Figure 7-14. Level Trigger, dialog box

The table allows you to enter the following information:
 You specify the name for the threshold that you want to search for in the Name column.
 You specify the threshold in microvolts in the Threshold column.
 In the drop-down list in the Direction column, you can choose the direction of the voltage

curve in which the threshold violation is defined. "Positive" means that the marker is set
when the voltage is rising and the threshold is reached. "Negative" means that the marker is set when the voltage is falling and the threshold is reached.
 In the drop-down list in the Channel column, you can choose the channel on which the

threshold is to be searched for.
 In the Reset Value column, you can enter the value in microvolts at which the trigger is to

be reset. This value is usually identical with the threshold but you can set another value
for specific purposes. If the direction is "Positive", the value obtained must be below this
one before a new trigger of this kind is found. If the direction is negative, the value obtained must be above this one.
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As soon as you make an entry in a cell, a new row is added to the table. To delete a row,
select it by clicking the border of the row and then press the <Del> key. You do not need
to be in edit mode to do this.
In the Time Tolerance [ms] text box, you can enter an interval within which no distinction is
drawn between triggers of the same direction on the same channel. If several thresholds are
exceeded within this interval, only the maximum threshold is detected and only one marker
is set. The same applies analogously when values fall below several thresholds within the
tolerance range. You should adjust the size of the interval to the steepness of the edges of
the trigger channels.
If you check the Set Marker on Trigger Channel box, the markers are set on the selected
channel. Otherwise, the markers are interpreted as global markers and are set independently of the channels.
You can also specify the point at which the markers are to be set in relation to the threshold:
 Set Marker at Threshold sets a marker at the point at which the threshold is exceeded.
 Set Marker at Peak sets a marker at the maximum or minimum value of the channel be-

tween the time at which the threshold is exceeded and the time of the reset.
 Set Marker at Reset sets a marker at the point at which the trigger is reset.

7.1.8

Linear Derivation

Summary

The Linear Derivation transform allows you to create new channels from linear combinations
of existing channels. The new channels are calculated from coefficients that are assigned to
existing channels based on the following formula: New channel = coeff1 * channel1 + coeff2
* channel2 + .... You can enter these coefficients in a matrix and also save and load them.

Procedure

No previous processing steps are required before the transform is used.
To call the transform, choose Transformations > Dataset Preprocessing > Linear Derivation.
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Figure 7-15. Linear Derivation, dialog box

You can edit the table by copying the values of one or more cells and pasting these at the
required position. To do this, right-click in the table and choose Copy or Paste from the context menu.
If you check the Keep Old Channels box, the original channels are included in the new data
set. The new channels are therefore additional channels. If you do not check the box, the
data set only contains the new channels.
If you check the New Channels on Top box, newly created channels are inserted at the top of
the channel list.
Copy Old Channels allows you to import the original channels into the channel matrix.
You can enter the number of new channels in the Number of New Channels text box. Click
Refresh to refresh the coefficient matrix accordingly.
Alternatively, you can click Load from File... to load a coefficient matrix from a text file.
You can save the coefficient matrix by clicking Save to File….
If you want to read in a matrix text file you have generated, you must ensure it has the following structure:
New1
New2

channel1
coeff.
coeff.

channel2
coeff.
coeff.

channel3
coeff.
coeff.

(The decimal separator used in the coefficients is the decimal point (.))
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7.1.9

Formula Evaluator

Summary

The Formula Evaluator transform allows you to calculate new channels as functions of existing channels. A wide range of mathematical options are available to you for this.

Procedure

No previous processing steps are required before the transform is used.
To call the transform, choose Transformations > Dataset Preprocessing > Formula Evaluator.
Figure 7-16. Formula Evaluator, dialog box

You specify the name of the channel you wish to calculate in the Name column. You enter the
formula used to calculate the data in the Formula column. Your entry is not case-sensitive.
You specify the unit for the new channel in the Unit column.
The Insert Line, Remove Line and Remove All buttons allow you to add rows to the table, remove individual rows or remove all rows.
You can save the formula to an ASCII file by clicking Save to File.... You can load formulae into
the table from an ASCII file by clicking Load from File…. If you want to create the ASCII files
using an editor or another program, ensure that each line in the file takes the format "name
= formula".
If you check the Keep Old Channels box, all channels of the input data set that have not been
redefined are retained without change.
If you check the New Channels on Top box, newly calculated channels are inserted at the top
of the table. This setting is only relevant if you have checked the Keep Old Channels box.
The following elements are available to you for entering a formula:
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 The operators +, –, *, and / plus parentheses. Mathematical rules of precedence are ob-

served.
 Channel names. These are interpreted point by point.
 The constants e, pi and i (imaginary unit) as well as numeric entries.
 The mathematical functions sqrt, abs, ln (natural logarithm), log (logarithm to base 10),

sin, cos, tan, atan, sinh, cosh, tanh, real (real part), imag (imaginary part), arg (argument
of a complex number).
 The shift function.

The transform processes both real and complex data. Note that the format of the output data
must be identical to the format of the input data. Real numbers are automatically converted
to complex numbers, if necessary. The mathematical functions are currently available for real
arguments only.
Numeric constants are interpreted as a fixed number across the entire time or frequency domain. Channel names are interpreted point by point. The shift function can be applied to
channel names. It takes the form "shift(channel, shift index)".
The shift index can be positive or negative. The function is regarded as a left shift. That
means, for example, that shift(p1, 1) shifts Fp1 in such a way that the data point that has the
index 2 becomes the data point with the index 1. In the same way, shift(Fp1, -2) shifts the
data point with the index 1 to become the data point with the index 3.
You can calculate the majority of the functions of existing transforms using the Formula
Evaluator:
 Linear derivation can be calculated using a formula of the following type: channel =

a*channel 1 + b*channel 2 + ...
 RMS (Root Mean Square) of Fp1, Fp2 and Fz can be calculated with formula RMS =

sqrt((Fp1*Fp1 + Fp2*Fp2 + Fz*Fz) / 3)
Other measures can also be defined:
 Rectify can be defined by means of channel = abs(channel).

It is also possible to use the shift function to implement simple filters such as sliding averages:
 Fp1 = (shift(Fp1, -1) + Fp1 + shift(Fp1, 1)) / 3 or
 Fp1 = shift(Fp1, -1) * 0.25 + Fp1 * 0.5 + shift(Fp1, 1) * 0.25

If you use numeric channel names, enclose them in quotes in the formula:
 1 = (shift("1", -1) + "1" + shift("1", 1)) / 3

Examples
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7.1.10 Change Sampling Rate
Summary

The Change Sampling Rate transform allows you to change the sampling rate of a data set.

Procedure

No previous processing steps are required before the transform is used.
To call the transform, choose Transformations > Dataset Preprocessing > Change Sampling
Rate.
Figure 7-17. Change Sampling Rate, dialog box

The current sampling rate is shown under Current Rate [Hz]. Enter the new sampling rate in
the New Rate [Hz] text box.
You can also specify whether data conversion is to be carried out by means of cubic spline
interpolation (by selecting Use Spline Interpolation) or sinc interpolation (by selecting Use
Sinc Interpolation).
If you use the Use Sinc Interpolation function, you can check the Handle Large DC Offset box
to improve the accuracy of the interpolation when applied to data with a high DC offset. If this
parameter is selected then all the data values used to calculate any given interpolated value
are shifted by a fixed amount. The interpolation is calculated on the basis of this improved
DC value. The interpolated values are then shifted back by the same amount. This results in
interpolated data with a DC offset that is comparable with the DC offset of the input data.
Please note that artifacts may occur in the data if you interpolate data with a high DC offset
without using the Handle Large DC Offset option.
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7.1.11 Topographic Interpolation
The Topographic Interpolation transform allows you to obtain virtual EEG channel values on
the basis of real existing values. The background to topographic interpolation is the spatial
distribution of the electrodes on the surface of the head. The purpose is to establish the comparability of the EEG data with external data.

Summary

The Topographic Interpolation transform is used in two cases:
It is used when the channels of two different EEGs are to be compared, but the EEGs differ in
their channel configuration. Additional (virtual) channels are created for the EEG that correspond to those of the data set to be compared.
The transform is also used when a defective channel has to be replaced (for example, because of excessive noise or a failed electrode during recording of the EEG). In this case, the
Edit Channel transform is used first to remove the affected channel from the data set. In a
second step, the corresponding value is calculated by means of topographic interpolation.
The virtual channel that has been calculated is then added to the EEG data set.
The EEG data set to be processed must have at least four channels with coordinates.

Prerequisites for use

To call the transform, choose Transformations > Others > Topographic Interpolation.

Procedure

Figure 7-18. Topographic Interpolation, dialog box

In the dialog box, you specify whether the data is to be calculated using triangular interpolation (Triangulation and Linear Interpolation) or interpolation with splines (Interpolation by
Spherical Splines).
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If you decide on interpolation with splines, enter the spline order in the Order of Splines text
box and the maximum degree of the Legendre polynomial in the Max. Degree of Legendre
Polynomials text box.
If you check the Default Lambda box, the default value of 10-5 (1e-5) is used. If you want to
use a different value, clear the checkbox.
We recommend that you use the value 10 for Max. Degree of Legendre Polynomials and the
value 10-5 (1e-5) for Lambda.
You use the Keep Old Channels checkbox to specify whether the original channels are to be
retained. If you check the New Channels on Top box, the new channels are displayed before
the original channels in the data set.
In the table, you enter the name, radius and coordinates (Theta, Phi) of the channels that are
to be created by means of interpolation.
Please note the following special rule: If you enter a channel name of a channel that already
exists in the EEG, this channel is no longer included in the output data set. (However, this is
only relevant if you have checked the Keep Old Channels box.) The original channel is always
used in interpolation, regardless of the special rule.
Note that it is not possible to enter one and the same channel name in the table. You receive
an error message if you do this.
The dialog box now also contains the buttons Default Position / Current Position and Select
from Map which you can use to reset the coordinates of each channel to a specific position.
Default Position resets the coordinates to the corresponding channel's default position.
Current Position resets the coordinates to the position specified in the initial data set.
Select from Map opens a further dialog page in which you can select the coordinates of the
desired channel from a map display (see Figure 7-19).
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Figure 7-19. Topographic Interpolation, Map for coordinate selection

The Select Channel (Snap-In) option allows you to select the exact coordinates of the channels that you want to interpolate. To do this, simply click near the required channel; the
mouse cursor then moves automatically to this channel. However, if you instead want to select the coordinates of a channel that is not present in the current electrode layout, you
should choose Free Coordinate Selection. You can then single-click to add the channel to the
map.
The currently selected coordinates are displayed under Selected Electrode; the coordinates
of the mouse pointer are displayed in the lower part of the dialog box.
You can use the drop-down list to select the electrode layout that is to be displayed on the
map. If you choose a layout here then you can also check the Display Current Channels box
to display the channels in the initial data set (these are highlighted in red). You can use the
Display Channel Names checkbox to show or hide the channel names.
Use the Load File button to read in your own layout in Brain Vision Electrode Files Format (
see also Appendix J on page 583).
Two different interpolation methods are used: triangulation and linear interpolation and interpolation by spherical splines. In the first method, the surface of the head is triangulated

Additional information
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(divided up into triangles), and the values are calculated for each triangle by means of linear
interpolation.
Interpolation by spherical splines consists of a set of basic spline functions. The form of the
basic functions is influenced by the Order of Spline parameter. The spherical splines are calculated by means of an approximation method. The degree of accuracy of the result of the
calculation depends on the Max. Degree of Legendre Polynomials and Lambda parameters.
We recommend that you enter the value 10 in the Max. Degree of Legendre Polynomials text
box and the value 10-5 (1e-5) in the Lambda text box. Experience has shown that these values lead to satisfactory results. Because they are used so frequently, the results are also
comparable. If you check the Default Lambda box, the default value 10-5 (1e-5) is used. If
you clear the checkbox, you can enter a different value. We recommend that you only do this
if you know that this value will meet your requirements.

References
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7.1.12 Add Channels
The Add Channels transform is an optional component of the Analyzer. You can only use it if
you possess a dedicated license. To check which licenses you currently possess, you can select About Analyzer in the Help tab in the ribbon.
It should also be noted here that the license for the Add Channels transform can only be used
in combination with a Sentinel HASP dongle. If you are using a HASP HL dongle then you can
convert it into a Sentinel HASP dongle by running an upgrade file on your computer. If you
would like to purchase licenses, please contact your local dealer.

Summary

The Add Channels transform can be used to add external data recorded together with the EEG
to a raw EEG data set in the form of additional channels. In this way, the data can be made
available for processing using the Analyzer's powerful and versatile methods.
One important possible application for this transform is eye-tracking data. The analysis of
eye-tracking data in combination with the EEG is a research area that is growing in importance. The Add Channels transform permits the smooth, simple integration of the eye-tracking data which can then be further processed in a variety of ways (
see also "Typical
application scenarios" in the current section).
The external data recorded together with the EEG must be prepared using synchronization
and interpolation methods before it can be used in subsequent processing steps in the Analyzer. On the one hand, this makes it possible to use external data that was not regularly
sampled in the same way as the EEG data. On the other, the transform compensates for tem-

Transforms in the "Dataset Preprocessing" group 231

poral shifts that occur because the EEG amplifier and the external recording device are not
synchronized with one another at hardware level.
The transform allows you to import information about the test subject's eye movements into
your data set so that you can then further process this together with the EEG.
For example, you can import blinks from the eye-tracking data into the EEG data set and mark
them as "bad intervals" for further processing steps.
In particular, information about so-called Areas of Interest (AOI; marked areas of the visual
field) and fixations can be used to segment the data set, which consists of external data and
the EEG, on the basis of the corresponding markers. In this way, you can perform ERP analyses as well as correlation and spectral analyses (FFT, Average, Wavelets, LORETA).
By performing segmentation using Advanced Boolean Expression (ABE), it is possible to prepare a data set for further statistical processing (conditional segmentation). Segmentation
with ABE can be used to select the specific segments that indicate, for example, when the
test subject moved his or her gaze to a given AOI.
Please note that, in its present state, the transform supports eye-tracking data recorded using devices from the following manufacturers:
 SMI (BeGaze 3.0.0): You can also examine eye-tracking data recorded using SMI's eye-

tracking devices in the SMI program BeGaze in order to detect the presence of saccades,
blinks and fixations.
In order to use this data that has been prepared in BeGaze in the Analyzer, you must export it in text format. When you do this, you must create a separate export file for each
complete recording. We expressly recommend that you do not create export files for each
experimental trial since this would unnecessarily complicate further processing.
In addition, you must also export any "trigger" type markers recorded in BeGaze.
 Tobii (TobiiStudio 2.2.3, TobiiStudio 3.0.1): You must postprocess eye-tracking data re-

corded using Tobii eye-tracking devices with the program TobiiStudio 2.2.3 or TobiiStudio 3.0.1 in order to be able to export it. When doing this, make sure that you select the
correct marker columns for export.
 ASL

The ASL Results 2.4.3 software needs to be installed on the computer where the Analyzer
is running.
 EyeTrac 6 (without fixation markers): No preprocessing steps are necessary in order

to import eye-tracking data without fixation markers into the Analyzer.
 ASL Results 2.4.3 (including fixation markers): If you want to import fixation markers

into the Analyzer, you must detect these markers using the ASL Results software and
then export them in the form of a text file. You must give this text file (extension:

Typical application scenarios
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.fixations) the same name as the associated eye-tracking file (extension: .eyd). Example: MyData.eyd and MyData.fixations.

Prerequisites for use

Recording conditions and
experimental setup

The following conditions must be met to use the transform successfully:
1

It must be possible to read the external data row-by-row and each row must correspond
to a sampling point. Each row consists of multiple columns, with each column corresponding to a channel (multiplexed).

2

Irregularly sampled data usually possesses a special column which contains the timestamp information. Timestamps indicate when each individual sampling operation was
performed. They are usually specified in microseconds. The transform requires these
timestamps in order to correct the clock offset and clock drift.

3

To permit the subsequent synchronization of the data in the Analyzer, the two data sets
(EEG and external data) must contain common markers. The markers in the external data
must be coded in one of the following two ways: As messages or as triggers. Messages
are special lines that contain information about the coding of the marker names and the
marker position (sampling point). Triggers are special columns that contain information
about the definition of the marker names and the marker position (sampling point).

During recording, markers must be written both in the EEG and in the external data. This can
be done, for example, by means of stimulation software.
It is vital to make sure that the markers are sent to both recording devices from the same
source (see Figure 7-20).
In order to avoid the loss of markers it is mandatory that the source used to send markers is
only switched on after both EEG and external systems are already running in recording mode
and is switched off according to the reverse order. We recommend that you send a large number of consecutive markers to both recording devices so that it is possible to successfully
correct both the clock offset and the clock drift later (
see also "Method" as of page 233
in the current section). The type of marker used does not make any difference.
You will find information on configuring the amplifier's trigger input in the corresponding
Operating Instructions as well as in the BrainVision Recorder User Manual. For information
on configuring the external recording device, please refer to the device manufacturer's user
documentation.
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Figure 7-20. Add channels, experimental setup

To guarantee error-free data acquisition, you should ensure that the capacity of the computer
used for recording is not impaired by processes running in the background while the data is
being acquired.
In particular, you should deactivate the following Windows® functions and services: sleep
mode, Windows Update, Windows Defender and automatic defragmentation. You should
also disable your virus scanner and firewall.
For detailed information on configuring the
Windows® operating system for data acquisition, refer to the User Manual for the BrainVision Recorder recording software.
The timing of the external data set is aligned and is then interpolated with the sampling rate
of the EEG data.
Synchronization of the EEG data and external data is necessary because the EEG amplifier
and external recording device are not synchronized with one another – unlike in the case of
combined EEG-fMRI measurements during which the SyncBox can be used for clock synchronization. Instead, the two data sets exhibit both constant temporal shifts (clock offset) and
temporal shifts that become larger or smaller over a given period (clock drift).
It is necessary to interpolate the external data with the EEG sampling rate because the EEG
amplifier records the EEG data at a predefined sampling rate and therefore generates regularly sampled data. In contrast, external devices may also generate irregularly sampled data.
Please note that the external data also has to be interpolated even if it has been regularly
sampled and has the same sampling rate as the EEG data. The reason for this is that the sampling clock intervals of the two recording devices are never fully phase-synchronized.

Method: Synchronization and
interpolation
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Synchronization of the external data with the EEG

You can use the recorded markers to synchronize the external data set. To do this, you can
use two methods that are described below:
1

FirstMarker method to correct the clock offset (without correcting the clock drift)

2

StartAndEndMarker method for correcting the clock offset and the clock drift

Depending on the synchronization method you choose, you must select one or two markers
from the recorded markers in the Analyzer. When you do this, you can use any markers you
want provided that both are present in the EEG as well as in the external data set. These
markers are referred to as "synchronization markers" below. The synchronization marker or
markers indicate the start or start and end of the recording. The timing of the external data
set is aligned on the basis of the synchronization markers and is then interpolated with the
sampling rate of the EEG data.
You can also use all the markers present, including the markers that have already been declared as synchronization markers, as test markers. Test markers allow you to analyze any
remaining imprecisions in synchronization.
1

FirstMarker method to correct the clock offset (without correcting the clock drift)
When this method is used, a single marker that is present in both the EEG and the external data set is used at the start of both data sets. This marker is referred to as "FirstMarker". On the basis of the FirstMarker, the external data set is shifted in such a way that the
timing of the external marker at the start of the data set is aligned with the corresponding
marker in the EEG data set (see Figure 7-21 and Figure 7-22).

Figure 7-21. Add channels, before clock offset correction
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Figure 7-22. Add channels, result of clock offset correction

2

StartAndEndMarker method for correcting the clock offset and the clock drift
This method uses two markers which indicate the start and end of the two data sets, respectively. Once the clock offset has been corrected, the interval between the start and
end markers is determined in both data sets. The quotient of the two interval lengths is
used to correct the external clock drift. In this way, each sampling point in the external
data set is either compressed or stretched so that both the start and end markers in the
EEG data set and the external data set are precisely aligned (see Figure 7-23).
We recommend that you use the second synchronization method if the data contains
start and end markers.

Figure 7-23. Add channels, result of clock drift correction

Following synchronization, the external data is interpolated with the sampling rate of the EEG
data. Three interpolation methods are available for this (see also
[Pre93]):
 Spline interpolation
 Zero-order interpolation

Interpolation and caching of
the external data
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 First-order interpolation

The interpolated data is then cached. If you open the history node in the Analyzer then this
data is loaded from the cache and displayed as additional channels below the EEG channels
(see Figure 7-24).
Figure 7-24. Add channels, external data as additional channels

Note on the accuracy of
synchronization

The markers can be sent to the recording devices in various ways: e.g. as TTL pulses (EEG amplifier) or as UDP data packets (external recording device, e.g. eyetracker).
TTL pulses are usually sent with a smaller time delay than UDP data packets. This results in
a temporal shift between the markers in the EEG data, on the one hand, and the markers in
the external data, on the other. These shifts are unknown and may vary. This means that the
accuracy of synchronization is always limited.
Because the temporal shifts cannot be automatically determined and corrected, the transform allows you to shift the external data forward or backward by a user-defined time interval.
In addition, all the available markers can be used to calculate the corresponding temporal
shift for each pair of EEG markers and external markers and display the distribution of the
shifts in a histogram. This histogram makes it possible to perform a plausibility check once
synchronization and interpolation have been completed.

Procedure

To call the transform, choose Transformations > Dataset Preprocessing > Add Channels.
Make sure that the external data is not located in the Analyzer raw data folder of the current
workspace. If it is, a conflict will occur when the Analyzer accesses the data.
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On the first page of the dialog, you specify the parameters for accessing the external data
(see Figure 7-25).
Figure 7-25. Add Channels, dialog page 1, File parameters

Under Device, you specify the device that you used to record the external data. The filename
extension displayed in the Extension text box is set to the default value for the corresponding
device. You can change this value subsequently.
In addition, you must specify the folder for the external data set in the Directory text box. If
the external data set consists of multiple files then you must always select the header file
here.
In the Base Name text box, specify the name of the header file without a filename extension.
You can also click the Browse button to help you enter these values.

Dialog page 1: File parameters
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The transform checks whether the external data set exists and matches the file format for the
selected recording device. If this is the case then all the files belonging to the external data
set are displayed in green in the Resulting File(s) text box.
The Find Placeholders button allows you to replace the name of the history file ($h) and the
name of the current data set ($n) with placeholders. The use of placeholders has the advantage that the history nodes generated by the transform can be used in history templates.
You must also set the following three parameters to ensure that the file can be read in correctly: decimal symbol, column separator and markers (i.e. type of marker coding as Messages or Triggers). When you select a recording device under Device, the options that are not
supported by your device are grayed.

Dialog page 2: Synchronization parameters

On page 2 of the dialog, you enter all the parameters that are necessary for the correction of
the clock offset and/or the clock drift (see Figure 7-26).
Figure 7-26. Add Channels, dialog page 2, Synchronization parameters
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You select the synchronization method under Synchronization.
For information on the
two synchronization methods, see "Synchronization of the external data with the EEG" as of
page 234 in the current section.
If you select FirstMarker here then only the clock offset is corrected. You then choose the required EEG synchronization marker and required external synchronization marker from the
associated drop-down list.
If the selected marker occurs more than once in the EEG and in the external data set then the
first marker is used as "FirstMarker" in both cases.
If you select StartAndEndMarkers then both the clock offset and the clock drift are corrected.
You then choose the required EEG synchronization markers and required external synchronization markers from the associated drop-down lists.
If the selected marker occurs more than once in the EEG and in the external data set then the
first marker is used as "FirstMarker" and the last marker as "EndMarker" in both cases.
The type of data supported by your recording device is displayed for information purposes
under Time Stamps: Regular for regularly sampled and Irregular for irregularly sampled data.
If your external data is regularly sampled data, enter the corresponding sampling rate in the
External Sampling Rate text box. You can also click the From Header button to read the sampling rate in from the associated header file provided that the file contains this information.
The sampling rate of the external data is only required for the following parameter configuration: If you want to use the FirstMarker synchronization method and the external file has no
timestamp information then equidistant timestamps are generated on the basis of the specified sampling rate. For the purposes of this operation, it is assumed that the available external data is sampled equidistantly. However, if you want to use the StartAndEndMarkers
synchronization method then the sampling rate is not required.
On dialog page 3, you make the settings for the manual correction of the time delay between
the EEG synchronization markers and the external synchronization markers (see Figure 727).

Dialog page 3: Histogram
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Figure 7-27. Add Channels, dialog page 3, Histogram

Under Manual Delay of External Data, you can specify a value for the time delay if this is
known to you. If it is not, choose none.
You can also calculate the Delay histogram. The result of this calculation makes it possible
to perform a plausibility check once synchronization and interpolation have been completed.
To do this, check the Compute Delay Histogram box and select the markers that you want to
use as test markers under Select Markers for Delay Check.
Next click Compute to compute the time delay between the selected test marker pairs. The
result is displayed in graphical form at the bottom of the dialog box and relevant statistical
values (sample size, mean, median, minimum and maximum delay, standard deviation,
range) are output.
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If the spread (standard deviation or range) of the Delay histogram is significantly larger than
the length of the sampling interval of the EEG data then we recommend that you subject your
experimental setup to a thorough examination and make any corrections that are required
(
see also "Recording conditions and experimental setup" as of page 232 in the current
section). It is recommended that you use markers based on hardware signals whenever possible (i.e. if the eye tracker has a sync-in connector).
Dialog page 4 lists all the channels found in the external data set (see Figure 7-28).
Figure 7-28. Add Channels, dialog page 4, Channel selection and import

Dialog page 4: Channel
selection and import

To import the detected channels, check the Import External Data Channels box and then select the required channels by checking the corresponding box in the Select column. You can
also rename the external channels by clicking in the Name column.
You can set the interpolation method separately for each channel. You can choose between
three interpolation methods (
see also "Interpolation and caching of the external data" as
of page 235 in the current section).
On page 5 of the dialog, you can import the events present in the external data set. External
events include, for example, the closing of an eye, a saccade or the fixation of an AOI. They

Dialog page 5: Selecting and
importing external events
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are usually characterized by a start and a certain duration. External events are analogous to
EEG markers in the Analyzer.
External events are grouped together in event types which correspond to the marker type in
the Analyzer. The dialog page lists all the event types found in the external data set (see
Figure 7-29). You can choose the event types that are to be imported.
Each event type may contain individual events that are labeled differently. Correspondingly
a marker description is generated on the basis of the labels assigned to these events. Please
note that these labels are not displayed in the dialog.
Figure 7-29. Add Channels, dialog page 5, Selecting and importing external events

To import the detected external events, check the Import External Event Types box and then
select the required types by checking the corresponding box in the Select column.
The selected device defines which type of external events are available (column Type). External events are translated into marker types (column Marker Type). Please note that you can
edit these marker types.

Transforms in the "Dataset Preprocessing" group 243

If you check the Write Pairs of Start and End Markers box, the start and duration of each individual external event are marked by pairs of markers: one at the start of the external event
and one at the end.
In addition, each marker generated in the Analyzer is assigned a User Property which contains the sequential number of each external event.
On dialog page 6, you can specify whether you want to import additional information present
in the header of the external file (see Figure 7-30). To do this, check the Import External
Properties as User Properties box. Please note that this information is imported in string format.

Dialog page 6: Additional
header information

Figure 7-30. Add Channels, dialog page 6, Importing additional header information

Click Finish to add the external data to your EEG.
[Hol2011] Holmqvist, K., et al. (Eds.) (2011), Eye tracking: a comprehensive guide to methods and measures, Oxford: Oxford University Press.
[Pre93] Press, W. H., et al. (1993), Numerical Recipes in C, The Art of Scientific Computing,
Cambridge: Cambridge University Press.
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Summary

7.2

Transforms in the Artifact Rejection/Reduction group

7.2.1

Complex Demodulation

The Complex Demodulation transform continuously transforms the EEG signal by means of
mathematical methods in such a way that the resulting signal consists only of frequencies
that lie in the defined range.
Unlike the Fast Fourier transform, only a specific frequency band can be extracted. The advantage of this transform is that it also works at high speed on non-segmented data and that
the output of each channel is in turn a continuous channel.
This transform is not to be confused with the Band Rejection transform. The resulting signal
is not the filtered input signal; it describes the power or phase of the selected frequency
range at each point in time.

Procedure

No previous processing steps are required before the transform is used.
To call the transform, choose Transformations > Artifact Rejection/Reduction > Data Filtering
> Complex Demodulation.
Figure 7-31. Complex Demodulation, dialog box

Under Output, you specify whether the power (Power) or phase (Phase) is to be output.
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Under Frequency Range, you specify the beginning (Begin [Hz]) and end (End [Hz]) of the frequency band to be extracted.
If you specify that the power is to be output, the average power in the specified frequency
band is calculated for each data point.
If you specify that the phase is to be output, the phase of the signal in the specified frequency band is calculated. This number is only unambiguous for multiples of 2 . Depending on
the exact interval selected, the output values can therefore differ by multiples of this value.
On the basis of the phase, you can obtain the dominant frequency in the calculated frequency range. A rising phase indicates that the dominant frequency lies under the middle of the
selected interval, while a falling phase indicates that it lies above the middle of the interval.

7.2.2

IIR Filters

The IIR Filters transform allows you to filter EEG data. Three filter types are available:

Summary

 Low-cutoff (also "high-pass") filtering with a selectable cutoff frequency or time constant
 High-cutoff (also "low-pass") filtering with a selectable cutoff frequency
 Band rejection filtering for 50 Hz or 60 Hz (notch filter) to eliminate interference from the

electricity network. The notch filter has a bandwidth of 5 Hz which is symmetrical around
the set notch frequency (i.e. 50 Hz +/- 2.5 Hz or 60 Hz +/- 2.5 Hz). The filter slope is always 24 dB/octave.
The cutoff frequency or time constant specifies the frequency at which the signal is 3 dB lower than the input signal (i.e. the input signal is reduced by approx. 30%). The filters are implemented as phase shift-free Butterworth filters. It is also possible to choose the slope of
the filter for high and low-cutoff filters. It can be 12 dB/octave, 24 dB/octave or 48 dB/octave.
Transient phenomena always arise with IIR filters. These are observed if the data is calculated section-by-section. The transform allows you either to calculate the data section-by-section or to calculate and save all the data when creating the history node in order to minimize
transient phenomena.
We recommend that you use the transform before segmentation of the data in order to minimize as far as possible the effect of discontinuities on the filter and transient phenomena.

Prerequisites for use

To call the transform, choose Transformations > Artifact Rejection/Reduction > Data Filtering
> IIR Filters.

Procedure
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Figure 7-32. IIR Filters, dialog box

You can make the following settings for low-cutoff filters (Low Cutoff) and high-cutoff filters
(High Cutoff):
You use the Enable checkbox to switch the filters on or off. You can enter the cutoff frequency
in the Frequency [Hz] text box.
When using a low-cutoff filter, you should note that if you do not check the Store Data in
Cache File box then cutoff frequencies < 0.1 Hz may lead to transient phenomena that the Analyzer is not fully able to compensate for. We therefore recommend that you choose a cutoff
frequency > 0.1 Hz or that you check the Store Data in Cache File box.
In the case of a low-cutoff filter, you can enter the time constant in the Time Constant [s] text
box instead of the cutoff frequency.
The Slope [dB/oct] drop-down list allows you to specify the slope of the filter for the relevant
filter type.
In the case of the band-rejection filter (Notch), you are able to make the following settings:
The Enable checkbox allows you to switch the filter on and off. You specify a stop (rejection)
frequency for the filter of either 50 or 60 Hz in the Frequency [Hz] drop-down list.
If you check the Enable Individual Channel Filters box, you can make separate filter settings
for each channel in the table.
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The Fill All Rows and Fill Selected Rows buttons are used to take over the filter settings made
in Low Cutoff, High Cutoff and Notch into the channel table. If you click Fill All Rows then the
values for all the channels are taken over. You can then modify the settings for those channels that are to be filtered based on different criteria. If you click Fill Selected Rows then only
the values for selected channels are taken over.
If you check the Store Data in Cache File box then the data is calculated in full, when the history node is created. In this case, the data is passed through multiple times, filtered and
stored in a permanent cache. Although this procedure is time-consuming and occupies storage space on the hard disk, it eliminates the transient phenomena associated with the filter
except for the unavoidable transient phenomena at the start and end of the data set.
An IIR filter can only be applied to data sets which have a sampling rate which corresponds
to at least twice the filter frequency. In the dialog box, you cannot select frequencies above
this limit frequency. This restriction is particularly important in the case of notch filters for
which, under certain circumstances, only the 50 Hz filter or no notch filter at all may be available.

Sampling rate and filter
frequencies

The filter's frequency response is displayed graphically in the dialog box. The visible section
of the graph corresponds to the cutoff frequency associated with the sampling rate.

7.2.3

Band Rejection

The Band Rejection transform can be used to filter interference signals of constant frequency
out of the EEG signal. These interference signals may be due to the power supply or to poorly
shielded electrical devices. Since they have typical frequencies, they can be largely removed
from the signal by means of a combination of high-cutoff and band-rejection filters. You can
also eliminate the sources of interference by improving the shielding of electrical devices.
Other interference signals are unavoidable such as those that occur during combined EEGfMRI measurements in MR scanners.

Summary

No previous processing steps are required before the transform is used.

Procedure

To call the transform, choose Transformations > Artifact Rejection/Reduction > Data Filtering
> Band Rejection.
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Figure 7-33. Band Rejection, dialog page 1, Defining the filters

In the table, you can specify as many band-rejection filters as you want to apply to your data.
The filter is determined by frequency (Frequency), bandwidth (Bandwidth) and order (Order).
The signal is reduced to half of its amplitude at the limiting frequencies (frequencybandwidth / 2). The order determines the slope of the filter. You can choose between an order of
2 and 4 in the drop-down list. A higher order results in stronger filtering in the interval between the two limiting frequencies.
The Insert Line, Remove Line and Remove All buttons allow you to add rows to the table, remove individual rows or remove all rows.
Page 2 of the dialog box allows you to select the channels to which the filters are to be applied (Enabled Channels) (see Figure 7-34). In this way, channels, such as control signal
channels, that are not affected by interference signals can be excluded from filtering.
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Figure 7-34. Band Rejection, dialog page 2, Selecting the channels

To use different band-rejection filters for different channels, you apply the transform multiple
times to one and the same data set.

7.2.4

Artifact Rejection

The Artifact Rejection transform allows you to search the data set for physical artifacts following segmentation and to remove or mark segments with artifacts. To mark artifacts prior
to segmentation, you can use the Raw Data Inspection transform (
see also Section 7.2.5
as of page 262).

Summary

The transform is typically applied following segmentation.

Prerequisites for use

To call the transform, choose Transformations > Artifact Rejection/Reduction > Artifact
Rejection.

Procedure
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On the first tab of the dialog box (see Figure 7-35), you can choose between three segment
selection methods:
 manual
 semiautomatic
 automatic

Figure 7-35. Artifact Rejection, segment selection methods

You can enable individual channel mode by checking the Individual Channel Mode box. In
individual channel mode, "Bad Interval" markers are only written in channels in which artifacts occur. If you do not use individual channel mode, entire segments are marked as "bad
intervals" across all the selected channels.
If you check the Mark bad segments instead of removing them box, segments with artifacts
are merely marked rather than removed. If you do not check this box, the segments with artifacts are removed and the new data set only contains the segments without artifacts.
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If you choose Manual Segment Selection but do not use the Mark bad segments instead of
removing them, the following interactive view appears (see Figure 7-36).
You can use the mouse to mark intervals found in the various channels as artifacts and then
remove these. To delete the marked section, click it with the <Shift> key held down. If you
have not activated individual channel mode, you can remove individual segments containing
artifacts.
Figure 7-36. Artifact Rejection, manual segment selection without the Mark bad segments
instead of removing them function

Manual segment selection
without the "Mark bad segments instead of removing
them" function
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The interactive view contains the following information and functions:
The current segment number is displayed at the top.
The field below indicates whether the current segment is to be removed or kept ("Remove"
or "Keep").
The table in the lower part of the view lists all the artifacts to be removed, together with the
channel and segment affected in each case. You can double-click an entry to go directly to
the corresponding artifact.
Click the Keep button to remove the current segment from the table and switch to the next
segment. Click Remove to add the current segment to the list of segments to be removed and
switch to the next segment.
The >> and << buttons allow you to switch to the next and previous segment, respectively. To
select a segment to which you want to navigate, choose Goto Segment….
If you check the Step Only to Kept Segments box, when you click the << button you are taken
to the nearest previous segment that is not listed in the table of segments to be removed.
The same applies to subsequent segments when you click the >> button.
If you check the Step Only to Removed Segments box, when you click the << button you are
taken to the nearest previous segment that is listed in the table of segments to be removed.
The same applies to subsequent segments when you click the >> button.
If you subsequently want to change the settings made in the transform's dialog box, click
Change Criteria.
The Undo and Redo buttons allow you to undo and redo changes, respectively.
If you want to interrupt what you are doing and resume later, you click the Suspend button.
The Artifact Rejection transform is highlighted in red in the history tree, and all the processing steps carried out continue to apply. Click the OK button to conclude and apply your input.

Manual segment selection
with the "Mark bad segments
instead of removing them"
function

If you choose Manual Segment Selection and also use the Mark bad segments instead of
removing them function, a small number of differences appear in the interactive view (see
Figure 7-37).
You can use the mouse to mark intervals found in the various channels as artifacts. To do
this, left-click in the EEG. If you press and hold down the mouse button, you can move the
mouse to create a selection of the desired length.
If the mouse pointer is located above an existing marked section then this is highlighted. You
can now process the section with the mouse. You can move the marked section by pressing
and holding down the left mouse button. You can change its length by grabbing the positioning handles with the mouse. To delete the marked section, click it with the <Shift> key held
down.
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Figure 7-37. Artifact Rejection, manual segment selection, Mark bad segments instead of
removing them function
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The interactive view contains the following information and functions:
The current segment number is displayed at the top.
This field below it indicates whether or not an artifact has been marked at any point in the
current segment ("Segment with Artifacts" or "No Artifact").
The table in the lower part of the view lists all the marked artifacts, together with the channel
and segment affected in each case. You can double-click an entry to go directly to the corresponding artifact.
Click the Mark all Channels button to mark all the channels in color to indicate the presence
of artifacts and switch to the next segment. You can use Clear all Channels to clear all the
"Bad Interval" markers in the current segment and switch to the next segment.
The >> and << buttons allow you to switch to the next and previous segment, respectively. To
select a segment to which you want to navigate, choose Goto Segment….
If you check the Step Only to Clean Segments box, when you click the << button you are taken
to the nearest previous segment that does not contain an artifact and is therefore not listed
in the table of segments to be removed. The same applies to subsequent segments when you
click the >> button.
If you check the Step Only to Segments with Artifacts box, when you click the << button you
are taken to the nearest previous segment that contains artifacts and is therefore listed in
the table of segments to be removed. The same applies to subsequent segments when you
click the >> button.
If you subsequently want to change the settings made in the transform's dialog box, click
Change Criteria.
The Undo and Redo buttons allow you to undo and redo changes, respectively.
If you want to interrupt what you are doing and resume later, you click the Suspend button.
The Artifact Rejection transform is highlighted in red in the history tree, and all the processing steps carried out continue to apply. Click the OK button to conclude and apply your input.

Semiautomatic segment
selection

If you choose the Semiautomatic Segment Selection option, then you can make further settings in the Channels and Criteria tabs in the dialog box.
In the Channels tab (see Figure 7-38), you can select the channels that are to be searched for
artifacts (Enabled Channels). You can also exclude specific channels from the artifact search
(Disabled Channels).
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Figure 7-38. Artifact Rejection, selecting channels

On the Criteria tab, you specify the criteria for marking channels (individual channel mode
enabled) or excluding segments (individual channel mode disabled). The following criteria
are available to you: gradient, max-min, amplitude, low activity and intervals. For each criterion, there is a separate tab below the Criteria tab.
You can combine the different criteria. As an aid to clarity, the title of each tab indicates
whether the corresponding criterion is currently used or not: (x) indicates that the corresponding criterion applies. ( ) indicates that the criterion has not been selected.
When the gradient criterion is applied, the absolute difference between two neighboring
sampling points must not exceed a specific value (see Figure 7-39).

Gradient criterion
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Figure 7-39. Artifact Rejection, gradient criterion

To apply the gradient criterion, check the Check Gradient box.
In the Maximal allowed voltage step text box, you can specify the maximum permissible difference in voltage between two data points.
In the Mark as bad before event and Mark as bad after event text boxes, you can enter the
period before and after the actual occurrence of the criterion that is to be marked as an artifact.

Max-min criterion

When the max-min criterion is applied, the difference between the maximum and minimum
in a segment must not exceed a specific value (see Figure 7-40).
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Figure 7-40. Artifact Rejection, min-max criterion

To apply the min-max criterion, check the Check maximum difference of values in the segment box.
In the Maximal Allowed Absolute Difference text box, you can enter the maximum difference
in voltage.
In the Interval Length text box, you can specify the length of the interval in milliseconds or
the period within which the difference in voltage must not exceed the specified value.
In the Mark as bad before event and Mark as bad after event text boxes, you can specify the
period before and after the actual occurrence of the criterion that is to be marked as an artifact.
When the amplitude criterion is applied, the amplitude must not violate specified maximum
and minimum values (see Figure 7-41).

Amplitude criterion
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Figure 7-41. Artifact Rejection, amplitude criterion

To apply the amplitude criterion, check the Check maximal and minimal amplitude box. In
the Minimal allowed amplitude and Maximal allowed amplitude text boxes, you can enter
the minimum and maximum permissible values for the voltage.
In the Mark as bad before event and Mark as bad after event text boxes, you can specify the
period before and after the actual occurrence of the criterion that is to be marked as an artifact.

Low activity criterion

When the low activity criterion is applied, the difference between the maximum and minimum in an interval of a selectable length must not exceed a specific value (see Figure 7-42).

Transforms in the Artifact Rejection/Reduction group 259

Figure 7-42. Artifact Rejection, low activity criterion

To apply the low activity criterion, check the Check low activity in intervals box.
Enter the minimum activity in the Lowest allowed activity (Max-Min) text box.
You can enter the length of the interval within which activity must not fall below the specified
level in the Interval Length text box.
In the Mark as bad before event and Mark as bad after event text boxes, you can specify the
period before and after the actual occurrence of the criterion that is to be marked as an artifact.
You can use the interval criterion to restrict the artifact search to a selectable range within
the segments in the data set (see Figure 7-43).

Interval criterion
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Figure 7-43. Artifact Rejection, intervals criterion

To apply the criterion to limit the artifact search to certain intervals, check the box Limit the
check to an interval within segment.
Below this, you can specify the interval size based on time specifications (Based on Time option) or data points (Based on Data Points option). In the Start [ms] and End [ms] text boxes,
you can specify the beginning and end of the interval, and in the Duration [ms] text box you
specify its length. (If you make an entry in one of the six text boxes, the values in the other
text boxes affected by it are adjusted accordingly.)
To test the selected criteria, click Test Criteria. A dialog box is then displayed containing information about the proportion of the EEG that will be marked as constituting an artifact given the current settings.
When you have made all your settings, click OK on one of the tabs. An interactive view opens
in which the marked artifacts are listed in a table (see Figure 7-44). You can adjust the results
of your settings subsequently in the same way as for manual segment selection.
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Figure 7-44. Artifact Rejection, semiautomatic segment selection, interactive view
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Automatic segment selection

The settings in automatic segment selection correspond to those made during semiautomatic segment selection. The only difference is that you are not able to make corrections as you
can in the interactive view.

7.2.5
Summary

Raw Data Inspection

The Raw Data Inspection transform allows you to check the raw EEG data set for physical artifacts. The inspection can be carried out manually, semiautomatically or automatically.
To remove artifacts after segmentation, use the Artifact Rejection transform.
information, refer to Section 7.2.4 as of page 249.

For detailed

In a semiautomatic or automatic inspection, you can specify criteria for the artifacts (socalled "bad intervals") and define ranges before and after the artifact that are to be marked
as "bad intervals". In a manual or semiautomatic inspection, you can subsequently change
or delete the intervals and add new intervals.

Procedure

No previous processing steps are required before the transform is used.
To call the transform, choose Transformations > Artifact Rejection/Reduction > Raw Data
Inspection.
On the Inspection Method (see Figure 7-45) tab, you can choose between three inspection
methods:
 manual
 semiautomatic
 automatic
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Figure 7-45. Raw Data Inspection, selecting the inspection method

You can enable individual channel mode by checking the Individual Channel Mode box. In
individual channel mode, "Bad Interval" markers are only written in the selected channels in
which artifacts occur. If you do not use individual channel mode, the corresponding EEG sections are marked as "bad intervals" across all the selected channels once the inspection has
been completed.
If you choose the Manual Inspection option and click OK, an interactive view appears (see
Figure 7-46).
You can use the mouse to mark intervals found in the various channels as artifacts. To do
this, left-click in the EEG. If you press and hold down the mouse button, you can move the
mouse to create a selection of the desired length.
If the mouse pointer is located above an existing marked section then this is highlighted. You
can now process the section with the mouse. You can move the marked section by pressing
and holding down the left mouse button. You can change its length by grabbing the positioning handles with the mouse. To delete the marked section, click it with the <Shift> key held
down.

Manual inspection
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Figure 7-46. Raw Data Inspection, manual inspection, interactive view

The interactive view contains the following information and functions:
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In Default Interval [s], you can specify the default length of the "Bad Interval" markers that
are to be inserted when you click a channel.
Clicking the Show Statistics button opens a dialog box in which the artifacts are listed by
type and channel.
You can use Go to Next Artifact >> and << Go to Previous Artifact to go to the next and previous
artifacts, respectively.
If you subsequently want to change the settings made in the transform's dialog box, click
Change Criteria. A dialog box is then displayed containing information about the proportion
of the EEG that will be marked as constituting an artifact given the current settings.
The table in the lower part of the view lists all the identified artifacts, together with the associated channel and position. You can double-click an entry to go directly to the corresponding artifact.
The Undo and Redo buttons allow you to undo and redo changes, respectively.
If you want to interrupt what you are doing and resume later, you click the Suspend button.
The Raw Data Inspection transform is highlighted in red in the history tree, and all the processing steps carried out continue to apply. You click the OK button to conclude your entries.
If you choose the Semiautomatic Inspection option, then you can make further settings in
the Channels and Criteria tabs in the dialog box.
In the Channels tab (see Figure 7-47), you can select the channels that are to be searched for
artifacts (Enabled Channels). You can also exclude specific channels from the artifact search
(Disabled Channels).

Semiautomatic inspection

266 Chapter 7 Primary and secondary transforms

Figure 7-47. Raw Data Inspection, selecting the channels

On the Criteria tab (see Figure 7-48), you can specify the criteria for marking channels (individual channel mode enabled) or excluding segments (individual channel mode disabled).
The following criteria are available to you: gradient, max-min, amplitude and low activity. For
each criterion, there is a separate tab below the Criteria tab.
You can combine the different criteria. As an aid to clarity, the title of each tab indicates
whether the corresponding criterion is currently used or not: (x) indicates that the corresponding criterion applies. ( ) indicates that the criterion has not been selected.

Gradient criterion

When the gradient criterion is applied, the absolute difference between two neighboring
sampling points must not exceed a specific value (see Figure 7-48).
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Figure 7-48. Raw Data Inspection, gradient criterion

To apply the gradient criterion, check the Check Gradient box.
In the Maximal allowed voltage step text box, you can specify the maximum permissible difference in voltage between two data points.
In the Mark as bad before event and Mark as bad after event text boxes, you can enter the
period before and after the actual occurrence of the criterion that is to be marked as an artifact.
When the max-min criterion is applied, the difference between the maximum and minimum
in a segment must not exceed a specific value (see Figure 7-49).

Max-min criterion
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Figure 7-49. Raw Data Inspection, max-min criterion

To apply the min-max criterion, check the Check maximum difference of values in the segment box.
In the Maximal Allowed Absolute Difference text box, you can enter the maximum difference
in voltage.
In the Interval Length text box, you can specify the length of the interval in milliseconds or
the period within which the difference in voltage must not exceed the specified value.
In the Mark as bad before event and Mark as bad after event text boxes, you can specify the
period before and after the actual occurrence of the criterion that is to be marked as an artifact.

Amplitude criterion

When the amplitude criterion is applied, the amplitude must not violate specified maximum
and minimum values (see Figure 7-50).
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Figure 7-50. Raw Data Inspection, amplitude criterion

To apply the amplitude criterion, check the Check maximal and minimal amplitude box.
In the Minimal allowed amplitude and Maximal allowed amplitude text boxes, you can enter
the minimum and maximum permissible values for the voltage.
In the Mark as bad before event and Mark as bad after event text boxes, you can specify the
period before and after the actual occurrence of the criterion that is to be marked as an artifact.
When the low activity criterion is applied, the difference between the maximum and minimum in an interval of a selectable length must not exceed a specific value (see Figure 7-51).

Low activity criterion
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Figure 7-51. Raw Data Inspection, low activity criterion

To apply the low activity criterion, check the Check low activity in intervals box.
Enter the minimum activity in the Lowest allowed activity (Max-Min) text box.
You can enter the length of the interval within which activity must not fall below the specified
level in the Interval Length text box.
In the Mark as bad before event and Mark as bad after event text boxes, you can specify the
period before and after the actual occurrence of the criterion that is to be marked as an artifact.
To test the selected criteria, click Test Criteria.
When you have made all your settings, click OK on one of the tabs. An interactive view opens
in which the marked artifacts are listed in a table (see Figure 7-52). You can adjust the results
of your settings subsequently in the same way as for manual inspection.
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Figure 7-52. Raw Data Inspection, semiautomatic inspection, interactive view
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Automatic inspection

The settings for the automatic inspection method correspond to those made for the semiautomatic method. The only difference is that you are not able to make corrections as you can
in the interactive view.

7.2.6
Summary

Ocular Correction ICA

The Ocular Correction ICA transform allows ocular artifacts in the EEG to be corrected. This is
an ICA-based correction process using a simplified version of ICA. Compared with ICA, however, the Ocular Correction ICA transform has the advantage that it offers more comprehensive methods of detecting artifact-related ICA components. Alongside the automatic and
manual detection of ocular artifacts (e.g. blinks), you can also automatically detect the ICA
components that are of relevance for eye activity. Ocular artifacts could also be corrected using the ICA transform in semiautomatic mode.

Prerequisites for use

Since this method consists of an ICA-based correction, we therefore recommend that you always apply the transform to filtered data.

Linearly dependent data and
the ICA method

Because the objective of the ICA method is to identify independent components from a data
set, certain prerequisites must be fulfilled if useful results are to be achieved using the method. The most important prerequisite is that the data set to which the ICA is to be applied must
contain a sufficient quantity of mutually independent signals. This means that the channels
of the data set must not be linearly dependent.
A given set of channels is linearly dependent if one of the channels can be calculated as a
weighted sum of the remaining channels. This can be the case if you have applied transforms
such as Linear Derivation, Pooling, Formula Evaluator or Topographic Interpolation to your
data set. The same applies to data generated using an ICA-based correction method during
previous processing, as this involves removing components.
Data containing an average reference or data containing a reference channel is also unsuitable. However, if you exclude a channel of the data set that contains an average reference
from the ICA calculation, you can then use this data set. If you have data containing a reference channel, you should exclude this channel from the calculation in order to obtain usable
results.
Data can also be unsuitable if the linear dependence is only approximate. If, for instance,
you have used two electrodes to record vertical ocular activity, these channels are often so
similar that they cannot be used as such in an ICA calculation. You should instead use the
difference between the two channels or exclude one of the two channels from the ICA calculation. Similar problems can be caused by gel bridges or channels with constant values
(straight lines). Please note that we cannot here provide a complete list of those scenarios
in which the data is potentially unsuitable for ICA calculation.
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If you apply the ICA method to unsuitable data, the components which are identified will not
be usable. Furthermore, the ICA matrix cannot be inverted and neither the inverse ICA nor corrections based on these ICA components return usable results.
To call the transform, choose Transformations > Artifact Rejection/Reduction > Ocular
Correction ICA.

Procedure

You select the Ocular Correction ICA settings on page 1 of the dialog (see Figure 7-53).

Dialog page 1: Ocular Correction ICA settings

Figure 7-53. Ocular Correction ICA, dialog page 1, Ocular Correction ICA settings

On the first page of the dialog, you can combine the options available in the Blink Markers
and ICA groups to select the following functions:
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1

New Markers and ICA-based Correction: Blink detection and use of the ICA method.

2

Use Existing Markers and ICA-based Correction: Use of existing markers in combination
with the ICA method.

3

New Markers and Marker Placement (no ICA): Blink detection without using an ICA method.

4

Use Existing Markers and Marker Placement (no ICA): Processing of the existing markers
without using an ICA method.

When you choose combination1 or 2, the dialog consists of a total of seven pages. However,
if you choose the other combinations then the dialog consists of three pages.
In the Blink Markers group, you specify whether markers already exist or new ones should be
created. If you choose Use Existing Markers then no blink detection is performed. You can
either use the existing markers for the ICA method or process them. The Use Existing Markers
option corresponds to the earlier option Using Markers. If, on the other hand, you select New
Markers, the blinks are detected by means of an algorithm. The New Markers option corresponds to the earlier option By Algorithm.
In the ICA group, you specify whether an ICA-based Ocular Correction is to be performed. If
you choose ICA-based Correction, then an ICA-based Ocular Correction is performed. If you
choose both Marker Placement (no ICA) and New Markers then markers are simply placed
but no ICA-based correction is performed. In semiautomatic mode, it is also possible to move
the markers. The Marker Placement (no ICA) option corresponds to the earlier option Write
only Markers.
In the Mode Selection group, you specify whether the transform is to run in automatic or
semiautomatic mode. Selecting the Semiautomatic Mode option activates semiautomatic
mode. This allows you to correct the data set subsequently provided that you have selected
the ICA-Based Correction option. Otherwise, no correction is performed and you can only
process the markers if you are using an interactive view.
If you are using the Ocular Correction ICA in template mode then it is advisable to choose the
Automatic option since otherwise template execution is interrupted when the interactive
view is displayed and is not continued until you click Finish to confirm the component selection.
In the Marker Output group, you can specify whether blinks are to be marked by interval
markers or start and end markers. If you choose the Interval Markers option then the blinks
are marked by intervals and a marker is set at the interval corresponding to the blink. If you
select the Pairs of Start and End Markers option, the blinks are marked by pairs of markers:
one at the start of the blink and one at the end.
Please note that combination 4 should always be performed in semiautomatic mode.

Dialog page 2, marker selection option

The options available for selection on page 2 of the dialog depend on the combination chosen on page 1 of the dialog. If you chose a combination involving the Use Existing Markers
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option on page 1 of the dialog (combination 2 or 4) then you can select the existing blink
markers on page 2 of the dialog (see Figure 7-54).
Figure 7-54. Ocular Correction ICA, dialog page 2, Use Existing Markers, selecting blink
markers

In the Markers to Read group, you can select the markers in the data set that contain eye
movement-related information.
To use interval markers (see Figure 7-55), you must select the Interval Markers option and
choose a marker name from the associated drop-down list.
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If you want to use start and end marker pairs (see Figure 7-56), choose the Start Markers and
End Markers option and select the markers you want to use from the corresponding dropdown lists.
Figure 7-55. Ocular Correction ICA, interval markers

Figure 7-56. Ocular Correction ICA, start and end markers

Dialog page 2, blink detection
option

If you chose the New Markers option on page 1 of the dialog (combination 1 or 3), then page
2 of the dialog is as follows (see Figure 7-57).
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Figure 7-57. Ocular Correction ICA, dialog page 2, New Markers, algorithm for blink
detection

The Detection Algorithm group allows you to choose between two blink detection algorithms:
 Meaned Slope Algorithm. No further settings are required. Those sections of the selected

VEOG channel with strong variations in gradient are detected. Experience shows that
these are blinks.
 Value Trigger Algorithm. In this case, blinks are detected on the basis of their absolute

value. Movements that definitively constitute blinks are determined by means of a correlation method.
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If you choose the Value Trigger Algorithm then you can make further settings in the Advanced: Parameters for the Value Trigger Algorithm group:
The value set for Blink Value Trigger [%] specifies the threshold above which blinks are recognized as being blinks. The Polarity drop-down list allows you to specify the polarity of the
VEOG recording (positive or negative). If you choose Automatic, the polarity is determined
automatically.
In the Correlation Trigger [%] text box, you enter the minimum correlation required. The possible blinks are correlated with a blink sample, and only when their correlation is higher than
the value entered in Correlation Trigger [%] are they recognized definitively as blinks.
If you choose the ICA-based Correction option on page 1 of the dialog (combination 1 or 2)
then on page 3 of the dialog you can specify the names of the channels in which eye activity
is most prominent (see Figure 7-58).
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Figure 7-58. Ocular Correction ICA, dialog page 3, ICA-based Correction, eye activity

The following description applies to the components of vertical eye movements. Check the
VEOG Channel box to set the VEOG channel, and then choose a channel from the associated
drop-down list.
If vertical eye activity was measured with only one electrode during the recording of the EEG,
or if it was measured with two electrodes and the difference between the measured values
already exists in a separate channel, select the Use Common Reference option. On the other
hand, if vertical eye activity was measured with two electrodes and the measured values are
in two different channels, use the Use Reference Channel option and then choose the reference channel from the associated drop-down list.

Vertical eye movements
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Horizontal eye movements

The following description applies to the components of horizontal eye movements.
Check the HEOG Channel box to set the HEOG channel, and then choose a channel from the
associated drop-down list.
You select the common reference or the reference channel in the same way as in the above
description of the settings for vertical eye movements.

Dialog page 4: Channel
selection

On page 4 of the dialog, you can select the channels that are to be included in the ICA calculation and ocular artifact correction (see Figure 7-59).
Figure 7-59. Ocular Correction ICA, dialog page 4, selecting the channels
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You can add the VEOG and/or HEOG channels to the list of channels to be corrected. If associated reference channels exist then it is not essential to add these as well.
You select the ICA settings on page 5 of the dialog (see Figure 7-60).
Irrespective of the amount of data you use here to calculate the ICA matrix, the matrix is always applied to the entire data set when correction is performed.
Figure 7-60. Ocular Correction ICA, dialog page 5, selecting the ICA method

If you select the Whole Data option, the entire data set is included in the calculation of the
ICA matrix. Note that calculating the matrix is very time-consuming when you use the Whole
Data option. An alternative is to select a large interval.

Dialog page 5: ICA method
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If you select the Around Blinks option, only intervals defined around blinks are included in
the ICA calculation. The middle of each of these intervals is the beginning of a blink, and the
interval is twice as long as the blink.
If you want to define an interval to be included in the calculation, select the Interval option
and enter the beginning and length of the interval in the Start [s] and Length [s] text boxes.
It is also possible to calculate an amount of data of a specified length after subtraction of the
"Bad Intervals". In this case, only those intervals are taken into consideration that are present in the selected channels. You can enter the required interval length in the Bad Interval
Free [s] text box.
If you then leave the text box by clicking in the Start [s] or Length [s] text box, the value in the
Length [s] text box is automatically adjusted to reflect the change. In the same way, the value
in the Length [s] text box is adjusted when you make a change to the value entered in Start
[s]. The value in Bad Interval Free [s] is adjusted when you make a change to the value entered in Length [s].
The view window below the text boxes is used to display the "Bad Intervals". The length of
the slider exactly represents the selected interval. If you move the slider, the values in the
Start [s] and Length [s] text boxes are adjusted accordingly. The value in Bad Interval Free [s]
remains constant provided that the chosen slider position allows it to do so. (if, for instance,
the end of a data set has a large number of "Bad Intervals", the value does not remain constant.)
If you want to use automated interval selection, click the Suggest Values… button (see
Figure 7-61).
Figure 7-61. Ocular Correction ICA, automated interval selection

You can choose whether:
 the interval is to start at the beginning of the data set (At the Beginning option)
 the interval is supposed to be located in the middle of the data set (In the Middle option)
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 the end of the interval is to coincide with the end of the data set (At the End option)
 the interval is to start at the value that you entered in Start [s] (Keep Start at [VALUE] s

option).
You can also choose between the Default Length for [VALUE] Channels and Keep Length of
[VALUE] s options.
If you choose the Default Length for [VALUE] Channels option, an interval length free of "Bad
Intervals" is used by default. This length depends on the number of selected channels and
is calculated as follows:
Take Q as the square of the number of channels selected.
The calculation is performed using the following method that is very popular among ICA users and is frequently employed: 20Q points if less than 64 channels have been selected and
30Q if more than 64 channels have been selected. The result of this calculation is shown in
seconds in the Bad Interval Free [s] text box. A length of at least 10 seconds is proposed even
if the result is less than 10.
If you select the Keep Length of [VALUE] s option, the value entered in Bad Interval Free [s]
is used for the calculation.
If you check the Bound Number of Blinks box, you can enter in the associated text box the
maximum number of blinks to be included in the calculation. If you do not check this box, all
blinks are included in the ICA calculation. This function is always accessible, regardless of
what you select under Data Used to Compute the ICA Matrix. If you use the Whole Data or
Interval options and limit the number of blinks, this only affects blinks used to obtain the relevant VEOG components.
By combining the options available in the ICA group, you can choose between the four possible ICA procedures: Restricted Infomax, Extended Infomax, Restricted Fast ICA and Extended Fast ICA.
If you select an infomax method, the Biased Infomax checkbox is available to you. If you
check this box, an additional method as described in [MBJ97] is used at each ICA calculation
step in order to improve the quality of the ICA method by highlighting particular characteristics of individual components.
ICA training is performed until the modifications made to the matrices is smaller than the value specified in Convergence Bound. In other words, the data is processed until the result of
this calculation is sufficiently accurate. However, the number of training steps can never exceed the value specified in Number of Steps.
In the Number of Steps text box, you can enter the maximum number of steps to be taken in
order to approximate to the separating matrix (the matrix calculated for component separation). The default value for fast ICA methods is 150. The default value for infomax methods
is 512. You can also modify these values.

For example, if you select the

Interval option and enter a value of 60 in the Bound Number
of Blinks text box, the first 60

blinks that occur in this interval
are used to obtain the relevant
VEOG components. The same applies if you select the Whole
Data option, although in this
case the interval is the entire
data set.
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Dialog page 6: Determining
the artifact-related ICA components

On page 6 of the dialog, you can determine the artifact-related ICA components (see Figure 762).
You can also select the criteria that are to be used to determine the relevant ICA components
for the eye activity. In addition, you can specify the percentage of the energy of the ICA components to be removed from the EEG. Energy in this case means global field power, correlation or VEOG or HEOG variance.
Figure 7-62. Ocular Correction ICA, dialog page 6, defining the artifact-related ICA
components
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To determine the ICA components that are relevant for the vertical eye movements, you can
select one of the following criteria: Global field power, relative VEOG variance or sum of the
squares of the correlation with VEOG.

Vertical eye movements

You can specify the criteria in the Find ICA Components Arising From VEOG Activity group.
If you choose the Use the Global Field Power option then the global field power of the components is determined. In this case, the components with the maximum global field power
during blinks and whose sum exceeds the percentage specified for Total Value to Delete [%]
are marked.
If you use the Use Relative VEOG Variance option, the components are found by means of
relative VEOG variance when blinks occur. The components with the highest values for relative VEOG variance and whose sum exceeds the percentage specified for VEOG Variance to
Delete [%] are marked. The variance criterion can only be chosen if the corresponding VEOG
channel (and possibly also the reference channel) was added to the list of channels to be included in ICA correction and ocular artifact correction on page 4 of the dialog.
If you choose the Use Sum of Squared Correlations with VEOG option then the components
are found by means of the reference channel when blinks occur. The components with the
highest values for the sum of squared correlations and whose sum exceeds the percentage
specified for Total Value to Delete [%] are deleted from the EEG.
The following description applies to the components of horizontal eye movements.

Horizontal eye movements

To identify the ICA components that are relevant for horizontal eye movements, you can
choose between two criteria: Relative HEOG variance in the interval and sum of the squares
of the correlation with HEOG.
You can specify the criteria in the Find ICA Components Arising From HEOG Activity group.
If you use the Use Relative HEOG Variance option, the components are found by means of
relative HEOG variance when blinks occur. The components with the highest values for relative HEOG variance and whose sum exceeds the percentage specified for Total Value to Delete [%] are deleted from the EEG. The variance criterion can only be chosen if the
corresponding HEOG channel (and possibly also the reference channel) was added to the list
of channels to be included in ICA correction and ocular artifact correction on page 4 of the
dialog.
If you choose the Use Sum of Squared Correlations with HEOG option then the correlations
of the ICA components with the HEOG channel are calculated. In this case, the correlations
are calculated based on the entire data range. The components for which the sum of squared
correlations exceeds the percentage specified for Total Value to Delete [%] are marked.
On page 7 of the dialog, you can select settings for the export of the ICA matrix and the inverse of the matrix to LDR-compatible files so that the matrix and its inverse can be used by
the Linear Derivation transform (see Figure 7-63).

Dialog page 7: ICA matrix
export options
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To do this, check the Write LDR-File for ICA Matrix and Write LDR-File for Inverse ICA Matrix
boxes. You enter the name of the LDR file in the corresponding File Name text box. The placeholders $h (for the name of the history file) and $n (for the name of the current data set) are
available to you. The Resulting File Name text box displays the selected file name.
Figure 7-63. Ocular Correction ICA, dialog page 7, export options

On this page, there are also three options available to you for exporting the LDR files:
 Write to Export Directory. The LDR files are written to the export directory.
 Write to Raw Data Directory. The LDR files are written to the raw data directory.
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 Write to Following Directory. The LDR files are written to the directory you select.

If you selected the Marker Placement (no ICA) option on page 1 of the dialog, the next page
is the last of the dialog (see Figure 7-64).
In this case, you can only specify the VEOG channel. To do this, check the VEOG Channel box
and select a channel from the associated drop-down list.
You will find a description of the Common Reference and Use Reference Channel as of
page 279 in the section "Vertical eye movements".
Figure 7-64. Ocular Correction ICA, dialog page 3, Marker Placement (no ICA), eye activity
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If you have activated both semiautomatic mode and ICA-based Correction on page 1 of the
dialog, an interactive view opens when you have entered your parameters (see Figure 7-65).
Figure 7-65. Ocular Correction ICA, semiautomatic mode, ICA components

In the upper part of the interactive view, there are two tabs that allow you to switch between
ICA components and blinks.
The table lists the energy values of all the ICA components, depending on the criterion selected on page 6 of the dialog (global field power, VEOG variance, HEOG variance, correlation).
In the interactive view, you can edit the blink markers as follows:
 To move a blink marker, click in the middle of the marker and hold down the mouse but-

ton while moving the marker in the required direction.
 To change the width of a blink marker, click the border of the marker and hold down the

mouse button while dragging the border to the required width.
 To add a new blink marker, hold down the key and left mouse button and select the re-

quired range in the EEG.
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 To delete a blink marker, hold down the <Shift> key and click the marker you want to de-

lete.
The cells in the left table column are either green or red. Red means that the corresponding
component has been marked as a blink component and will not be taken into account for the
purposes of the corrected data. Green means that this component has not been marked as a
blink component. If you double-click the cell, the color switches from green to red.
If you click a row in the table, it is highlighted in blue and the mapping view (below the table)
indicates the map for the corresponding component.
You can use the drop-down list below the mapping view (see window detail) to control the
display in the interactive view:
 ICA Components displays the components first, followed by the unselected channels.
 Correction displays the data set that was reconstructed on the basis of the components

marked in green.
 Subtracted displays the data set that was reconstructed on the basis of the components

marked in red.
 Topographies displays the associated map next to the components.

If you check the Show Normed Mappings box, the maps and topographies are replaced with
standardized maps and topographies.
If you check the Overlay with Original Data box, the current data is overlaid with the original
data. This option is especially important when you have chosen Correction or Subtracted
from the drop-down list.
If you want to view unselected channels and calculated ICA components simultaneously, it
is difficult to find a scaling factor that suits them both. To increase the size of the ICA components independently of the channels, you can choose from the ICA Scaling drop-down list
a coefficient by which the ICA components are to be multiplied to optimize the display. You
can choose one of the four predefined values or enter a value yourself. Note that the ICA Scaling option is only available if you choose ICA Components from the drop-down list.
If you want to confirm the component selection, select Finish. The reconstructed data set is
then displayed without the components marked in red. If you want to change your settings,
click Recalculate. This re-opens the dialog which again contains all the dialog pages with the
exception of page 1.
You can use the Blinks tab in the top part of the interactive view to perform a blink inspection
in order to accept or reject the blinks (see Figure 7-66).
Click Start Inspection to activate inspection mode. The first blink marker in the data set is
marked in yellow, and the system navigates automatically to this blink marker.
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If you use the Marker Placement (no ICA) option, the interactive view contains only the
control elements for the blink inspection.

Figure 7-66. Ocular Correction ICA, blink inspection

The blink markers can have the following statuses that are indicated using different colors:
 blue: possible blink
 yellow: currently selected blink
 green: accepted blink
 red: rejected blink
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Figure 7-67. Ocular Correction ICA, blink markers displayed in different colors

The text box under the Start Inspection button displays the status of the currently selected
blink marker.
You can use the Reject as Blink and Accept as Blink buttons to reject and accept blink markers. When you click one of these buttons, the focus switches to the next blink marker.
You can use the --> and <-- buttons to go to the next or previous blink marker that fulfills one
of the criteria Step to Next (next marker), Step to Next Accepted (next accepted marker) or
Step to Next Rejected (next rejected marker).
Alternatively, you can use the following keys for navigation:
 You press <R> to reject the blink.
 You press <A> to accept the blink.
 You press <P> to navigate to the right.
 You press <Q> to navigate to the left.

To exit inspection mode, click End Inspection.
If you interrupt the inspection by clicking Recalculate or terminate it with Finish, only red
markers are rejected. All other blink markers (blue, yellow and green) are accepted.
Recalculate allows you to modify all the settings you have made: The transform dialog box is
opened again. On the alternative first page, you can make entries relating to the blinks (see
Figure 7-68).
If you select the New Markers option, the blinks are detected again. If you select Use Existing
Markers, the blink markers that you have not rejected are used in the subsequent calculation.

Note that you can only use these
keys when the interactive view is
active.
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Figure 7-68. Ocular Correction ICA, dialog page 1, Recalculate

Method

Ocular artifact correction is ICA-based. Its operation is analogous to the correction performed
using the ICA transform. The ICA components relevant for the feature to be corrected are subtracted from the EEG. In comparison to the ICA transform, the Ocular Correction ICA transform offers two functions for the specific task of correcting ocular artifacts: The automatic
and manual detection of blinks and automatic detection of ICA components that are relevant
to the eye activity. The blink markers are determined by means of the same method used for
non-ICA-based Ocular Correction. Moreover, they can be edited in semiautomatic mode.
The relevant ICA components are selected by means of the following methods:
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1

The global field power method calculates the share of each ICA component in the global
field power of the data set using only the intervals containing blinks. It is not important
to this method which values the VEOG channel assumes. In other words, the VEOG channel is required exclusively for the detection of blinks.

2

The method of relative VEOG variance calculates the share of each ICA component in the
variance of the selected VEOG channel using only the intervals containing blinks. If the
VEOG channel itself is not included in the ICA calculation, this calculation is replaced by
a correlation calculation.

3

The HEOG variance method calculates the share of each ICA component in the variance
of the selected HEOG channel across the entire amount of data that was used to calculate
the ICA matrix. If the HEOG channel itself is not included in the ICA calculation, this calculation is replaced by a correlation calculation.

4

The correlation method calculates the correlation of each ICA component with the data
set across the entire amount of data that was used to calculate the ICA matrix. In the case
of vertical eye movements, the correlation is only calculated around blinks. In the case of
horizontal eye movements, the entire data set that was used for the ICA calculation is included.

The advantage of semiautomatic mode is that the user can use the blink markers to assess
the relevance of the ICA components and identify the relevant components.
[JMH2000] T.-P. Jung, S. Makeig, C. Humphries, T.-W. Lee, M. J. McKeown, V. Iragui, T. J. Sejnowski, Removing electroencephalographic artifacts by blind source separation. Psychophysiology, 37 (2000), 163–178.
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USA, 94 (1997), 10979-10984.

7.2.7

Ocular Correction

The Ocular Correction transform eliminates or at least reduces the effect of eye movements
on the EEG. The Gratton & Coles method [GCD83] is used for this.

Summary

To call the transform, choose Transformations > Artifact Rejection/Reduction > Ocular
Correction.

Procedure
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Figure 7-69. Ocular Correction, dialog box

In the dialog box, you first choose the method that you want to use. The Gratton & Coles algorithm and a slightly modified version of it, "Gratton & Coles without Raw Average Subtraction", are available for selection. The "Gratton & Coles without Raw Average Subtraction"
algorithm is only available if you are using segmented data. These algorithms and their differences are described under "Method" on page 295.
Check the VEOG Channel box if there is a VEOG channel in the EEG. You can choose the channel's name from the Channel Name drop-down list.
If you select the Common Reference option, it is assumed that the reference electrode of the
VEOG channel is shorted to the common reference. If you select the Reference Channel option, it is assumed that the reference electrode of the VEOG channel is not identical to the
common reference.
The following principle applies: If your VEOG signal takes the form of a single channel, you
should select Common Reference, because, as far as the program is concerned, the signal is
a unipolar signal and thus shorted to the common reference. However, if your VEOG signal
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takes the form of two individual channels (for example, "VEOG Upper" and "VEOG Lower"),
select the Reference Channel option and then the second channel from the list of available
channels. In blink detection, the program will then treat these two channels as a bipolar
channel pair.
The functions of the HEOG group for the HEOG channel correspond to the functions of the
VEOG group for the VEOG channel.
Under Blink Detection, you can specify
 Whether the blinks are to be searched for in the VEOG channel selected above (By

Algorithm option) or
 Whether you have detected the blinks that are relevant to you without using the Ocular

Correction transform (using a macro based on your own algorithm, for example) and have
marked them with a "Blink Start" and "Blink End" marker (Based on Markers option).
Then select the desired markers in the Start Marker and End Marker drop-down lists.
If you select the By Algorithm option, you can also check the Write Only Markers box to specify that no data correction is carried out in this analysis step and that the blinks found are
merely marked in the data set. If you want to change these markers subsequently, you use
the relevant functions in the interactive view of the Ocular Correction ICA transform. (
For
detailed information on this transform, refer to Section 7.2.6 as of page 272.)
Please note that on page 1 of the Ocular Correction ICA transform, the Write Only Markers
and Write Pairs of Start and End Markers checkboxes must be selected.
You can carry out the actual ocular artifact correction in a subsequent step by selecting the
Based on Markers option.
Under Enable/Disable Channels for Correction, you select the channels for which correction
is to be carried out.
The VEOG and HEOG channels can be used for correction. This is not advisable, however,
since the information contained in these channels is largely lost. The information loss is as
follows: If you use an ocular channel with the Common Reference option selected, this channel has a constant signal after the correction. On the other hand, if you use an ocular channel
with the Reference Channel option selected, both the ocular channel and the reference channel have the same signal after the correction. It is essential to take this into account when
reusing the channels as pure data channels.
The Gratton & Coles algorithm corrects ocular artifacts by subtracting the voltages of the ocular channels, multiplied by a channel-dependent correction factor, from the EEG channels.
The correction factors are calculated in several steps.
In the first step, a blink detection method is applied to the vertical ocular channel in order to
calculate separate factors within and outside blinks.

Method
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In the next step, after the subtraction of the average, an average of the various events (i.e. of
the different segmentation markers) is obtained for each channel.
To calculate the correction factors, in the third step this average is subtracted from the channel in each segment in order to prevent the event-correlated data from being included in the
calculation. This step is not included if you select the "Gratton & Coles without Raw Average
Subtraction" method.
Finally, the correction factors are calculated by linear regression.

References

Summary

[GCD83] G. Gratton, M.G.H. Coles, E. Donchin, A new method for off-line removal of ocular
artifact. Electroencephalography and Clinical Neurophysiology, 55 (1983), 468-484.

7.3

Transforms in the Frequency and Component Analysis
group

7.3.1

ICA (Independent Component Analysis)

The ICA transform is used to split the EEG signals up into independent components using information theory methods. It is assumed here that EEG signals are a linear combination of
independent components (independent as defined in information theory). The ICA transform
separates the complex signals into independent virtual components.
The purpose of the ICA transform in what is known as "blind source separation" is to reconstruct source signals from a combination of these signals. Both the source signals and the
combination are unknown. However, assumptions are made about the signals and how they
are combined. It is assumed that the signals to be reconstructed are statistically independent of each other.
You will find detailed information on the underlying theory in [BS95],
[Car98] and [MBJS96]. At this point, it is enough to say that the ICA transform is a purely statistical or mathematical method. It is based on the above assumptions and does not use any
additional physiological information. It is up to you to check that the assumptions are correct
and that they correspond to the actual physiological conditions. These directly influence the
validity of the results obtained using the ICA transform.
The result of the ICA transform is a set of components that are defined analogously to EEG
channels in the time domain. In addition, the ICA transform provides a weight matrix or ICA
matrix by means of which the components can be calculated from the channels. The infomax
algorithm or the fast ICA algorithm is used to determine the ICA matrix. The infomax algorithm is an iterative gradient method used to estimate maximum likelihood and is described
in [MBJ97], for example. The fast ICA algorithm is an iterative fixed-point method used to minimize negentropy and is described in HKO01 ], for example.
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Please note that the term "fast" has a slightly different meaning when it is used in the name
of the fast ICA algorithm from when it is used in the Fast Fourier transform (FFT), for example.
The Fast Fourier transform is an accelerated method that returns the same results as a conventional Fourier analysis. ICA with infomax and fast ICA are two different methods of calculating independent components. However, only in an ideal case do they return the same
results. Fast ICA has stricter requirements in terms of the separability of components. If these
requirements are met, it calculates more quickly than conventional methods, hence its
name. If the requirements for good component separability are not met, calculation with fast
ICA is generally slower than with other methods. In this case, the suitability of the initial data
for an ICA analysis should be examined.
Because the objective of the ICA method is to identify independent components from a data
set, certain prerequisites must be fulfilled if useful results are to be achieved using the method. The most important prerequisite is that the data set to which the ICA is to be applied must
contain a sufficient quantity of mutually independent signals. This means that the channels
of the data set must not be linearly dependent.

Linearly dependent data and
the ICA method

A given set of channels is linearly dependent if one of the channels can be calculated as a
weighted sum of the remaining channels. This can be the case if you have applied transforms
such as Linear Derivation, Pooling, Formula Evaluator or Topographic Interpolation to your
data set. The same applies to data generated using an ICA-based correction method during
previous processing, as this involves removing components.
Data containing an average reference or data containing a reference channel is also unsuitable. However, if you exclude a channel of the data set that contains an average reference
from the ICA calculation, you can then use this data set. If your data contains a reference
channel, you should exclude this channel from the calculation in order to obtain usable results.
Data can also be unsuitable if the linear dependence is only approximate. If, for instance,
you have used two electrodes to record vertical ocular activity, these channels are often so
similar that they cannot be used as such in an ICA calculation. You should instead use the
difference between the two channels or exclude one of the two channels from the ICA calculation. Similar problems can be caused by gel bridges or channels with constant values
(straight lines). Please note that we cannot here provide a complete list of those scenarios
in which the data is potentially unsuitable for ICA calculation.
If you apply the ICA method to unsuitable data, the components which are identified will not
be usable. Furthermore, the ICA matrix cannot be inverted and neither the inverse ICA nor corrections based on these ICA components return usable results.
To call the transform, choose Transformations > Frequency and Component Analysis > ICA.

Procedure

On page 1 of the dialog, you can make settings for the export of the ICA matrix and the inverse
of the matrix to LDR-compatible files so that the matrix and its inverse can be used by the
Linear Derivation transform (see Figure 7-70).

Dialog page 1: ICA matrix export options
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To do this, check the Write LDR-File for ICA Matrix and Write LDR-File for Inverse ICA Matrix
boxes. Also, please enter the name of the LDR file in the corresponding File Name text box.
The placeholders $h (for the name of the history file) and $n (for the name of the current data
set) are available to you. The Resulting File Name text box displays the selected file name.
Figure 7-70. ICA, dialog page 1, export options

On this page, there are also three options available to you for exporting the LDR files:
 Write to Export Directory. The LDR files are written to the export directory.
 Write to Raw Data Directory. The LDR files are written to the raw data directory.
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 Write to Following Directory. The LDR files are written to the directory you select.

On dialog page 2 (see Figure 7-71), you specify the size of the ICA matrix. When you do this,
the number of columns is defined by the number of channels and the number of rows is defined by the number of independent components.
Figure 7-71. ICA, dialog page 2, channels and components

Dialog page 2: Size of the ICA
matrix
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Under Channel Names, you specify which channels are to be included in the ICA calculation.
The number of selected channels is displayed below the list (Number of Enabled Channels:
[VALUE]).
Under Number of ICA Components, you specify how many ICA components are to be calculated. By default, the number of components calculated is equal to the number of channels
selected (Number of Enabled Channels option). You can also specify that a lower number of
components is calculated. To do this, select the Number of Components option and enter the
required number in the corresponding text box.
If you erroneously enter a value in this text box that is higher than the number of selected
channels, this entry is ignored and the maximum possible number of components (i.e. number of selected channels) is calculated.
You can also specify that the number of components to be calculated is determined automatically by selecting the Components With Eigenvalue At Least option. If you select this option,
the covariance matrix of the signals is diagonalized (PCA method). The resulting values are
referred to as eigenvalues.
ICA components with the smallest eigenvalues provide little information. In most cases, they
consist of noise and can therefore interfere with the calculation of the ICA matrix. They
should therefore not be included in the calculation of the ICA matrix. To this end, you enter a
threshold value in the Components With Eigenvalue At Least text box (default value: 0.001).
The components whose eigenvalues are below this threshold value are not included in the
calculation of the ICA matrix.
You can use the Number of Components or Components With Eigenvalue At Least options to
process data with linearly dependent channels. To do this, use the Number of Components
option if you want to define the number of components to be extracted yourself. Otherwise,
use the Components With Eigenvalue At Least option if the number of independent components is to be determined by the algorithm.

Dialog page 3: Data used to
calculate the ICA matrix

On page 3 of the dialog, you can specify the amount of data to be used to calculate the ICA
matrix (see Figure 7-72).
Specific ranges of the EEG signal are often more meaningful than the whole data set as far as
the components are concerned. This is why you are able to limit the amount of data to be
used here in order to limit the calculation to relevant ranges and consequently improve performance.
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Figure 7-72. ICA, dialog page 3, data used to calculate the ICA matrix

You can determine the amount of data using five different options which are described in
more detail below. For options 3, 4 and 5, the data quantity results from the combination of
the intervals that have been defined separately by means of markers.

Options for specifying the
amount of data

Irrespective of the amount of data included in the calculation of the ICA matrix, the matrix is
always applied to the entire data set.
Whole Data: The entire data set, after exclusion of the "Bad Intervals", is used for the calculation.

Option 1: Entire data set
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Option 2: Interval

Interval: The calculation applies only to a specific interval, the beginning and length of which
you specify in the Start [s] and Length [s] text boxes in the Interval group.
It is also possible to calculate an amount of data that has a specified length after the exclusion of the "Bad Intervals". In this case, only those intervals are taken into consideration that
are present in the channels selected on dialog page 2 (see Figure 7-71 on page 299). To do
this, enter the required length in the Bad Interval Free [s] text box.
If you then leave the text box by clicking in the Start [s] or Length [s] text box, the value in the
Length [s] text box is automatically adjusted to reflect the change. In the same way, the value
in Length [s] is adjusted when you make a change to the Start [s] text box. The value in Bad
Interval Free [s] is adjusted when you make a change to the value entered in Length [s].
The view window below the text boxes is used to display the bad intervals. The length of the
slider exactly represents the selected interval. If you move the slider, the values in the Start
[s] and Length [s] text boxes are adjusted accordingly. The value of Bad Interval Free [s] remains constant provided that the chosen slider position allows it to do so (if, for instance,
the end of a data set has a large number of "Bad Intervals", the value does not remain constant).
If you want to use automated interval selection, click the Suggest Values… button (see
Figure 7-73).
Figure 7-73. ICA, automated interval selection

You can choose whether:
 the interval is to start at the beginning of the data set (At the Beginning option)
 the interval is supposed to be located in the middle of the data set (In the Middle option)
 the end of the interval is to coincide with the end of the data set (At the End option)
 the interval is to start at the value that you entered in Start [s] (Keep Start at [VALUE] s

option).
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You can also choose between the Default Length for [VALUE] Channels and Keep Length of
[VALUE] s options.
If you choose the Default Length for [VALUE] Channels option, an interval length free of "Bad
Intervals" is used by default. This length depends on the number of selected channels and
is calculated as follows:
Take Q as the square of the number of channels selected.
The calculation is performed using the following method that is very popular among ICA users and is frequently employed: 20Q points if less than 64 channels have been selected and
30Q if more than 64 channels have been selected. The result of this calculation is shown in
seconds in the Bad Interval Free [s] text box. A length of at least 10 seconds is proposed even
if the result is less than 10.
If you select the Keep Length of [VALUE] s option, the value entered in Bad Interval Free [s]
is used for the calculation.
Equal Intervals Around Markers: Intervals of equal size around the markers are used. You
choose a marker name from the Name drop-down list in the Marker and Interval Around
Marker Position group. In the Start [ms] and End [ms] text boxes, you specify the beginning
and end of the interval relative to the selected interval. Example: If you enter a value of -100
in the Start [ms] text box and a value of 500 in the End [ms] text box, the interval begins 100
ms before the selected marker and has a length of 600 ms.

Option 3: Equal intervals

If the selected marker is an interval marker, the interval is defined in relation to the starting
point of this marker.
Interval Markers: Intervals defined exclusively by interval markers are used. You choose the
marker to be used from the Name drop-down list in the Interval Marker group.

Option 4: Interval markers

Intervals Between Start and End Markers: Intervals defined by start and end markers are
used.

Option 5: Intervals between
start and end markers

You choose the start and end markers to be used from the drop-down lists in the Start and
End Markers group. If either or both of the selected markers are interval markers, the interval
is defined in relation to the starting point of the markers. In other words, the end of the interval is defined by the starting point of the end marker.
If an end marker occurs after several successive start markers, the interval starts at the first
start marker in the series and ends at the end marker. If this end marker is followed by further
end markers, these are ignored. The next interval starts at the next start marker. An interval
is not recognized as an interval unless it is concluded by an end marker.
On page 4 of the dialog, you select the algorithm that is to be used to perform the calculation
(see Figure 7-74).

Dialog page 4: ICA method
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Figure 7-74. ICA, dialog page 4, selecting the ICA method

In the Sphering group, you can choose between two sphering methods. Sphering is for the
preliminary processing of the EEG signals:
 Classic PCA (conventional sphering using PCA): The conventional method treats all com-

ponents equally.
 Probabilistic PCA (probabilistic sphering using PCA): The combination of probabilistic

sphering and any ICA method is referred to in the literature as probabilistic ICA (PICA).
The noise is filtered out of the EEG data set using the probabilistic method.
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By combining the options available in the ICA group, you can choose between the four possible ICA procedures: Restricted Infomax, Extended Infomax, Restricted Fast ICA and Extended Fast ICA.
If you select an infomax method, the Biased Infomax check box is available to you. If you
check this box, an additional method as described in [MBJ97] is used at each ICA calculation
step in order to improve the quality of the ICA separation by highlighting particular characteristics of individual components.
ICA training is performed until the modifications made to the matrices is smaller than the value specified in Convergence Bound. In other words, the data is processed until the result of
this calculation is sufficiently accurate. However, the number of training steps can never exceed the value specified in Number of Steps.
In the Number of Steps text box, you can enter the maximum number of steps to be taken in
order to approximate the ICA matrix. The default value for fast ICA methods is 150. The default value for infomax methods is 512. You can also modify these values.
Please take account of the following note on combining probabilistic PCA (Sphering group)
with the Number of Components option or the Components With Eigenvalue At Least option
(dialog page 2, see Figure 7-71 on page 299): If the number of components specified in Number of Components or Components With Eigenvalue At Least on dialog page 2 is too small,
the optimum number of components may not be calculated. In extreme cases, selecting too
small a number can cause multiple independent components to be combined to form a single component and thereby increase noise. As a result of this noise, these components may
be excluded more frequently when probabilistic PCA is selected. We therefore recommend
that you either enter a larger number of components manually (Number of Components option) or choose a lower value for the eigenvalue trigger (Components With Eigenvalue At
Least option).
The advantages and drawbacks of the probabilistic ICA method are described in detail in [TB99] and [BS04].
In the Ordering group, you can select one of the following sort criteria for the components:
 Kurtosis (in descending order)
 Energy (in descending order)

Kurtosis (K) is a numerical estimate of the steepness of a curve (graph). The following distinctions are drawn:
 K = 0: normal peak, Gaussian or mesokurtic.
 K > 0: steep peak, super-Gaussian or leptokurtic.
 K < 0: flat peak, sub-Gaussian or platykurtic.

Note that the restricted infomax method, unlike the extended infomax method, can only separate components with positive kurtosis (K > 0).

Important note to users
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Semiautomatic mode allows you to experiment with the result of the exclusion of certain
components and the reconstruction of the data set from the other components. To do this,
check the Semiautomatic Mode box. When you have entered the parameters, an interactive
view appears (see Figure 7-75). Click OK to start the ICA calculation.

Display

Please note the following points about the display:
The names of the components consist of the letter "F" followed by a number in accordance
with the selected sort criterion (kurtosis or energy).
If you include all the channels in the ICA calculation, only the components are displayed. If,
on the other hand, you have excluded channels from the ICA , the components are displayed
at the top. The unselected channels are displayed below these in the order in which they occur in the original EEG.
Channel markers that were originally on a selected channel automatically turn into global
markers. Channel markers that were originally on an unselected channel remain in position
on that channel. Markers that were originally global remain global.
If the ICA components are displayed with unselected channels, their amplitude is considerably lower than the amplitude of the channels. To obtain a better display, select one, several
or all components and view them separately.
Figure 7-75. ICA, semiautomatic mode with interactive view

The table at the top of the interactive view (see Figure 7-75) presents the ICA matrix of independent components (in rows) and channels (in columns). In addition, the Kurtosis, Energy
and User Comments relating to the components are listed in the last 3 columns.
This table allows you to select the components that you want to include in the reconstruction
and those that you want to exclude. The selection is color-coded in the first column: Green
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means that the component has been selected for reconstruction. By contrast, a red marking
means that the component contains information that is not relevant and that it should therefore not be used for reconstruction. Initially, all the components are set to green. To change
the color from green to red (or vice versa), double-click the relevant cell. In addition, you can
click the Revert option to invert the markings of all the components.
If you click a row in the table, it is highlighted in blue and the mapping view (below the table)
indicates the map for the corresponding component. The topographical maps indicate the inverse weighting values of the components at the associated channels.
To enter a comment for a component, click this component in the table and then click the
Comments button in the dialog box for the interactive view. The Write Comment dialog box
appears (see Figure 7-76).
Figure 7-76. ICA, semiautomatic mode, entering comments

You can use the drop-down list below the mapping view to control the display in the interactive view:
 ICA Components displays the components first, followed by the unselected channels.
 Correction displays the data set that was reconstructed on the basis of the components

marked in green (see Figure 7-77).
 Subtracted displays the data set that was reconstructed on the basis of the components

marked in red.
 Topographies displays the associated map next to the components (see Figure 7-78).

You can access previous comments whenever you want via
the drop-down list in the dialog
box.

308 Chapter 7 Primary and secondary transforms

Figure 7-77. ICA, semiautomatic mode, Correction

When you click Revert, the displays of the Correction and Subtracted views change accordingly.
Figure 7-78. ICA, semiautomatic mode, Topographies

If you check the Show Normed Mappings box, the maps are replaced with standardized
maps.
If you check the Overlay with Original Data box, the current data is overlaid with the original
data. This option is important, above all, when you have chosen Correction or Subtracted
from the drop-down list box.
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If you want to view unselected channels and calculated ICA components simultaneously, it
is difficult to find a scaling factor that suits them both. To increase the size of the ICA components independently of the channels, you can choose from the ICA Scaling drop-down list
a coefficient by which the ICA components are to be multiplied to optimize the display. You
can choose one of the four predefined values or enter a value yourself. Note that the ICA Scaling option is only available if you choose ICA Components from the drop-down list box above
it.
Recalculate allows you to modify all the settings you have made: The transform dialog box is
opened again.
If you check the Show Correction After Finish box and click Finish, the reconstructed data set
is displayed without the components marked in red. If you do not check the box, the ICA components are displayed first, followed by the unselected channels (see <Figure 7-79).
Figure 7-79. ICA, display of the ICA components from the unselected channels

If you are using automatic mode or are using semiautomatic mode but have not selected
Show Correction After Finish, the following User Properties are automatically saved in the
created node: Mean Value, ICA-Matrix, inverse Matrix, Number Components (see Figure 780):
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The User Properties can be
read by means of OLE Automation and used by other
solutions.

Figure 7-80. ICA, User Properties

If you do not want to export the ICA User Properties then you can modify them using the Edit
User Properties transform (
you will find detailed information on this transform in
Section 7.7.5 as of page 480).
The values for Kurtosis and Energy as well as any comments entered for all the components
can be found in the node's Operation Infos when semiautomatic mode is terminated.

The ICA method

The ICA transform consists of the following steps:
1

The mean values of the channels are subtracted from the data set.

2

PCA preprocessing: The sphering matrix is calculated and applied to the data set.
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3

ICA training: The resulting data is inspected repeatedly until the ICA matrix has been calculated with sufficient precision.

4

The ICA components are determined by applying the ICA matrix to the data set.

5

The arrangement of the components in the newly created data set is adjusted depending
on which sort criterion is selected.

When performing PCA preprocessing, you can choose between two sphering methods: conventional and probabilistic sphering. Unlike conventional sphering, probabilistic sphering
can help reduce the noise in the EEG.
When selecting the algorithm to be used for ICA training, you can once again choose between
two options: Infomax and Fast-ICA. The infomax methods, which are also known as gradient
methods, are generally slower than the fast ICA methods when component separability is
good. However, there are also exceptions in the case of the fast ICA methods when calculation is interrupted and new parameters have to be selected. In such cases, it is perfectly possible for a fast ICA method to be slower than the infomax methods.
You can also choose between the Restricted and Extended options. The restricted methods
repeat the same training method for each component. The extended methods adapt the
training method to suit the component depending on the kurtosis of the partially calculated
component.
You should note that if you choose the combination Infomax-Restricted then only components with positive kurtosis are calculated.
The data in the selected interval is stored in the main memory of the computer for further processing. If the volume of data in the interval exceeds the size of the available main memory,
the maximum possible amount of data is stored and processed. Consequently, the more
main memory the computer has available, the better the ICA transform works. We also recommend that you close other applications to make more memory available for the Analyzer.
[BS95] A.J. Bell, T.J. Sejnowski, An information-maximation approach to blind separation and
blind deconvolution. Neural Computation 7 (1995), 1129-1159.
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7.3.2
Summary

Inverse ICA

The Inverse ICA transform is used to apply the inverse of an ICA matrix directly to the ICA node
or to its subnodes (child nodes). The transform makes it possible to reconstruct the EEG
channel in the time domain on the basis of the selected components. It is only possible to
use the transform if the Correction After Finish option has not been selected in the ICA node.
In principle, it is possible to calculate the inverse ICA matrix with the assistance of the Linear
Derivation transform. However, the Inverse ICA transform offers the following benefits:
 It is not necessary to store the inverse matrix calculated by the ICA transform in a sepa-

rate file. The ICA Inverse transform reads the inverse ICA matrix directly from the history
node. This means that it is not necessary to import and export inverse ICA matrices.
 In the same way as in the ICA transform, you can use semiautomatic mode to exclude un-

wanted ICA components.

Prerequisites for use

Figure 7-81. Inverse ICA, sample branch for inverse ICA

All the following conditions must be met to run the transform:
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 u The Inverse ICA transform can only be applied to a node if the branch in which the node

is located contains an ICA node above it (see Figure 7-81). In addition, no corrected channel data must have been calculated in the ICA node. This means that in the ICA transform's semiautomatic mode, the Show Correction After Finish box must NOT be checked
before you have exited this mode by choosing Finish (see window detail). You are, however, allowed to modify the ICA components by applying other transforms (e.g. segmentation).
 The Inverse ICA transform can only be applied to a node if the node has the same number

of channels as the closest ICA node above it in the branch.
 Since the resulting inverse ICA node contains EEG channel data, the transform can only

be used once in one and the same branch of the history tree.
 If the branch contains a number of ICA nodes, the Inverse ICA transform uses the corre-

sponding inverse ICA matrix of the closest ICA node. This means that if you want to use
the inverse ICA matrix of another ICA node in the branch, this is only possible by inserting
a further branch at the required location in the branch.
To call the transform, choose Transformations > Frequency and Component Analysis >
Inverse ICA.

Procedure

Figure 7-82. Inverse ICA, dialog box

The Semiautomatic Mode check box allows you to specify whether semiautomatic mode is
to be used when running the transform.
If you do not run the transform in semiautomatic mode, the inverse ICA matrix is applied to
the data set without excluding components.
Semiautomatic mode works in the same way as semiautomatic mode for the ICA transform
except that the Recalculate and Show Correction After Finish options are not available (see
Figure 7-83).

Semiautomatic mode
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Figure 7-83. Inverse ICA, semiautomatic mode

If you did not use semiautomatic mode to generate the parent ICA node, semiautomatic
mode for the Inverse ICA transform has the following default values:
 All components are marked green in the table.
 The User Comments column of the table is empty.

If you used semiautomatic mode to generate the parent ICA node, semiautomatic mode for
the Inverse ICA transform has the settings and comments made there. The function of the
Overlay with Complete Data check box corresponds to that of the Overlay with Original Data
check box in semiautomatic mode for the ICA transform. The box has a different name here
because it is possible that other transforms that have been executed may have modified the
original data set. In this case, the overlay is created with the current data.

7.3.3
Summary

FFT Analysis

The Fourier transform converts data from the time domain to the frequency domain. In other
words, the resulting data indicates the extent to which the individual frequencies between 0
Hz and half of the sampling rate are present in the EEG. The Fast Fourier Transform (FFT) is an
efficient (fast) algorithm that computes the discrete Fourier Transform. The FFT algorithm assumes that the number of data points in the data intervals is a power of two. In order to be
applied to data intervals of arbitrary length, those intervals are padded with zeros.
For
detailed information, refer to section "Frequency resolution and interpolation" as of
page 317.
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In principle, no previous processing steps are required before the transform is used. We nevertheless recommend that you run the FFT on segmented data. Segments should have equal
length.

Prerequisites for use

To call the transform, choose Transformations > Frequency and Component Analysis > FFT
Analysis.

Procedure

Figure 7-84. FFT, dialog box

Under Resolution, you can specify the frequency resolution (in Hz) of the FFT-transformed
data set. You can choose between two options: Maximum resolution, which depends on the
number of data points in a segment and the sampling rate. Other Resolution is an arbitrary
spectral resolution defined by the user.
For detailed information, refer to section "Frequency resolution and interpolation" as of page 317.
Under Output, you can specify the data type and units of the desired output. You can choose
between the following data types: Voltage [μV], Voltage Density [μV/Hz], Power [μV2] and
Power Density [μV2/Hz].
If the options Voltage Density or Power Density are selected, the spectral line values are
scaled as if they were calculated with spectral resolution of 1 Hz. This permits comparisons
between FFT analyses that have been carried out with different spectral resolutions. To this
end, the voltage or power values are divided by the spectral resolution.
If you check the box Produce Complex Output, the transform generates complex data. You
should use this option whenever you want to further process the data resulting from the FFT
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with transforms that take into account both the spectral line values and the phase information. The Coherence transform is one example of such an application.
The Use Full Spectrum checkbox allows you to specify whether you want to use one or both
halves of the spectrum to calculate the spectral line values. When both halves are used, the
spectral line values are doubled. This is of particular significance when power spectra are
calculated, since this option allows both definitions of spectral power (μV2 or μV2/2) to be
taken into account. If you check the box Use Full Spectrum, the resulting power spectra behave in accordance with the Parseval theorem, which states that the total signal power in the
frequency domain equals the total variance of the signal in the time domain.
In EEG research it is sometimes desired to analyze relative measures such as the change of
spectral power values in comparison to the power in a certain spectral range (or relative to
the full power spectrum). This can be achieved by normalizing the spectral line values. To
this end, each spectral line value in the entire segment is divided by the value of the total
area of the spectrum within this frequency range and multiplied by 100. As a result, a relative
distribution of the individual spectral lines is provided, allowing to compare changes in the
relative spectral distribution across segments and channels. Please note that, since the total
area of the spectrum is data-dependent, the normalization factor may differ from segment to
segment and channel to channel.
In the text boxes Interval Start [Hz] and Interval End [Hz] you can enter the lower and upper
limits of the normalization range. The minimum lower limit is set to 0.5 Hz, since slow EEG
components under 0.5 Hz might be affected by non-neural artifacts which are extremely unstable from segment to segment.
Band comparisons, such as the relative alpha activity or the alpha slow wave index, can thus
be easily calculated using this option. Normalization also makes it much easier to calculate,
for example, the spectral corner frequency.

Window function

Since the FFT method assumes that the segment repeats itself periodically, artifacts occur in
high frequency ranges due to discontinuities at the segment boundaries. By applying a window function to the data prior to performing an FFT, these artifacts can be reduced. In the
group Data Window, you can select the type of the FFT data window. You can choose between
the window types: No Window, Hanning Window and Hamming Window. In the text box Window Length [%], you can specify in percentage values which fraction of the segment will be
affected by windowing.
Due to the fact that signal strength is reduced as a consequence of windowing, it might be
desirable to compensate for this weakening effect. If you check the box Apply Variance Correction, the power in the EEG signal is identical before and after the application of the FFT
transform, even when a window function is used.
The options Periodic and Symmetric allow you to configure the borders of the window function. Periodic configures the right-hand border of the window in such a way as to optimize
the analytical characteristics of the window for the periodic continuation of the window.

Transforms in the Frequency and Component Analysis group 317

Symmetric configures the right-hand and the left-hand borders of the window function to be
symmetric.
The checkbox Use Compression allows you to specify whether you want to store compressed
or uncompressed data. Compressed data saves storage space in the history file but is not as
accurate as uncompressed data. If you decide to compress the data, you can specify the resolution of the data in nanovolts (1000 nV = 1 μV) in the text box Resolution [nV]. The lower
the resolution of the data (higher values), the higher the compression effect. Consequently,
less storage space is required.

Data compression

The output values are scaled in such a way that a sine wave of 1 Hz and an amplitude of 100
μV result in a value of 50 μV at 1 Hz when the output data type is Voltage, calculation takes
place without a data window (No Window) and only half of the spectrum is computed (the
box Use Full Spectrum is unchecked). If the box Use Full Spectrum is checked, this results in
the original value of 100 μV at 1 Hz.

Additional information

The FFT transform is executed separately for each segment. The total number of data points
in a segment does not have to be a power of two, because in this case, the segment length
is internally extended to the next power of two. The corresponding number of zeros is added
to the existing segment data. In this case the Maximum resolution is computed as:

Frequency resolution and interpolation

sampling rate
-----------------------------------------------------------------------------------------------------------------------extended segment length (in data points)
For instance, if the sampling rate is 1000 Hz and the segment length is 1 s (or 1000 data
points), then the extended segment length is 1024 data points, and the Maximum resolution
is:
1000
-------------- = 0.977 Hz
1024
This process, which is also known as zero-padding, is mathematically equivalent to an interpolation in the frequency domain. As a result, a frequency spectrum that has a higher resolution than the original data set is obtained. In this case, no data is lost, and the resulting
spectra do not contain artifacts.
However, it cannot be expected that using this process on data with any segment length and
sampling rate will always produce comparable results, since the FFTs calculated in this way
differ in terms of the total number of data points and thus also in terms of the information
content of the input data. This inevitably leads to differences in the resulting spectra. The
more zeros are appended to the segment by padding, the larger the difference in the resulting spectra. However, spectral data obtained after padding might be suitable for visual data
inspection.
To avoid interpolation of FFT data at a given resolution, the number of data points in the segments should be a power of two and you should select the option Maximum resolution. As
padding is not necessary in this case, the Maximum resolution is computed as:
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sampling rate
1
------------------------------------------------------------------------------------------- = ---------------------------------------------------------------------------------segment lenght (in data points)
segment lenght (in seconds)
For instance, if the sampling rate is 1024 Hz and the segment length is 1 s (or 1024 data
points), then the Maximum resolution is:
1024
1
-------------- = ------- = 1 Hz
1024
1s
If you select the option Other Resolution and a custom frequency resolution different from
the maximum resolution is entered into the corresponding text box, then the resulting spectra are obtained by post-FFT interpolation of the data in the frequency domain.
This can be illustrated by applying the FFT transform to segmented EEG data with a sampling
rate of 1024 Hz and a segment length of 4096 points. In this case the maximum spectral resolution is 1024/4096 = 0.25 Hz and the resulting spectra are computed based on the full
segment length of 4096 points. If you enter a custom resolution of 1 Hz = 4 x 0.25 Hz, postFFT interpolation is applied by integrating 4 spectral line values. If the resolution ratio is not
an integer, an interpolation across spectral lines takes place.
In some cases, a custom frequency resolution might lead to an interpolation which is identical to applying FFT to padded segments. Therefore, the resulting spectra do not contain artifacts.
However, a better alternative to entering a custom resolution is to achieve the corresponding
maximum resolution by appropriately adjusting the segment length to a power of two. In this
case, the spectra obtained by an FFT transform with a maximum resolution are not equal to
the spectra resulting from a matching custom resolution. Please be aware that this is an inevitable result of the differences in the information content of the input signal. Therefore,
spectra obtained by post-FFT interpolation are suitable above all for visual data inspection
and should not form the basis for subsequent calculations.
This limitation applies particularly to the calculation of complex FFT values when a resolution
other than the maximum spectral resolution is entered. This is because not only the spectral
line values, but also the phase information have to be interpolated. The phase information
is usually fairly continuous. This continuity can be impaired by interpolation and make the
result of a subsequent phase analysis method (for instance coherence) questionable.

Windowing of segments

In the FFT transform, it is assumed that the output signal is repeated periodically. Since this
requirement is generally not met when EEG sections are transformed, the difference between
the voltage level at the beginning and end of the segment is a point of discontinuity that
causes the FFT-transformed data to be corrupted.
To reduce this effect, you can place a data window over the segment to be transformed. This
data window damps the EEG data at its borders.
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The window function (t) is mathematically expressed by the formula:
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P is a value between 0 and 1, and corresponds to the percentage value specified in the Window Length [%] text box. The time point t lies within the data segment of length SL.
If the option Hanning Window is chosen,  and  have the same value of 0.5. For the option
Hamming Window apply values of  = 0.54 and  = 0.46.
You can specify the range in which the window function is used as a percentage. Note that
0% (when P approaches 0) refers to the rectangular window or option No Window (Figure 785, left panel), where no values in the whole segment are damped by the data window. 100%
means that:
SL
P = 1 and t 1 = t 2 = ------2
In this case all values are damped by the data window, except the value in the middle of the
segment, which matches the original data value (Figure 7-85, central panel). Note that the
case P = 1 corresponds to the original definition of Hanning and Hamming Windows. Any
percentage value between 0 and 100% (0 < P < 1) leads to no damping of values in the middle time interval t1 < t < t2, while values are increasingly damped when approaching the borders of the segment (Figure 7-85, right panel). The lower the specified percentage, the
smaller the range affected by the window function. This principle is displayed graphically in
the Data Window group of the dialogue.
Figure 7-85. FFT, window function (t). For these three cases  == 0.5.
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It follows from the way in which the data window works, as described above, that the overall
signal and thus the total variance of the EEG signal are weakened by the window, particularly
toward the borders. Accordingly, the use of a data window also results in the damping of the
data produced by the FFT transform.
For this reason, before the FFT transform is applied, a correction factor is calculated for the
data window and window width used. This factor is used to multiply the data on completion
of the FFT transform. This correction ensures that the total variance of the FFT-transformed
signal matches the total variance of the source signal.

7.3.4

FFT Inverse

Summary

The FFT Inverse transform allows data to be converted back from the frequency domain to the
time domain. This is generally desirable when artifacts or parts of the EEG that are not required can be removed more easily from the frequency-transformed data, but further processing is to take place in the time domain. A typical example of this is the use of userspecific filters, which is considerably easier and clearer in the frequency domain.

Prerequisites for use

The FFT Inverse transform is typically used after
 Segmentation
 FFT

Settings in the FFT dialog box

To enable a Fast Fourier transform to be inverted accurately, you have to make certain parameter settings in the FFT dialog box (see Figure 7-86):
 Select the Voltage option.
 Check the Produce Complex Output box.
 Do not check the Normalize Segments box.

We also recommend that you make the following settings in the FFT dialog box:
 You should select the No Window option. If you do not do this, the output data of the FFT

Inverse transform is multiplied with the window function.
 You should not check the Use Compression box. This is because the data can no longer

be recovered in its entirety following compression; only an approximation is possible.
 You should not select the Other Resolution [Hz] option. If you do, the inverse FFT can only

reconstruct the data converted by an interpolation process at a different sampling rate.
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Figure 7-86. FFT, parameter settings for the inverse FFT

Once you have made the required settings in the FFT dialog box, you call FFT Inverse by
choosing Transformations > Frequency and Component Analysis > FFT Inverse.

Procedure
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Figure 7-87. FFT Inverse, dialog box

Because the FFT in the Analyzer adds the value 0 to segments whose length is not a power of
two, you can specify a pruning parameter under FFT Segment Pruning. This value determines
the length to which the segment is truncated in the time domain. There are four options for
the pruning parameter:
 No Segment Length Pruning. The segment is not truncated, and any zeros added are re-

tained.
 Prune Based on Time. Time-based truncation. You can enter a value for this.
 Prune Based on Data Points. Data point-based truncation. You can enter a value for this.
 Prune Automatically. Automatic truncation. The FFT Inverse transform stores the invisible

information about the original length of the segments (i.e. before zeros were added to the
data set) in the data set node.
For each channel and segment, the FFT stores a value that is required for the execution of the
inverse FFT in the data set node. For this reason, the number of segments, the number of
channels and the channel sequence must not be changed by the transforms executed between the FFT and the inverse FFT. Otherwise, it is no longer possible to assign the value to
the appropriate channel or segment.
By default, the required data is calculated at runtime without any intermediate storage. However, if you check the Store Data in History node box, the data is saved in a history node in
order to optimize the performance of subsequent modules.
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In addition, if you check the Compress Stored Data box, the data can be compressed with
the specified resolution. You can also specify the required resolution in the Resolution text
box.

7.3.5

Wavelets

The Wavelets transform is used to perform a spectral analysis of EEG signals. Unlike the FFT,
which calculates the entire frequency spectrum for a given interval, the Wavelets transform
performs a local analysis of non-stationary signals in the time-frequency domain. Accordingly, it provides simultaneously the frequency content of the signal in the vicinity of each time
point. You can use this transform to analyze short-lasting changes in the frequency spectrum
of the EEG signal over time.
FFT analysis cannot detect short-lasting spectral changes, because the FFT depicts the frequency spectrum over a longer time interval. A typical example of this are fast changes in the
gamma band ([TBBPP98] and [TBB99]).
Figure 7-88. Wavelets, frequency layers and time-frequency points

To depict the relationship between the time course of the EEG signal and the frequency spectrum, a dedicated data type is used: the time-frequency domain. In the time-frequency domain, the temporal evolution of the signal at multiple frequencies is displayed. In this
display, the frequencies are stacked on top of each other as frequency layers. In each layer,
output values at each time-frequency point are depicted according to a linear color scale (see
Figure 7-88). This particular example shows a spectral power increase of 650 μV2 at the time-

Summary
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frequency point (731 ms, 9.285 Hz).
Section 4.2.7 as of page 128.

For detailed information, refer to the corresponding

Several methods employing different wavelet functions are described in the literature. The
Wavelets transform in the Analyzer allows you to use the following methods:
 Continuous Wavelet Transform with Morlet, complex Morlet, or Mexican Hat functions
 Invertible Discrete Wavelet Transform with Haar or Daubechies functions
 Discrete Wavelet Transform with Haar or Daubechies functions

For information on the individual methods and Wavelet functions, refer to the "Methodological principles" section as of page 334.
After selecting the Wavelet method, the user should specify other parameters such as the
number of frequency layers. Other settings, such as Wavelet Normalization, Data Normalization, Baseline Correction and Z-Transform, depend on the selected Wavelet method.
Furthermore, the Wavelets transform allows you to calculate the Inverse Wavelets Transform, but only for data produced by the Invertible Discrete Wavelet Transform.

Procedure

To call the transform, choose Transformations > Frequency and Component Analysis >
Wavelets.
In the first dialog, you select a Wavelet Method: Continuous Wavelet Transform, Invertible
Discrete Wavelet Transform or Discrete Wavelet Transform (see Figure 7-89).
For information on the individual methods, refer to the "Methodological principles" section as of
page 334.
Please note that the layout and the amount of subsequent dialog pages depend on the selected Wavelet method. Also, the subsequent dialog differs depending on whether you apply
the Wavelet transform to unsegmented or segmented data.
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Figure 7-89. Wavelets, selection of method

Figure 7-90. Wavelets, Continuous Wavelet Transform, parameter settings

Continuous Wavelet Transform
parameters
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If you select the method Continuous Wavelet Transform then you are able to choose between
three different types of wavelets in the Wavelet group of the first page of the dialog: Morlet
Complex, Morlet and Mexican Hat (see Figure 7-90). Time-frequency analysis of EEG signals
is commonly done with Morlet Complex Wavelets. These wavelets are sinusoids modulated
in time by Gaussian bells. Therefore, local spectral changes can be easily tracked by them.
For detailed information on the individual methods, refer to the "Methodological principles" section as of page 334.
You can define the desired frequency range in the Min. Frequency [Hz] and Max. Frequency
[Hz] text boxes. Under Frequency Steps, you can specify the number of frequency layers to be
calculated.
A logarithmic or linear subdivision of the frequency range is achieved by selecting the Logarithmic Steps or Linear Steps options, respectively.
You can enter the Morlet Parameter in the corresponding text box in order to select a specific
mother Morlet wavelet. This parameter directly affects the trade-off between time resolution
and frequency resolution. For a given frequency, a larger Morlet Parameter entails a better
frequency resolution to the expense of time resolution and vice versa.
In the Wavelet Normalization group you can select from three different methods: Instantaneous Amplitude, Uniform Scale Power and Relative Wavelet Power.
For information on
the individual methods, refer to the "Methodological principles" section as of page 334.
Please note that the Instantaneous Amplitude method is not available if the selected Wavelet type is Mexican Hat.
Depending on the parameters selected above, the content displayed by the Layers table and
the two graphics for Frequency Domain and Time Domain will adapt accordingly.
According to the value in the Frequency Steps text box, the Layers table provides details on
the corresponding frequency layers, e.g. Central Frequency, Low and High frequency borders, Spectral Bandwidth (2σf), and Wavelet Duration (2σt). The Spectral Bandwidth and
Wavelet Duration estimate the frequency and time resolution that is accomplished for the
current Wavelet analysis. You can use the Show Gauss Borders and Show Filter Borders options to display the corresponding estimated lower and upper borders of a given frequency
layer. These values reflect the accuracy with which spectral changes are localized in the timefrequency plane.
For detailed information on these quantities, refer to the "Methodological principles" section as of page 334.
The Frequency Domain graph provides a visualization of the frequency layers. A Gaussian
function is associated to each layer. It weights the contribution of each frequency to the given layer. The peak of each Gaussian corresponds to the Central Frequency, which is displayed together with the Spectral Bandwidth at the bottom of the graph. The graph also
contains a vertical green bar which can be moved continuously along the frequency range.
The values for Central Frequency and Spectral Bandwidth at the bottom of the graph are up-
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dated accordingly. If you select the Jump to Frequency Layers checkbox, the vertical green
bar can only be moved in discrete steps from one Gaussian peak to the next.
The Layers table and the Frequency Domain graph interact dynamically. For instance, when
a layer is selected in the table, the corresponding Gaussian function will be highlighted in
the graph. When a Gaussian function is selected in the graph, the corresponding layer will be
highlighted in the table.
The Time Domain graph provides a visualization of the selected Wavelet function. If Morlet
Complex is used, two curves (colored as black and red) corresponding to the real and imaginary parts of the Complex Wavelet function are displayed. The quantities Wavelet Duration
and Wavelet Length are displayed at the bottom of the graph. For each frequency, the quantity Wavelet Length (2πσt) provides the time interval containing as many Wavelet cycles as
specified by the Morlet Parameter. This quantity estimates the length of the sliding time window used to compute each value in the time-frequency domain, by convolution of the signal
with the Wavelet function.
Please note that the Wavelet Duration and Wavelet Length are not available for the Mexican
Hat Wavelet type.
For information on these quantities, refer to the "Methodological principles" section as of page 334.
When you select a layer or row in the Layers table, or if you select the corresponding Gaussian in the Frequency Domain graph, the Wavelet function will be rescaled accordingly. For example, the selection of a larger Central Frequency will result in smaller values for Wavelet
Duration and Wavelet Length. Accordingly, the Wavelet function itself will be narrower.
You can rescale the Frequency Domain and Time Domain graphs horizontally and vertically
using the and buttons.
Please note that the options available on the first page of this dialog closely interact, so that
any change in one parameter will result in a new computation and graph visualization. As
shown in Figure 7-90 the frequency layer 20 is selected, which corresponds to 9.285 Hz as
the Central Frequency. A Morlet Parameter of 5 implies that at this frequency the Spectral
Bandwidth is 3.714 Hz. Therefore, the Low and High Gauss Borders of this frequency layer
are 7.428 Hz and 11.142 Hz respectively. A Morlet Parameter of 5 also implies that the
Wavelet Length is 538.519 ms and the Wavelet Duration is approximately 171.416 ms. For
this example, spectral changes can then be localized in the time-frequency plane with an accuracy of 3.714 Hz and 171.416 ms. This specific selection of options and parameters enFor detailed information on these
tails a time-frequency view as shown in Figure 7-88.
calculations, refer to the "Methodological principles" section as of page 334 and Figure 798.
In the Output Values group of the next page of the dialog, you can specify supplementary
computations on the results of the Wavelet transform. If the Wavelet transform is applied to
segmented data, you can also select additional options. For example, you can baseline-cor-
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rect the Output Values relatively to a specified time interval. For non-segmented data, these
options are not available.
Figure 7-91. Wavelets, Morlet Complex Wavelet, output value settings

If the Morlet Complex Wavelet is selected, the available options for Output Values are (see
Figure 7-91):
 Wavelet Coefficients - Complex Values [μV]. The wavelet coefficients are comput-

ed.These Output Values are complex numbers and contain both amplitude and phase information for each time-frequency point. You should select this option if you are
interested in exploring phase dynamics (e.g. computation of the Phase Locking Factor
(PLF)) [TBBDP96]. Note that while the Wavelet transform results in complex values, the
displayed values in the time-frequency view are the spectral amplitudes (see explanation
below).
 Squared Wavelet Coefficients - Complex Values [μV2]. The squared wavelet coefficients

are computed. Output Values are complex numbers, and preserve the spectral power information for each frequency layer and time point. Phase values are doubled. Please note
that while the Wavelet transform results in complex values, the displayed values in the
time-frequency view are the spectral power (see explanation below).
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 Spectral Amplitude - Real Values [μV]. The absolute values of the wavelet coefficients

are computed. Output Values are real numbers and contain only information about spectral amplitude for each frequency layer and time point. Phase information is lost.
 Spectral Power - Real Values [μV2]. The squared absolute values of the wavelet coeffi-

cients are computed. Output Values are real numbers and contain information about the
spectral power for each frequency layer and time point. Phase information is lost.
Figure 7-92. Wavelets, Morlet Wavelet, output value settings

If Morlet or Mexican Hat are selected, then the following options for Output Values are available (see Figure 7-92):
 Wavelet Coefficients [μV]. The wavelet coefficients are computed at each time-frequency

point.
 Squared Wavelet Coefficients [μV2]. The squared value of the wavelet coefficients are

computed at each time-frequency point. This quantity expresses the Instantaneous Power of the signal at each frequency layer and time point.
 Unsigned Wavelet Coefficients [μV]. The absolute values of the wavelet coefficients are

computed at each time-frequency point. This quantity expresses the Instantaneous Amplitude of the signal at each frequency layer and time point.
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If the Wavelet transform is applied to segmented data, you can specify the reference intervals for Normed Output, Baseline Correction and Z-Transform (see Figure 7-92 and Figure 795). You define the reference intervals in time or data points, relatively to the "Time Zero"
marker of each segment. For example, if your data is segmented from -500 ms to 1000 ms,
and you want to use the entire prestimulus interval as the reference interval, then you must
please specify -500 ms for the Start and 0 ms for the End of the interval.
Please note that the Z-Transform is not available if the Output Values are complex numbers
or if the options Normed Output and/or Baseline Correction are selected. Moreover, if the
options Normed Output and Baseline Correction are simultaneously selected, and the same
reference interval has been selected for both, then a warning message is displayed stating
that the resulting data might be invalid, since Data Normalization is applied to an interval
where the mean of the data is zero.
For detailed information on the Normed Output,
Baseline Correction and Z-Transform functions, please refer to the "Methodological principles" section as of page 338.

Invertible Discrete Wavelet
and Discrete Wavelet parameters

If the Invertible Discrete Wavelet or the Discrete Wavelet were selected, the Wavelet type can
be selected on the first page of the subsequent dialog (see Figure 7-93). You can choose between the Haar wavelet and several Daubechies wavelets.
Figure 7-93. Wavelets, Invertible Discrete Wavelet and Discrete Wavelet, parameter settings
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Based on the sampling interval and the segment length of the data, the transform calculates
the maximum number of potentially available frequency layers and displays these in the Layers table.
Please note that the frequency intervals (between Low and High) displayed in the table
should only be understood as guideline values. Actually, the frequency layers extend beyond
the indicated limits.
In the Start Level and End Level text boxes, you can specify the frequency range for which you
want to perform the calculation.
If you apply the transform to non-segmented data, the dialog contains no further pages. If
you use segmented input data and choose the Invertible Discrete Wavelet method, you can
select a Window Function and Window Length on the next page of the dialog in the same way
For detailed information on the Window Funcas for the FFT transform (see Figure 7-94).
tion, refer to Section 7.3.3 as of page 316).
Figure 7-94. Wavelets, Invertible Discrete Wavelet and Discrete Wavelet, window function

If the Wavelet transform is applied to segmented data, you can specify the reference intervals for Normed Output, Baseline Correction and Z-Transform on the next page of the dialog
Please see also Figure 7-92 on page 329 and the associated explana(see Figure 7-95).
tions.
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Please note that Output Values can only be specified for Discrete Wavelets. For Invertible
Discrete Wavelets, by contrast, these options are not available.
Figure 7-95. Wavelets, Discrete Wavelet, output value settings

Inverse Wavelets Transform

You can apply the Inverse Wavelets Transform to data sets which have been generated using
the Invertible Discrete Wavelet method and contain more than one frequency level. To do
this, you apply the Wavelets transform to the corresponding Wavelet node. The following dialog box is displayed (see Figure 7-96).

Transforms in the Frequency and Component Analysis group 333

Figure 7-96. Wavelets, Inverse Wavelets Transform

The table contains all frequency layers available for the current data set. You cannot select
any frequency layers that you have not used for the calculation of this Wavelet node during
the direct Wavelet Transform. Select or unselect frequency levels using the checkboxes in
the Enabled column.
You can enter a custom weighting factor in the Factor column. The default weighting factor is
1. A weighting factor 0 is equivalent to disable the level. In this case, this frequency level
does not contribute to the result of the Inverse Wavelets Transform.
Please note that the original signal can only be recovered if you selected the maximum number of frequency levels in the Invertible Discrete Wavelet transform. In addition, Data Windowing must not have been applied and the Normed Output, Baseline Correction and ZTransform options must have been disabled. Besides, the Inverse Wavelets Transform must
also use the maximum number of levels, and all Weighting Factors must be set to 1.
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Methodological principles

The Wavelet transform is based on a function ψ(t) , the so-called Mother Wavelet. The mother
wavelet ψ(t) is shifted and scaled to define the family of functions
t–b
1
  a, b   t  =  --------   ------------
 a  a 
where a is the scaling factor and b is the shift. The pair (a,b) defines a point in the time-frequency domain. The value of the Wavelet transform WT(s) at the time-frequency point (a,b)
is the result of the convolution of the signal s(t) with the (daughter) Wavelet function ψ[a,b](t),
as follows:
1
t–b 
WT(s)(a, b) =  -------- s  t    ------------ dt

a 
a



For the Continuous Wavelet Transform, the following three Mother Wavelets ψ(t) are implemented in the Analyzer:
The Morlet Complex family is a set of mother wavelets which are defined by the Morlet Parameter c. According to the purpose of the user, a specific value of c should be chosen. This
parameter allows you to specify whether the uncertainty in localizing the spectral variations
is primarily reflected in the time or frequency domain.
Due to a general mathematical principle known as Heisenberg's uncertainty relation, it is not
possible to estimate the spectral variations with arbitrary accuracy in time and frequency domains since the product of the time and frequency uncertainties is bigger than a given constant. In order to obtain a higher resolution in the frequency domain, you should select a
relatively larger value for the Morlet Parameter c. In order to obtain a higher resolution in the
time domain, you should select a relatively smaller value for the Morlet Parameter c.
The Morlet Complex family of wavelets (see Figure 7-97 A) consists of complex sinusoidal
functions (real part: black, imaginary part: red) whose amplitudes are modulated by the
Gaussian bell function (cyan), as follows:
2
–t
-----------22 t i2ft
e
  t, f  = Ae
where t is time, f is frequency, and σt is the standard deviation of the Gaussian bell function
[TBBPP98].
Please note that the formulas:
f
c = -----f

c = f  2 t 

express how the Morlet Parameter c relates to the frequency f and standard deviation σt.
The quantity σf reflects the spectral dispersion (uncertainty) around a Central Frequency,
which also behaves according to a Gaussian function along the frequency axis. It is related
to the Morlet Parameter c and frequency f as shown in the formulas above.
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Figure 7-97. Wavelets, Continuous Wavelet. A) Complex Morlet, B) Morlet C) Mexican Hat

The Morlet Wavelet family (see Figure 7-97 B) consists of the real parts of the Morlet Complex
Wavelets. Consequently, the Morlet Parameter c plays a similar role in both Morlet Complex
and Morlet cases.
The Morlet Wavelet family is defined by the following formula:

  t, f  = Ae

2
–t
-----------22 t

cos  2ft 

The Mexican Hat mother wavelet (see Figure 7-97 C) is the second derivative of the Gaussian
bell function. This mother wavelet differs from zero within a limited range and approaches
zero outside this range. In theory, this allows for a better localization of the spectral variations in the time domain compared to the Morlet families.
The Mexican Hat Wavelet is defined by the following formula:
2
–t
--------2 2
  t  = A  1 – t e
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Figure 7-98. Wavelets, Morlet Complex Wavelet, time-frequency trade-off

Figure 7-98 provides a schematic presentation of all parameters and quantities (see
Figure 7-90) that were used to obtain the time-frequency view shown in Figure 7-88. An increase of Spectral Power is shown at the time-frequency point (731 ms, 9.285 Hz) as displayed on the top-left graph. The red box around this point displays the Spectral Bandwidth
(3.714 Hz) and Wavelet Duration (171.416 ms). These quantities are associated to the standard deviation of the Gaussian bells in time (bottom-left graph) and frequency (top-right
graph) domain. The Wavelet Length (538.519 ms) estimates the time interval which is taken
into account to compute a value at each time-frequency point. This is illustrated by the red
bar at the basis of the Gaussian in the time domain.
The Continuous Wavelet Transform produces a high level of redundancy of the information
in the time-frequency domain because the calculations for neighboring points overlap. Discrete Wavelets solve this problem, since values are calculated only at selected points in the
time-frequency domain. However, this approach bears the problem that results cannot be
easily interpreted visually since only the following shifts and scalings are considered:
–m
--------- 
m
2
t – n2 b
  m, n   t  = 2   --------------------------
 2m 
The mother Wavelets ψ used to compute the Discrete Wavelet Transform have the property
that the corresponding shifts and scales ψ[m,n] always build a family of orthogonal functions.

Transforms in the Frequency and Component Analysis group 337

This produces a basis of Wavelet functions. The calculation of the Discrete Wavelet Transform is nothing other than the representation of a given function relatively to this basis.
The Daubechies-type mother Wavelets implemented in the Analyzer compute the Discrete
and Invertible Discrete Wavelet Transform. They are determined by a numerical index N
which is always an even number between 2 and 20.
In the case of general Daubechies wavelets, it is not possible to specify any closed formula.
The required N coefficients are determined by approximation. If N = 2, the resulting
Daubechies wavelet is also known as Haar wavelet:

 1 if  o  t < ---1 

2


t = 
 1  t < 1
 -1 if  --
2

 0 otherwise

Figure 7-99 below represents time on the horizontal axis and frequency on the vertical axis.
The frequency levels are scaled logarithmically when the transform is used with Discrete
Wavelets.
Figure 7-99. Wavelets, Discrete grid in the time-frequency domain
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Optional calculations

The absolute value is always a real number; in the case of real numbers x, the absolute value
is a positive number denoted by |x|, representing the number x without any sign. In the case
of complex numbers, which comprise a real part u and an imaginary part v, the absolute value is calculated as follows:
u + vi =

2
2
u + v 

The square of complex numbers is also complex:
2
2 2
 u + vi  =  u – v + 2uvi 

Data Normalization and Baseline Correction

Baseline correction calculates the average of the reference interval for each frequency layer
and subtracts this average from each point in the respective layer.
If you select Normed Output, for each frequency layer the absolute values within the reference interval are summed up and multiplied with a factor that represents the ratio of the reference interval length to the full interval length, resulting in a reference value. Finally, all
values in the layer are divided by this quantity. If you select Baseline Correction in conjunction with Normed Output, Baseline Correction is performed first, and Data Normalization is
performed based on the baseline-corrected data.
The Z-Transform is a combination of Baseline Correction and Norming, both of which are
performed using the reference interval specified in the text boxes of the Z-Transform. The
norm used for the Z-Transform is calculated using a Euclidean norm instead of the sum of
absolute values. The Z-Transform is not available for complex data.

Wavelet normalization

Wavelet Normalization consists of a multiplication of the Wavelet function by a normalization coefficient. Three methods are available:
 Instantaneous Amplitude (Gabor Normalization). If the Wavelet function is normalized

using the Gabor normalization factor A as follows:
1
A = ------ 2
--t 
then the amplitude of the signal at each frequency layer is given as output. For instance,
the sum of a 3 V oscillation at 10 Hz and a 5 V oscillation at 20 Hz will be wavelet-transformed into a Wavelet spectrum with two peaks with amplitudes 3 V and 5 V centered at
10 Hz and 20 Hz respectively.
 Uniform Scale Power (Unit Energy Normalization). This method normalizes the Wavelet

function in such a way that all frequency levels have the same energy value of 1. In this
case, the Wavelet power spectra of the analyzed signal can be compared across all frequency levels. The formula for this normalization is as follows:
1 1
A = ---------- ----------4  t
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 Relative Wavelet Power (Unit Scale Power Sampling Rate). This method is similar to Uni-

form Scale Power, but the factor depends on the square root of the sampling rate SR as
follows:
1 1
A = ---------- ----------- SR
4  t

[Bri08] R. Brinks, On the convergence of derivatives of B-splines to derivatives of the Gaussian function, Comp. Appl. Math., 27, 1 (2008).
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7.3.6

Wavelet Extraction

The Wavelet Extraction transform allows you to extract a frequency level (layer) from a wavelet data set in order to observe it or further process it separately. The data set obtained as a
result of this transform is a pure time domain data set contrasting with the time-frequency
domain of the wavelets.

Summary

The transform is applied following the Wavelet transform.

Prerequisites for use
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Procedure

To call the transform, choose Transformations > Frequency and Component Analysis > Wavelet Extraction.
Figure 7-100. Wavelet Extraction, dialog box for selecting a layer

In the Layer text box, you can specify the layer to be extracted from the data set. The table
below this lists the layers with their filter limits.

7.3.7
Summary

PCA (Principal Component Analysis)

On the one hand, a principal component analysis is used to reduce the data volume. On the
other, it makes it possible to extract hypothetical variables which can be used to characterize a data set. It groups together covariant variables of a data set that can be interpreted as
a single factor.
PCA is a secondary transform. In other words, it stores its results in the current workspace as
secondary history files.
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You can use Analyzer 1 to open PCA nodes created in Analyzer 2 without problems. However,
this is only possible if at least one of the history nodes that was used for the PCA calculation
is present in the workspace. The reason for this is that in Analyzer 1, PCA recalculates the
data each time the corresponding PCA node is opened.

Downward compatibility

In contrast, the PCA transform in Analyzer 2 saves the calculated data set in the node. This
means that you can open the PCA node whenever you want and even if you have deleted all
the history nodes that were used to calculate the PCA.
In addition, in Analyzer 2, the behavior of PCA nodes created in Analyzer 1 differs from that
of PCA nodes calculated in Analyzer 2 in terms of the data that is forwarded to the child
nodes. The Analyzer 2 nodes forward the PCA components segment by segment. The Analyzer 1 nodes forward only the loadings as standard data (i.e. as graphs).
If you want to apply the transform to segmented, averaged, ... data, this is only possible if all
the segments – even those from different data sets – have the same length.

Prerequisites for use

If you want to apply the transform to non-segmented data, the data must be of a uniform
length (in this case, each data set is viewed as a single segment).
To call the transform, choose Transformations > Frequency and Component Analysis > PCA.

Procedure

On page 1 of the dialog, you can specify whether channel or time point-based PCA calculation is to be performed (see Figure 7-101).

Dialog page 1: General settings
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Figure 7-101. PCA, dialog page 1, General settings

If you select the Variables at Channels option then the channels are interpreted as variables.
If you select the Variables at Time Points option then the time points are interpreted as variables.
If you have selected the Variables at Time Points option, the Condense Time Domain With a
Factor of: checkbox and associated text box have a special significance. If you select this
checkbox, the time domain is subdivided into groups of points of equal length. The length of
each group corresponds exactly to the value in the Condense Time Domain With a Factor of:
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text box (this value is always between 1 and 1000). This means that the length of the time
domain in points is reduced by this factor, and the sampling interval is increased by this factor. The use of a condensing factor reduces the volume of data and thus accelerates processing.
If you check the Use VARIMAX Rotation box, an optional method is used to rotate the inverse
of the covariance matrix in its space. The purpose of this rotation is to make the differences
between PCA components clearer.
In the Output File text box, you enter the name of the secondary history node that is to be
created.
On the second page of the dialog, you select the history files that are to be included in the
PCA (see Figure 7-102).

Dialog page 2: Selecting the
history files
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Figure 7-102. PCA, dialog page 2, Selecting the history files

If you select the Use Whole Workspace option, the history nodes are searched for in both primary and secondary history files. If you select the Select Individual History Files option, on
the other hand, you can select specific history files.
If you check the Primary History Files Only box, you can restrict the selection to primary history files.
In the Selection Filter text box, you can enter a filter to be used to search through the history
file names. The placeholders "?" (for an unknown letter) and "*" (for an unknown part of a
word) are available to you for this. When you click Refresh, the filter is applied to the history
files that are available for selection.
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On the third page of the dialog, you select the history nodes (see Figure 7-103).
Figure 7-103. PCA, dialog page 3, Selecting the history nodes

Dialog page 3: Selecting the
history nodes

In the Selection Filter text box, you can enter a filter to be used to search through the history
node names. The placeholders "?" (for an unknown letter) and "*" (for an unknown part of a
word) are available to you for this. When you click Refresh, the filter is applied to the history
nodes that are available for selection.
On the fourth page of the dialog, you select the channels (see Figure 7-104).

Dialog page 4: Selecting the
channels
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Figure 7-104. PCA, dialog page 4, Selecting the channels

Dialog page 5: Calculating the
eigenvalue

On the fifth page of the dialog, you select an option for calculating the eigenvalue (see
Figure 7-105).
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Figure 7-105. PCA, dialog page 5, Calculating the eigenvalue

Under Eigenvalue Selection Criteria, you select the criterion to be used to calculate the eigenvalue:
 Take Eigenvalue 1 as Limit includes all eigenvalues greater than 1.
 Take Eigenvalue Limit includes all eigenvalues greater than the value entered in the as-

sociated text box.
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 Take a Fixed Number of Eigenvalues selects the n largest eigenvalues, where n is the val-

ue in the associated text box.
 Take Percentage of Total Variance includes the largest components in terms of variance

(eigenvalues), whose sum exceeds the percentage entered in the associated text box
(the text box can contain any value from 1 to 100).
When you have completed your input, a new history file with the corresponding name appears on the Secondary tab of the History Explorer. If the Secondary tab already contains a
file with an identical name, it is replaced with the new file.
If you open a secondary history file, a specific PCA view with a user interface appears at the
right-hand border.
In PCA nodes calculated with the Variables at Channels option selected, the components are
displayed as graphs (see Figure 7-106) and the loadings as head topographies (see Figure 7107).
Figure 7-106. PCA, display of the components as graphs when Variables at Channels is
selected
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Figure 7-107. PCA, display of the loadings as head topographies when Variables at
Channels is selected

In PCA nodes calculated with the Variables at Time Points option selected, the components
are displayed as head topographies (see Figure 7-108) and the loadings as graphs (see
Figure 7-109).
Figure 7-108. PCA, display of the components as head topographies when Variables at
Time Points is selected
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Figure 7-109. PCA, display of the loadings as graphs when Variables at Time Points is
selected

The list at the top of the user interface contains all the employed history nodes. You can easily switch between these nodes in order to move between different views of the components.
If you select the Show All Segments option, all the segments of the history node that you
have selected are displayed. If you select the Show Segment option, you can select a segment to be displayed from the associated drop-down list.
In the lower drop-down list, you can specify what is to be displayed by choosing Components
or Loadings. If you choose Loadings here, the other controls are inaccessible. This is because the loadings correspond to the lines of a square root of the inverse of the shared covariance matrix and are therefore identical for all segments and all selected data sets.
If graphs are displayed then the Clear Overlays button is available to enable you to remove
any overlays that may have been created. Note that overlays can only be created with the
channels in the grid view.
If topographic heads are displayed, you will see an additional group containing the checkbox
Show Only One Map. By checking this box, you can restrict the display to a single map. The
associated drop-down list always contains the names of the head topographies that are currently being displayed (see Figure 7-110).
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Figure 7-110. PCA, displaying a single map

A data set created by means of the Variables at Channels option is referred to as a data set
of the type "Components". A data set created by means of the Variables at Time Points option is referred to as a data set of the type "Loadings".
Each secondary history node created by the PCA transform consists of two interlinked data
sets: one of the type "Components" and one of the type "Loadings". In a history node of the
type "Components", the underlying data set is of the type "Components". The additional data
set of the type "Loadings" takes the form of a set of inserted User Properties (see Figure 7111):

Remarks
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Figure 7-111. PCA, properties of a node of the type "Components" (containing the data set
of the type "Loadings" in the form of User Properties)

In history nodes of the type "Loadings", the reverse applies (see Figure 7-112).
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Figure 7-112. PCA, properties of a node of the type "Loadings" (containing the data set of
the type "Components" in the form of User Properties)

It is necessary to understand the structure of PCA nodes in order to be able to navigate purposefully within them: The data displayed corresponds to the PCA segments in their natural
arrangement within a selected node. The segment packages, which correspond to different
selected nodes, are arranged in the same sequence as the nodes in the selection dialog. The
markers of the type "New Segment", which define these segments, have meaningful names
that take the following form: The first "New Segment" marker in a segment package has the
name of the path of the original node in the history tree. All subsequent markers of the type
"New Segment" have the ordinals 2, 3, 4 and so on as their names. These markers also contain the following User Properties: "Original Node" and "Original Segment" (see Figure 7-113
and Figure 7-114).

Structure of PCA nodes
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Figure 7-113. PCA, marker names

Figure 7-114. PCA, User-defined marker properties (User Properties)

If you use the PCA transform on non-segmented data, the original data sets become segments. In all cases, however, the number of channels of the PCA node corresponds exactly
to the number of components found by the PCA transform. These have the names P1 to Pn.
In contrast to the channels of the PCA node, the channels are named as follows in the PCA
view: In data of the type "Components", the names of the channels take the form k(segn),
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and the loadings are named P1 to Pn. In data of the type "Loadings", the channels are named
P1 to Pn, and the names of the head topographies take the form k(segn).
If you use segmented data containing a "Time Zero" marker, these kinds of markers are also
inserted in PCA components or PCA loadings.
The entire set of data (from all the selected segments and nodes) is used to calculate a covariance matrix that corresponds to the selected criterion.
In principal component analysis, the covariance matrix of all the variables is calculated first.
If there are n variables, this results in an nxn matrix from which n factors can theoretically be
extracted. In practice, however, you limit yourself to a number whose variance is greater than
a specific limit in order to eliminate effects such as those caused by noise from the calculation.
If the number of desired factors is m, the m largest eigenvalues and the associated eigenvectors are calculated from the covariance matrix.
The factor loadings are obtained from the product of the root of the eigenvalue and the eigenvector. From the factor loadings, the associated component is calculated for each value
of a variable in such a way that the sum of the products of the component and factor loading
approximate the value of the variable to optimum effect.
The covariance matrix is a square matrix whose size corresponds to the number of channels
when the Variables at Channels option is selected or to the number of points when the
Variables at Time Points option is selected. Consequently, the user must select channels
that are present in all the selected history nodes or have carried out segmentation and calculated averages using the same segment length each time. (Otherwise, error messages are
displayed.)
When variables are selected as points in time, the variables take on different values depending on the channel, the segment and the EEG file. When variables are selected as channels,
the values depend on the point in time, the segment and the EEG file.
The covariance matrix, which is always a symmetrical, real, positive-definite matrix, is diagonalized using the Lagrange method. The diagonal elements are referred to as the eigenvalues of the matrix. The largest eigenvalues are chosen using the selection criterion defined in
the dialog, and the part of the covariance matrix that meets this criterion is retained.
The covariance matrix is a symmetrical, real, positive-definite matrix. A square root of the
corresponding inverse matrix is calculated for this matrix. The columns of this matrix are
known as loadings. However, this method of breaking down the variables is just one of many.
A direct result of the construction of the loadings is that they are orthogonal. Orthogonality
alone is often not sufficient for the result to be relevant from a physiological point of view.
For this reason, the results of the principal component analysis are often rotated subsequently (Use VARIMAX Rotation option) in the hope of obtaining data that is more meaningful
in physiological terms. The results of the principal component analysis with or without rota-

Method
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tion should never be accepted uncritically and you should subject them to a personal scientific examination.
If the Variables at Channels option is selected, the loadings are vectors whose length corresponds to the number of channels, and they are displayed as head topographies. If the
Variables at Time Points option is selected, the loadings are vectors whose length corresponds to the number of points, and they are displayed as EEG graphs.
The loadings matrix is multiplied out individually with each EEG segment as a matrix. The result of this multiplication is referred to as a PCA component. If the Variables at Channels option is selected, the PCA components are vectors whose length corresponds to the number
of points, and they are displayed accordingly as EEG graphs. If the Variables at Time Points
option is selected, the PCA components are vectors whose length corresponds to the number
of channels, and they are displayed as head topographies.

References

[RM81] F. Rösler, D. Manzey, Principal Components and VARIMAX-Rotated Components in
Event-Related Potential Research: Some Remarks on Their Interpretation. Biological
Psychology 13 (1981), 3-26.

7.4

Transforms in the Segment Analysis Functions group

7.4.1

Peak Detection

Summary

The Peak Detection transform is used to detect and mark peaks. Peaks are local minima and
maxima within an averaged EEG. The transform allows you to specify peaks in a table, together with their name and range. You also have to specify whether the peak is positive or negative. You can select specific channels in which the peaks are to be marked.

Prerequisites for use

The Peak Detection transform is typically applied following averaging.

Procedure

To call the transform, choose Transformations > Segment Analysis Functions > Result
Evaluation > Peak Detection.

Dialog page 1: Methods

On the first page of the dialog, you select the methods to be used for peak detection (see
Figure 7-115).
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Figure 7-115. Peak Detection, first page of the dialog box

Under Automation Methods, you specify whether peak detection is to be carried out in semiautomatic mode (Semiautomatic Detection option) or automatic mode (Automatic Detection
option).
If you select semiautomatic detection, you can change the position of the peak manually. The
position at which the algorithm detects the corresponding peak is highlighted with a movable marker in the view.
Under Detection Methods, you can select the method to be used to search for peaks:
 Search for Global Maxima in Interval searches for the global maximum (or minimum) in

a predefined interval.
 Search for Local Maxima in Interval searches for a local maximum.
 Search for Weighted Local Maxima in Interval searches for a weighted local maximum.

The difference between a local and global maximum is that, in the search for a global maximum, the edge points of the intervals are found as peaks if the value there is greater (or less)
than all the values within the interval. In the search for local maxima, extreme values are
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searched for within the interval and the edge values are only included if this initial search is
unsuccessful.
Since several local maxima can occur in an interval in certain circumstances, it is possible to
weight them during selection. When this method is used, all maxima that are found are multiplied by the weighting factor 1-a*t*t, and the highest value is then searched for. The value
"t" is from the interval [-1, 1] and describes the variance of the position of the data point from
the middle of the search interval. The value "a" can be entered in the Weight text box. The
value can be in the range from 0 and 1.
If the weighting is 0, the weighted method is identical to the unweighted method. If the
weighting is > 0, peaks that are closer to the middle of the interval have a higher weighting
than peaks at the edges of the interval. However, the peaks found are still all local maxima
of the voltage distribution. The weighting function only has an impact on the selection of
peaks when there are several possible local maxima, not on their position or size.
Under Searching Methods you can choose between the methods available for searching for
peaks:
 Separate Search for Every Channel searches for peaks in each selected channel sepa-

rately.
 Search Peak in a Reference Channel and Set Markers with Respect to this Peak only

searches for peaks in one predefined channel. In all the selected channels, the peaks are
marked at the position at which they are found in the specified channel.
The detected peaks are output as markers of the type "Peak".
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On the second page of the dialog, you define the peaks that you want to search for (see
Figure 7-116).
Figure 7-116. Peak Detection, dialog page 2, Separate Search for Every Channel option

Dialog page 2, "Separate
Search for Every Channel"
option

Enter the name of the peak in the Name text box. In the Start [ms] and End [ms] text boxes,
you specify the length (i.e. the beginning and end) of the interval in which you want to search
for peaks.
In the Polarity drop-down list, you specify the polarity of the peak (positive or negative).
In the Color text box, you can select a color to be used for the peak indicator in the interactive
view. To do this, click the corresponding cell to open the color selection dialog box.
The Insert Line, Remove Line and Remove All buttons allow you to add rows to the table, remove individual rows or remove all rows.
If you have selected the option Search Peak in a Reference Channel and Set Markers with
Respect to this Peak, the table on the second page of the dialog contains an additional column labeled Reference (see Figure 7-117). Here you can select a reference channel in which
you want to search for peaks.

Dialog page 2, Reference
channel option
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Figure 7-117. Peak Detection, dialog page 2, Search Peak in a Reference Channel option

Dialog page 3: Channel
selection

On the third page of the dialog box, you can select the channels in which the peak marker is
to be set (see Figure 7-118).
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Figure 7-118. Peak Detection, dialog page 3, selecting channels

If you selected semiautomatic peak detection, an interactive view appears in which you can
adjust the detected peaks (see Figure 7-119 and Figure 7-120).
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Figure 7-119. Peak Detection, Semiautomatic peak detection, Separate Search for Every
Channel option

You can select the active channel from the drop-down list. The active channel is displayed in
orange. You can then edit the position of the peak marker for this channel.
Please note that you cannot select an active channel in the interactive view if you search for
peaks in a fixed reference channel (Search Peak in a Reference Channel option) (see
Figure 7-120).
If you click a row of the table, a section highlighted in gray appears that indicates the search
interval set for the peak.
If you double-click a row, the associated peak cursor turns into a movable slider. You can use
the mouse to move this slider into the ideal position. You can cancel the operation by pressing the <Esc> key. The slider turns back into a peak cursor. Alternatively, you can display the
gray highlighting and the slider by clicking the peak cursor. This also activates the corresponding channel.
The Undo and Redo buttons allow you to undo and redo changes, respectively.
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If you want to interrupt what you are doing and resume later, you click the Suspend button.
The Peak Detection transform is highlighted in red in the history tree, and all the processing
steps carried out continue to apply. Click OK to conclude your entries.
Figure 7-120. Peak Detection, Semiautomatic peak detection, Search Peak in a Reference
Channel option

7.4.2

LRP (Lateralized Readiness Potential)

You can use the LRP transform to calculate the lateralized readiness potential (LRP) from two
data sets (e.g. movements of the left and right hands).

Summary

No previous processing steps are required before the transform is used.

Procedure

To call the transform, choose Transformations > Segment Analysis Functions > Result
Evaluation > LRP.
The first step is to create two data nodes. You should segment the first node based on the
first condition (e.g. movement of the left hand) and the second node based on the second
condition (e.g. movement of the right hand). In the second step, you obtain an average for
both nodes (see Figure 7-121).
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Figure 7-121. LRP, preliminary processing of the data

The LRP transform calculates the lateralized readiness potential and writes the result to new
channels whose names take the form LRP(., .). To do this, you select the path for the second
data set in the dialog box (see Figure 7-122).
The structure of the selection tree is the same as that of the Analyzer's history tree. When you
click a node, the corresponding path is selected. You can use the buttons at the right-hand
edge of the dialog box to open or close parts of the tree.
In addition, you can use the Keep Channels of Parent checkbox to specify whether the channels of the parent node are to be included in the new data set or whether the new data set is
to consist of LRP data only.
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Figure 7-122. LRP, selection dialog box for the second data set

Double-click the selected node or click Next. On the next page of the dialog, you can select
the channels that are to be used to calculate the LRP (see Figure 7-123).
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Figure 7-123. LRP, channel selection dialog box

When the LRP is calculated, the difference between contralateral and ipsilateral electrodes
in the parent node and the corresponding reverse difference in the second node are formed,
and the average of these two differences is calculated. The two left-hand columns of the
channel list are therefore assigned to the first data node (parent node), and the two righthand columns are assigned to the second data node.
It is usually sufficient to complete the two left or two right columns. The program searches
for the corresponding channels in the second data set and completes the other columns accordingly if suitable channels are found. You can also modify these entries. If no suitable
channels are found, you have to fill all columns manually.
When all the columns of the required rows are filled correctly, you conclude your entries by
clicking Finish. The LRP is calculated. The structure of the LRP channels is also described in
the Operation Infos.

Case example

The following example is intended to illustrate how entries are made:
In an experiment, a warning stimulus tells the test subject which hand to use in response to
a subsequent imperative stimulus. The warning stimulus, imperative stimulus and response
(left hand, right hand) are stored as markers in the raw EEG. The Segmentation transform and
advanced Boolean expressions are used to create two segmented data sets (nodes). One
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node corresponds to the response with the left hand, and the other to the response with the
right hand.
You will find detailed information on performing segmentation in
Section 7.4.5 as of page 371.
An average is calculated for the two nodes, and the average nodes are given meaningful
names (e.g. "Avg left", "Avg right"). The LRP data is to be created as subnodes of the "Avg left"
node. The LRP module is therefore applied to this node. The "Avg right" node is selected as
the second data set. The LRP is to be calculated, for example, for channels C3 and C4 (i.e. C4
– C3 is calculated for "Avg left" and C3 – C4 for "Avg right"). These differences are then averaged. In the channel selection dialog box, C4 is entered in the first column and C3 in the second column. The channel names C3 and C4 then appear in the third and fourth columns. The
calculation returns a channel with the name LRP (C4, C3) calculated on the basis of the formula (C4(li) – C3(li) + C3(re) – C4(re)) / 2.
[SUL96] W. Sommer, R. Ulrich, H. Leuthold, Das Lateralisierte Bereitschaftspotential als
psychophysiologischer Zugang bei der Untersuchung kognitiver Prozesse. Psychologische
Rundschau, 47 (1996) 1-14.

7.4.3

References

ERS/ERD (Event-Related Synchronization/Desynchronization)

The ERS/ERD transform can be used to analyze the event-related course of individual frequency bands in the EEG.

Summary

The transform is typically used after

Prerequisites for use

 Segmentation
 Baseline correction (optional)
 Band-pass filtering (optional)

To call the transform, choose Transformations > Segment Analysis Functions > Result
Evaluation > ERS/ERD.

Procedure
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Figure 7-124. ERS/ERD, dialog box

To use filters, check the Use Filter box. In the Filter Frequency [Hz] and Filter Bandwidth [Hz]
text boxes, you enter the filter frequency and bandwidth.
If you have already carried out band-pass filtering, it is not necessary to use filters.
In the ERS/ERD Method group, you select the method for the processing of the EEG data. The
methods – Instantaneous Power and Intertrial Variance – differ in terms of the data processing performed before averaging (
see also [KP95]). In the case of the Instantaneous Power
method, the voltage measured is squared before averaging, while the Intertrial Variance involves calculating the variance of the signal.
If you check the Show Change Compared to Reference Interval box, the data is specified as
a percentage change based on the comparison with the reference interval.
In addition, you can create a data set for the significance by checking the Create a Data Set
for Significance box.
The significance is calculated for either ERS (Show Significance for ERS option) or ERD (Show
Significance for ERD option).
To configure the reference interval, under Reference Interval Settings select either Based on
Time for a time-based setting or Based on Data Points for a data point-based setting.
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You can also specify that either the mean (Reference Uses Mean option) or the median
(Reference Uses Median option) is to be used.
You make the settings for the averaging of the segmented data under Segment/Channel
Selection as described in
Section 7.4.7 as of page 385.
The number of available segments is displayed under Available Segments.
You can obtain an average for all segments (Use Full Range) or for a selected range of segments (Specify Range of Segments). You can specify the range of segments in the From and
To text boxes.
In addition, you can specify whether only segments with odd segment numbers (segment 1,
3, 5, etc.) or only segments with even segment numbers (2, 4, 6, etc.) are to be averaged. To
do this, check the Calculate with Odd - Even Segments box and select the Use Only Odd
Segments or Use Only Even Segments option.
You can enable individual channel mode by checking the Enable Individual Channel Mode
box. In individual channel mode, each channel is checked separately for the presence of
"Bad Interval" markers when averaging is performed. If only individual channels in a segment
have been marked as "bad intervals", the other channels are still used for averaging. As a result, the number of segments included in averaging may be different for each channel. If you
do not use individual channel mode, all segments that contain a "Bad Interval" marker in a
channel are rejected in their entirety.

Before you can use individual
channel mode, you have to take
a number of steps by way of
preparation. To do this, follow
the instructions in Section 7.4.7
as of page 385.

[KP95] J. Kalcher, G. Pfurtscheller, Discrimination between phase-locked and non-phaselocked event-related EEG activity. Electroencephalography and Clinical Neurophysiology, 94
(1995), 381-384.
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7.4.4

Grand Average

The Grand Average transform allows you to generate one or more grand averages based on a
number of different averages.

Summary

Grand Average is a secondary transform. In other words, it stores its results in the current
workspace in the form of secondary history files.
Because averages are calculated across a number of different data sets, it is possible that
the data sets included in the calculation may contain different channels. In the Grand Average dialog box, you can specify how such cases are to be handled.
On the one hand, it is possible to exclude data sets which do not contain all the necessary
channels from the average. Here, the channels present in the first of the data sets read in order to establish the grand average define which channels are used. If you create multiple
grand averages in a single pass then a separate channel list is maintained for each of these.

Notes on the use of divergent
channel lists
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Alternatively, you can specify that all the channels in all the data sets included in the average
are to be used. In this so-called individual channel mode, the number of data sets that contain the channel is counted for each of the channels individually. This number is used for averaging. It is therefore possible that different numbers of data sets are included in the
calculation of the average for the different channels present in the result data set.
In the Operation Infos of the Grand Average result node, you can see whether data sets with
divergent channel lists were detected during the calculation. Depending on whether or not
you have selected individual channel mode, this information describes how many averages
have been included in each channel and which data sets have been excluded.
Unlike in the case of the Average transform, no "Bad Interval" markers are taken into account
in the Grand Average transform. The Grand Average transform assumes that the "Bad Interval" markers in the original segment data have already been taken into account in the calculation of the individual averages.

Procedure

To call the transform, choose Transformations > Segment Analysis Functions > Result
Evaluation > Grand Average.
Figure 7-125. Grand Average, dialog box
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In the top part of the dialog box, you can enter the following specifications: In the column
Name of the Involved History Nodes separated by commas, you specify the names of the employed data sets, separated by commas. In the Output file column, you specify the names
you want to give the output files.
If you check the Primary History Files Only box, only primary history files are used for the
grand average. If you select the Use Whole Workspace option, all the available files in the
workspace are included in the calculation of the grand average.
If you want to select specific history files, use the Select Individual History Files option.
In the Selection Filter text box, you can enter a selection filter to filter the available files on
name criteria. You can use an asterisk (*) to stand for one or more characters, and a period
(.) to stand for a single character. If the workspace contains the files "Test1H2", "Test2G" and
"Rest5", for example, " the string "Test*" filters out the files "Test1H" and "Test2G" (i.e.
makes them available). The filter expression "est" would accept all three files. When you
have set the filter expression, click Refresh to refresh the selection of available files.
If you check the Create a Data Set for Standard Deviation box, an additional data set is created. This contains the standard deviation.
You can enable individual channel mode by checking the Enable Individual Channel Mode
box. This determines the behavior of the Grand Average transform if the data sets that are to
be considered contain different channels.
This setting is described on page 369 in this
section.
If you check the Calculate Weighted Average box, the average nodes included in the calculation of the grand average are weighted with the number of segments included in them.
If you select the Include Selected History Files to Saving Parameters box, the selected history files are stored in the parameter file.
You can use the Load Parameters button to load previously saved settings from a parameter
file and then use or modify them. Choose Save Parameters if you want to save the settings
you have made in a parameter file so that you can re-use them later.

7.4.5

Segmentation

You can use the Segmentation transform to subdivide the EEG into individual segments. The
sections of the EEG data set that do not meet the segmentation criterion are automatically
suppressed and the resulting data set appears as a sequence of segments that meet the criterion. Existing segment boundaries are respected during segmentation. In other words, no
new segments are created within which another segment boundary is located.
The result of segmentation can be either a data set with multiple segments or a separate data
set for each segment calculated.

Summary
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You can also further segment an already segmented data set using additional criteria (subsegmentation). We advise you to use subsegmentation when you want to average different
stimuli in a data set separately having carried out artifact correction beforehand. In this case,
you select all the stimulus markers first, segment the data set and then carry out artifact correction. You can subsegment the resulting corrected data set again separately for each stimulus marker.
In addition to real data in the time domain, the Segmentation transform now also supports
complex data in the time domain as well as both real and complex data in the time-frequency
domain. Segmentation here always relates to the time axis and operation is therefore identical for all these data types.

Procedure

No previous processing steps are required before the transform is used.
To call the transform, choose Transformations > Segment Analysis Functions > Segmentation.
On the first page of the dialog, you select the segment type and a storage method (see
Figure 7-126).
Figure 7-126. Segmentation, dialog page 1, Segmentation type and storage options

Under What kind of Segmentation would you like to be performed?, you specify the criterion
or segmentation type to be used in order to perform segmentation:
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 Create new Segments based on a marker position. Segmentation is carried out relative

to a marker position. You must specify a start position and an end position for the segmentation. The start and end positions can also be before the marker position. You can
select any marker types.
 Divide data set in equal sized segments. The data set is subdivided into segments of the

same length.
 Set new segments manually. You specify the segments manually.
 Create new segments limited by start and end markers. The beginning and end of the

segment are defined by markers.
Under How should the data be stored?, you specify the storage options for the data:
 Do not store data, calculate data on demand. The data is not stored. It is created on re-

quest.
 Cache data to a temporary file. The data is stored in a temporary file on the hard disk.

You will find detailed information on the storage options in the subsection
entitled "Additional information: storage options"
on page 380 in this section.

 Cache data to a permanent file. The data is stored in a permanent file on the hard disk.

If you check the Cache Data on Request box, the cache is not calculated until you request
the data for the first time. If you do not use this function, the data is calculated as soon
as you conclude your entries with OK.
 Store data compressed in history file. The data is stored compressed in the history node.

In the Resolution [nV] text box, you can specify the resolution (precision) of the compression.
If you have selected marker-based segmentation (Create new Segments based on a marker
position option), then, on the second page of the dialog, you select from the list of available
markers (Available Markers) one or more markers on which segmentation is to be performed
(Selected Markers option) (see Figure 7-127).
In the Advanced Boolean Expression text box, you can enter the selection criteria of the advanced Boolean expressions. You can use marker names together with time windows in milliseconds and the operators "not", "and" and "or".

Marker-based segmentation

For detailed information on
the advanced Boolean expressions, refer to
Appendix K as of page 585.
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Figure 7-127. Segmentation, dialog page 2, marker-based segmentation

On the third page of the dialog, you specify the relative positions of the interval based on
time specifications (Based on Time option) or data points (Based on Data Points option) (see
Figure 7-128).
In the Start [ms] and End [ms] text boxes, you can specify the beginning and end of the interval, and in the Duration [ms] text box you specify its length. (If you make an entry in one of
the six text boxes, the values in the other text boxes affected by it are adjusted accordingly.)
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Figure 7-128. Segmentation, dialog page 3, marker-based segmentation

If you check the Allow Overlapped Segments box, overlapping segments are included in segmentation. If you do not check this box, only the first segment of two overlapping segments
is included.
To exclude markers of "Bad Interval" type, check the Skip Bad Intervals box. (You can set
"Bad Interval" markers using the Raw Data Inspection transform.)
If you subsequently want to use the Average transform in individual channel mode (
see
also Section 7.4.7 as of page 385), you should on no account check the Skip Bad Intervals
box.
If you selected time-based segmentation (Divide data set in equal sized segments option),
you can make the following settings on the second page of the dialog (see Figure 7-129).

Time-based segmentation
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Figure 7-129. Segmentation, dialog page 2, time-based segmentation

Under Size of Segments, you specify the interval size of the segment in seconds (Based on
Time option) or points (Based on Data Points option).
Under Overlap Segments, you can also specify how the segments are to overlap. You can
again specify the values in seconds (Based on Time) or data points (Based on Data Points).
If you want to exclude segments containing "Bad Interval" markers, check the Skip Bad
Intervals box.
On the third page of the dialog, you are asked whether a separate data set should be created
for each new segment. This allows you to further process each segment separately (see
Figure 7-130).
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Figure 7-130. Segmentation, dialog page 3, time-based segmentation

If you selected Set new segments manually on the first page of the dialog box, you can define
the new segments on page 2 (see Figure 7-131).
Figure 7-131. Segmentation, dialog page 2, setting segments manually

The first table (Parent Segment Table) lists the segments that already exist in the parent
node. You enter the new segments in the second table. You can specify the beginning, end
and duration of the new segment based on time and data points. (If you make an entry in one

Specifying segments manually
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of the six text boxes, the values in the other text boxes affected by it are adjusted accordingly.)
If a new segment extends beyond the boundary of an existing segment, the error message
"Segment intersects a parent segment" is output. In this case, choose different values.
The Insert Line, Remove Line and Remove All buttons allow you to add rows to the table, remove individual rows or remove all rows.
On the third page of the dialog, you are asked whether a separate data set should be created
for each new segment (see Figure 7-132). This allows you to further process each segment
separately.
Figure 7-132. Segmentation, dialog page 3, setting segments manually

Segmentation based on start
and end markers

If you selected Create new segments limited by start and end markers then you can select
the corresponding markers on the second page of the dialog (see Figure 7-133).
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Figure 7-133. Segmentation, dialog page 2, selecting the delimiting segment markers

Two drop-down lists allow you to select the start and end markers. The first start marker
found is linked with the first end marker found to form a segment, the second start marker is
linked with the second end marker and so on. Consequently, it is also possible to create
overlapping segments. If an end marker is found without a preceding start marker, it is ignored. Start markers for which no end marker is found by the end of the data set are also ignored.
If you want to exclude segments containing "Bad Interval" markers, check the Skip Bad
Intervals box.
On the third page of the dialog, you are asked whether a separate data set should be created
for each new segment. This allows you to further process each segment separately (see
Figure 7-134).
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Figure 7-134. Segmentation, dialog page 3, segmentation based on start and end markers

Additional information: Storage options

In the case of most transforms, it is not the results that are stored temporarily but information
that describes the result of the operation. In the case of the Segmentation transform, this information consists of the position of the new segments in the original data set.
If you request data for display or further processing (transform or export), it is recalculated
by the Segmentation transform. The advantage of this approach is that no intermediate files
are generated for the various operations yet all intermediate results are nevertheless retained.
A disadvantage, however, is that the speed of certain processing steps – such as Ocular
Correction, Baseline Correction and Average – is reduced as a result of the constant recalculation.
To counteract these negative effects, the results of the Segmentation transform can be
stored temporarily in a cache file. The transform then accesses the cache file when data is
requested.
Temporary and persistent cache files are available to you for storing the segmentation data.
You can also store the data directly in the history file.

For detailed information on
the Purge Deleted Nodes
function, refer to
Section 2.4.3 as of page 90.

Persistent cache files are stored in the same folder as history files. They are saved permanently and not deleted until the associated history node is deleted from the history tree by
means of the Purge Deleted Nodes function. You can consider these cache files as forming
part of the history file. However, this storage method is more efficient and makes it possible
to store even sizeable quantities of uncompressed data. Note that persistent cache files of a
node continue to use storage space on the hard disk until the node is finally deleted from the
cache for deleted nodes.
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Temporary files only exist for as long as the history file is open. If the history file is opened
again after being closed, the temporarily stored information is still available, but it is nevertheless recalculated on request. You should therefore carry out operations that follow segmentation without closing the history file.
If you subsequently want to carry out further operations following segmentation, you can recreate the temporary cache file. To do this, open the Segmentation node's context menu and
choose the Cache Data command (see Figure 7-135).
Figure 7-135. Segmentation, Segmentation node, creating the cache data again

To access the folder in which the temporary files are stored, you choose File > Configuration
> Administration in the ribbon. You can select a folder under Cache Path: on the Application
Paths tab (see Figure 7-136).
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Figure 7-136. Selecting the cache folder in the "Administration" dialog box

After averaging, the cache is no longer required because the Average transform stores the result in the history file.
As an alternative to persistent or temporary cache files, you can also store the data directly
in the history node. This means the raw data is no longer needed for subsequent operations
that access the segmented data. This is particularly advantageous when the raw data of a
workspace is distributed across multiple CDs and, for example, a PCA is to be carried out.
The Segmentation transform compresses the data before it is stored. The Analyzer works internally with floating-point numbers only, but these are unsuitable for compression and have
to be converted into integers first. To this end, you have to specify a resolution (precision).
For EEG data this resolution should be about 100 nV (nanovolts, 1 μV = 1000 nV), which is
0,1 μV. A lower value means a higher resolution but less compression.
The data is generally stored segment by segment, regardless of the storage option selected.
This can result in problems if you have created very long segments because the computer
many not have enough RAM. Very long segments are therefore subdivided into smaller
blocks when they are saved.

Transforms in the Segment Analysis Functions group 383

7.4.6

Grand Segmentation

You can use the Grand Segmentation transform to concatenate different averages as segments. The transform is very similar to the Grand Average transform with the difference that
it creates a segmented data set from the averages instead of calculating an "average of averages".

Summary

Grand Segmentation is a secondary transform. In other words, it stores its results in the current workspace as secondary history files.
Because the segments come from different data sets, it is possible that the included data
sets may contain different channels. In the Grand Segmentation dialog box, you can specify
how such cases are to be handled.

Notes on the use of divergent
channel lists

On the one hand, it is possible to exclude data sets which do not contain all the necessary
channels from the Grand Segmentation transform. Here, the channels present in the first of
the data sets read in order to run the Grand Segmentation transform are the most important.
If you create multiple grand segmentations in a single pass then a separate channel list is
maintained for each of these.
Alternatively, you can specify that all the channels in all the data sets included in the grand
segmentation are to be used. In so-called individual channel mode, any channels that are
absent in a data set are filled when the segments are created.
In the Operation Infos of the Grand Segmentation result node, you can see whether data sets
with divergent channel lists were detected during the calculation. Depending on whether or
not you have selected individual channel mode, this information indicates which data sets
have been excluded.
Unlike in the case of the Average transform, no "Bad Interval" markers are taken into account
in the Grand Segmentation transform. The transform assumes that the "Bad Interval" markers in the original segment data have already been taken into account in the calculation of
the individual averages.
To call the transform, choose Transformations > Segment Analysis Functions > Grand Segmentation.

Procedure
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Figure 7-137. Grand Segmentation, dialog box

In the top part of the dialog box, you can enter the following specifications: In the column
Name(s) of the Involved History Nodes separated by commas, you specify the names of the
employed data sets, separated by commas. In the Output file column, you specify the names
you want to give the output files.
If you check the Primary History Files Only box, only primary history files are used for the calculation. If you select the Use Whole Workspace option, all the available files in the workspace are included in the calculation.
If you want to select specific history files, use the Select Individual History Files option.
In the Selection Filter text box, you can enter a selection filter to filter the available files on
name criteria. You can use an asterisk (*) to stand for one or more characters, and a period
(.) to stand for a single character. If the workspace contains the files "Test1H2", "Test2G" and
"Rest5", for example, " the string "Test*" filters out the files "Test1H" and "Test2G" (i.e.
makes them available). The filter expression "est" would accept all three files. When you
have set the filter expression, click Refresh to refresh the selection of available files.
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You can enable individual channel mode by checking the Enable Individual Channel Mode
box. This determines the behavior of the transform if the data sets that are to be considered
contain different channels.
This setting is described on page 383 in this section.
If you select the Include Selected History Files to Saving Parameters box, the selected history files are stored in the parameter file.
You can use the Load Parameters button to load previously saved settings from a parameter
file and then use or modify them. Choose Save Parameters if you want to save the settings
you have made in a parameter file so that you can re-use them later.

7.4.7

Average

The Average transform is used for averaging previously segmented data.

Summary

The transform is typically used after

Prerequisites for use

 Filtering (optional)
 Segmentation
 Ocular artifact correction (optional)
 Artifact rejection
 Local DC Detrend (optional)
 Baseline correction

Note that you make settings for marker types, exclude segments with incorrect test subject
responses and make other settings in the Segmentation transform, not here.
To call the transform, choose Transformations > Segment Analysis Functions > Average.

Procedure
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Figure 7-138. Average, dialog box

Under Segment Range, you specify the time range to be considered for averaging; the number of available segments is displayed under Available Segments. If you want to use all the
segments for averaging, choose Use Full Range. If you want to restrict averaging to a specific
range of segments, choose Specify Range of Segments and enter the required range in the
From and To text boxes.
If you want to use individual
channel mode, please take account of the additional information in this section.

You can enable individual channel mode by checking the Enable Individual Channel Mode
box. In individual channel mode, each channel is checked separately for the presence of
"Bad Interval" markers when averaging is performed. If only individual channels in a segment
have been marked as "bad intervals", the other channels are still used for averaging. As a result, the number of segments included in averaging may be different for each channel. If you
do not use individual channel mode, all segments that contain a "Bad Interval" marker are
rejected in their entirety.
In addition, you can specify whether only segments with odd segment numbers (segment 1,
3, 5, etc.) or only segments with even segment numbers (2, 4, 6, etc.) are to be averaged. To
do this, check the Enable Odd-Even Averaging box and select either the Average Only Odd
Segments or Average Only Even Segments option. The segments in the specified time range
(Segment Range) are used as the basis for the count.
If you check the Create a Data Set for Standard Deviation box, the standard deviation is output as a new data set.
If you check the Calculate Signal-to-Noise Ratio (SNR) box, the signal-to-noise ratio is calculated and stored in the Operation Infos.

Additional information:
Individual channel mode

Before you can use individual channel mode, you have to take a number of steps by way of
preparation.
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 If you want to use the Raw Data Inspection transform, you must also activate individual

channel mode here.
 You must not suppress the "bad intervals" during segmentation (do not check the Skip

Bad Intervals box).
 If you use the Artifact Rejection transform instead of or the Artifact Rejection transform

together with the Raw Data Inspection transform then you must also activate individual
channel mode here in order to merely mark channels rather than reject entire segments.
The signal-to-noise ratio (SNR) is a measure of the quality of the EEG signal. Since there is no
exact information available on either the signal or the noise in the EEG, their average total
powers must be estimated statistically.

Additional information: signalto-noise ratio

The average noise power of the EEG is first calculated for each channel. It is assumed that
averaging eliminates the noise. For this reason, each EEG value in the original data set is assigned the average value corresponding to its time position. The square of the difference between the EEG value and the assigned average value is then used as an estimated value for
the noise power for each point.
The average noise power of each EEG channel is determined by calculating the sum of the
estimated values for each point across all the data points of the channel in the original data
set and dividing the result by the number of points minus 1.
In order to ascertain the average power of the signal in the EEG, you first calculate the total
power of a channel of the EEG. The total power is obtained by calculating the mean of the
squares for all data points of the channel before averaging.
It can be assumed that the signal and noise are uncorrelated. Consequently, the average
power of the signal is equal to the difference between the average total power and the average noise power.
The SNR is calculated from the quotient of the average signal power and the average noise
power.
The result of the SNR calculation is stored in the resulting history node as a description. You
obtain the result and other information by right-clicking the history node and choosing the
Operation Infos command in the node's context menu.

7.4.8

Baseline Correction

You can use the Baseline Correction transform to adjust the baseline of every segment. Correction is generally performed before averaging. An interval in a segment is defined in which
the average voltage level corresponds to the new zero point of the segment values. In other
words, the average (baseline) of the points in the defined interval is calculated, and this is

Summary
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subtracted from all points in the segment. This operation is carried out for all the channels
in the data set.

Prerequisites for use

Baseline correction is typically used after
 Segmentation
 Artifact rejection
 Filtering (optional)
 Ocular artifact correction (optional)
 Local DC Detrend (optional)

Procedure

To call the transform, choose Transformations > Segment Analysis Functions > Baseline
Correction.
Figure 7-139. Baseline Correction, dialog box

You can select any interval to be used to obtain the average voltage. It is generally positioned
where activity is at its lowest level, ideally before the stimulus or other reference markers. To
do this, you specify the values for the beginning (Begin [ms]) and end (End [ms]) of the interval in milliseconds.
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Note that if you do not use the Baseline Correction transform, there may be a flattening off of
the average signal.

7.4.9

DC Detrend

The DC Detrend transform calculates the DC trend from the EEG signal. Two different methods
are used, depending on whether the transform is applied before or after segmentation.

Summary

If you apply the transform before segmentation, global trend correction is carried out as described in [Hen93]. To begin with, the average voltage is calculated for each prestimulus interval of the specified marker type. In a second step, the average voltage is calculated for
every DC reset in an interval directly before the DC reset. The difference between the average
voltage before the DC reset and the average voltage of the first prestimulus interval after this
DC reset is added as an offset to all voltage levels after this DC reset. In a third step, all average values calculated for the prestimulus intervals along the time axis and corrected by adding the offset are taken into account, and the trend is calculated by applying linear
regression to this data. Only intervals that do not contain a DC reset are included in the calculation. Finally, the trend is subtracted from the original data, taking into account the DC
offset.
To minimize the impact of DC trends on ocular artifact correction as far as possible, it is advisable to perform DC trend correction before ocular artifact correction.

Restrictions on use

To call the transform, choose Transformations > Segment Analysis Functions > DC Detrend.

Procedure

If you apply the DC Detrend transform to non-segmented data or to data that has been manually segmented (segmentation type Set new segments manually, Segmentation transform)
then global DC trend correction is used (see Figure 7-140).
Figure 7-140. DC Detrend, Global DC trend correction
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In the Marker Type for Calculation drop-down list, you specify the marker type relative to
which the prestimulus intervals are to be calculated. You enter the length of these intervals
in the Length of Interval Before Markers [ms] text box.
Under Interval Lengths, you can specify whether the interval length is entered in milliseconds (Based on Time option) or in data points (Based on Data Points option).
In the Before Marker and Before DC Correction text boxes, you enter the length of the intervals before DC trend correction that are to be used to calculate the average voltages and the
offsets for the subsequent data.
The local DC trend correction (see Figure 7-141) is applied to all the segmented data that
does not correspond to the segmentation type Set new segments manually. A linear function
is subtracted from the data of each segment. The slope and limit values of this linear function
are calculated for every segment from a certain interval at the beginning and end of the segment.
Figure 7-141. DC Detrend, Local DC trend correction

The Based on Time and Based on Data Points options allow you to specify whether the intervals are based on time or data points. In the At Segment Start and At Segment End text boxes, you specify the length of the intervals – in milliseconds or data points – at the beginning
and end of the segment.

References

[Hen93] E. Hennighausen et al., A correction method for DC drift artifacts. Electroencephalography and clinical Neurophysiology, 86 (1993), 199-204.
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7.5

Transforms in the Comparison and Statistics group

7.5.1

t-Test

It is often not possible to estimate reliably on the basis of two EEG curves – the grand averages of two groups or two experimental conditions, for example – whether visible differences
are also statistically significant. Conversely, with examinations of a more exploratory nature,
it is often not possible to clearly ascertain from the available averages the intervals in which
the conditions or groups have particularly marked differences. In such cases, it can be very
useful to calculate t-values for the data.

Summary

The t-Test transform can be used to calculate paired and unpaired t-tests as well as t-tests
against 0.
The transform can be applied to segmented data as well as averaged data and grand averages. To use it, it is not necessary to subject the data to any preparatory steps such as the calculation of differences or averaging. Nor do the data set lengths of reference and comparison
nodes have to match. In this case, the t-test is only carried out for the common time range.

Prerequisites for use

The t-Test transform is typically applied following segmentation.
To call the transform, choose Transformations > Comparison and Statistics > Statistical
Analysis > t-Test.

Procedure
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Figure 7-142. t-Test, first page of the dialog

On the first page of the dialog, you can choose between a paired (Paired t-Test) and unpaired
t-test (Unpaired t-Test).
For the unpaired t-test, you can use the Equal Variance checkbox to specify whether equal
variance is to be assumed between the two groups compared. Since this is a common assumption in EEG research, this box is checked by default. However, if you know that this assumption does not apply, clear this checkbox.
Please note that an F-test for equal variance is not carried out in the t-Test transform. If you
check this box, the formula corrected for variance inequality is used.
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You can enable individual channel mode by checking the Enable Individual Channel Mode
box. In individual channel mode, each channel is checked separately for the presence of
"Bad Interval" markers when the calculation is performed. If only individual channels in a
segment have been marked as "bad intervals", the other channels are still used for the calculation. As a result, the number of segments included in the calculation may be different for
each channel. If you do not use individual channel mode, all segments that contain a "Bad
Interval" marker are rejected in their entirety.
If you selected the paired t-Test on the first page of the dialog, the next page of the dialog
(see Figure 7-143) allows you to choose between a regular paired t-test (Test Against Second
Dataset) and a t-test against zero (Test Against Zero). The latter is a special case of the
paired t-test. This tests whether the values differ significantly from zero.
If you want to carry out the paired t-test against a reference node, you can select this from
the list of existing history files.
If you check the Use Relative Path for Template or Drag and Drop box the relative path of the
data set for comparison is stored in the newly created data set. In this way, for example, you
can carry out the same t-test for each history file when running history templates, without
having to specify the comparison data sets explicitly each time.
Please note, however, that this checkbox is only available for comparison nodes that are located in the same history file as the reference node. When you select the checkbox, all the
history files except your current one are removed from the list of available history files.
If the Use Relative Path for Template or Drag and Drop box is not checked, the newly created
data set stores the absolute path of the data set for comparison including the name of the
history file. In a history template, the data set in this history file is then always used.
If you selected the unpaired t-test on the first page of the dialog, the next page offers you the
same settings as for the paired t-test. The only difference is that the option of a test against
zero is not available to you.
Depending on whether you select a paired t-test, an unpaired t-test or a t-test against zero,
all the required calculation steps are carried out (e.g. obtaining the differences across all
segments in the paired t-test for segmented data, averaging of the differences and calculation of the t-values).
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Figure 7-143. t-Test, Selecting the t-Test type of the second data set

7.5.2

Cross Correlation

Summary

The Cross Correlation transform enables you to calculate the cross correlation between two
channels in a segmented EEG. It is a statistical measure of the dependency of two channels.
Time- and frequency-shifted dependencies are also calculated. If you apply the transform to
complex data, the complex cross correlation is calculated.

Prerequisites for use

The Cross Correlation transform is applied following segmentation.
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To call the transform, choose Transformations > Comparison and Statistics > Cross
Correlation.
Figure 7-144. Cross Correlation, dialog box

The calculation is carried out as follows:
First, the cross correlation between the specified pairs of channels is calculated segment by
segment using the following formula:
 CrCorr(c1, c2)(j) = i (c1(i) – Avg(c1) ) (c2 (i+j) – Avg(c2) ) */ ( StdDev(c1) *StdDev(c2))
 i = 1,..., segment length, j = 1-segment length, ..., segment length
 Avg: average of all values in the segment
 StdDev: standard deviation of all the values in the segment
 The value 0 is added to the channels outside the segment for the purpose of the calcula-

tion.
In a second step, an average is obtained across all segments for each of these pairs.
In the table, enter the channels between which the cross correlation is to be calculated.
To calculate the autocorrelation of a channel, enter the name of the channel in the left and
right columns in the table. As a result, you get the channels in which the average of the cross
correlations is shown against the time or frequency shift. You can also use the Restore Default function to fill the table completely so that every channel can be correlated with itself.
The Insert Line, Remove Line and Remove All buttons allow you to add rows to the table, remove individual rows or remove all rows.
When you apply the transform to data in the frequency domain, you can enter a frequency
band to which the calculation is to be restricted under Band Selection.

Procedure
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To include the entire frequency range in the calculation, choose Take Whole Range. To define
a specific frequency band, select the Take Band option and enter the beginning and end of
the band in the Begin [Hz] and End [Hz] text boxes.
The total number of available segments is displayed under Available Segments.
If you want to use all the segments for the calculation, select the Use Full Range option. If
you want to define a specific range of segments, select the Specify Range of Segments option.
You can enable individual channel mode by checking the Enable Individual Channel Mode
box. In individual channel mode, each channel is checked separately for the presence of
"Bad Interval" markers when the calculation is performed. If only individual channels in a
segment have been marked as "bad intervals", the other channels are still used for the calculation. As a result, the number of segments included in the calculation may be different for
each channel. If you do not use individual channel mode, all segments that contain a "Bad
Interval" marker are rejected in their entirety.

7.5.3
Summary

Data Comparison

The Data Comparison transform allows you to compare two data sets or two channels of a
data set after averaging. The following comparison operations are currently possible:
 Difference waves
 Cross-correlation

Procedure

No previous processing steps are required before the transform is used.
To call the transform, choose Transformations > Comparison and Statistics > Data
Comparison.
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Figure 7-145. Data Comparison, first page of the dialog

On the first page of the dialog, you select the required method. You can choose between:
 Calculation of difference waves (Difference)
 Calculation of the sum of two channels (Sum)
 Calculation of the ratio of the initial channel to the comparison channel (Ratio)
 Calculation of the ratio of the initial channel to the comparison channel as a percentage

(Percent Ratio)
 Calculation of the cross-correlation (Cross Correlation)

In the calculation of ratios, the initial data value is divided by the other data value. If the other data value is zero, zero is used as the result.
On the next page of the dialog, you specify whether the comparison is to be carried out within
the current data set (Compare Channels) or between two data sets (Compare Datasets) (see
Figure 7-146).
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Figure 7-146. Data Comparison, comparing channels or data sets

If you opt for a comparison of channels within a data set, the next page of the dialog contains
a channel selection menu (see Figure 7-147). Here you can select channel groups to be subtracted from each other.
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Figure 7-147. Data Comparison, comparing channels

The Insert Line, Remove Line and Remove All buttons allow you to add rows to the table, remove individual rows or remove all rows.
If you opt for a comparison of two data sets, the next page of the dialog contains a list of all
the history files in the current workspace (see Figure 7-148). Double-click the name of the
history file that you want to open.
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Figure 7-148. Data Comparison, comparing data sets

The following buttons simplify navigation:
 Expand Reference History File opens the current history file.
 Expand Same Names opens all history files that have a data set with the same name, up

to this data set.
 Expand All opens all the history files.
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 Collapse All closes all the history files.

If you check the Keep Remaining Channels box, all channels that do not have a corresponding channel in the other data set are nevertheless retained.
If the Use Relative Path for Template or Drag and Drop box is checked, the relative path of
the data set for comparison is stored in the newly created data set. In this way, for example,
you can carry out the same comparison for each history file when running history templates,
without having to specify the comparison data sets explicitly each time.
Please note, however, that this checkbox is only available for comparison nodes that are located in the same history file as the reference node. When you select the checkbox, all the
history files except your current one are removed from the list of available history files.
If the Use Relative Path for Template or Drag and Drop box is not checked, the newly created
data set stores the absolute path of the data set for comparison including the name of the
history file. Comparison is then always carried out with the data set in this history file in a
history template.
You select a data set by means of a double or single click. Click the Finish button to conclude
and apply your input.
A view with overlays opens. The black graph represents the result of the transform, the red
graph represents the initial node, and the blue graph represents the other node for comparison (see Figure 7-149 and Figure 7-150).
Figure 7-149. Data Comparison, standard view (data set overlay)
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Figure 7-150. Data Comparison, grid view (channel overlay)

If you click the name of a node (when comparing data sets) or channel (when comparing
channels), the corresponding node or channel is deactivated or activated again.
The view's context menu contains the additional command Display Static Overlays (see
Figure 7-151) which allows you to switch between overlays generated by the comparison operation and the normal overlays. You can only add other overlays to the node for comparison
if this command does not have a check mark against it.
Figure 7-151. Data Comparison, Displaying static overlays
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7.5.4

Covariance

The Covariance transform can be used as a preliminary step for various forms of coherence
calculation. If you use this module in combination with the Formula Evaluator transform, it is
possible to implement the majority of the methods described in the literature as well as other
related methods.

Summary

In contrast to the Coherence transform, the data output by the Covariance transform is always of the same type as the processed input data. It is therefore possible, for example, to
calculate and further process complex-valued coherence or to calculate the correlation of
channels in the time domain.
The Covariance transform is typically applied following segmentation.

Prerequisites for use

To call the transform, choose Transformations > Comparison and Statistics > Covariance.

Procedure
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Figure 7-152. Covariance, dialog box

You can specify whether all possible channel combinations (Calculate Covariance of All
Combinations of Channels option) or only a selection of channel combinations (Select Combination of Channels for Covariance Calculation option) are to be included in the calculation.
If you decide on individual combinations, you can enter the required channel combinations
in the channel table. Alternatively, you can choose a channel from the drop-down list on the
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right. If you click Combine Channel with All, all combinations of the selected channel are
added to the table.
The Insert Line, Remove Line and Remove All buttons allow you to add rows to the table, remove individual rows or remove all rows.
The two methods use the following formulae to calculate the covariance:
1

Cov(c1, c2)(x) = 1/N  (c1, i (x) – avg(c1 (x)) ) (c2, i (x) – avg(c2 (x)) )*

2

Cov(c1, c2)(x) = 1/N  c1, i (x) c2, i (x)*

The Subtract Average checkbox allows you to specify whether method 1 or 2 is used. In both
formulae, totaling is carried out using the segment number i. The average value obtained applies to the segments at a fixed time or at a frequency of x and with a fixed channel c.

7.5.5

Coherence

You can use the Coherence transform to calculate the coherence between channels. Coherence is a measure of the dependency of the data between the individual channels over time.

Summary

The Coherence transform is typically applied following an FFT analysis.

Prerequisites for use

Note that calculation is only possible with complex frequency data.
To call the transform, choose Transformations > Comparison and Statistics > Coherence.
You can choose between four methods for calculating coherence:
1

Use Correlation/Autocorrelation: Quotient from correlation and autocorrelation

2

Use Cross-Spectrum/Autospectrum: Quotient from cross-spectrum and autospectrum

3

Calculate Only Cross-Spectrum: Calculation of the non-normalized cross-spectrum

4

Calculate Phase of Cross-Spectrum: Calculation of the phase of the cross-spectrum

5

Imaginary Part of Cross-Spectrum/Autospectrum: Imaginary part of the quotient of the
cross-spectrum and autospectrum

Procedure
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Figure 7-153. Coherence, dialog box

Method 1 calculates the coherence using the following formula:
Coh(c1, c2)(f) = | Cov(c1, c2)(f) |² / ( | Cov(c1, c1)(f) | | Cov(c2, c2)(f) | ),
where Cov(c1, c2)(f) =  (c1, i (f) – avg(c1 (f)) ) (c2, i (f) – avg(c2 (f)) )*.
In the second formula, totaling is carried out using the segment number i. The average is obtained with reference to the segments with a fixed frequency f and a fixed channel c.
Method 2 uses the cross-spectrum instead of the covariance. The formula is as follows:
Coh(c1, c2)(f) = | CS(c1, c2)(f) |² / ( | CS(c1, c1)(f) | | CS(c2, c2)(f) | ),
where CS(c1, c2)(f) =  c1, i (f) c2, i (f)*.
Here, too, totaling is carried out using the segment number i. Segments containing "Bad Interval" markers are excluded from this calculation.
Method 3 merely calculates the cross-spectrum, as specified in the formula with CS.
Method 4 calculates the phase of the cross-spectrum. The phase is specified as a radian
measure, and the curve is continuously extended at the transitions -Pi and +Pi in such a way
that the range of values can theoretically extend across the entire range of real numbers but
always specifies an angle (between the complex number vector and the real axis).
Instead of using the magnitude squared of the cross-spectrum, method 5 uses the square of
the imaginary part of the cross-spectrum. The formula is as follows:
ImCoh(c1, c2)(f) = imag(CS(c1, c2)(f))² / ( | CS(c1, c1)(f) | | CS(c2, c2)(f) | )
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Here, too, totaling is carried out using the segment number i. Segments containing "Bad Interval" markers are excluded from this calculation.
In methods 1 and 2, values between zero and one are obtained for each frequency and each
channel. Method 3 results in values which may reach any level of complexity. However, only
the absolute value corresponding to these values is output.
Under Channels, you can specify whether all possible channel combinations are to be included in the calculation (Calculate Coherence of All Combinations of Channels option) or
only a selection of combinations (Select Combination of Channels for Coherence Calculation option).
The Insert Line, Remove Line and Remove All buttons allow you to add rows to the table, remove individual rows or remove all rows.
If you decide on individual combinations, you can enter the required channel combinations
in the channel table.
Alternatively, you can choose a channel from the drop-down list. If you click the Combine
Channel with All button, all combinations of the selected channel are added to the table.
If you check the Use Paired Channels View box, the result is displayed in a two-part view (see
Figure 7-154).
Figure 7-154. Coherence, Output of coherence data in the paired channel view
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On the left, the view contains curves in the frequency domain that represent the coherence
calculated for each frequency point and each channel combination. On the right, the coherence values between the channels are represented by lines (paired channel view). The colors
indicate the coherence on a scale of zero to one. If the box is not checked, the result is displayed in a frequency view.

Summary

7.6

Transforms in the Special Signal Processing group

7.6.1

LORETA

The LORETA transform allows you to view the LORETA data in the Analyzer over the time
range. Regions of interest (ROIs) are defined for this purpose. Each ROI is displayed as a virtual channel.
The virtual MR anatomical images are made available by the Montreal Neurological Institute
of McGill University.
We advise you only to apply the LORETA transform to data with an average reference. If necessary, you can use the New Reference transform to re-reference your data.

Procedure

To call the transform, choose Transformations > Special Signal Processing > LORETA.
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Figure 7-155. LORETA, dialog box

To create a new ROI, click New ROI…. The New Region dialog box appears (see Figure 7-156).
You can enter a name for the ROI here. This name is also used for the virtual channel.

Creating a new ROI

410 Chapter 7 Primary and secondary transforms

Figure 7-156. LORETA, Creating a new ROI

To add lobes to the ROI, click Add Lobe…. You can now decide whether you want to add the
left lobe, right lobe or both lobes (see Figure 7-157).
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Figure 7-157. LORETA, Adding lobes to the ROI
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In the same way as selecting lobes, you can use the Add Gyrus… and Add Brodmann Area…
buttons to add gyri and Brodmann areas to the ROI.
The ROIs are defined (block,
point, circle) using the MNI coordinate system.

The Add Current Position… button allows you to add a specific position to the ROI (see
Figure 7-158). You can choose whether to add the nearest voxel to the mouse pointer (by selecting the Nearest Voxel option) or to define a sphere with a specified radius around the current position (by selecting the Sphere around Point option).
Figure 7-158. LORETA, Adding a specific position to the ROI

You can use Add Block… to add a rectangular block, whose limits you can specify, to the ROI
(see Figure 7-159).
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Figure 7-159. LORETA, Adding a block to the ROI

The Details of Selected Region of Interest text box lists all the components of the ROI (see
Figure 7-160)
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Figure 7-160. LORETA, Components of the "Frontal" ROI

Other settings

Under Anatomy, you can choose between various virtual MR anatomical images.
The Remove ROI and Remove All buttons allow you to remove ROIs individually or all at once.
In the Value Extracted from Voxels group, you can specify which value is to be calculated for
the virtual channel from the corresponding ROI. You can choose the x-coordinate, y-coordinate, z-coordinate, absolute value of the coordinates or power (square of the value).
You use the Keep Old Channels checkbox to specify whether the original channels are to be
retained. If you check the New Channels on Top box, the virtual channels are displayed before the original channels in the view.
The Up and Down buttons allow you to specify the order of the ROIs and consequently that
of the virtual channels in the data set
You can use Import ROIs… to load previously created ROIs. The Export ROIs… button allows
you to export ROIs you have created as an XML file so that they can be used subsequently.
The Export Blank ROIs File button exports voxel data, including the anatomical data, in a CSV
file. You can open this file in Excel, for example, edit the ROIs and reimport them as a CSV file.
If you edit this CSV file, it is essential to make sure that you do not change the number or sequence of the rows in the table. Otherwise errors may occur when you import the file again.
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The values in CSV files are separated by commas and not, as in earlier versions of the transform, by semicolons. Please note this when exchanging data with other programs and when
reading older CSV files.
Click the OK button to start the calculation of the transform matrix. The ROIs are output as
new virtual channels. You can use the other modules of the Analyzer to work with these channels.
The LORETA transform stores your internal data in the history node so that the node becomes
available quicker if you use it in the future. You can delete this internal data by choosing
Remove Loreta Streams in the LORETA node's context menu (see Figure 7-161). The data is
recalculated the next time the node is opened.
Figure 7-161. LORETA, Deleting Loreta streams

[PML94] R.D. Pascual-Marqui, C.M. Michel, D. Lehmann, Low resolution electromagnetic
tomography: a new method for localizing electrical activity in the brain. International Journal
of Psychophysiology, 18 (1994) 49-65.
For a detailed description of the LORETA transform, go to http://www.uzh.ch/keyinst/
loreta.htm.

References
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7.6.2

MR Correction

Please note that unlike in Analyzer 1, there are separate transforms for scanner artifact correction and cardioballistic artifact correction in Analyzer 2.

Summary

The MR Correction transform allows the detection and correction of artifacts that occur during
combined EEG-fMRI measurements in an MR scanner as a result of changes to the magnetic
field in the scanner.

Preliminary remarks on methodology and notes for users

The methods used in MR scanner artifact correction are based on techniques described in
[All00].
The basic principle behind the correction of scanner artifacts is that the intervals interfered
with by the MR scanner are averaged. This approach reduces the proportional contribution
of the EEG to the averaged curve because the EEG sequences are statistically independent of
one another. This results in a correction template which contains only a small EEG contribution and which replicates the scanner artifact.
The averaged scanner artifact curve is then subtracted from the original curve in the affected
intervals. This generally does not completely eliminate the scanner artifacts because other
types of interference may be present. Consequently, you should subject the data in the corrected ranges to a further correction by means of filters included in the transform.
The first step during correction is to determine the EEG sections affected by the artifact. The
quality of the averaged artifact curve to be subtracted from the individual sections in a subsequent step depends directly on the precision with which the artifact intervals are localized
over the duration of the signal.
It is possible to separate the detection of scanner episodes from scanner artifact correction
and, as an initial step, to merely mark up the artifacts. Furthermore, the correction can be
based either on an artifact detection method or on markers already contained in the EEG.
This type of marker can be created by the scanner directly or by means of a macro.
The transform assumes that a reference point is always marked for the scanned intervals
(generally the starting point). Any markers already present in the EEG do not therefore necessarily have to identify the starting point.
Two methods are available for artifact detection: the simple gradient method and the gradient method with TDD (template drift detection).
In the simple gradient method, the sum of the gradients of the curves between successive
data points in the selected channels is calculated. If this sum exceeds the defined threshold,
a "Scan Start" marker is set.
In the gradient method with TDD, the current scanned interval is also compared with the first
scanned interval. An interpolation method is used to determine drifts and shifts in each
scanned sampling interval containing an artifact.
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The scanner artifacts may change during the measurement due to head movements on the
part of the test subject. If a correction template contains artifact intervals from the period before and after the movement then this considerably impairs the quality of the correction. To
prevent this, you can use "Head Movement" markers. You can use the Edit Markers transform
to position these markers at those points in the EEG at which the subject clearly moved his
or her head. The transform considers the EEG sections delimited by markers as separate
EEGs and performs a separate template calculation and correction for each of these sections.
"Drifts" are the differences in time between the averaged artifact curve and the scanner artifact of each interval. This drift is caused when the time of repetition (TR) of the scanner is not
a multiple of the sampling rate. As a result, the scanner artifact is displaced by a fraction of
a sampling interval relative to the amplifier's sampling rate in every new interval even if the
"Scan Start" markers are positioned perfectly.
Consequently, in a discretely measured EEG, the artifacts in the individual intervals do not
correspond precisely. Because this discrepancy is due to a temporal drift, knowledge of the
drift for each interval makes it possible to draw conclusions about the intervals which contain similar artifacts. The information about drifts of a sampling interval is determined using
the TDD method and is made available by the template drift compensation method when the
artifacts are subsequently corrected.
The TDD optimizes the position of the "Scan Start" markers on the basis of the drifts in order
to compensate for the displacement that occurs due to the repeated effect of the drifts. This
can result in the position of the "Scan Start" marker being moved by up to two points. These
corrections, which are referred to as "shifts", do not need any information about the gradient
of the EEG curve and can be performed even if the simple gradient method cannot be applied
successfully. This is of great benefit particularly in the case of continuous artifacts.
If the scanner artifacts occur one after the other without being interrupted by artifact-free
sections, it is very difficult to determine exactly where the next interval begins. Against this
background, template drift detection can often significantly improve the positioning of the
"Scan Start" markers.
In the simple gradient method, the accuracy with which the beginning of the artifact is detected does not necessarily increase when a larger number of channels are included. We
therefore recommend that you use a single channel for this. Ensure that this channel actually
contains all the existing scanner artifacts.
The accuracy of template drift detection, on the other hand, does increase when more channels are used. Results can therefore improve if you select a larger number of channels than
you do for the simple gradient method.
The interval to be corrected can be moved relative to the starting point obtained (by means
of markers or the detection method) in accordance with the selected interval range. If you enter negative values for the starting point when selecting the interval range, the beginning of
the interval is positioned before the marked reference point.

On drifts and shifts
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Drifts of the TR of the scanner in relation to the sampling rate no longer occur if the scanner
and MR amplifier have been synchronized by means of the BrainVision SyncBox. This hardware option provides an ideal alternative to using TDC.

Template Drift Detection (TDD)

The transform uses an automatic method to determine drifts and shifts in the individual artifact intervals. The TDD method makes use of the fact that interference caused by changes
in the magnetic field results in very large, narrow maxima in the data. Peak values of this type
cannot come from the normal EEG signal, as this does not have gradients of a comparable
magnitude.
The TDD method then interpolates that data around the peaks in order to determine the temporal drifts accurately. In addition, the TDD method constructs an internal table containing
the positions of the peaks. By comparing this "fingerprint" with that of another artifact interval, it is possible to determine whether one of the intervals has been displaced by more than
one data point.
In this way, the TDD method permits the highly accurate detection of drifts and shifts in typical MR data sets with, for example, a sampling rate of 5000 Hz. Tests have shown that the
information about artifact intervals obtained using this method largely agrees with information obtained using correlation-based methods. However, the TDD method is considerably
faster and more efficient.

Template Drift Compensation
(TDC)

TDC is a method that is used for the averaging of artifact intervals and is intended to reduce
interference caused by the offset of the scanner TR compared to the sampling rate (drift). The
idea underpinning this method consists not only of determining a correction template but
also of subdividing the artifact intervals based on their degree of similarity and using them
for the calculation of multiple correction templates.
The method assumes that the interference caused by drift is determined by the precise value
of the drift. It also assumes that the artifacts in different intervals are more similar to one another, the less the drifts of the intervals differ. The reason for this lies in the fact that the drift
consists of a temporal offset of the physical artifact of less than one sampling interval and
the resulting interference effects have similar impacts on the digitized signal in the amplifier.
The TDC subdivides the artifact intervals into separate groups depending on the drift. An averaging operation is performed and a template created for each of these groups. The more
groups that are used, the more similar the drifts of the artifacts in each group are. Consequently, the artifacts are also more similar to one another.
The TDD assigns the drift relative to the ideal position to each scanned interval as a fraction
of a sampling interval between -0.5 and 0,5. A range of these drifts is assigned to each of the
correction templates managed by template drift compensation. During averaging, each template takes into account only those intervals that fall within its range.
The main disadvantage of the method is that fewer individual artifact intervals are included
in each correction template. In addition, the number of intervals included in each template
may differ.
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It is possible to perform artifact detection and correction in one and the same pass. However,
you can also perform processing in two steps:
1

Search the scanned intervals and set markers. You can then execute further transforms
to analyze the time-related stability of the markers found (compare the marker position
with the beginning of the scanner artifact). You should carry out checks like this, in particular, when you want to use external markers. The Analyzer's "Marker Timing" solution
is ideal for the analysis of the artifact markers. It shows the time between successive
markers as a time-voltage curve.

2

Correct the scanned intervals.

Prerequisites for use

To call the transform, choose Transformations > Special Signal Processing > MR Correction.

Procedure

On the first page of the dialog box, you can select the method to be used to determine the
scanner episodes (see Figure 7-162).

Dialog page 1: Choosing the
artifact detection method
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Figure 7-162. MR Correction, dialog page 1, Artifact detection method

You can separate the detection of scanner episodes from scanner artifact correction and, as
an initial step, merely add markers to the scanner artifacts. The correction can therefore be
based either on a detection method or on markers that already exist in the EEG. Under Detection, you can specify whether you want to use a detection method (Use Detection Method option) or markers (Use Markers option) for artifact detection. You should select the Use
Markers option if the scanned intervals are defined by existing markers. You select markers
from the drop-down list box, which contains all the markers set in the EEG.
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If you select the Use Detection Method option, the Write Only Markers function becomes
available. In this case, only markers are set and no artifact correction is performed. You can
subsequently use the set markers for correction. To do this, run the MR Correction again and
choose the Use Markers option.
You can also combine artifact detection with the TDD method. The TDD improves the quality
of artifact correction since the marker position is adjusted during detection in order to compensate for the effect of the drift of the scanner TR (
see also "On drifts and shifts" on
page 417 in this section).
If you select the Use Detection Method option and check the Use Template Drift Detection
box, the gradient method is used in combination with the TDD in order to improve the position of the newly detected markers. However, if you do not check the Use Template Drift Detection box then the markers are detected on the basis of the simple gradient method only.
Unlike in Analyzer 1, it is possible to check the Use Template Drift Detection box when the
Use Markers option is selected. This is because it is not certain that the selected markers
have drifts as User Properties. Choose this option if you are using external markers and want
to apply the TDC method.
You then select the channels for which artifact detection is to be carried out.
In the Gradient Trigger (μV/ms) text box, you can specify the value of the gradient trigger for
the gradient method. The Histogram… function helps you to determine a suitable gradient
trigger. If you click this button, the Gradient Histogram dialog box opens (see Figure 7-163).
The histogram displays the frequency distribution of the gradients and allows you to set a
suitable gradient trigger. The gradient trigger is a limit value for automatically determining
the scanner artifacts. The point in the EEG graph at which the gradient is greater than the gradient trigger is taken as the beginning of the artifact. You can use the Display button to indicate the position of the value entered for Trigger. The +/- buttons allow you to resize the
image.
The optimum gradient trigger value depends, among other things, on the channel selection.
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Figure 7-163. MR Correction, histogram

Dialog page 2: Artifact type
and interval length

On page 2 of the dialog, you specify whether the scanner artifacts are interrupted (Interleaved) or continuous (Continuous) (see Figure 7-164).
 Select Interleaved if you want to detect intervals with artifacts that are followed by EEG

sections that are free of scanner artifacts.
 Select Continuous if you want to detect intervals with artifacts that follow one another

without interruption. When you make this setting, specify the value of the scan period in
the TR [ms] text box. The TR value is used to delimit the intervals with reference to one
another.
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Figure 7-164. MR Correction, dialog page 2, Artifact type and interval length

On page 2 of the dialog, you can also make settings for the marker position or the point at
which the artifact begins. You can specify the positions based on time or data points (Based
on Time or Based on Data Points options). If you make an entry in one of the six text boxes,
the values in the text boxes affected by it are adjusted accordingly.
If you checked the Select Channels for Detection > Write Only Markers box, the dialog contains only pages 1 and 2.
On page 3 of the dialog, you can make settings for baseline correction and averaging (see
Figure 7-165).

Dialog page 3: Baseline and
averaging settings
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Figure 7-165. MR Correction, dialog page 3, Baseline and averaging

We recommend that you always perform a baseline
correction because this prevents jumps from occurring
in the corrected EEG. If baseline correction is not performed, the correction
template has a constant offset which is also subtracted
during correction.

Under Baseline Options, you can specify whether baseline correction is to be carried out before averaging and which period of the interval (relative to the marker, in other words to the
reference point) is to be used for this. To do this, check the Enable Baseline Correction for
Average box. Baseline correction is carried out by averaging the data in the time range specified in the Start and End text boxes. This average is calculated channel by channel and subtracted from each data point in the interval.
If you check the Compute Baseline Over the Whole Artifact box, the baseline is calculated
precisely across the whole artifact. In this case, the Start and End text boxes are no longer
available.
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For some EEGs, the method for obtaining the baseline delivers better results when the baseline is calculated within an interval that is partially outside the artifact. In this case, enter a
relatively large negative value (e.g. -300) in the Start text box and a relatively small negative
or positive value (e.g. between -25 and 25) in the End text box.
For other EEGs, the method delivers better results when you calculate the baseline within the
artifact. In this case, enter a relatively small positive value in the Start text box and a relatively large positive value in the End text box. To calculate the baseline within the artifact, you
can also use the default: Compute Baseline Over the Whole Artifact.
The Average Options group contains the four methods of selecting the intervals for the calculation of the averaged artifact curve: template calculation with all intervals, correlation,
sliding average and Template Drift Compensation (TDC).

Correction method

All four methods are based on subtracting templates (averages) from the artifacts. These
templates are always calculated by averaging the artifacts. The EEG sections marked as "bad
intervals" are not included in the calculation of the template. However, they are corrected as
far as possible by means of template subtraction.
Depending on the method selected, not all the scanned intervals are used to calculate the
templates, since data in some intervals may not be suitable for use in the calculation and
would falsify the averages obtained.
In the template calculation method with all intervals, all the scanned intervals are used. In
the correlation method, only those intervals are included in the calculation that have at least
a minimum correlation with the existing averaged artifact curve. In the sliding average calculation, a sliding average of the intervals is calculated. If you have used template drift detection to obtain the intervals, you can use the template drift compensation method to
distribute the intervals to a number of averaged artifact curves, depending on the drift.
Note that the Detect Saturation function from Analyzer 1 is not included in the MR Correction
transform. This is because the Raw Data Inspection transform provides more flexible methods for the same purpose.
If you select the Use All Scanned Intervals for Average option, all the scanned intervals are
used in the template calculation, and you do not have to make any further settings. All artifact sections of the EEG that are identified by markers are included in averaging.

Method 1: Template calculation using all intervals

If you choose the Select Scanned Intervals for Average by Following Criteria option, the artifact intervals used for template correction are chosen on the basis of the correlation method
[All00]. In this case, the inclusion of individual artifacts in the template depends on whether
they correspond to the averaged template.

Method 2: Correlation

In the Start at Interval Number text box, you specify the interval at which averaging is to begin, thus allowing you to eliminate from the averaging a specific number of episodes at the
beginning of the measurement. This makes sense when your MR system inserts "dummy volumes" at the beginning of a measurement to stabilize the system. These "dummies" often
have anything from a slightly different to a significantly different structure over time from the
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MR volume measurements. Consequently, including these "dummies" in the averaged artifact would make this template less representative.
In the Include Always Following Number of Intervals from Start Interval text box, you enter
the number of intervals that must be included in the averaging in order to obtain a useful value for the subsequent correlation.
The value in the Include Other Intervals Only If Correlation Exceeds text box is used as follows:
If you check the Common Use of All Channels for Bad Intervals and Correlation box, the correlation of all the interval's channels with the corresponding channels of the template is calculated as a first step. If a correlation is lower than the value in Include Other Intervals Only
If Correlation Exceeds, a switch is made to the next interval, and the channels from the affected interval are not included in the template calculation. If all the correlations are greater
than this value, the entire interval is included in the template calculation.
If you do not check the Common Use of All Channels for Bad Intervals and Correlation box,
the correlation of each of the interval's channels with the corresponding channel of the template is calculated. If this correlation is greater than the value in Include Other Intervals Only
If Correlation Exceeds, the interval's channel is included in the template calculation. If the
correlation is lower, the corresponding channel is not included.
We recommend that you do not check the Common Use of All Channels for Bad Intervals and
Correlation box if you are using the second method because correction is more precise when
more intervals per channel are included in the template calculation.
In the following example, four intervals are ignored at the beginning, but the following five
intervals are included in the template calculation. All other intervals must have a correlation
of 0.8 with the template to be included in the template calculation:

In Upper Limit for Number of Intervals, you can limit the number of intervals to be included
in the template calculation in order to reduce the processing time.
The Write Markers for Low Correlation checkbox allows you to put a "Low Correlation" marker
on intervals that do not meet the correlation criterion specified in the Include Other Intervals
Only If Correlation Exceeds text box.
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If you check the Common Use of All Channels for Bad Intervals and Correlation box, a global
marker is set for all channels. Otherwise, a separate marker is set for each channel.
The Use Sliding Average Calculation option allows you to address the problem of combined
EEG-fMRI measurement, namely that the scanner artifacts may sometimes be greatly modified by even slight movements of the test subject's head in the scanner. This would substantially reduce the quality of a template calculated across all intervals. A solution to this
problem is to calculate the template by means of a sliding average of a selected number of
intervals. A separate template is calculated for each interval to correct the interval.

Method 3: Sliding

In the Total Number of Intervals in Template text box, enter the number of intervals that are
to be used for the calculation of the correction template.
We recommend that you enter an odd number. If you enter an even number, the program
rounds your entry to the next higher odd number (i.e. if you enter the value 20, 21 intervals
are used for correction). The reason why the number is always odd is because the same number of intervals are used before and after the artifact, plus the interval containing the artifact
itself.
Another way to solve the problem (of the test subject moving his or her head) is to position
"Head Movement" markers manually.
The Template Drift Compensation method (TDC) uses several artifact templates to reduce
problems caused when scanned intervals drift relative to each other by fractions of a sampling interval (template drift). The method is based on using for averaging only those intervals that have similar template drift.
For detailed information, refer to "On drifts and
shifts" on page 417 and "Template Drift Compensation (TDC)" on page 418 of this section.

Method 4: Template Drift
Compensation

Note that you can only use the TDC method if you checked the Use Template Drift Detection
box to measure the template drift when detecting the scanned intervals.

We would like to point out again
here that TDC does not have to
be used if the scanner and amplifier are synchronized with each
other by means of the BrainVision SyncBox.

In the Number of Templates To Use text box, you specify the number of templates used. Using a large number of templates should result in a more precise correction. However, in this
case, fewer intervals are included in the calculation of each template. Consequently, the significance of the template is reduced.
If you check the Drift-differences and Shifts in Operation Infos box, all drift differences and
shifts are added to the Operation Infos. The drift differences are not nominal drift values; instead, they represent the difference between two successive drifts.
For a better selection of the number of templates used, you can also base yourself on the values of the drift differences or the distribution of the drifts.
On page 4 of the dialog, you can select the channels for which the correction is to be performed (see Figure 7-166). You can select all the channels (Use All Channels for Correction)
or only specific channels (Use Following Channels).

Dialog page 4: Channel
selection
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Figure 7-166. MR Correction, dialog page 4, Selecting the channels

Dialog page 5: Sampling rate
and filter settings

On page 5 of the dialog, you can reduce the sampling rate for the data set and make filter
settings (see Figure 7-167).
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Figure 7-167. MR Correction, dialog page 5, Sampling rate and filters

The EEG is recorded in the MR scanner with a very high sampling rate so that the scanner artifacts can be detected correctly and subsequently corrected. However, data with high frequencies takes a lot of time to process and requires a great deal of storage space. You should
therefore reduce the sampling rate (downsampling) for the data set following artifact correction. To do this, check the Do Downsampling box.
You specify the sampling rate of the output data in the New Frequency [Hz] text box. You can
select a value from the drop-down list or enter the required value manually.
If you enter a frequency yourself rather than choosing one of the predefined values, the frequency you have specified may be corrected to the nearest possible frequency when you

Please note that in Version 1 of
the Analyzer the downsampling
factor was specified at this
point.
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move the cursor out of the New Frequency [Hz] box. This is because downsampling can only
be performed using integer factors in order to avoid interpolation effects.
You can adjust the filter settings under Filtering. Filtering is necessary if residual frequencies
that do not have a physiological origin remain after the correction of the EEG.
There are two filter types available: High-cutoff (low-pass) and band-rejection filters. If you
check the Apply Lowpass Filter box then frequencies that are higher than the value entered
in Cut-off Frequency [Hz] are filtered.
You can also choose between an FIR filter and an IIR filter. You specify the gradient of the IIR
filter in the Slope for the IIR Filter drop-down list. Two values are available.
The FIR filter used here is the same as the filter used in Analyzer 1 and is very strong. Analyzer
2 therefore offers you the option of using an IIR filter. This IIR filter is a typical Butterworth
filter, as used in the IIR Filters transform.
You can use the Apply Bandrejection Filter function to filter out specific frequency ranges
(the band-rejection filter used here is an FIR filter). To do this, enter the mean values of the
frequency ranges in the Rejected Frequencies [Hz] box and the bandwidth of the frequency
ranges in the Bandwidth box. To enter values in Rejected Frequencies [Hz], enter this in the
box on the right and click Add. To remove a value again, select it and click Delete.

Dialog page 6: Storage options

On page 6 of the dialog, you specify the storage options for the calculated data so that the
subsequent operations can be performed more quickly (see Figure 7-168).

Transforms in the Special Signal Processing group 431

Figure 7-168. MR Correction, dialog page 6, Storage options

The following storage options are available:
 Do Not Store Data, Calculate Data on Demand. The data is not stored. Instead, it is cal-

culated on demand.
 Store Corrected Data in Cached File. The data is stored in a cache file.

We recommend that you use this option to avoid increasing the size of the history files.
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 Store Data Uncompressed in History File. The data is stored in the history file uncom-

pressed.
 Store Compressed Data in History File. The data is stored in the history file compressed.

Compression means the data takes up less storage space, but precision is reduced. In
the Compression Resolution [nV] text box, you enter the coefficient by which the data is
to be compressed. The default value is 100.

References

[All00] P.J. Allen et al., A Method for Removing Imaging Artifact from Continuous EEG Recorded during Functional MRI. Neuroimage 12 (2000), 230-239.

7.6.3

CB Correction

Please note that unlike in Analyzer 1, there are separate transforms for scanner artifact correction and cardioballistic artifact correction in Analyzer 2.

Summary

The CB Correction transform allows the detection of pulse beats and the correction of cardioballistic artifacts that occur during combined EEG-fMRI measurement in an MR scanner.

Recommendations on the use
of the transform

Although it is theoretically possible to detect and correct pulses in one and the same process, it is not advisable – particularly not when the quality of the correction using the selected parameters for a given data set cannot be assessed. We therefore recommend that you
break the process down into two separate steps:
1

Search for ECG episodes before correcting the cardioballistic artifacts. Unless you perform the search for cardioballistic artifacts in semiautomatic mode, we recommend that
in this step you merely set markers and then analyze their structure over time. The Analyzer's "Marker Timing" solution is ideal for the analysis of the cardioballistic markers. It
shows the time between successive markers as a time-voltage curve.

2

Correct the cardioballistic artifacts.

The advantage of subdividing the process into two steps is that you can analyze the interim
results and perform intermediate steps, for example adjust the markers or run an artifact
search using the Raw Data Inspection transform.

Procedure

To call the transform, choose Transformations > Special Signal Processing > CB Correction.

Dialog page 1: Choosing the
artifact detection method

On page 1 of the dialog, you can specify whether you want to use a detection method (Use
Detection Method) or markers (Use Markers option) for artifact detection (see Figure 7-169).
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Figure 7-169. CB Correction, dialog page 1, Artifact detection method

If you select the Use Markers option, the markers already set in the EEG are used to determine the pulse intervals, and artifact correction is performed for those pulses that are identified by a marker. You can select the marker from the R-Peak Markers drop-down list which
contains all the markers already present in the data set.
If you select the Use Peak Detection option, the pulse peaks (R-peaks) are detected and
marked. This is performed either for the current correction or, if you are using the Write Only
Markers function, for future corrections.

Note that these markers do not
necessarily correspond to the
point identified as the R-peak in
heart physiology; they are simply a recurring attribute of the
pulse, allowing the time at which
the pulse beats occur to be identified.
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The Semiautomatic Mode checkbox allows you to enable/disable semiautomatic mode for
subsequent editing of the results of pulse detection.
You make the settings for the pulse template under Search Pulse Template.
If you check the Use Template Markers box, the existing pulse template is used. This checkbox is only available if the data set contains markers with the names "TSTART", "TPEAK" and
"TEND" in exactly this order.
If you do not use this function then you can specify an interval in which a pulse template is
to be searched for in the Start and Length text boxes. Choose the channel in which the search
is to be conducted from the ECG (EEG) Channel drop-down list. This is generally an ECG channel. If the ECG recording is not of sufficient quality, or no ECG channel has been recorded,
you can use an EEG channel with well-defined pulse artifacts instead.
If you check the Mark Found Template box, three markers ("TSTART", "TPEAK", "TEND") are
set in the pulse template (see Figure 7-170).
Figure 7-170. CB Correction, Pulse template with the markers TSTART, TPEAK and TEND

In semiautomatic mode, the pulse template is marked with an interval marker (see Figure 7171).
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Figure 7-171. CB Correction, Pulse template in semiautomatic mode

In the Pulse Rate group (see Figure 7-169), you make the pulse rate settings (the interval between two pulses). You specify the average pulse rate and associated tolerance range (+/-)
in milliseconds and the minimum (Min.) and maximum (Max.) tolerance values in beats per
minute (bpm). (When you change the value in one of the four text boxes and position the
mouse pointer in another text box, the values in the text boxes affected by this are adjusted
as appropriate.)
For the purposes of pulse detection, the values in the Correlation and Amplitude group play
the following role: In the intervals in which the current correlation is greater than the value in
the Correlation Trigger Level text box, maximum correlations are searched for. If the value of
the amplitude at the maximum correlations lies strictly between the minimum and maximum
amplitude triggers, this value is identified as the pulse peak. The Correlation Trigger Level
value is always between 0 and 1.
The default values for the amplitudes in the Min. and Max. text boxes are 0.6 and 1.2 respectively. If these values do not lead to satisfactory results, you can increase or reduce them.
In the Mark Pulses with R-Peak-Marker text box, you can enter the name of the R-peak marker.
If you have checked the Write Only Markers box, there are no further pages in the dialog because no artifact correction is performed. All that happens is that pulses are marked. Click
Finish to conclude your entries.
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Dialog page 2: Time delay calculation and channel selection

On page 2 of the dialog, you can make settings for the calculation of the time delay and select
channels (see Figure 7-172).
Figure 7-172. CB Correction, dialog page 2, Time delay and channel selection

The time delay is the delay between the heartbeat and the occurrence of the artifacts caused
by it in the EEG channels. You can specify the time delay either automatically or manually.
Please note that at very high heart rates or fluctuating heart rates the automatic calculation
of the time delay can fail.
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If you check the Use Whole Data to Compute the Time Delay box, the entire data set is used
for the automatic calculation of the time delay.
If you only want to include selected intervals in the calculation, clear the Use Whole Data to
Compute the Time Delay box and check the Use Following Interval to Compute the Time Delay box. You can specify the interval within which the time delay is to be determined in the
Start [s] and Length [s] text boxes.
If you wish to specify the time delay value manually, clear both boxes and enter the required
value in the Use Following Value for Time Delay [s] box. This value will typically lie between
0.2 and 0.4 seconds.
In the Total Number of Pulse Intervals Used for Average text box, enter the number of intervals that are to be used for the calculation of the correction template.
We recommend that you enter an odd number. The program increases an even number by
one because the same number of intervals are always used before and after the artifact in
addition to the interval containing the artifact itself. This means, for example, that if you enter the value 20 then 21 intervals will be used for the correction.
You then select the channels for which you want to perform the correction.
On page 3 of the dialog, you specify the storage options for the calculated data so that the
subsequent operations can be performed more quickly (see Figure 7-173).

Dialog page 3: Storage options
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Figure 7-173. CB Correction, dialog page 3, Storage options

The following storage options are available:
 Do Not Store Data, Calculate Data on Demand. The data is not stored. Instead, it is cal-

culated on demand.
 Store Corrected Data in Cached File. The data is stored in a cache file.

We recommend that you use this option to avoid increasing the size of the history files.
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 Store Data Uncompressed in History File. The data is stored in the history file uncom-

pressed.
 Store Compressed Data in History File. The data is stored in the history file compressed.

Compression means the data takes up less storage space, but precision is reduced. In
the Compression Resolution [nV] text box, you enter the coefficient by which the data is
to be compressed. The default value is 100.
If you did not check the Semiautomatic Mode box in the Pulse Detection Parameters dialog
box, you start the artifact correction process by clicking Finish.
If, however, you are using semiautomatic mode, a data window opens in which you can subsequently modify the results of cardioballistic artifact correction.
To examine the pulse peaks in more detail, click the name of the ECG or EEG channel that you
selected on page 1 of the dialog (ECG (EEG) Channel text box). The channel initially contains
only red and green markers. Yellow markers are added subsequently (see Figure 7-174).
Figure 7-174. CB Correction, markers in semiautomatic mode

The colors have the following significance:
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 The green markers indicate points that the peak detection process clearly recognizes as

pulse peaks.
 The red markers indicate points that are potentially pulse peaks but do not meet all the

mathematical conditions for this.
 Yellow markers are markers which have been confirmed or added by the user or markers

that were originally red or green and have been moved by the user.
Rules for using markers:
 If you click a green or red marker, the color of the marker changes to yellow.
 If you use the mouse to move a yellow marker, its color remains unchanged.
 If you click a yellow marker, it is removed.
 If you click anywhere in the channel, a yellow marker is added.

The Undo and Redo buttons at the bottom of the interactive view (see Figure 7-175) allow you
to undo and redo changes, respectively.
If you want to interrupt what you are doing and resume later, you click the Suspend button.
The CB Correction transform is highlighted in red in the history tree, and all the processing
steps carried out continue to apply.
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Figure 7-175. CB Correction, interactive view

When you terminate semiautomatic mode by clicking Finish, the green and yellow markers –
but not the red ones – are treated as pulse peaks.
In the top part of the interactive view, you can see the parameters most recently selected in
the dialog:
 Name of the selected channel
 Interval between two pulses with a tolerance range
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 Marker name
 Correlation trigger
 Amplitude trigger

The table shows the intervals in which not enough peaks were detected. These intervals are
known as gaps. If you double-click a row in the table, the view switches to show the position
of the gap. The table is continuously updated as you reject and/or confirm markers.
If you use the Correlation > Graph function, the correlation graph is displayed in the channel
as an overlay. The Correlation Scale box contains the factor used to display the correlation.
You can change the size of the correlation graph in order to adjust it to the display of the EEG
by modifying this factor.
Correlation > Trigger displays the correlation trigger.
Correlation > Cut displays either
 the correlation wherever it is greater than the correlation trigger (only within these inter-

vals is a search carried out for the maximum correlations), or
 the constant trigger value wherever the correlation is lower than the correlation trigger.

The green markers indicate local maximum correlations obtained within the intervals by
means of the "correlation > correlation trigger" attribute (see Figure 7-176).
Figure 7-176. CB Correction, Correlation trigger (green line) and local minimum correlation
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If you use the Amplitude > Graph function, the amplitude graph is displayed in the channel
as an overlay. The value entered in Amplitude Scale is used to display the amplitude.
Amplitude > Trigger displays both amplitude triggers.
The Amplitude > Cut function shows either
 the constant value of the minimum trigger if the amplitude is lower than the minimum

trigger value (A < min), or
 the amplitude graph if min < A < max, or
 the constant value of the maximum trigger if A > max.

Consequently, only the pulse peaks that meet the criteria "correlation > correlation trigger"
and "min. amplitude trigger < amplitude < max. amplitude trigger" are output as reliable
peaks (see Figure 7-177).
Figure 7-177. CB Correction, Minimum (pink) and maximum (blue) amplitude triggers
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In the left-hand highlighted section of Figure 7-178, we can see that the local maximum correlation is greater than the correlation trigger. However, the amplitude is outside of the permitted amplitude range. A red marker is therefore written here (unreliable peak). In the
highlighted area on the right, the criteria "correlation > correlation trigger" and "min. amplitude trigger < amplitude < max. amplitude trigger" are met, so the corresponding peak is output as a reliable peak (green marker).
Figure 7-178. CB Correction, Amplitude trigger and correlation trigger

Overlays: explanation of colors

To specify the colors of these overlays in semiautomatic mode, right-click in the interactive
view and choose Settings from the view context menu. The View Settings dialog box appears. Here, you choose the Overlay tab (see Figure 7-179).

For information on the overlay settings, refer to
Section 4.6.3 on page 166
ff.

The colors of the overlays with the numbers 1, 2 and 3 (Overlay Nr. column) correspond to
the overlays "Correlation Graph", "Correlation Trigger" and "Correlation Cut". The colors of
the overlays with the numbers 4, 5, 6 and 7 correspond to the overlays "Amplitude Graph",
"Amplitude Trigger Min", "Amplitude Trigger Max" and "Amplitude Cut".
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Figure 7-179. CB Correction, Colors of the overlays in the interactive view

The pulse template is identified in the channel by a light blue marker. This marker also contains an internal peak marker (a vertical black line with a circle). Both the position and size
of the marker and the position of the internal marker can be changed.
If you press the right mouse button and then choose > Move Template Here, you can move
the template to the required position in the EEG (see Figure 7-180).
Figure 7-180. CB Correction, Moving the pulse template

Colors of the overlays in the
interactive view
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If you click Recalculate in the interactive view, the markers are recalculated relative to the
template which may have been moved in the meantime.
If you click Change Settings and Recalculate then the Change Settings dialog box appears
(see Figure 7-181). This contains the same elements for peak detection as the main Pulse
Detection dialog box. It also provides you with the Use Marked Template and Find Another
Template options.
Figure 7-181. CB Correction, making changes to settings

If you select the Use Marked Template option, the existing pulse template is used. If you select Find Another Template, a new template is obtained.
Click the OK button to conclude and apply your input. Click Finish in the interactive view to
start artifact correction.

Method

As with MRI scanner artifact correction, the correction of cardioballistic artifacts is based on
a template averaging process. Because the pulse beats are extremely variable, only the sliding method can be used successfully. The first step is to reliably detect the ECG episodes in
order to determine precisely the time at which the artifacts associated with a heartbeat begin. It is not absolutely essential to determine the R-peak position here; it is enough to obtain
a clearly defined, recurring attribute of the ECG recording.
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It is possible to separate the detection of pulse episodes from cardioballistic artifact correction and, as an initial step, to highlight the pulse attributes. The correction can therefore be
based either on a detection method or on markers that already exist in the EEG.
The correlation method compares the ECG curve over time with a template curve in terms of
their shape and amplitude and searches for peaks in those sections in which the correlation
exceeds a specific threshold.
Because of the great variety of EEG/ECG recordings and situations, it is difficult to apply the
parameters used in one case to another case. Semiautomatic mode is available to allow suitable parameters to be found and to provide an insight into the detection process.
In order to calculate averages for the cardioballistic artifacts in the EEG channels, the trigger
times (R-markers) obtained are transferred from the ECG channel to the EEG channels, taking
into account a selectable time delay. The correction is performed over an interval that includes the R-marker. To obtain the average pulse curve, corresponding intervals of the preceding and following sections of the EEG are used. Linear trends are calculated before
averaging. Sections identified as "bad intervals" are excluded from the calculation. The correction involves subtracting the calculated average pulse curve from the EEG. This is performed separately for each ECG episode and each channel.
[All98] P.J. Allen et al., Identification of EEG Events in the MR Scanner: The Problem of Pulse
Artifact and a Method for Its Subtraction. Neuroimage 8 (1998), 229-239.

7.7

Transforms in the Others group

7.7.1

Data Cache

The Data Cache transform allows the data of the parent node to be saved so that it can be
accessed more quickly than if it had to be recalculated. The transform always queries the
data of the parent node at fixed intervals. Segmented nodes are saved segment by segment.
Non-segmented nodes are saved at user-definable intervals. Whether or not the Data Cache
transform can be used effectively depends on the preceding transforms. Some transforms,
such as the Average transform or the Fast Fourier transform, always save their data in the history node. Others, such as the MR Correction transform, have parameter options that allow
data to be stored temporarily.

References

Summary

In addition to real data in the time domain, the Data Cache transform now also supports complex data in the time domain as well as both real and complex data in the time-frequency domain. Operation is therefore identical for all these data types.
No previous processing steps are required before the transform is used.
To call the transform, choose Transformations > Others > Data Cache.

Procedure
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Figure 7-182. Data Cache, dialog box

The four options in the dialog box allow you to choose between four different methods of
data storage:
 Store in Persistent Cache File. The data is stored in a permanent file on the hard disk.
 Store in Temporary Cache File. The data is stored in a temporary file on the hard disk.
 Store Uncompressed in History Node. The data is stored uncompressed in the history

node.
 Store Compressed in History Node. The data is stored compressed in the history node.

In the Compression Resolution [nV] text box, you can specify the resolution (precision)
of the compression. For EEG data the resolution should be about 100 nV (nanovolts, 1 μV
= 1000 nV), which is 0,1 μV. A lower value means a higher resolution but less compression.
For detailed information on
the Purge Deleted Nodes
function, refer to
Section 2.4.3 as of page 90.

Note that persistent cache files continue to use storage space on the hard disk until the associated transform node is removed from the cache for deleted nodes by means of the Purge
Deleted Nodes function. Note also that when very large quantities of data are stored uncompressed in the history node, this can result in increased access times.
The Cache Data on Request checkbox is only relevant for the first two storage methods. If the
box is checked, the cache is only calculated the first time you request the data. If the checkbox is cleared, the data is only calculated when you conclude your entries with OK.
Regardless of the setting of the Cache Data on Request box, the data of the parent node is
always requested in segments or the intervals used.
Total Data Size indicates the total volume of the uncompressed data.
The text boxes in the Cache Intervals group are only relevant in the case of non-segmented
data:
 Data Request Interval [s]. The data is always written to the cache at intervals of n sec-

onds.
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 Request Buffer Before Interval [s]. The data is also requested from the parent node n sec-

onds before the actual cache interval.
 Request Buffer After Interval [s]. The data is also requested from the parent node n sec-

onds after the actual cache interval.
Consequently, the cache consists of several intervals of the length specified in the text boxes
in the Cache Intervals group. For each of these intervals, a quantity of data is requested from
the parent node that corresponds to the sum of all three values. The request before and after
the cache interval is relevant when transient phenomena have to be taken into account, as
with IIR filters, for example.

To minimize transient phenomena resulting from the
use of filters, we recommend that you enter a value
> 100 s in the Data Request Interval [s] text box.

The four data storage methods always respect the above when data is not segmented. Consequently, the cache is always filled with the same data, regardless of the order in which it
is structured.

7.7.2

Edit Markers

You can use the Edit Markers transform to set and edit markers in the EEG.

Summary

No previous processing steps are required before the transform is used.

Procedure

To call the transform, choose Transformations > Others > Edit Markers.
Figure 7-183. Edit Markers, first page of the dialog

To begin with, you specify the type of marker editing:
 Automatic. In this mode, you can edit complete, existing marker groups.
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 Table. In this mode, you can set and edit individual markers. The markers are positioned

with pinpoint precision.
 Graphical. This mode allows you to set and edit individual markers freely in the EEG.

Automatic mode

In automatic mode, you can edit marker groups in accordance with the editing rules. You can
enter the editing rules in a table (see Figure 7-184). For each rule, all the markers of the data
set are selected with a suitable type and description and edited in accordance with your
specifications. The rows are processed in the order in which they appear in the table.
You must always make sure that there is no conflict between the individual editing rules. It
is, for example, not possible to start by renaming markers and then specify an editing rule
that refers to the original marker descriptions.
The elements in the upper part of the dialog box make it easy to create new rows for the table.
You can edit existing rows directly in the table.
Figure 7-184. Edit Markers, automatic mode

From the Choose Marker Type drop-down list, you can choose the type of the marker to be
changed. The list contains the marker types present in the data set together with the entry
<All Types> which allows you to select all the marker types present in the data set. The New
Marker Type text box is updated depending on your selection.
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You can choose a marker description in the Choose Marker Description drop-down list. If you
want to select all the descriptions, choose <All Descriptions> here.
If you check the Delete these Markers? box, all the markers of the corresponding type and
description are deleted.
You can change the marker type and description in the New Marker Type and New Marker
Description text boxes. If you have selected <All Types> or <All Descriptions>, the default entry
<No Change> is displayed in the New Marker Type or New Marker Description box. This indicates that no changes have been made to the marker type or marker description.
You can use the Choose Channel drop-down list to assign a new channel to the marker. If the
marker channel is not to be changed, select no change.
In the Time Shift in ms text box, you enter the value for the time shift of the marker. The relevant marker is moved by this value to the left (negative value) or right (positive value) on
the axis.
Choose Clear to delete all the entries and reset Choose Channel to All.
You can use Add to add a new editing rule to the table.
The Move Row Up and Move Row Down buttons allow you to change the position of the selected row in the table and thus the order of the various processing steps.
Clicking User Properties opens the following dialog box which contains the user-defined
marker properties. These properties apply to a single marker group in each case (see
Figure 7-185).
Figure 7-185. Edit Markers, "User Properties" dialog box

Under Property Name, you can enter the name of the marker property. You can enter a name
of your choice here. Value shows the associated value. This has a data type for programming
purposes. You can select this type from the Datatype drop-down list.
Show Original User Properties and Show Changed User Properties allow you to choose
whether the original User Properties of the marker or the properties you have changed are to
be displayed.
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To delete existing marker properties, choose the view of the changed User Properties, select
the relevant row of the table and press the <Del> key. The row turns red, and the data type
NULL appears in the Datatype column. Alternatively, you can specify the data type by choosing NULL from the drop-down list. To undo this deletion, you can set a specific data type for
the row at any time.

Manual (table) mode

In manual (table) mode, you can edit individual markers. The table contains the following information for all the markers present in the EEG: type, description, the associated channel or
channels, marker position in data points, line width, user-defined marker properties (User
Properties) and marker status (see Figure 7-186).
A marker can have the following statuses: unchanged, changed, deleted and added. The
Status column is updated automatically. The statuses have the following color codes:
 Unchanged markers: black
 Changed markers: blue
 Added markers: green
 Deleted markers: red

Figure 7-186. Edit Markers, manual (table) mode

You change the marker properties Type, Description, Position and Points by double-clicking
in the corresponding cell. You can select a channel via the drop-down list. To delete a row in
the table, select it and press the <Del> key.
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You can edit the table by copying the values of one or more cells and pasting these at the
required position. To do this, right-click in the table and choose Copy or Paste from the context menu.
If you want to add markers, go to the end of the marker table and enter the required marker
in the empty row. An empty row is then automatically added to the table and you can enter
further new markers. Please note that after a change of the Show Original Markers and Show
Changed Markers views, the table is reorganized on the basis of the marker positions.
Show Original Markers displays the status of the markers in the original data set. Show
Changed Markers displays all the changed markers together with the corresponding color
marking.
If you want to reset selected markers to their original status, click Reset Selected Markers.
You can use Reset All to reset all the markers to their original status.
Clicking User Properties opens a dialog box which contains the user-defined marker properties. These properties apply to a single marker in each case. The dialog box is the same as
the User Properties dialog box in automatic mode (see Figure 7-185 on page 451).
In graphical mode, you can use an interactive view that helps you to edit markers (see
Figure 7-187).

Graphical mode
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Figure 7-187. Edit Markers, graphical mode with interactive view

A marker must be active before you can edit it. This is the case if the name of the marker is
surrounded by a gray box. In the case of a marker with multiple points, the box appears as
soon as you position the mouse pointer on the marker. In the case of a marker with only one
point, the box appears when you position the mouse pointer on the marker name.

Adding markers

You set a marker by holding down the <Shift> key and clicking in the graph. To set a marker
for all channels, click in the area below the EEG graphs.
You can preset the properties of the new marker using the parameters under Next New Marker. This is useful if you wish to create several markers of the same type. If you have preset the
channel for the new marker, it does not appear at the point on the screen at which you
clicked, but at the appropriate place in the selected channel.
By means of a single mouse click you create a marker of the width specified in the Point
Width text box. If you want to set a marker with a different number of points, hold the mouse
button down and drag the mouse pointer to the left or right over the graph (see Figure 7-188).
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Figure 7-188. Edit Markers, Setting markers with more than one point

You change the position of a marker by clicking the marker, holding down the mouse button
and dragging the marker to the desired position. The graph on which you are positioning the
active marker changes color from black to orange (see Figure 7-189).
You can place a marker on a graph, in a channel or, for all channels in the area of the marker,
in the margin along the bottom of the screen. If you hold down the <Alt> key when dragging,
the marker is placed on the new channel but remains on the same data point. Conversely, if
you hold down the <Alt> and <Shift> keys when dragging, you can change the position of the
marker without changing its channel.
Figure 7-189. Edit Markers, Changing marker positions

Markers with several points have a positioning handle at each end with which you can
change the size of the marker. The positioning handle becomes visible when you move the
mouse pointer over the marker (see Figure 7-190 and Figure 7-191).
Figure 7-190. Edit Markers, Channel marker with positioning handle

Changing marker positions
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Figure 7-191. Edit Markers, Global marker with positioning handle

Editing markers

To edit a marker, click the marker or its name. A dialog box appears, in which you can change
the marker's description, type and width (see Figure 7-192).
Figure 7-192. Edit Markers, Editing marker properties
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To delete a marker, press the <Shift> key and click the marker or its name.

Deleting markers

The controls in the Next New Marker group (see Figure 7-187 on page 454) set the properties
of the next marker created with <Shift> plus a mouse click. In the Description and Type dropdown lists, you can either choose a description or type from those already in the data set or
enter a new text. In the Point Width text box, you enter the length of the marker in data points.
The Set Channel checkbox specifies whether the channel of the next marker is also to be preset. If the channel is preset, the next marker is always created in this channel, irrespective of
which graph you actually click.
You can choose one of the visible channels from the drop-down list below the checkbox or
choose the entry All to create a marker for all channels. If you change the channels displayed,
and the channel selected in the drop-down list is no longer visible, the entry All is selected
from the list in order to ensure that the new markers are always visible.
If you preset the channels for the next marker, it is particularly easy to set markers for all
channels at significant points of an individual channel (e.g. peaks). To do this, select All and
click directly on the channel containing the significant location in order to position the marker exactly.
The Undo and Redo buttons at the bottom of the interactive view allow you to undo and redo
changes, respectively.
If you want to interrupt your editing of the markers and resume later, you click the Suspend
button. The Edit Markers transform is highlighted in red in the history tree and all the processing steps carried out continue to apply until you open the node again with a doubleclick. No transforms or anything else can be applied to the interrupted node. If you click the
Cancel button, interactive mode is terminated and the operations performed are not saved.

7.7.3

Import Markers

The Import Markers transform is used to import markers from a different history node or from
a file.
When you import from a file, you can import the markers from either a text file or an XML file.
The format of these files is the same as for the export component Export Markers (
see
also Section 10.1.3 as of page 510). The Import Markers transform automatically recognizes
which format is used.
Below is an example of a file in text format:
Sampling rate: 250Hz, SamplingInterval: 4 ms
Type, Description, Position, Length, Channel
Stimulus, S254, 207, 1, All

Summary
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Stimulus, S 41, 467, 1, All
Stimulus, S 42, 723, 1, All

Procedure

To call the transform, choose Transformations > Others > Import Markers.
Figure 7-193. Import Markers, first page of the dialog

To import markers from a file, select the Import Markers from File option. If you want to import markers from a history node in the active workspace, select Import Markers from History
Node.
You use the Keep Old Markers checkbox to specify whether the markers of the parent node
are also imported.
The second page of the dialog contains different elements, depending on the import source
you selected (see Figure 7-194 and Figure 7-195).
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Figure 7-194. Import Markers, Importing markers from a file

Importing markers from a file

If you check the Delete Import File When Running from a Template box, the file is deleted
immediately after import has been completed. This option is particularly useful when using
history templates.
You enter the file name in the Marker File Name group. You can use the Browse button to select a file directly.
You can also use placeholders to select the file in a history template, for instance, on the basis of the name of the history file. Note that you can specify any folder to use files in locations
other than the export folder. The placeholder $e is used to specify the export folder independently of the workspace.
If you first export markers in XML format in a history template and then import them again
with the Delete Import File When Running from a Template box checked, the behavior is approximately the same as when you import markers from a different history node. However,
you have the additional option of editing the markers in an external program that is started
automatically from the template either using an add-in or SAX BASIC, for example.
If you have chosen to import markers from a history node, you are taken to a dialog box in
which you can select the data sets (see Figure 7-195). The list contains all the history files in
the current workspace. Double-click a file name to open the corresponding node.

Importing markers from history nodes
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Figure 7-195. Import Markers, Importing markers from history nodes

The following buttons simplify navigation:
 Expand Reference History File opens the current history file.
 Expand Same Names opens all history files that have a data set with the same name, up

to this data set.
 Expand All opens all the history files.
 Collapse All closes all the history files.

If you check the Use Relative Path for Template or Drag and Drop box the relative path of the
import node is stored in the newly created node. If the newly created node is used in a history
template, it always imports markers from the corresponding node in the history file of the
parent node.
Please note, however, that this checkbox is only available for marker nodes that are located
in the same history file as the reference node. When you select the checkbox, all the history
files except your current one are removed from the list of available history files.
If the Use Relative Path for Template or Drag and Drop box is not checked, the absolute path
of the import node including the name of the history file is stored in the newly created node.
In a history template, the markers are then always imported from the node in this history file.
You select a data set by means of a double or single click. Click the Finish button to conclude
and apply your input.
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7.7.4

MATLAB®

The software package MATLAB® from MathWorks has become established in the scientific
world for a variety of reasons. Its numerous libraries for signal processing and visualization,
some of which are available for free, have made MATLAB® a valuable tool in the field of brain
research as well. Of all the libraries that are available in this field of application, the EEGLAB
toolbox has made a particular name for itself.
For detailed information on EEGLAB refer
to [DM2004].

Summary

MATLAB® and the Analyzer have different strengths in terms of functionality and user guidance, so they complement each other ideally. The MATLAB® transform allows data to be exported from the Analyzer to MATLAB®, processed there and then reimported into the
Analyzer. In this way, MATLAB® processing methods are integrated in the Analyzer, in a similar way to macros, and can also be used in history templates.
If you simply want to export data to MATLAB® and it is not necessary to receive calculation
results from MATLAB®, then you can use Generic Data Export instead of the MATLAB® transform. For example, in EEGLAB you can choose File > Import Data > From Brain Vis. Rec. .vhdr
File to import the Brain Vision Data Exchange Format.
In order to use the transform, you must have a valid license for MATLAB® Version 7.4 or higher installed on your computer. This is not shipped with the Analyzer; you have to purchase
the license directly from MathWorks. Simply installing a MATLAB® runtime environment
does not allow you to run the MATLAB® transform.

Prerequisites for use

The transforms of the Analyzer can essentially be subdivided into two categories: There are
transforms that calculate and store their data when the history node is created, and there are
transforms that first create a history node and do not calculate the data and make it available
until requested to do so by views or subsequent transforms. The transforms of the first category include the Average transform and the Fast Fourier transform (FFT). The data calculated
by these transforms differs so fundamentally in its structure from the original data that it
makes sense to calculate it fully and store it each time the transform is called.

Processing Analyzer data with
MATLAB®

The transforms belonging to the second category include, for example, the IIR Filters and
RMS transforms. These transforms can be calculated by simply using sections of the original
data set. The original data sets that use these transforms are generally of the same order of
magnitude as raw data. Calculating and storing all of this data would be very heavy on resources. Consequently, calculation on request makes more sense.
The MATLAB® transform supports both procedures. This means you can select the most suitable option, depending on the original data and the scope of the required calculation in
MATLAB®.
When you perform an EEGLAB export, the MATLAB® transform now also allows you to export
"urevents" for segmented data from the Analyzer to EEGLAB.

Conceptual differences
between markers in the
Analyzer and events in EEGLAB
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Please note that this option is only of relevance for experienced EEGLAB users. If you do not
work with EEGLAB, you can skip the explanations below.
Whereas the Analyzer labels all time-related events (such as stimuli, the test subject's reactions or bad intervals) with markers, in EEGLAB this role is played by "events". Events can be
found in the "EEG.event" field of the EEG struct. The "EEG.event" variable is a field of structs.
In addition to events, EEGLAB also uses so-called "urevents" ("Ur" coming from the German
term meaning "original"). On the one hand, these urevents designate events that were previously present in the EEG data and, on the other, events that the user has added manually at
a latter point. Events can be found in the "EEG.urevent" field of the EEG struct. The
"EEG.urevent" variable is a field of structs.
Alongside attributes such as "type", "latency" and "duration", every event also possesses an
"urevent" attribute. This attribute contains the position of the associated urevent in the list
of all urevents.
The "urevent" attribute makes it possible to assign an event to its original temporal context
even after it has undergone various processing steps.
For detailed information on the EEGLAB format as well as on working with urevents, refer to
the EEGLAB user documentation.
Because the markers in the Analyzer do not possess a comparable "urmarker" attribute, the
MATLAB® transform generates this information when converting markers into events. When
doing this, it handles continuous data and epoched data (segmented data in EEGLAB) in different ways. While for continuous data the urevents are created as a copy of the events (without the "urevent" attribute), the information relating to epoched data is, as far as this is
possible, reconstructed from a history node which can be selected by the user.

Limitations in EEGLAB mode

It has to be regarded that EEGLAB and the Analyzer differ in the way data structures are
stored, processed, and exported. For example, exporting data in the frequency domain is not
possible. The same applies to data that has been generated using the following transforms:
 Comparison
 Cross Correlation
 ERS/ERD
 Grand Average
 Grand Segmentation
 ICA, if the history node contains components instead of reconstructed data.
 PCA
 RMS/GFP
 t-Test
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Please note that these restrictions only apply to the EEGLAB mode of the transform and not
to the MATLAB® mode.
To call the transform, choose Transformations > Others > Matlab.

Procedure

On the first page of the dialog, you can specify the type of calculation to be performed and
enter the MATLAB® code that you want to execute. If you select Show Matlab Window, the
data export is terminated by the following message window, which has to be confirmed in
order to return to the Analyzer.
Figure 7-196. MATLAB®, Message window

Depending on whether you want to calculate the data when the node is created or on request
(
see "Processing Analyzer data with MATLAB®" on page 461), you select the Calculate
Data on Creation of Node or Calculate Data on Request option. The appearance of the dialog
differs depending on which option you select.
If you select Calculate Data on Creation of Node, the Code Executed on Creation of Node box
is displayed as part of the dialog (see Figure 7-197). Here, you enter all the MATLAB® code
required to process the EEG data, change properties and create new markers.
You can also start the complete MATLAB® environment manually. To do this, enter the command desktop in the Code Executed on Creation of Node text box.

You can find examples of the two
options in this section as of
page 475.
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Figure 7-197. MATLAB®, first page of the dialog with the Calculate Data on Creation of
Node option selected

If you select the Calculate Data on Request option, the dialog contains two text boxes for
MATLAB® code (see Figure 7-198). In the first of these text boxes, you enter all the MATLAB®
commands that you want to be executed when the node is created. These will generally involve changes to the EEG properties or the creation of new markers. Please note that if you
select this option, for performance reasons no EEG data is made available to you at this
stage. The EEG data is not transferred to MATLAB® until requested by subsequent transforms or views. In the lower text box, you enter the code for the processing of this data.
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Figure 7-198. MATLAB®, first page of the dialog with the Calculate Data on Request option
selected

On the second page of the dialog, you can select the export options (see Figure 7-199).
Please note that you must select the Calculate Data on Creation of Node option on the first
page of the dialog if you want to be able to access the EEGLAB export functions.
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Figure 7-199. MATLAB®, dialog page 2, Export options

Data can be exported to MATLAB® in two different formats: a simple matrix format or the EEGLAB format.
If you do not want to use the EEGLAB format, do not select any of the functions listed under
EEGLAB Export Options.
The matrix format of the data which you get in this case has the following structure (see
Figure 7-200).
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Figure 7-200. MATLAB®, Data in simple matrix format

The exported EEG data is stored in a MATLAB® matrix with the name EEGData. The data
points correspond to the rows of the matrix, and the channels correspond to the columns.
In the case of segmented data, the matrix has an additional dimension that corresponds to
the individual segments. This format is ideal for further processing by the signal processing
and data visualization commands (filter, plot, etc.) contained in MATLAB®.
The EEG properties are contained in the MATLAB® "Properties" variable (see Figure 7-201).
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Figure 7-201. MATLAB®, Properties variable

This is a variable of the type "struct" in which the individual properties can be accessed by
means of their names. This also applies to any User Properties in the data set. The individual
properties are stored in MATLAB® according to their type. For example, you can access the
channel properties via the field of structs called "Channels" (see Figure 7-202).
Figure 7-202. MATLAB®, Channel properties
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We expressly draw your attention to the fact that you must not use special characters such
as ‘, % and @ in channel and marker names because these are assigned to functions in
MATLAB®. You must also avoid designations such as cos, sin or pi. You can find a full list
of the relevant special characters at http://www.mathworks.de/help/techdoc/ref/
specialcharacters.html.
To export markers to MATLAB®, you have to check the Export Markers box in the dialog. This
will create a variable called "Markers" in MATLAB®. This is a field of structs (see Figure 7203). As with the Properties, the structs provide access to the individual marker properties.
Figure 7-203. MATLAB®, Markers variable

The "EEGPosition" and "EEGPoints" variables specify the position and length of the EEG data
in the overall data set. They are relevant primarily when the EEG data is processed on request. Otherwise, the position is 1 and the length is the length of the original data set.
The "FileName" variable specifies the name of the history file, and the "NodeName" variable
specifies the name of the history node. In addition, information about the Analyzer environment is available in the "Analyzer" variable (see Figure 7-204).
You can also use these variables in template mode to program flexible behavior in MATLAB®
scripts.

470 Chapter 7 Primary and secondary transforms

Figure 7-204. MATLAB®, Variables with information on the node and the Analyzer
environment

The "EEGTime" variable, which is exported together with segmented data, contains a time
vector of the EEG data set. This can be used, for example, in the plot function for drawing the
time axis.
If the data set to which you apply the transform contains data in the frequency domain then
the vector "EEGFrequency" (unit: Hz) is exported together with the data instead of the vector
"EEGTime".
The data is imported into the Analyzer again from the variables described above. In other
words, changes in "Properties" and "EEGData" are imported back into the Analyzer as changes. For performance reasons, changes cannot be made in the markers. However, you can create new markers by creating a variable in MATLAB® called "NewMarkers" that has a similar
structure to the Markers variable. The newly created markers are read by the Analyzer. In
MATLAB®, Position and Channel indices of all markers are based on One, whereas indices
in the Analyzer are internally based on Zero. Therefore, when creating the "NewMarkers"
structure the fields Position and Channel need to follow the internal indexing logic of the Analyzer (Example 1). Markers that refer to all channels contain the default property Channel =
-1 (Example 2).
Example 1:
A new marker which is supposed to be placed in the first position and first channel of a data
set has to be defined in MATLAB® as following:
NewMarkers(1).Channel = 0;
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NewMarkers(1).Description = 'My Marker Description';
NewMarkers(1).Type = 'Comment';
NewMarkers(1).Position = 0;
NewMarkers(1).Points = 1;
Please note that the values of the fields Channel and Position have to be set to Zero.
Example 2:
For new markers that are supposed to be placed in all channels of a data set the field Channel has to be set to -1 as in the following:
NewMarkers(1).Channel = -1;
NewMarkers(1).Description = 'My Marker Description';
NewMarkers(1).Type = 'Comment';
NewMarkers(1).Position = 100;
NewMarkers(1).Points = 1;
If you check the Delete Original Markers after Export box, the original markers are deleted
after being exported from the history node. This does not apply to NewMarkers created in
MATLAB®.
In addition to the options described above, you can also edit the following settings in the
second page of the dialog (see Figure 7-199 on page 466):
To save storage space when there are large volumes of data, the EEG data is stored as floating-point numbers with single precision if you check the Export Data in Single Precision box.
When large volumes of data are transferred to MATLAB®, storage bottlenecks can occur
there because MATLAB® loads matrices in contiguous portions of main memory. If you check
the Pack Data During Transfer box, a pack command is called in MATLAB® at regular intervals during the transfer of data in order to enlarge the contiguous portion of main memory.
To improve performance, we recommend that you only use this function if large volumes of
data are to be transferred or if problems with main memory are to be expected.
Please note that it only makes sense to select the Show Matlab Window and Raise EEGLAB
checkboxes for working interactively with MATLAB®/EEGLAB if the data is calculated and
stored when the history node is created.
You can then execute commands interactively in MATLAB® and examine and edit data. Note
that these commands entered interactively are not returned to the Analyzer. They are thus
not suitable for the History Template mode. However, interactive mode is ideal for familiarizing yourself with the data in MATLAB® and compiling commands that you can enter in the
MATLAB® command field when the MATLAB® transform is called subsequently.
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When you click OK in the message window, the Analyzer resumes processing, re-imports the
data from MATLAB® and writes it to the history node created.
If you want to use data in EEGLAB format, check the EEGLAB Export Options box under EEGLAB Export Options. When the export is performed, an "EEG" variable of type "struct" is creFor
ated instead of the MATLAB® matrix and structs described above (see Figure 7-205).
a detailed description of the EEGLAB format, please refer to the EEGLAB user documentation.
Figure 7-205. MATLAB®, Data in EEGLAB format

If you check the Raise EEGLAB box, the EEGLAB interactive user interface appears (see
Figure 7-206). For this to be possible, EEGLAB must be installed on your computer, and the
paths must be registered with MATLAB®.
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If you use the Raise EEGLAB function, you can enter the name of the data set in EEGLAB. You
can use the placeholders $h and $n for this, as elsewhere in the Analyzer.
Figure 7-206. MATLAB®, Interactive EEGLAB user interface

If the active node contains epoched data and the Export Data in EEGLAB Format and Export
Markers boxes are checked then the function Export Ur-Event Struct for Epoched Data is
available to you. The term "epoched data" (segmented data in EEGLAB) is used here to refer
to data segments of the same length. To create epoched data, perform segmentation using
the Create new segments based on a marker position or Divide data set in equal sized segments option (
see also the corresponding settings in Section 7.4.5 as of page 371).
As described under "Conceptual differences between markers in the Analyzer and events in
EEGLAB" on page 461 ff, there is no equivalent to urevents in the Analyzer. The MATLAB®
transform therefore attempts to reconstruct the urevents and their relation to the events relative to the markers in a reference history node.
The "urmarker" associated with a marker is identified based on the correspondence of the
type, description and Real Time (recording time). You must therefore make sure that you always select a reference node from which the urevents can be reconstructed. This is usually
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the raw data node. However, if you edited any markers during the preliminary processing
then you must select the corresponding Edit Marker node as the reference node.
In addition, if reconstruction is to be performed successfully, the reference node must contain all the markers present in the active node with the exception of the New Segment and
Time Zero markers.
If the reconstruction of the urevents is not successful then a warning message is output. The
export to EEGLAB is still performed but the urevent struct is not generated.
You can use the Select Reference Node for Ur-Events button to select a suitable reference
node (see Figure 7-207).
Figure 7-207. MATLAB®, Selecting a reference node

You can use Expand All... to expand all the available history nodes.
If you check the Use Relative Path for Template or Drag and Drop box the relative path of the
reference data set is stored in the newly created data set. In this way, for example, you can
perform the same processing for each history file when running history templates, without
having to specify the reference data sets explicitly each time.
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Please note, however, that this checkbox is only available for reference nodes that are located in the same history file as the MATLAB® node. When you select the checkbox, all the history files except your current one are removed from the list of available history files.
If the Use Relative Path for Template or Drag and Drop box is not checked, the newly created
data set stores the absolute path of the reference data set including the name of the history
file. In a history template, the data set in this history file is then always used.
On the final page of the dialog, you can select whether all the channels or only a selection of
channels are to be exported to MATLAB® (see Figure 7-208). If you only want to export specific channels, select the Export Channel Selection option. You can use the Keep remaining
channels checkbox to specify whether the remaining channels are to be displayed in the resulting data set.
Figure 7-208. MATLAB®, Selecting channels for export

The functionality of the MATLAB® transform is illustrated below using two examples.

Examples
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Example 1: Simple plot with
MATLAB®

In the first example, the plot function of MATLAB® is used to display the EEG data. The exported matrix already has the appropriate format for this.
For this example, select a node with a short data set (an Average node for example). The example does, of course, work with longer data sets, but that requires more resources.
Select Calculate Data on Creation of Node and Show Matlab Window. In the code text box,
enter the command plot(EEGTime, EEGData); (see Figure 7-209). Now run the transform.
Figure 7-209. MATLAB®, Example, Simple plot 1

MATLAB® is called, and an additional window opens. This contains a MATLAB® plot of the
EEG data (see Figure 7-210).
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Figure 7-210. MATLAB®, MATLAB® plot of the EEG data

When you click OK to close the message window, MATLAB® is closed again and a new node
is created. This node contains the data of the original node since, apart from being displayed
in MATLAB®, it has not been subjected to any additional operations.
If you want to navigate through the MATLAB® plots using the Analyzer navigation function,
specify that the graph is to be created on request (see Figure 7-211). For this example you
can use a larger data set (a raw data set, for example).
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Figure 7-211. MATLAB®, Example, Simple plot 2

First of all, a new node is created in the Analyzer that displays the same data as the original
data set. In this case, no data is stored additionally in the history node. In addition, a
MATLAB® plot window appears whose display changes when you navigate in the Analyzer.

Example 2: FIR-Filter with
MATLAB®

MATLAB® offers comprehensive signal processing methods. For example, you can use two
commands to create an average FIR filter. Because this kind of filter tends to be used on raw
data, it is advisable to select the Calculate Data on Request option (see Figure 7-212).
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Figure 7-212. MATLAB®, Example of the creation of an FIR filter

In this case, an FIR filter with a length of 9 is created with constant filter coefficients of 1/9.
If necessary, you can use the MATLAB® functions to define more complex FIR filters.
When you execute the MATLAB® transform with the above parameters, you get a new history
node that makes the filtered data available on request with the help of MATLAB®. Compare
the data with the raw data in the Analyzer using the overlay function, and try navigating
through the data set. Try the transform out in a history template as well.
At this point, we would like to express our special thanks to the scientists and developers
involved in EEGLAB whose constructive collaboration helped us in the further development
of the transform.
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7.7.5
Summary

Edit User Properties

You can use the Edit User Properties transform to assign new User Properties (user-defined
properties) to history nodes or to modify or delete existing User Properties. The edited User
Properties are inherited by child nodes.
You can use the edited User Properties for automation purposes or for further processing using add-ins, solutions and macros.

Procedure

No previous processing steps are required before the transform is used.
To call the transform, choose Transformations > Others > Edit User Properties.
Figure 7-213. Edit User Properties, dialog box
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Enter the name of the property under Property Name. You can enter any value you choose.
Value shows the associated value. This value has a data type for programming purposes. You
can select this type from the Datatype drop-down list.
Show Original User Properties and Show Changed User Properties allow you to choose
whether the original User Properties or the properties you have changed are to be displayed.
To delete an existing property, choose the view of the changed User Properties, select the relevant row of the table and press the <Del> key. The row turns red, and the data type NULL appears in the Datatype column. Alternatively, you can specify the data type by choosing NULL
from the drop-down list. To undo this deletion, you can set a specific data type for the row at
any time.
Please note that it is not possible to edit User Properties with names that start with
"BrainProducts." or "BrainVision." because these are used internally by the program.
To view the User Properties that you have created or modified using the transform, right-click
the associated history node and choose Properties... from the node's context menu. In the
dialog box that now opens, choose the All Properties tab (see Figure 7-214).
Figure 7-214. Edit User Properties, Viewing modified User Properties in the history node
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The transient transforms are exclusively for the temporary display and inspection of the EEG
data. They do not generate any new history nodes but instead output their results in a dockable window in the EEG display.
You call the transient transforms by using the mouse to select a point or section of the EEG.
When you release the mouse button, a context menu appears in which you can select a transient transform (see Figure 8-1).
Figure 8-1. Selecting a transient transform

Alternatively, if a section of the EEG is already selected, you can right-click to open the view
context menu and select a transient transform under Transient Views (see Figure 8-2).
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Figure 8-2. Transient transforms in the view context menu

If you select one of the transforms, a dockable window appears at the right-hand border of
the main window. This window displays the result of the transient transform. This result applies to the selected point or the highlighted section of the EEG. If you change the position
of the point or highlighted section, the result of the transient transform is updated.
For some transient transforms, the docking window has a separate toolbar which allows you
to change the settings for the transient transform.
You can change the size of the subwindow for the display of the transient transforms by using
the mouse to move the separating bar between the dockable window and the main window.
To close the dockable window for a transient transform, click in its title bar

.
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8.1

3D head view

For further information on
the 3D head view, refer to

Section 4.2.6 as of page 127.

The 3D head view creates a three-dimensional topographic map that displays the voltage
distribution on the head in the time or frequency domain (see Figure 8-3).
In order to generate the 3D head view, the program requires information about the position
of the electrodes. If you used the 10-10 or 10-20 system when recording the EEG, the program should have this information. If you used other channel names, you can use the Edit
Channels transform to enter the correct coordinates.
For detailed information, refer to
Section 7.1.6 as of page 216.
Figure 8-3. 3D-Head-View, 3D head view as a transient transform
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8.2

Band mapping view

The band mapping view creates a two-dimensional topographic map (see Figure 8-4) to display the voltage distribution on the head in the frequency domain.
To do this, the band mapping view uses the same procedure as when the mapping view is
used in the frequency domain. Unlike the mapping view, the band mapping view does not
relate to a fixed subdivision of the selected range in intervals but to the frequency bands located within the selected range.
Figure 8-4. Band mapping view
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The number of topographies displayed depends on the number of frequency bands that are
fully located within the highlighted range and is updated when you move the highlighting. If
no frequency bands lie fully within the highlighting, a topography which relates to the entire
blue selection area is displayed. You can use the Bands tab in the view settings to define the
frequency bands.

You will find detailed information on configuring frequency bands in
Section 4.6.3 as of
page 166.
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For detailed information on
the CSD Interpolation primary transform, refer to
Section 7.1.4 as of page 213.

8.3

CSD map

If you use the CSD transform in its transient form, the current source density is represented
in a map (see Figure 8-6). An order of 4 and a polynomial degree of 10 are used implicitly for
the calculation.
To display the result of the CSD map to best effect, we recommend that you choose
Interpolation by Spherical Splines as the interpolation method for the map in the Default
View Settings dialog box (see Figure 8-5).

You will find detailed information on configuring the
view settings in Section 4.6
as of page 154.

Figure 8-5. CSD map, Selecting the interpolation method in the view settings
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Figure 8-6. CSD map, CSD map as a transient transform
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For detailed information on
the LORETA primary transform, refer to Section 7.6.1
as of page 408.

8.4

LORETA

The transient LORETA transform is used for source localization based on the Low Resolution
Brain Electromagnetic Tomography procedure described by R. D. Pascual-Marqui.
The virtual MR anatomical images are made available by the Montreal Neurological Institute
of McGill University.
We advise you only to apply the transient LORETA transform to data with an average reference. If necessary, you can use the New Reference transform to re-reference your data.
Figure 8-7. LORETA, LORETA as a transient transform

In the status bar of the LORETA window, Range indicates the range or point selected in the
view (range or single-point highlighting), the cross-section coordinates of the sliders (in parentheses) and the current flow density.
The information box above the status bar relates to the position of the mouse in the LORETA
window. It provides the following information:
 The parentheses contain the cross-section coordinates of the current position of the

mouse pointer (crosshair). When you move the mouse pointer around the cross-section,
the coordinates displayed change accordingly.
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 The Best Match at value specifies the distance from the current mouse position of the

next voxel containing stored physiological data. This is the data from the LORETA program.
 The next three lines indicate the associated anatomical data of the brain areas in the vi-

cinity of the mouse pointer.
If the mouse pointer is positioned outside the three cross-sections, the information box displays the values of the current intersection of the three cross-sections.
Figure 8-8. LORETA, Display of the mouse pointer in the cross-section

You can navigate in the cross-sections or layers of the tomography either by using the mouse
to move the four yellow sliders on the borders of the cross-sections in the desired direction
or by clicking a point in the cross-section and using the mouse wheel to scroll up and down.
When you click in a cross-section, the position of the sliders is updated.

Navigation

If you move the highlighting in the EEG and then release the mouse button, the display in the
LORETA window is updated.
If you want to make any settings, right-click in the window. This opens a context menu which
contains the following commands (see Figure 8-9):

Settings
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Figure 8-9. LORETA, Settings in the LORETA window

Save as File saves the LORETA window as a graphics file. The formats EMF, BMP, PNG and
JPEG are available to you.
Print opens a dialog box which you allows you to print the LORETA window.
If you choose the Lock Navigation to Maximum command, the display focuses on the position with the strongest brain activity.
Settings… opens the Settings dialog box (see Figure 8-10): You can choose various virtual
MR anatomical images from the 3D Anatomy drop-down list. You can also switch between automatic and manual scaling.
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Figure 8-10. LORETA, Settings dialog box

Show Horizontal Slices… opens the Horizontal Slices dialog box containing horizontal crosssections (z-axis) at fixed intervals. If you right-click in the dialog box, the associated context
menu appears (see Figure 8-11):
The Set Borders and Step… command opens the Borders and Step dialog box. Here you can
specify the minimum and maximum z-coordinates and the size of the steps (Step).
You can use the Export as Bitmap… command to export the file as a bitmap.
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Figure 8-11. LORETA, Display of horizontal cross-sections

The transient LORETA transform stores its internal data in the history node so that the view
becomes available quicker the next time you use it. You can delete this data by calling the
context menu for the relevant node and choosing Remove Loreta Streams (see Figure 8-12).
Figure 8-12. LORETA, Deleting Loreta streams
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8.5

FFT

The transient FFT displays the frequency spectrum for the selected range (see Figure 8-13). It
always uses the standard view and the currently selected montage.
A separate toolbar is provided for the transient FFT.
Figure 8-13. FFT, FFT as a transient transform

The context menu for the transient FFT contains the additional command FFT Resolution....
This opens a dialog box in which you can specify the resolution of the display in hertz. You
can choose between the maximum resolution, which is obtained from the number of points
in the highlighted range and the sampling rate (Maximum Resolution), and a user-defined
resolution (Other Resolution [Hz]). The maximum resolution is calculated as follows: sampling rate ÷ segment length.

For detailed information on
the primary FFT, refer to
Section 7.3.3 as of page 314.
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For further information on
the mapping view, refer to

8.6

Mapping view

Section 4.2.4 as of page 124.

The mapping view creates a two-dimensional topographic map that display the voltage distribution on the head in the time or frequency domain (see Figure 8-14).
As with the transient 3D head view, valid head coordinates are required to display the 2D
map. If you used the 10-10 or 10-20 system when recording the EEG, the program should
have this information. If you used other channel names, you can use the Edit Channels transform to enter the correct coordinates.
For detailed information, refer to Section 7.1.6 as
of page 216.
Figure 8-14. Mapping view, Map as a transient transform
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8.7

Zoom view

The zoom view allows you to enlarge the selected section of an EEG (see Figure 8-15). It always uses the standard view and the currently selected montage.
A separate toolbar is provided for the zoom view.
Note that the zoom function is only available for the time domain.
Figure 8-15. Zoom view
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Chapter 9 Add-ins

9.1

Marker Navigation

You can use the Marker Navigation add-in to navigate to selected markers.
To display the add-in, choose Add Ins > Tools > Marker Navigation. A dockable window opens
in the upper part of the main window (see Figure 9-1).
Figure 9-1. Marker Navigation

The Marker Type and Marker Description drop-down lists contain all the marker types and
marker descriptions in the data set. You can use these drop-down lists to select specific
markers. To navigate to any type or any description, choose <any> from the corresponding
drop-down list.
The buttons < and > allow you to navigate to the next or previous marker that meets the criteria
chosen from the Marker Type and Marker Description drop-down lists. If the data set does
not contain a combination of marker type and description, the buttons are inaccessible.
If you navigate to a marker in this way, the marker appears in the middle of the part of the
EEG that is displayed. The marker appears in green in the marker window.
If you check the Move Selection box, the area selected in the view moves and is set to the
position of the marker.
Please note that the add-in does not change the channel display. In other words, channel
markers may not be visible.
If you have multiple data sets open, navigation is carried out separately for each data set,
and that includes the selection of the marker type and description.
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9.2

Analyzer Video

You can use the Analyzer Video add-in for the synchronized playback of video data and EEG
data in the Analyzer.

Requirements

The following conditions must be met before you can use the add-in:
1

You must possess the appropriate license.
The add-in is an optional component of the Analyzer. You can only use it if you possess
a corresponding license. You can purchase licenses from us even after Analyzer installation.
To check which licenses you currently possess, you can select About Analyzer in the Help
tab in the ribbon.
Analyzer program components are licensed in two different ways depending on the type
of dongle you possess:
 If you use a Sentinel HASP dongle then the licenses are stored directly in the dongle

(

see also Section 1.5 as of page 59).

 If you use a HASP HL dongle then the licenses are installed separately on your system

in the form of a sub-license file.
For detailed information on downloading and installing sub-licenses, refer to Appendix G as of page 575.
2

Your system must have a full installation of DirectX version 9c. The .NET components
Microsoft.DirectX.AudioVideoPlayback.dll and Microsoft.DirectX.dll, which are used to
address DirectX, must also be present.
For detailed information on installing DirectX,
refer to Appendix L as of page 595.

3

The video codec must be installed.
You will find the codec and associated installation instructions in the folder \VideoCodec
on the BrainVision program DVD.

Playing back videos

Open an EEG data set containing a video sequence, and call the add-in by choosing Add Ins
> Plug In > Analyzer Video. A dockable video window opens in the upper part of the main window (see Figure 9-2).
The video view is possible for both raw data nodes and history nodes.
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Figure 9-2. Combined EEG/video playback

The date and time of the video recording are displayed at the top of the docking window. The
Play , Pause
and Stop
buttons allow you to control the playback of the video.
The Sync. EEG
video position.

button is used for the manual synchronization of the EEG with the current

The transparent bright blue highlighting indicates the position in the EEG. If you click the
marker to activate it, the context menu for transient transform selection does not open. You
can, however, display it by subsequently right-clicking with the mouse.
If you check the Video is Master box, the navigation in the EEG follows the navigation in the
video. In other words, if you change the position of the slider for the video, the slider for the
EEG jumps to the corresponding position in the EEG view.
If you check the EEG is Master box, the navigation in the video follows the navigation in the
EEG. In other words, if you change the position of the slider for the EEG, the slider for the video jumps to the corresponding position in the video.
If both boxes are checked, navigation in the video and navigation in the EEG are linked.
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9.3

Generic Data Header

The Generic Data Header add-in allows you to generate header files for the Generic Data
Reader (GDR). You can create header files in the VHDR format or in the XHDR format.
To call the add-in, choose Add Ins > Others > Generic Data Header.
A file selection dialog box appears in which you can select a file containing EEG data. The
Generic Data Header dialog box then appears (see Figure 9-3).
Figure 9-3. Generic Data Header, dialog box

For a detailed description of
these entries, refer to
Appendix M as of page 599.

The dialog box allows you to make entries for the header file to be created. On the various
tabs (Properties, ASCII Infos, Binary Infos and Channels), you can make appropriate entries
for your EEG.
The entries for data in the time-frequency domain are listed on a separate tab which is only
displayed if you have selected a time-frequency data type.
On the Channels tab, you can specify the number of channels in the EEG in the Number of
Channels text box. Click Refresh to add new rows to the table or delete rows from the table.
You can also rename the channels in the table, among other things (see Figure 9-4). However, we recommend that you find out how many channels there are before you do this.
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Figure 9-4. Renaming channels

You can edit the table by cutting or copying the values of one or more cells and pasting these
at the required position. To do this, right-click in the table and choose Cut or Copy followed
by Paste from the context menu.
You use XML Format and Text Format to specify the format of the header file. To save your
entries, click Save Header.
Once the header file has been created, you can display the data on the right-hand side of the
dialog box by clicking Display View (see Figure 9-5). The label on the button then changes to
Update View. If you make changes to the settings, you can update the view by clicking Update View.
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Figure 9-5. Displayed EEG

You can use the buttons + / –, Scale up/Scale down and <-- / --> to navigate in the displayed
EEG.

9.4

LORETA

The functions of the LORETA add-in are the same as the functions of the transient LORETA
transform (
see also Section 8.4 as of page 490).
The difference between the transient transform and the add-in lies in the fact that the transient LORETA is bound to the selected data set whereas, in the add-in, the display of the data
relates to the currently active view and it is possible to switch between nodes.
To execute LORETA as an add-in, choose Add Ins > Others > LORETA.
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The export components can be used, for example, to export data sets, markers and area dimensions to files so that they can be further processed using other programs.
As with transforms, there are two groups of export components: simple export components
that export individual nodes and multiple export components that export multiple nodes.
You can find the export components in the Export tab on the ribbon.
The simple export components are always applied to an existing data set. They create a history node below the existing data set. This history node contains information about the export but no EEG data. ASCII exports are an example of this.
Simple export components can only be executed if a data set is open and – in the same way
as primary transforms – they always refer to the active data set window. In contrast to the
multiple export components, the simple export components can be used in history templates.
The simple export components permit the use of so-called placeholders in file name specifications. The placeholders stand for the name of the history file ($h) and the name of the current data set ($n). The advantage of using placeholders is that export components can also
be used in history templates without existing exported files being constantly overwritten.
This can be illustrated using the following example: For two history files "EEG1" and "EEG2",
the data set "Average" is exported and the name "$h_$n" is entered. The resulting filenames
are "EEG1_Average" and "EEG2_Average".
You can also use the simple export components to export a selected section (block) of the
EEG.
The multiple export components apply to multiple data sets. They include the Peak Information Export component, which creates a table of peak values on the basis of a selection of
history files or history nodes.
To select the folder in which the Analyzer is to store the export files, open the dialog for editing workspaces via the Analyzer button or the ribbon. Here you can specify the required
folder in the Export Files text box (see Figure 10-1).
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Figure 10-1. Specifying the export folder

Note on all export components

When you have completed your entries, a dialog box containing the name and storage location of the export file appears. Figure 10-2 presents this dialog box using the example of the
export component Generic Data Export.
Simple export components generate a node in the history tree which does not contain any
EEG data of its own. You can use this node to call the dialog box complete with the associated export specifications at a later date.
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Figure 10-2. Export file specifications after completion of input

10.1

Simple export components

10.1.1 Besa Export
You can use the export component Besa Export to export a data set or section of a data set
in BESA ASCII format. The export file has the file name extension .raw.

Summary

To call the export component, choose Export > Node Export > Besa.

Procedure
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Figure 10-3. Besa Export, dialog box

If you check the Export Selected Block box, only the selected EEG range (block) is exported.
This option is only available if you have selected a range (block) in the EEG.
If you check the Export Channel Names box, you can also export the channel names.
Enter the name of the export file in the Export File Name text box. You can also use placeholders to do this. The name you select is shown under Resulting File Name.

10.1.2 EDF Export
Summary

You can use the export component EDF Export to export EEG files in EDF or EDF+ format.

Procedure

To call the export component, choose Export > Node Export > EDF.
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Figure 10-4. EDF Export, dialog box

The EDF and EDF+ options allow you to specify whether the data is to be exported in EDF or
EDF+ format.
If you check the Export all Channels box, all channels are exported. You can also use Select
>> to choose specific channels.
If you check the Set Resolution Manually box then the Range +/- [μV] text box becomes accessible. Here you can specify the range of values for the data that is to be exported. The resolution of the values is automatically adjusted in the Resolution [μV/bit] text box.
Enter the name of the export file in the Export File Name text box. You can also use placeholders to do this. The name you select is shown under Resulting File Name.
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10.1.3 Export Markers
Summary

The Export Markers export component stores selected markers either in ASCII format or in
XML format. XML format saves all the marker information including the User Properties (userdefined marker properties). This format is well suited for further processing with external programs. ASCII format is identical with the marker format of the Generic Data Reader (
see
also Section 11.1.2 as of page 526).

Procedure

To call the export component, choose Export > Node Export > Markers.
Figure 10-5. Export Markers, dialog box

If you select the Export All Markers option, all markers in the data set are exported.
If you select Export Only Selected Markers, only selected markers are exported. You can use
Add >> and << Remove to specify which of the available markers is to be exported.
Under File Format, you can specify whether the markers are to be exported in XML format or
in ASCII format.
You can also specify the type of line delimiter to be used in ASCII format. This is useful to allow you to further process the data under various different operating systems. The three com-
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monly used formats for the majority of computer operating systems (PC Format), Unix (Unix
Format) and Apple Mac (Mac Format) are available for you to select.
Enter the name of the export file in the Export File Name text box. You can also use placeholders to do this. The name you select is shown under Resulting File Name.

10.1.4 Generic Data Export
The export component Generic Data Export allows you to export data – including complex
data – in the time and frequency domains in ASCII or binary format.

Summary

Once the data has been exported, it can be used in other applications that are able to import
exported ASCII or binary formats. Some applications are able to read the Brain Vision Data
Exchange Format directly. For example, you can use the EEGLAB option File > Import Data >
From Brain Vis. Rec. .vdhr File to perform the import.
To call the export component, choose Export > Node Export > Generic Data.
On the first page of the dialog, you specify the data that is to be exported and select the
names of the files that are to be created (see Figure 10-6).
Figure 10-6. Generic Data Export, dialog page 1, General settings

Procedure
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If you check the Export Selected Block box, only the range (block) selected in the EEG is exported. This option is only available if you have selected a range (block) in the EEG.
If you check the Write Header File box, a header file is created. The header file contains information about channels, sampling rate, data set type etc. and is used if the data is read in
again using the Generic Data Reader. The format of the header file is determined by the settings made under Header and Marker File Format.
If you check the Write Marker File box, a marker file is created. The marker file lists all the
markers present in the data set together with their positions, types, descriptions etc. The format of the marker file is determined by the settings made under Header and Marker File Format.
The two options present under Header and Marker File Format allow you to select the format.
You can choose between the following formats:
You will find a detailed
description of the text format and XML format in
Appendix M as of page 599.

 Text Format generates files in the Generic Data Reader's conventional format (.vhdr used

as the file name extension for header files and .vmrk used for marker files). This file format is based on the INI format used in Windows®.
 XML Format generates files in the Generic Data Reader's XML format (.xhdr used as the

file name extension for header files and .xmrk used for marker files). It is easier to read
this file format into external programs since very many libraries exist for the handling of
XML formats. XML format also allows you to define certain properties in greater detail
than in text format.
Under Export File Name, you specify the name of the export file as well as the names of the
header and marker files, if required. You can also use placeholders to do this. In the Base
Name text box, you enter the base name of the file, and in the Extension text box its file name
extension. The names you select are displayed in the Resulting Data File Name, Resulting
Header File Name and Resulting Marker File Name text boxes.
On page 2 of the dialog, you can specify the format of the data file that is to be created (see
Figure 10-7).
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Figure 10-7. Generic Data Export, dialog page 2, Format of the data file

Under Data File Format, you can specify the format of the files to be exported. You can
choose between text and binary format. In the case of a text export, the values are written
directly in μV or μV2. You can make the detailed settings for each of these formats on the following pages of the dialog.
Under Data Orientation, you specify the data orientation by selecting either the Vectorized
or Multiplexed option. Both of these settings apply to all the channels. Vectorized in this context means that all the data points of the first channel are written to the export file first, followed by those of the second channel, and so on. In a text export, each channel to be
exported is written to a separate line. Multiplexed means that the data of the first sampling
point is written first, followed by the data of the second sampling point, and so on. In a text
export, the data of each sampling time point is written to a separate line. If you export complex values, the real part is written first, followed by the imaginary part.
Under Line Delimiters, you can specify the line delimiter to be used for all exported text files.
This is useful to allow you to further process the data under various different operating systems. The three commonly used formats for the majority of computer operating systems (PC
Format), Unix (Unix Format) and Apple Mac (Mac Format) are available for you to select.
On page 3 of the dialog, you can specify the format of the data file that is to be created in
detail. The possible settings differ depending on whether you want to perform the export in
text or binary format.
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Settings for data in text files

If you selected the Text Format option under Data File Format on page 2 of the dialog, then
the following dialog page is displayed (see Figure 10-8).
Figure 10-8. Generic Data Export, Settings for text format

If you check the Add Channel Names to the Data File box, the channel names are added to
the file. In the case of multiplexed data, the channel names appear in the first line. Otherwise, they appear in the first column.
If you check the Overwrite Default Decimal Symbol (,) box, you overwrite your computer's default decimal symbol (point or comma) with the character entered in the Decimal Symbol text
box. Your computer's decimal symbol depends on its country settings.
If you check the Use Custom Precision box, you can specify the number of decimal places following the decimal symbol in the Precision text box. If you do not do this, all available decimal places are written.
Under Value Layout, you can control how the individual values in lines are separated from
one another. You can choose between the following options:
 Pad Values to Column Width writes spaces after each value until the required column

width has been reached. The column width is based on the longest entry in the column.
If present, channel names are also taken into account here.
 Separate Values by Space inserts a single space between the individual values.
 Separate Values by Custom Separator inserts the string specified in the Separator text

box between the individual values.
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If you selected the Binary Format option under Data File Format on page 2 of the dialog, then
the following dialog page is displayed (see Figure 10-9).
Figure 10-9. Generic Data Export, Settings for binary format

You can choose between a number of different binary displays of the data values. These are:
 IEEE 32 Bit Floating Point Format writes the values as floating point numbers with single

precision. In programming languages, this format is represented, for example, by the
data types float or single. The Analyzer also uses this format internally for data processing and the data is not pre-processed before being written.
 16 Bit Signed Integer Format multiplies the data values by a resolution factor which de-

termines the resolution and writes the result as a 16-bit signed integer.
 32 Bit Signed Integer Format multiplies the data values by a resolution factor which de-

termines the resolution and writes the result as a 32-bit signed integer. This format offers
a better resolution than the 16-bit format.
The following settings only apply to the 16-bit and 32-bit integer formats:
If you check the Set Resolution Manually box, you can set the resolution at which the data is
written manually. In the Resolution [μV] text box, you can then enter the resolution of the values, and in the Range +/- [mV] text box the range of the data to be exported. If you make an
entry in one of these two text boxes, the value in the other text box is adjusted accordingly.

Settings for data in binary files
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The resolution – in μV or μV2 – specifies the minimum difference between two values to be
stored. Since the 16-bit format is restricted to a maximum of 216 values, too high a resolution
can result in data peaks being truncated. The range in mV that is achieved at the specified
resolution is shown in the dialog. You can also enter this range instead of the resolution.
Alternatively, you can have the program calculate and set the optimum resolution. In this
case, however, you should always export a header file as well, since this is the only place you
will find the resolution that has been used.
If you check the Individual Optimized Resolution for Each Channel box, you can optimize the
resolution for each channel separately. If you do not use this function, a common resolution
is selected for all channels.
If you check the Convert to Big-Endian Order box, the exported data is converted to big-endian order. If you want to work with exported integer data on a system such as a Mac or a SUN
workstation, the least and most significant bytes of each value have to be stored the other
way round in big-endian order.
On the page 4 of the dialog box, you can select the channels that you want to export (see
Figure 10-10).
To export all the channels, check the Export All Channels box. Alternatively, you can choose
Select >> and select specific channels to be included in the export.
Figure 10-10. Generic Data Export, dialog page 4, Channel selection
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10.1.5 Create New Dataset
You can use the Create New Dataset export component to export a history node as a primary
history file. This export component is based on Generic Data Export; the values are exported
as multiplexed data in IEEE 32-bit floating point format.
To call the export component, choose Export > Node Export > Create New Dataset.
Figure 10-11. Create New Dataset, dialog box

You enter the name you want to give to the new history file in the Dataset Name text box. The
placeholders $h (for the name of the history file) and $n (for the name of the current data set)
are available to you. The desired name is displayed next to Resulting Dataset Name.
The new history file is exported to the Raw File Folder. Write authorization is required for this.
Existing files are not overwritten. The new history file is displayed as usual in the Primary tab
in the History Explorer. When the history file has been created, the information on the history
file is displayed. (see Figure 10-12).
Figure 10-12. Create New Dataset, information

Procedure
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10.2

Multiple export components

10.2.1 Area Information Export
Summary

You can use the export component Area Information Export to export the area dimensions
(μV*ms or μV*Hz) of an interval, the average activity (μV) or the total activity in an interval to
an ASCII table.

Procedure

To call the export component, choose Export > Multiple Export > Area Information.
Figure 10-13. Area Information Export, dialog box

You specify whether the data to be exported is in the time domain (by selecting the Time
Domain option) or the frequency domain (by selecting the Frequency Domain option).
In the Start [ms] and End [ms] text boxes, you specify the interval to be exported.
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In the Name(s) of the Involved Data Sets (History Nodes) text box, you specify the names of
the data sets or history nodes used, separated by commas.
If you check the Primary History Files Only box, you limit the Use Whole Workspace and Select Individual History Files options to primary history files.
In the Selection Filter text box, you can enter a selection filter to filter the available files on
name criteria. You can use an asterisk (*) to stand for one or more characters, and a period
(.) to stand for a single character. If the workspace contains the files "Test1H2", "Test2G" and
"Rest5", for example, " the string "Test*" filters out the files "Test1H" and "Test2G" (i.e.
makes them available). The filter ".est*" would accept all three files. Once you have set the
filter, you click the Refresh button to refresh the selection of available files.
All the available files are listed in the Available Files text box. The Selected Files text box contains all the selected files. To select one or more files, highlight the required file(s) and click
Add.
If you check the Overwrite Default Decimal Symbol (,) box, you overwrite your computer's default decimal symbol (point or comma) with the character entered in the Decimal Symbol text
box. Your computer's decimal symbol depends on its country settings.
Under Rectification, you can specify whether the data is to be included in the calculation
without preceding signs by selecting the Use Activity (Unsigned Values, Rectified) option or
with preceding signs by selecting the Use Voltage (Signed Values) option. In the former
case, the signal is rectified and the area or activity is then calculated. This option is only
available for data in the time domain. In the case of complex data, all calculations are automatically based on the absolute values.
Under Export Type, you can specify the type of calculation to be carried out for the data to be
exported.
If you select the Area option, the area is exported. If you select the Mean Activity option, the
average activity is exported. The Area as Raw Sum of Activity Values option is only available
for frequency data. The sum of the spectral line values in the defined range is exported without reference to the width of the spectral lines.
The storage location of the export file is displayed under Output. Enter the name and file
name extension of the export file in the Output File text box.

10.2.2 Peak Information Export
The export component Peak Information Export allows you to export information on the position and voltage of peak markers that have been set in selected history files or nodes to an
ASCII table. The markers to be exported are usually set using the Peak Detection transform.

Summary

To call the export component, choose Export > Multiple Export > Peak Information.

Procedure
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Figure 10-14. Peak Information Export, dialog box

In the Peak Name text box, you enter the name you specified for the peak in the Peak Detection transform.
In the Name(s) of the Involved Data Sets (History Nodes) text box, you specify the names of
the data sets or history nodes used, separated by commas.
If you check the Primary History Files Only box, you limit the Use Whole Workspace and Select Individual History Files options to primary history files.
In the Selection Filter text box, you can enter a selection filter to filter the available files on
name criteria. You can use an asterisk (*) to stand for one or more characters, and a period
(.) to stand for a single character. If the workspace contains the files "Test1H2", "Test2G" and
"Rest5", for example, " the string "Test*" filters out the files "Test1H" and "Test2G" (i.e.
makes them available). The filter expression "est" would accept all three files. When you
have set the filter expression, click Refresh to refresh the selection of available files.
All the available files are listed in the Available Files text box. The Selected Files text box contains all the selected files. To select one or more files, highlight the required file(s) and click
Add.
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If you check the Overwrite Default Decimal Symbol (,) box, you overwrite your computer's default decimal symbol (point or comma) with the character entered in the Decimal Symbol text
box. Your computer's decimal symbol depends on its country settings.
If you check the Export Mean Value Around Peak box, the average value for the data around
the peak is exported. In the +/- [Points] text box, you can enter the width of this interval in
points.
You can also obtain an average value around the peak and export it. To do this, you enter a
value in the +/- [Points] text box indicating how many points before and after the point are
to be included in averaging. A value of 2 means that 5 points are included in averaging (two
before, two after, and the peak position itself).
If you used individual latencies for each channel in peak detection, you can also export these
by checking the Export Individual Latencies for Each Channel box. If not, the latency of the
first marker found in a data set is exported.
The storage location of the export file is displayed under Output. Enter the name and file
name extension of the export file in the Output File text box.

10.3

Other export components

10.3.1 Loreta Export
The LORETA export component allows you to export Analyzer data in a format that can be read
by LORETA. The data is exported in two files: a .xyz file, which contains the coordinates of the
electrodes, and a .dat file, which contains the actual EEG data.

Summary

To call the export component, choose Export > Others > LORETA.

Procedure

Figure 10-15. Loreta Export, dialog box
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Enter the name of the export file in the File Name Template text box. You can use the placeholders $h for the name of the history file and $n for the name of the current data set.

10.3.2 Export ICA Matrices
Summary

The Export ICA Matrices export component allows you to export ICA matrices (and inverse ICA
matrices) from a generated ICA node at a later time (i.e. without the need to calculate the ICA
node again).
Note that it is not possible to export matrices at a later time if you have selected the Show
Correction After Finish option in the semiautomatic mode of the ICA transform. In this case
(complete correction), the matrices are not saved in the properties of the generated ICA
node.
For detailed information on the semiautomatic mode of the ICA transform, refer to
Section 7.3.1 as of page 306.

Procedure

To call the export component, choose Export > Others > ICA Matrices.
Figure 10-16. Export ICA Matrices, dialog box
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You can choose the format in which the matrices are to be exported from the Choose Format
drop-down list: BrainVision LDR file or MATLAB®- or BCI2000-compatible ASCII file.
If you choose MATLAB/BCI2000 Compatible Ascii File, you should note that the ICA matrix is
exported without channel information, i.e. the exported ASCII file does not contain any channel names.
If the matrix has been exported as an LDR file, it can be used by the Linear Derivation transform. If the matrix has been exported as an ASCII file, it can be further processed with MATLAB® and BCI2000. In MATLAB®, you read in the export file with the command load
'<filename>' –ascii. A variable of the same name is created. In BCI2000, you read the
matrix in as a Spatial Filter (Filtering tab) using the Load Matrix function.
Enter the number of decimal places in the matrix entries that are to be taken into account
during export in the Number of Digits After Decimal Point text box.
The export folder is displayed under Export File Names. Enter the file name extension for the
export file in the Filename Extension text box.
If you check the Write ICA Matrix box, the ICA matrix is exported. Enter the name of the export
file in the Enter File Name text box. You can use the placeholders $h for the name of the history file and $n for the name of the current data set. The Resulting File Name text box displays
the selected file name.
If you check the Write Inverse ICA Matrix box, the inverse ICA matrix is exported. Once again,
the Enter File Name and Resulting File Name text boxes are available to you.
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Chapter 11 Importing data, positions and markers

11.1

Importing data

In addition to the standard readers for many commercially used file formats, the Analyzer
also allows user-defined formats to be imported.
For simple ASCII formats you may be able to use the Besa format. For more complex formats
you should use the Generic Data Reader, which gives you an abundance of configuration options for describing your raw data.

11.1.1 Besa format
ASCII files can be imported in Besa format. This format has the following structure:
First line: general information
NPTS=<number of data points> TSB=<0 time point in ms> DI=
<sampling interval in ms> SB=<scaling of data points in 1/µV>
SC=<display scaling (ignored)> NCHAN=<number of channels>
Example:
NPTS=1024 TSB=100 DI=3.90625 SB=1 SC=1 NCHAN=32
This is a data set with 1024 data points and a prestimulus interval of 100 ms. The digitization
interval is 3.90625 ms, which corresponds to a sampling rate of 256 Hz. The scaling value
for data points is 1, which means the values are specified directly in microvolts. The display
scaling (SC) is ignored. The data set has 32 channels.
Second line: channel names
The channel names are listed in the second line, separated by spaces. Example:
Fp1 Fp2 F3 F4 etc.
Third and subsequent lines: data
The data values are entered as of the third line in the form of floating point numbers. The decimal symbol used is always a decimal point. Each line contains the data of one channel. The
individual data values are separated by spaces.
If you store the data in the raw data folder of a workspace, the Analyzer reads it in like a normal raw EEG.
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sample file by exporting
part of an EEG as a Besa file.
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11.1.2 Generic Data Reader
You can use the Generic Data Reader (GDR) to read in EEG files of various formats for which
there is no specific reader (e.g. proprietary laboratory formats). The reader uses a header file
that describes a single EEG. It normally gets the same base name as the raw EEG described
in it. The header file is stored in the raw data folder of the workspace.
In addition to the header file, a marker file can also be assigned to the EEG file. The marker
file lists all the markers present in the data set together with their positions, types, descriptions etc.
The header file and marker file may be present in one of two formats, with the marker file always taking the same format as the header file:
 Text format. Files with this format are organized as ASCII files. The format is based on the

INI format used in Windows® and has the extension .vhdr for header files and .vmrk for
marker files.
 XML format. It is easier to use this file format in external programs since very many librar-

ies exist for the handling of XML formats. XML format also allows you to define certain
properties in greater detail than in text format. The format uses the file extension .xhdr
for header files and .xmrk for marker files.
The file formats for header and marker files correspond to those of the export component
Generic Data Export (
see also Section 10.1.4 as of page 511) as well as the Generic Data
Header add-in (
see also Section 9.3 as of page 502).
You will find a description of the
formats in Appendix M as of page 599.
The Generic Data Header add-in provides you with an easy way of creating a header file for a
raw data set. For this to be possible, the data set must be present in a text or binary file in a
supported format (e.g. IEEE float). You can use this header file to read in the data file with the
Generic Data Reader.
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11.2

Importing markers and channel positions

Markers can be imported from files in XML or text format using the Import Markers transform
(
see Section 7.7.3 as of page 457).
Combining this option with the Export Markers export component (
see Section 10.1.3 as
of page 510) in a history file allows the exported markers to be processed automatically in
an external program.
To read in additional data along with the raw data (output files from your stimulator, for example), you can create a BASIC macro that creates a new history node. This node inherits the
data of the raw EEG. However, you can delete existing markers and set new ones. You can
also change the names and positions of channels. You can use the BASIC macro to open and
read out ASCII files.
You will find examples of macros for reading in channel positions and markers in the
Analyzer Macro Cookbook which is available on the BrainVision program DVD or can be
downloaded from our website at http://brainproducts.com/downloads.php?kid=5&tab=2.
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Chapter 12 Printout

You can use File > Print > Print (ribbon) to print the currently displayed section of the EEG. The
usual Windows® dialog box for selecting a printer appears.
File > Print > Print Preview gives you a print preview. However, the actual output on the printer
may differ from what you see in the preview. This depends on the quality of the printer driver
you are using and is something over which we unfortunately have no influence.
If you print from the ribbon, the active main view and its transient views are printed. If you
want to print only the main view or only a transient view, you choose the Print command from
the view's context menu (see Figure 12-1).
Figure 12-1. Print function in the view context menu

To set headers, footers and margins, you choose File > Configuration > Preferences in the ribbon and select the Graphics Export/Output tab (see Figure 12-2).
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Figure 12-2. Printer settings

When printed, the view has
the same proportions as the
print area. It is easiest to
check the positioning of
view tools etc. in the printout if you adjust the size of
the view window beforehand
so that it has approximately
the same proportions as the
print area.

Here you can define the paper orientation (portrait or landscape) and the margins of the print
area.
To define headers and footers, click the Header/Footer button (see Figure 12-3).
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Figure 12-3. Defining headers and footers

Under Number of Lines, you can specify the number of lines for headers and footers (maximum five).
You can make the following specifications for each header and footer:
 Text. Here, you enter the text that you want to appear in the header/footer line. You can

also use placeholders, which are replaced with current values during printing or for the
print preview. Table 12-1 lists all the available placeholders.
If you use the $n placeholder, for example, the program replaces it with the name of the
current data set.
 Alignment. You can specify whether the text is to be printed left-aligned, centered or

right-aligned.
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 Font. This button displays the Windows® font dialog box, where you can choose the font

to be used.
Table 12-1. Placeholders and their meaning
Placeholder

Meaning

$ct

Comment. The comment you can enter for each data set is placed here.
To enter a comment for a data set, move the mouse pointer to the relevant raw data node in the History Explorer and right-click. A context
menu appears. Choose the Comment command and enter the comment.

$d

Current date

$h

Name of the history file

$n

Name of the current data set

$nd

Date of the data set at the beginning of the section being printed. Note
that not all EEG formats contain date information.

$nt

Time of the data set at the beginning of the section being printed. Note
that not all EEG formats contain time information. In this case, it is
assumed that recording begins at 0:00 hours. This means you see the
time offset of the section being printed.

$p

Full history path containing all the intermediate steps from the raw data
node to the current data set.

$t

Current time

$u

Computer user who is currently logged in

If the available printing capabilities are not sufficient for your needs, you can also export the
graphic and continue processing it in another program as described in Chapter 13 as of
page 533.
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Chapter 13 Exporting graphics

You can export the currently displayed EEG to the clipboard as a vector graphic and process
it further in other programs or export it to an image file. The graphics formats EMF, BMP, PNG
and JPEG are available to you.
The functions described here allow you to export the active main view and its transient views.
If you want to export only the main view or only a transient view, you choose the Save as File
command from the view's context menu (see Figure 13-1).
Figure 13-1. Export function in the view context menu

To export the EEG to the clipboard, you click the Copy button

on the toolbar.

The Enhanced Metafile (EMF) format is used for the export. Most Windows® graphics programs support this format.
You can change the default size of 16 x 12 cm for the graphic. To do this, select File >
Configuration > Preferences in the ribbon and then choose the Graphics Export/Output tab
in the Preferences dialog box (see Figure 13-2).
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Figure 13-2. Exporting to the clipboard

You can define the width and height of the graphic in the right-hand section of the dialog box.
Under Resolution, you can specify whether the screen resolution (by selecting the Screen
Resolution option) or the generally higher printer resolution (by selecting the Printer
Resolution option) is to be used.
Note that some programs have problems processing EMF data in printer resolution.

Exporting to a file

You can use File > Print > Print to Graphics (in the ribbon) to export the current view to a file.
A file selection dialog box is opened. Here you can select the format of the file to be exported
in the dialog box's File Type drop-down list.
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Chapter 14 Appending multiple raw data sets

You can append multiple raw EEGs in order to process them as a single data set. This may be
necessary if you interrupt data acquisition and want to resume it subsequently with a new
output file.
This operation does not modify the raw EEG files. The individual files are simply read one after the other in the newly created raw data node.
The prerequisite for appending one raw EEG to another is that the main properties of the two
data sets – channel name, sampling rate, etc. – must be identical.
To append raw EEGs, select a history file in the History Explorer, right-click to open the file's
context menu and choose the Append File… command (see Figure 14-1).
Figure 14-1. "Append File" function in a history file's context menu

A warning message informs you that processing steps that you have performed in the history
file will be lost (see Figure 14-2).
Figure 14-2. Message warning of the loss of processing steps

When you confirm that you want to continue, a menu opens in which you can select the history file that you want to append (see Figure 14-3).
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Figure 14-3. Selecting the history file to be appended

Click OK. The first history file is modified and the second one removed. The icon changes
from a book into a stack of books (see Figure 14-4).
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Figure 14-4. Bookstack icon

You can append other raw EEGs to this history file.
To find out which raw EEGs have been appended to the history file, you can right-click the corresponding bookstack icon to display the history file's context menu. Here you choose Apply
to History File(s). This displays a dialog box which contains information on the initial data
set and the appended data sets (see Figure 14-5).
Figure 14-5. Information on the initial data set and the appended data sets

To cancel the linkage between the data sets, exit the Analyzer and delete the corresponding
history file (xxx.ehst) and history information file (xxx.hfinf) in the history file folder. The next
time you start the program, these history files are automatically generated again and the raw
EEGs are once again separate.
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Chapter 15 Macros

You can use the BASIC interpreter integrated in the Analyzer to create anything from simple
automation macros to complex applications. The interpreter accesses the Analyzer via the
OLE automation interface. This interface provides access both to a large number of methods
and properties of the Analyzer and to each data point in each history node of each history
file.
In the Analyzer, you can use an Integrated Development Environment (IDE) to edit, run and
debug macros. The development environment takes the form of an additional, dockable window in the program interface.
You can also run existing macros without first opening them in the development environment. It is also possible to add macros to the ribbon where you can run them simply by clicking on them.
Macros have many uses in the Analyzer. For example, you can use a macro to calculate new
history nodes from existing EEG data. In the processing of an EEG, this type of macro plays
the role of a primary or secondary transform. A suitably programmed macro can even be used
as a "genuine" transform as part of a history template. You can find suggestions and detailed
information on creating macros in the Analyzer Macro Cookbook as well as in the Analyzer
Automation Reference Manual. Both of these documents are available on our website at
http://brainproducts.com/downloads.php?kid=5&tab=2.

Role of macros in the Analyzer

You can also obtain information on the integrated SAX BASIC interpreter and the SAX BASIC
development environment by selecting the Editor Help command in the Help tab of the macro editing window.
Please note that the format of the BASIC help file is no longer supported in systems running
under Windows® Vista, Windows® 7 or Windows® 8. Microsoft provides the necessary reader WinHlp32.exe for download free-of-charge at http://support.microsoft.com/kb/
917607/en-us.
To create a new macro, select Macros > Macros > New... in the ribbon. This opens an editing
window (see Figure 15-1). Enter the macro code between the lines Sub Main and End Sub.
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Figure 15-1. Macro editing window

You can use the Show Editor command in the ribbon to show and hide the macro editing window.

Example of a macro

The following small macro opens all the history files and outputs a message before it closes
the files again:
Sub Main
For Each hf In HistoryFiles
hf.Open
Next
MsgBox "All history files are open"
For Each hf In HistoryFiles
hf.Close
Next
End Sub
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Enter the code, and then click the Start/Resume button
in the editing window. You will
get the following intermediate result including the message "All history files are open" (see
Figure 15-2).
Figure 15-2. Intermediate result of the macro example

Click Save

to save the macro and close the editing window.

To open existing macros, choose Macros > Macros > Open….
To run an existing macro without first opening the macro editing window, choose Macros >
Macros > Run…. Select the macro you want to run in the file dialog.
You can also add macros to the ribbon. To do this, choose Macros > Macros > Options…. This
opens the Macro Manager (see Figure 15-3).
Figure 15-3. Macro Manager
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In the table on the left (Name of Macro Group), specify the name of the macro group. Then
choose a macro to be assigned to the group from the drop-down list in the table on the right
(Macro). To delete all the assignments, click Clear All Assignments in the Macro Manager.
The selected macros are now displayed in the Macros tab in the ribbon (see Figure 15-4).
Figure 15-4. Macros in the ribbon

You can then also call the macros by means of the keyboard shortcuts (<Alt-M>, <Alt-1>, <Alt2>, <Alt-3>, etc.)
After changes are made to the OLE components in the Analyzer macro environment, it may
be necessary to run the Analyzer once as the administrator so that the system registry can be
updated.


543

Chapter 16 Solutions

Solutions are modular extensions to the Analyzer that can be used to deal with a wide variety
of problems and tasks. A solution combines executable program code and the associated
user documentation in one and the same file. This ensures that the correct version of the documentation is always present and that it is possible to trace the method implemented by the
solution. Like macros, solutions use the Analyzer's integrated SAX BASIC interpreter. However, in contrast to macros, it is not possible to modify the source code of solutions. This ensures that any given solution is always used unchanged.
You will find a set of solutions in the \Analyzer2_Solutions subfolder of the BrainVision program DVD.
To install the solutions, you use the InstallSolutions.exe installation file, which is also located in the \Analyzer2_Solutions subfolder. There are solutions, for example, for ECG and EMG
processing, marker importing and ASCII exporting. Further solutions are available on our
website at http://brainproducts.com/downloads.php?kid=9&tab=3.
During installation, the solutions are copied to a folder on your computer. If you use the standard installation program, the solutions are automatically installed in thematically arranged
subfolders. You can also install the solutions manually with separate categorization if you
set up user-defined subfolders. You can use Windows® Explorer to delete individual solutions and subfolders of the solutions folder.

You can install or uninstall solutions after initial system installation without difficulty. If you
are interested in further, customized solutions, please contact us directly. You will find the
contact details on page 35.

Installing solutions

It is also possible to copy your own macros to a subfolder of the solutions folder. These will
then also appear on the Solutions tab. (In contrast to Analyzer 1, solutions and macros are
only visible in the ribbon if they are located in subfolders of the solutions folder and not in
the solutions folder itself.)
To access the base folder for solutions, you choose File > Configuration > Administration (in
the ribbon). You can select a folder in the Solutions Path: text box of the Administration dialog box (see Figure 16-1).
If you are working in a network with several colleagues, we recommend using a shared base
folder for the solutions.
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Figure 16-1. Defining the base folder for solutions

Solutions in the ribbon

The solutions appear on the Solutions tab in the ribbon. The structure of the tab corresponds
to the structure of the base folder and its subfolders. In this structure, each subfolder of the
base folder is displayed as a group. The solutions located in the subfolders are displayed as
entries in the groups. Solutions files have the file name extension .vaso (which is an abbreviation of Vision Analyzer Solutions).
In our example, the base folder is C:\Vision\Analyzer2\Solutions. It contains various subfolders.
The solution in the EKG subfolder has the name EKG Markers.vaso. The folder also contains
a PNG file for the graphical display of the solution (see Figure 16-2). The solution in the EMG
subfolder has the name EMG Onset Search.vaso.

545

Figure 16-2. Subfolder containing the "EKG Markers" solution

The Solutions tab for our example thus has the following structure (see Figure 16-3).
Figure 16-3. Structure of the "Solutions" tab

To assign an icon to a solution, copy the required image in the form of a bitmap or PNG file
to the subfolder of the corresponding solution base folder. It has the same name as the associated VASO file.
You can use the Refresh Solutions button to update the ribbon when you have made changes
to the solutions folder.
To display the documentation for the solutions, you choose Solutions > Help > Solutions
Help. The Solutions Help Explorer appears (see Figure 16-4). The Explorer contains all the
solutions and macros present in the solutions folder.
A single click on an entry in the Explorer opens a brief description of the corresponding solution. Double-clicking opens the full documentation in a separate window.

Help on solutions
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Alternatively, click the Show Documentation button in the dialog box or choose this command in the solution's context menu.
If you double-click a macro, its source code is displayed.
Figure 16-4. Solutions Help Explorer

Executing a solution

To execute a solution, open a history file and click the required solution on the Solutions tab.
Alternatively, you can open the Solutions Help Explorer and then choose Execute Solution
from the context menu that appears.
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Chapter 17 Analyzer help system

To access the Analyzer's help system, choose the Help tab in the ribbon. The menu contains
commands that you can use to maintain and update the Analyzer. You can also consult the
Analyzer user documentation here (see Figure 17-1).
Figure 17-1. Analyzer help system

Choosing the Installed Components command opens a list of all the installed Analyzer program components (see Figure 17-2). Here you can click Reset to Defaults in the Parameters
column to restore the default values for the various components. This is only possible for
those component types that use parameters.
Figure 17-2. List of installed program components

The Support Info command allows you to send information about the Analyzer to our support
team (
see also Section 17.1 on page 548).
You can use the Update Manager command to install updates and new program components
even after initial installation has been completed (
see also Section 17.2 on page 549).
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With Documentation, you can call the Analyzer User Manual and the Automation Reference
Manual.
To obtain information on the internal serial number and the expiry date of your dongle as well
as the licenses bound to the dongle, select About Analyzer in the Help group (
see also
Section 1.5 on page 59).
Clicking Online Info opens the Analyzer's online information page.

17.1

Support Info

The Support Info command is used to pass information about the Analyzer to our support
team.
It only makes sense to use this function after prior consultation with the support team. You
will find the contact details on page 35 of this manual.
Figure 17-3. Support Info, dialog box

You can use Save... to save the information gathered by the function in an archive file. The
archive file is intended for our support team and contains additional information on your
configuration, any errors that have occurred and any transform parameters.
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17.2

Update Manager

Thanks to the modular structure of Analyzer, it is possible to install updates and new components even after initial installation has been completed. Brain Products makes update
packages available for this purpose.
The Update Manager helps you keep your Analyzer installation up to date and is able to install several update packages in a single operation. It allows you to choose which of the
available packages are to be installed.
The Update Manager can use installation packages on a data medium (e.g. BrainVision program DVD) or download updates directly from our website.
To call the Update Manager, choose Help > Support > Update Manager.
You can also use the functions of the Update Manager without having to start the Analyzer.
To do this, use the BrainVision Analyzer Update Manager program under All Programs > BrainVision in the Windows® start menu.
Please note that under Windows® 8, there is no longer any start menu. To call the Update
Manager from outside of the Analyzer, you must right-click on the Windows® start page. This
opens a menu at the bottom of the page that contains the entry All apps. Click on this entry
to open the list. This list contains a section entitled BrainVision which provides you with
links to the Analyzer, the Update Manager and the user manuals (see also Figure 1-18 and
Figure 1-19 on page 56).
On the first page of the dialog you can choose whether you want to install updates from a
data medium or whether you want to download the updates directly from our website (see
Figure 17-4).
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Figure 17-4. Update Manager, selecting the installation source

Installing updates from the
website

If you click the button Check the program connects automatically to the Brain Products website and checks whether new updates are available for download. No personal data is sent
from your computer to Brain Products during this operation. This check may take a few seconds to complete.
Check simply verifies whether there are updates available that have not yet been downloaded. Please note that the button Check does not provide information on whether or not downloaded packages have actually been installed.
If new updates are available, you can retrieve them by clicking Download on the next page of
the dialog (see Figure 17-5). Additionally, information on the total size of the update files is
provided.
The time required for data transfer depends on the number and size of the updates. You can
cancel a transfer that is currently in progress. When you do this, any updates that have been
downloaded in full remain present on your computer and can be installed later.
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Figure 17-5. Installing updates from the website

When you have downloaded the updates, you can install them by clicking the button Install
The installation process is deNow on the next page of the dialog (see Figure 17-6).
scribed on page 553 and the following pages of the current section.
Please note that the Analyzer is automatically closed when you install an update and is then
subsequently restarted.
Figure 17-6. Installing updates immediately
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If no new updates are available, another dialog page is provided (see Figure 17-7) where you
can either click the button Cancel to close the Update Manager or choose the button Install
Now to install updates that have already been downloaded.
Figure 17-7. No new updates found

Installing updates from a data
medium

If you click the button Install on the first page of the dialog then you can install updates from
a data medium. It is possible to retrieve update packages from any installation source, i.e.,
you do not have to use a data medium issued by Brain Products such as the BrainVision program DVD. For instance, you can save update packages on a USB stick and then install them
on a computer that has no network connection.
You can choose between the following installation sources (see Figure 17-8):
 Install updates that have been downloaded previously. Downloaded updates are auto-

matically saved on your computer. You can install these updates later without having to
download them again.
 Install updates from a custom location. You can enter a path of your choice in the text

box or click Browse... to select a folder.
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Figure 17-8. Choosing the source for the update

When you have chosen an installation source, click on the buttons Continue and then Install
The installation process is described below.
Now (see Figure 17-9).
Figure 17-9. Installing updates offline

The Analyzer is closed automatically when you start the installation process. If you are using
Windows® Vista or later versions, the system may ask you to confirm that you want to perform the installation (User Account Control).

Installation process
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The Update Manager now identifies which updates are available and which of these have already been installed. This information is displayed in a dialog box (see Figure 17-10). Updates that have already been installed are highlighted in green.
Figure 17-10. Selecting updates for installation

Select the updates that you want to install from the list. All updates that have not yet been
installed are selected by default. You can click on an update to display additional information about it. You can right-click on the list to open a context menu containing additional selection options (e.g., to unselect all updates). If an update includes data-related changes,
the corresponding row of the column Note contains an exclamation mark (see Figure 17-11).
Figure 17-11. Information on data-relevant changes

If the checkbox Show already installed updates is unchecked, then only updates that have
not yet been installed are displayed in the list. To continue with the installation of the selected updates, click Install.
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If the updates contain data-relevant changes (e.g., when the resulting data values, markers
or data structure have been modified), an information message is displayed containing details about the changes (see Figure 17-12). In order to proceed with the installation of these
updates, you have to first click on the checkbox I have read the important information message. This selection confirms that you accept the changes. If you do not wish to install a datarelevant update, press Cancel in the window that displays the message to skip this update.
Figure 17-12. Important information message elicited for data-related changes

The actual installation of updates runs automatically. If errors occur during the installation
then these are displayed at the end of the installation process. When the installation is complete, a summary of the installation process is displayed. Installed updates are listed in
green rows. If the installation of an update is canceled before completion, the respective row
will be displayed in blue (see Figure 17-13).
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Figure 17-13. Results of the installation process

The overview in the tab Installation Result indicates whether each of the updates selected
for installation has been installed successfully. If an update could not be installed, an error
message is displayed.
The tab Update Status tells you which update packages are currently installed. This display
takes into account only updates available from the current update source. On the basis of
this information, you decide whether you want to continue the installation process by selecting and installing further updates.
The text in the tab Install Log contains detailed information on the installation process. If you
encounter any installation problems, you can select the text, copy it to the clipboard or an email in order to provide the Brain Products Scientific Support with information on the error.
If it is not possible to install an update, this does not necessarily mean that an error has occurred. It is, for example, possible that the prerequisite for the installation of an update is
the prior installation of another update that you have not selected for installation. In this
case, the missing update is indicated in the error message and you can select it for installation by clicking on the button Retry.
If the selected installation source contains further updates that have not yet been installed
then the results dialog box contains the button Retry (see Figure 17-14). If you called the Update Manager from within Analyzer, it is restarted automatically when you click Close. Clicking on Retry opens the dialog box Select Updates for Installation (see Figure 17-10 on
page 554), where you can select additional updates.
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Figure 17-14. Installing additional updates
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Appendix A Product identification information

Tabelle A-1.
Product designation:

BrainVision Analyzer

Manufacturer:

Brain Products GmbH
Zeppelinstraße 7
D-82205 Gilching (Munich)
Phone: +49 8105 73384 - 0
Fax: +49 8105 73384 - 505
Website: http://www.brainproducts.com
Email: support@brainproducts.com

Classification according to EU Directive
93/42/EEC (MDD), Annex IX, Rule 12:

The BrainVision Analyzer family does not comply with the Medical Device Directive (MDD)
93/42/EEC as amended by EU directive 2007/
47/EC since it is no medical device as of September 30th, 2013 and Software Version
2.0.4.

The Analyzer is not an applied part for use in the test subject environment. It can however be
used in the test subject environment provided that the computer on which it is running is a
computer approved for medical applications in accordance with IEC 60601-1.
The user or operator is liable for compliance with these requirements.
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Appendix B Raw data on removable media

Removable media are drives containing interchangeable storage media – CD-ROM, DVD and
USB drives, for example. If you use the same drive as a raw data source for different workspaces, a raw EEG may appear in several workspaces. This is because the Analyzer usually
analyzes all raw EEGs in the raw data folder when the workspace is changed or the program
is started up and creates history files where necessary.
The following rule applies to all removable media in order to simplify handling:
1

If there is at least one history file in the current workspace for which there is no equivalent
in the form of a raw data set on the removable medium,
and

2

if there are EEGs on the removable medium that have not already been read into the current workspace,

you are asked whether you want to add the raw data to the current workspace.
Note that the program can only detect removable media on the current computer, not on the
network.
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Appendix C Electrode coordinate system

Electrode coordinates are required whenever analytical procedures make use of channel positions or when topographies have to be output in 2D or 3D.
Spherical coordinates are used to specify a point on the surface of the head. A set of coordinates consists of the three variables r,  and  (radius, theta and phi).
The radius r specifies the distance (in millimeters) between point P and the origin of the coordinate system. The only exceptions are r = 0 and r = 1. r = 0 signifies an invalid position, for
instance when the position of an electrode is not known. When realistic electrode coordinates are used, r can have a different value for each channel. In other cases, the value of r
should be the same for all the channels if a spherical head model is used. For instance, in
the Analyzer's standard coordinate system, r = 1.
 specifies the angle between the x-axis and the projection of the line connecting the point
P and the origin of the coordinate system on the xy plane. In the case of the front right and
back left quadrants,  > 0; for the back right and front left quadrants,  < 0.
 is the angle between the z-axis and the line connecting the point P and the origin of the coordinate system. In the right hemisphere,  > 0. In the left hemisphere,  < 0.
Figure C-1 illustrates the coordinate system used by the Analyzer. The x-axis extends from
channel T7 on the left side of the head (negative values) to channel T8 on the right side of
the head (positive values). The y-axis runs from the back to the front of the head via channel
Fpz (positive values). The z-axis runs from the bottom of the head toward the crown via channel Cz (positive values).
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You can change the electrode
positions using the Edit Channels transform. For detailed information, refer to Section 7.1.6
as of page 216.
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Figure C-1. Coordinate system for electrodes
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Appendix D Markers (time markers)

All the markers used by the Analyzer are time markers. Time markers mark a point in time or
a period of time in the EEG.
A marker can be an item of stimulus information that is used to ascertain evoked potential.
It can also mark a new segment or indicate that a DC correction was carried out at a certain
time. Markers are an aid to orientation for segmentation and other transforms.
All markers in the Analyzer have the following five properties:
 Type: The type specifies the marker class, such as "Stimulus" or "New Segment". There

are different predefined types for specific tasks (see Table D-1). The color of the marker
in the view depends on the type. Since the types are just ordinary texts, you can create
new types by means of a macro, for example, or by setting markers manually.
 Description: This is the description given to a marker. It can also be regarded as a sub-

class. When you select markers (during segmentation, for example), in most cases you
can make a selection by type and description. The description is also saved as text, and
there are therefore no restrictions on its contents. The Analyzer or its reader components
construct some texts (for EEG formats, for example) that store stimuli as numeric values.
If an EEG contains a stimulus with the value 1, the reader component converts this value
to the text "S 1". The description is generally shown when the markers are displayed.
 Position: The position defines the data point at which the marker occurs in the EEG.
 Points: These are the data points over which a marker extends. In most cases, markers

have a length of one point. At present only one of the predefined markers extends over
multiple types, the "Bad Interval" marker. This marker is used during the Raw Data Inspection or Artifact Rejection transforms.
 Channel Number: A marker can be assigned to one or all channels (channel number 0).

The "New Segment" marker also has the Date Time property, which means that the date and
time of its occurrence is stored in every marker of this type, provided this information can be
extracted from the raw EEG.
Table D-1. Predefined marker types
Type

Function

Color in view

Bad Interval

This indicates an interval corrupted by artifacts.

Pink or gray

Comment

This is used for a comment.

Black

DC Correction

A DC correction occurs with EEGs recorded using a
DC acquisition system. There is usually a jump in
the voltage levels of the data at this time.

Yellow

New Segment

This is used to mark discontinuities in the EEG.
These include interruptions in the recording but
also segmentation.

Green

Peak

This marker is set by peak detection routines.

Black
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Table D-1. Predefined marker types
Type

Function

Color in view

Response

This is a response on the part of the test subject.

Blue

Stimulus

This indicates a stimulus.

Red

Threshold

This is set by the Level Trigger transform. Because
of its proximity to the stimulus marker, it is the
same color in the view.

Red

Time 0

The Time 0 marker only comes into play after aver- Long, black,
aging. It marks the boundary between the predashed line
stimulus and poststimulus.

Voltage

This marker causes most views to show the voltage and time on the relevant channel.

Black
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Appendix E Keyboard shortcuts

Whether and which shortcuts are active depends on which control element the focus is on.
If a control element supports keyboard input (e.g. the <right arrow> key for the primary history
data in the History Explorer), the input is ignored in the view. If the focus is on a view, the
following shortcuts are active.
Table E-1. Keyboard shortcuts and their functions
Right arrow

Moves the selection/highlighting (if
present) to the right

Left arrow

Moves the selection/highlighting (if
present) to the left

Page Up

Displays the preceding channel
group

Page Down

Displays the next channel group

Ctrl +

Right arrow

Next interval

Ctrl +

Left arrow

Previous interval

Ctrl +

Up arrow

Increases the scaling.

Ctrl +

Down arrow

Decreases the scaling.

Ctrl +

+

Zooms in

Numeric
keypad

Ctrl +

-

Zooms out

Numeric
keypad

Ctrl +

+

Zooms in

Keyboard

Ctrl +

-

Zooms out

Keyboard

Ctrl + Shift

Right arrow

Next interval in the transient view

Ctrl + Shift

Left arrow

Previous interval in the transient
view

Ctrl + Shift

Up arrow

Increases the scaling in the transient
view

Ctrl + Shift

Down arrow

Decreases the scaling in the transient view

Ctrl + Shift

+

Zooms into the transient view

Numeric
keypad

Ctrl + Shift

-

Zooms out of the transient view

Numeric
keypad

Ctrl + Shift

+

Zooms into the transient view

Keyboard

Ctrl + Shift

-

Zooms out of the transient view

Keyboard

Ctrl +

A

Highlights the view in the visible area
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Table E-1. Keyboard shortcuts and their functions
Ctrl +

C

Copies the view to the clipboard

Ctrl +

S

Saves the active history template

Ctrl +

W

Closes the active window

Ctrl +

Tab

Switches to the next view tab

Ctrl + Shift

Tab

Switches to the previous view tab

Del

In the History Explorer, in the history
template: Deletes a node

F2

In the History Explorer, in the history
template: Renames history nodes
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Appendix F Installing a network license (USB)

Introduction and installation
Intended use of the network license (USB)
The BrainVision Analyzer Professional network license is a licensing model that allows the
protected BrainVision Analyzer software to be run on multiple workstations in a network environment.
The network license is designed for operation in a local network (subnet) and permits the use
of the BrainVision Analyzer at only one location at any one time. We are unfortunately unable
to guarantee support in the case of operation in distributed networks (use of the Analyzer in
the office and at home).

Overview
This section provides an overview of the BrainVision Analyzer Professional network license
licensing model and describes how you can use this license in order to operate the Analyzer
in a network environment.
You can operate Analyzer as of version 2.0.3 with two different types of dongle: Either with
the HASP HL dongle or with the new Sentinel HASP dongle. The steps necessary to set up the
network license differ depending on the dongle type you are using:
 In order to use the license with a HASP HL dongle, you must install the HASP HL Net Key

(referred to as the USB network dongle below) and the HASP License Manager software
on one of the computers in the local network. This computer then makes the network licenses available to the other computers connected to the network and is referred to as
the network license server below.
 To use the license with a Sentinel HASP dongle, you must insert the Sentinel HASP Net

Key (referred to as the USB network dongle below) in a free USB port in a computer in the
local network. Make sure that the most recent Sentinel HASP driver is installed on this
computer. This computer then makes the network licenses available to the other computers connected to the network and is referred to as the network license server below.
Any computer within the network can act as the network license server. When choosing
which computer is to be the network license server, you should, however, consider that the
network license server only makes the licenses available while the server is running and the
USB network dongle is connected and when a local network connection is active.
It is also possible to set up several different computers in the local network as network license servers. This means that you can operate the USB network dongle on one of these computers if the original network license server fails or needs to be switched off.

BrainVision Analyzer User Manual | Software Version 2.0.4 | September 30, 2013

570 Appendix F Installing a network license (USB)

It is easiest to handle network licenses if the network license server and the workstations all
use the same range of network addresses (subnet). It is necessary to make additional settings on the network license server or the workstations if you wish to use network licenses in
a more complex network architecture (different subnets, VPN, WLAN, etc.). Consult your network administrator if you have any questions in this regard.
The more complex the network architecture, the greater the probability that sporadic connectivity and capacity problems will arise between the network license server and the workstations. Under certain circumstances, it may become impossible to establish a sufficiently
stable connection to allow the network licenses to be used. Unfortunately, in cases where
such problems prevent the network licenses from running reliably, we cannot guarantee to
be able to provide support.

Software and network requirements for the HASP HL dongle

You should observe the following requirements if you wish to use network licenses with the
HASP HL dongle:
 Operating systems: The HASP License Manager supports the following operating sys-

tems: Windows® 2000/XP/Server 2003/Vista/7 and 8 and Server 2008. Only native
Windows® systems are supported. Emulations or virtual machines are not supported.
Support cannot be provided for other operating systems such as Linux, Ubuntu, etc. even
if Aladdin/SafeNet (the manufacturer of the USB network dongle used) offers relevant
versions of the HASP License Manager.
 Opening ports on the firewall: If you are using a firewall other than the one supplied with

the Windows® operating system, ensure that port 475 is open for TCP and UDP. If this is
not the case, open the port manually.
 Network architecture: You should consult with your network administrator if you wish to

use network licenses in a complex network architecture.
 Dongle firmware: The firmware of the network dongle must be up-to-date before you can

start Analyzer as of version 2.0.3.
fer to Section 1.6 on page 61.

For information on how to update the firmware, re-

You will find all the drivers on the BrainVision program DVD and in the download area of our
website at http://brainproducts.com/downloads.php?kid=9&tab=4.

Software and network requirements for the Sentinel HASP
dongle

You should observe the following requirements if you wish to use network licenses with the
Sentinel HASP dongle:
 Operating systems: You can use any computer in the local network as the network license

server on which the Sentinel HASP dongle drivers can be installed: Windows® XP/Server
2003/Vista/7 and Server 2008. Only native Windows® systems are supported. Emulations or virtual machines are not supported. Support cannot be provided for other operating systems such as Linux, Ubuntu, etc. even if Aladdin/SafeNet (the manufacturer of
the USB network dongle used) offers relevant versions of the drivers.
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 Firewall port enabling: During driver installation, the required ports are automatically reg-

istered with the Windows® firewall. If you are using a firewall other than the one supplied
with the Windows® operating system, ensure that port 1947 is open for TCP and UDP. If
this is not the case, open the port manually. In addition, the program hsplms.exe must
be able to use any ports for TCP and UDP.
 Network architecture: You should consult with your network administrator if you wish to

use network licenses in a complex network architecture.
You will find all the drivers on the BrainVision program DVD and in the download area of our
website at http://brainproducts.com/downloads.php?kid=9&tab=4.

Installation on the network license server when using the HASP HL
dongle
Perform the following installation steps on the network license server:
1

Install the HASP HL device driver.
The installation program for the HASP HL device driver is in the DongleNetwork folder of
the BrainVision program DVD. Double-click on HASPUserSetup.exe there and follow the
instructions given by the installation program. You get to the folder by choosing Browse
the DVD in the program DVD's start dialog box.

2

Connect the USB network dongle to your network license server. When the LED on the
dongle lights up, you know that the installation has been successful.

3

Install the HASP License Manager.
The HASP License Manager is in the DongleNetwork folder on the BrainVision program
DVD. Double-click on lmsetup.exe and follow the instructions given by the installation
program. Select Service as the installation type and automatic port enabling for the firewall.
If you are installing the HASP License Manager under Windows® 7, you should also refer
to the separate installation instructions supplied with the installation package.

The BrainVision Analyzer network licenses are now available to you on the local computer
network.

Installation on the network license server when using the Sentinel HASP
dongle
Perform the following installation steps on the network license server:
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1

Install the Sentinel HASP device driver.
The installation program for the Sentinel HASP device driver is in the DongleNetwork
folder of the BrainVision program DVD. Double-click on HASPUserSetup.exe there and
follow the instructions given by the installation program. You get to the folder by choosing Browse the DVD in the program DVD's start dialog box.

2

Connect the USB network dongle to your network license server. When the LED on the
dongle lights up, you know that the installation has been successful.

The BrainVision Analyzer network licenses are now available to you on the local computer
network.

Installation steps at the workstations
In order to be able to use the network license on a workstation, you must install the dongle
drivers on this computer. In this case, proceed as for installation of a single workstation license. It is not usually necessary to perform any additional installation steps on computers
at which an Analyzer single workstation license is already in use. You can install the dongle
drivers at any time subsequently in order to prepare a computer to act as a workstation at a
later time.
Make sure that no other BrainVision Analyzer network license (either a USB dongle or LPT
dongle) is active on the local computer network. If this is the case, you should deactivate
these additional licenses in order to preclude the possibility of conflicts or malfunctions.
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Problems with dongles and error messages
If the Analyzer issues an error message (see Figure F-1), you should check that the connection between the network license server and the client computer is operating correctly and
that the network license server is able to send the necessary information over the network.
Figure F-1. Example of an error message from the Analyzer in the event of a problem with
the USB network dongle

If an error message such as this is still displayed after you have checked the network, it will
probably be necessary to make additional configuration settings, which will depend on the
network architecture.
It is also possible that the firmware of the network dongle may be obsolete.
tion on how to update the firmware, refer to Section 1.6 on page 61.

For informa-

You will find detailed information on dealing with errors when operating your network license
in combination with a HASP HL dongle on our website at: http://www.brainproducts.com/
downloads.php?kid=22.
If you use your network license in combination with a Sentinel HASP dongle then you can call
the Sentinel Admin Control Center. To do this, start your browser and enter the address
http://localhost:1947. This provides you with information about the Sentinel HASP dongles
in the network.
You can use the Sentinel Admin Control Center not only on the network license server but
also on any workstation. At a workstation, you can, for example, use the Sentinel Keys command to check which Sentinel HASP dongles are available in the network.
At the network license server, you can use the Configuration command to make advanced
server settings. The settings are divided between a number of different tabs, each with its
own help page containing detailed explanations of the individual settings. The link to the
help page is located in the bottom right section of the browser window.


Using the Sentinel Admin Control Center for troubleshooting
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Appendix G Installing sub-licenses

Please note that this appendix refers exclusively to operation of Analyzer as of version 2.0.3
with a HASP HL dongle. If you are using a new Sentinel HASP dongle then the information presented below is not relevant to you. If you are using a HASP HL dongle then you may need to
purchase sub-licenses before you can use certain optional Analyzer components.
To identify the dongle type installed on your system, choose Help > Help > About Analyzer in
the ribbon.
A sub-license is a file associated with your HASP HL dongle. You can install sub-licenses for
several dongles in parallel without problems. If you purchased sub-licenses at the same time
as you purchased the Analyzer, the sub-license file is included on a supplied USB data carrier. Sub-licenses that are purchased subsequently can be downloaded from the Brain Products website.
This appendix describes how to download and install sub-licenses that you purchase subsequently.
To activate the downloading of sub-licenses, your HASP HL dongle must first be registered.
To do this, go to http://brainproducts.com/ and choose Downloads & Support > Product
Registration.
To register your HASP HL dongle, enter the external and internal serial ID of your dongle, your
name, university and email address in the product registration form (see Figure G-1). The external serial ID is printed on your dongle. You can find out the internal serial ID using the Serial ID Check Program available on the website. Further related information is available on
our website at http://brainproducts.com/productreg.php.
Once your registration has been processed, you will receive a confirmation mail.
Figure G-1. Data entry form for product registration

After you have received the confirmation mail, you can log in to download your files by proceeding to the Login page (see Figure G-2). Use the login data you received by mail.
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Figure G-2. Login form

Now you can select and download the sub-license file License File for Analyzer 2 from the
download area under Downloads & Support > Downloads (see Figure G-3).
Figure G-3. Download area for sub-license files

Installing sub-license files

A sub-license file is an executable file whose name corresponds to the external serial number of the HASP HL dongle. The file installs the sub-license in the Analyzer installation folder
automatically.
Start the executable file and then click Continue to install the sub-license (see Figure G-4).
Then follow the instructions in the automatic installation routine.
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Figure G-4. Installing sub-licenses

If you are using Windows® Vista or Windows® 7, you should not double-click the license
file, but instead right-click it as administrator to avoid installation problems (see Figure G-5).
Figure G-5. Running the sub-license file as administrator (Windows® Vista/7)

Installation under Windows®
Vista or Windows® 7
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You can check what sub-licenses are active by selecting Help > Help > About Analyzer in the
ribbon (see Figure G-6).
Figure G-6. Displaying sub-licenses in the Analyzer

The installed sub-license is stored in the installation folder as a file with the extension .bplc.
The file is in signed text format.
Do not make any changes to this file, as otherwise the sub-license will become invalid.
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Appendix H Command-line parameters

The Analyzer supports a number of command-line parameters. To enter these, select the MSDOS prompt. A prompt appears. Change to the Vision folder by entering the command cd
<folder>.
Example:
C:\>cd C:\Vision\Analyzer2
You can call the Analyzer with additional parameters.
Example:
C:\Vision\Analyzer2>Analyzer -new -pPrinter
Alternatively, create a copy of the Analyzer shortcut placed on the desktop during installation. Then right-click the icon of the copy and choose Properties from the context menu that
appears. A dialog box appears. On the Shortcut tab, append the parameters to the existing
text in the Target text box.
Example:
C:\Vision\Analyzer2\Analyzer.exe
Change to:
C:\Vision\Analyzer2\Analyzer.exe -new –pPrinter
In this way, you can create several shortcuts on the desktop for different parameters.
Now we come to the parameters.
-m<Macro> calls the specified macro at program startup.
Example:
C:\Vision\Analyzer2\Analyzer.exe "-mCompress All"
This calls the macro Compress All after program startup. Quotation marks are only needed if
the macro name contains a blank. Note that the macro name must come immediately after
the -m with no intervening blank.
The -new parameter forces a new program instance of the Analyzer. When the Analyzer is
called more than once, the existing program instance is used. This parameter suppresses
this behavior.
Example:
C:\Vision\Analyzer2\Analyzer.exe -new
The -p<Profile-File> parameter uses the specified user profile file during the session.
Example:
C:\Vision\Analyzer2\Analyzer.exe –pPrinter
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The -g<Profile-File> parameter uses the specified user profile file with global system
settings during the session.
You could, for example, save all the settings for optimum printing in the profile file named
Printer.
It is possible to combine different parameter types. Note that -p is always executed before m.
-noworkspace: The last workspace to have been used is not loaded on program start-up.
-register re-registers the Analyzer's automation server. This can only be done if the user
has administrator permissions. Under Windows® Vista or Windows® 7 systems, the user is
asked whether they really wish to do this. The Analyzer is then closed immediately.
-unregister deregisters the Analyzer's automation server. This can only be done if the
user has administrator permissions. Under Windows® Vista or Windows® 7 systems, the
user is asked whether they really wish to do this. The Analyzer is then closed immediately.
-testregister shows a message indicating whether the Analyzer's automation server
has been registered correctly. The Analyzer is then closed immediately.
-registercomponents registers COM transforms from the Analyzer's installation folder,
the Vision Toolbox and a number of other components used by the Analyzer. This can only be
done if the user has administrator permissions. Under Windows® Vista or Windows® 7 systems, the user is asked whether they really wish to do this. The Analyzer is then closed immediately.
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Appendix I Shortcuts to raw data

In Windows® it is possible to create shortcuts. You can create a shortcut, for example, by using the mouse to drag a file from one folder to another in Windows® Explorer while holding
down the <Ctrl> and <Shift> keys. This creates a small file that points to the actual file.
The Analyzer can work with shortcuts to raw EEG files. These are treated in exactly the same
way as if the original file was in the folder. This enables you to set up a workspace containing
raw EEGs from various folders by creating shortcuts to the various raw EEGs in the raw data
folder of this workspace. A raw EEG file can therefore also be analyzed in different workspaces without having to be copied to these workspaces.
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Appendix J BrainVision electrode files

BrainVision electrode files are XML files that contain a list of electrode coordinates. Any number of <Electrode> tags can be enclosed within the surrounding <Electrodes> tags. The
<Electrode> tags each contain the name and spherical coordinates (as described in
Appendix C) of a single electrode.
Specify the spherical coordinates as floating-point numbers with a decimal point (.) as the
decimal separator.
The following example shows how the file is structured:
<Electrodes defaults="true">
<Electrode>
<Name>Fp1x</Name>
<Radius>1</Radius>
<Theta>-90.5</Theta>
<Phi>-72</Phi>
</Electrode>
<Electrode>
<Name>Fp2x</Name>
<Radius>1</Radius>
<Theta>90.5</Theta>
<Phi>72</Phi>
</Electrode>
</Electrodes>
The "defaults" attribute of the <Electrodes> tag can be used to control whether the electrodes
list is to be interpreted as a complete list (when the value "false" is set) or if the list is to be
added to an underlying list of standard Analyzer coordinates (when the value "true" is set).
If no value is set, "false" is assumed.
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Appendix K Segmentation using advanced Boolean expressions

The purpose of ABE
ABE is a method of conditional segmentation that is only used for segmentation relative to a
marker. This marker is termed the reference marker. Segmentation with ABE is used, for example, to select those segments in which the test subject has pressed a response button
within a certain time after the triggering of a stimulus.
Essentially, ABE allows segment selection to be made dependent on the existence or absence of one or more markers in one or more intervals relative to the reference marker.
The markers can be of any type (segment markers, reference markers, DC correction etc.).
To achieve this, a condition is formulated prior to segmentation and this condition is then
checked for every reference marker in the data set. If the marker meets the condition, a segment is created. Otherwise the marker is skipped.
Within a condition, it is possible to check the properties of the reference marker and the presence of markers in the vicinity of the reference marker or to check individual properties of the
markers in the vicinity.

Using ABE
Segmentation using ABE can be applied on the page Segmentation Wizard – Step 2 of 3 of
the Segmentation transform dialog box (
see also Section 7.4.5 as of page 371).
Enter the ABE expression in the Advanced Boolean Expression text box (see Figure K-1). If
you do not enter an expression, standard segmentation relative to the selected markers is
performed.
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Figure K-1. Marker-based segmentation, dialog page 2, text box for ABE

Overview of the ABE syntax
An ABE condition is made up of individual comparisons that can each return the value "true"
or "false". These individual comparisons allow you to determine various items of information
about the reference marker or the markers surrounding it.
In particular, it is necessary to specify the marker to which the individual comparison refers.
This is done using a selection expression that uniquely describes a marker in the vicinity of
the stimulus. A selection expression has the following generic form:
SelectionWord(MarkerType, MarkerName, StartOfInterval,
EndOfInterval)
The selection word FIRST, for example, specifies that the first marker that corresponds to
the description should be used. The selection word LAST specifies that the last marker that
corresponds to the description should be used. The interval specifies the range relative to
the reference marker in which markers are to be searched for.
If you apply segmentation with ABE to a data set that has already been segmented then the
selection expression only takes account of markers that are located in the same segment as
the reference marker.
In the simplest scenario, the task consists merely of determining whether a marker of a specific type is present at all in the specified time range. The expression
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FIRST(Response,R1,100,500)
determines whether a marker of the type "Response" and with the name "R1" is present in
the interval 100 ms through 500 ms relative to the reference marker. The selection word
FIRST refers to the first matching marker in the interval, so that the number of markers actually present is of no significance.
Individual comparisons are combined to form complete complex expressions using the logical operators AND, OR and NOT. The composite condition
FIRST(Response,R1,100,500) AND FIRST(Response,R2,100,500)
determines whether both a "Response" marker with the name "R1" and a "Response" marker
with the name "R2" are present in the interval.
The operator precedence rules are important in this context. The NOT operator has the highest priority. This is followed by the AND operator and finally the OR operator. The precedence
of operators can be changed using brackets. Expressions in brackets are resolved first. The
composite condition
NOT (FIRST(Response,R1,50,100) OR FIRST(Response,R2,100,200))
excludes all segments in which the test subject pressed either "R1" within 50 ms to 100 ms
or "R2" within 100 ms to 200 ms.
The individual comparisons we have looked at so far have all used the marker description
FIRST(…). A marker description will by default search for a marker that matches all the
specifications in the brackets. If any of these specifications is to be ignored, you can replace
it by an asterisk ("*"). For the interval specifications, the boundaries of the segment are then
used. Therefore,
FIRST(Response,*,100,*)
determines whether there is a response marker with any name in the interval from 100 ms to
the end of the segment. It is not possible to use an asterisk within a specification (to specify
R*, for example).
It is also possible to check whether a marker found in this way has a particular property, and
marker properties can be checked against control values. An extended expression such as
this can only return "true" if the marker exists at all or possesses the property. These checks
are therefore performed implicitly. Example:
FIRST(Response,R1,100,500)

checks whether the marker is present.

FIRST(Response,R1,100,500).Test

checks whether the marker exists
and possesses the property "Test".
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FIRST(Response,R1,100,500).Test > 5

checks whether the marker exists
and possesses the property "Test"
and whether the value of the property is greater than 5.

FIRST(Response,R1,100,500).Test =
Example

checks whether the marker exists
and possesses the property "Test"
and whether the value of the property is the string "Example".

The following comparison operators can be used: <, >, =, <>, <= and >=.
Note that the value of the property is only taken into account if an operator is used. Otherwise, the only check carried out is whether the property exists. Thus, the individual comparison
FIRST(Response,R1,100,500).Correct
also returns "true" if "Correct" is a Boolean user property with the value "false". To check
whether the value of the property is "true", use
FIRST(Response,R1,100,500).Correct = true
A marker description can match several markers. If you are not only testing whether a marker
exists, but are also accessing its properties, the marker that has been selected is significant.
Four search expressions are therefore available that select a marker from the list of matching
markers sorted by position.
FIRST(Response,R1,100,500)

selects the first matching marker.

LAST(Response,R1,100,500)

selects the last matching marker.

CURR(Response,R1)

selects the reference marker if it matches the
specifications.

STEP(2,Response,R1,100,500)

from the list of all the matching markers,
selects the one at the specified position
(which is the second matching marker in our
example).

If the list does not contain sufficient markers to select the one specified with STEP, the individual comparison returns "false".
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Detailed description of the ABE syntax
This section provides details on the individual components of ABE expressions: Selection expressions, property expressions, constants, type specifiers and operators. Information is
also provided on how to combine these components to form expressions.

Selection expressions
A selection expression searches a data set for markers that match a set of search specifications. To start with, a list is created containing all the markers that match all the search criteria. A single marker is then selected from this list. The following options are available:
FIRST(<Type>,<Description>,<StartTime>,<EndTime>)
LAST(<Type>,<Description>,<StartTime>,<EndTime>)
CURR(<Type>,<Description>)
STEP(<Position>,<Type>,<Description>,<StartTime>,<EndTime>)
The selection expression FIRST selects the first marker and LAST selects the last marker
from the list of matching markers. The selection expression CURR selects the reference marker if it matches the specifications. The selection expression STEP selects the marker at the
position in the list specified by <Position>. The system searches forwards through the list
if <Position> is positive and backwards through the list if <Position> is negative.
The <Type> and <Description> specifications are strings that are compared with the corresponding properties of the marker. Comparison is not case-sensitive. Please note that
spaces are ignored during the comparison. The <StartTime> and <EndTime> specifications are floating point numbers that represent time specifications in milliseconds relative
to the reference marker. The <Position> specification is a signed integer.
Any specifications within the brackets may only contain the special characters '\', '(', ')' and
',' if they are preceded by the escape character '\'. The escape character '\' prevents the subsequent character from being interpreted as a special syntax character. The '\' itself is ignored. For example, R\(x\) is read as R(x).
All the specifications within the brackets must be present. The wildcard * can be used to ignore a particular specification when searching. The wildcard cannot be used to ignore only
parts of a specification. The <Position> specification cannot be ignored in this way. If
<StartTime> and <EndTime> are ignored, the boundaries of the segment are taken as the
<StartTime> and <EndTime>.
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If you apply segmentation with ABE to a data set that has already been segmented then the
time range defined by <StartTime> and <EndTime> is limited to the segment containing
the reference marker.

Property expressions
A property expression accesses a property of a marker. A property expression always follows
a selection expression.
A property expression is made up of '.' followed by the name of a marker property. Standard
properties start with "BrainVision.", e.g. BrainVision.Description. Note that property
names are case-sensitive.
User-defined properties do not generally have a prefix such as this. '$' can be prefixed to the
property name as a shortcut to simplify access to standard properties. This automatically inserts "BrainVision.".
For example
FIRST(Response,*,100,500).$Description
becomes
FIRST(Response,*,100,500).BrainVision.Description
on evaluation.
The property name may only contain alphabetic characters, numeric characters and '.'. Other
characters that are still part of the marker property name must be prefixed by '\'. If a leading
'$' is not to be replaced by "BrainVision.", but is instead part of the property name, it must
also be escaped by prefixing it with '\'.

Constants
Constants specify fixed values that are to be used for comparison. Constants can be prefixed
by a type specifier.
A constant that represents a numeric value must not contain any spaces. If a constant is not
preceded by a type specifier, its data type is undefined for the purposes of comparison and
is redefined as necessary for each comparison.
A constant that represents a string can be enclosed in double quotes " to prevent special
characters in the string from being evaluated as part of the ABE. If a string of this type con-
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tains a double quotation mark, this must be escaped by prefixing it with '\'. A string enclosed
in quotes must not be prefixed by any type specifier other than (string).
If a string is written without quotes and if it is a valid representation of a numeric value, it can
also be interpreted as a numeric value by the ABE, depending on the context. This means that
it often makes sense to explicitly enclose strings such as these in quotes or to prefix them
with a type specifier.

Type specifiers
A type specifier specifies that the value of a constant or a marker property is of a specific data
type. The type specifier takes the form "(<DataType>)", where the data type can be string,
bool, byte, int, uint, single or double. A type specifier can, for instance, precede a property
expression to change the type of a property before comparison:
(string)CURR(*,*).$Position = "5000".

Comparison operators
Comparison operators are used in individual comparison expressions to compare constants
or property values. The result is always the Boolean value "true" or "false". The following operators are available: =, <, >, <>, <=, >= and "is". The second operand of the "is" operator is always a string.
For example, FIRST(Response,*,100,500).Answer is "string" checks whether
the "Answer" property of the marker is a string.

Rules for individual comparisons
An individual comparison is an expression that is not made up by combining sub-expressions logically using AND, OR and NOT. An individual comparison is referred to as complete if
two operands are actually compared using a comparison operator. It is referred to as incomplete if only one operand is present and the expression simply checks whether the marker or
marker property is present.
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Complete individual comparisons
The operands of an individual comparison can be two marker properties or one marker property and one constant. In the latter case, the marker property must always be on the left of
the comparison expression.
Any access to a marker property first assumes that the marker exists and then assumes that
the property exists in this specific marker. If the marker or property is not present, the individual comparison always returns "false".

Incomplete individual comparisons
Incomplete individual comparisons only have one operand. If the incomplete individual
comparison contains a property expression, the system checks whether the marker is present and whether it has this property. If the individual comparison does not contain a property
expression, the system only checks whether the marker is present.

Types in individual comparisons
Both operands of an individual comparison can have a fixed type or a free type. Operands
with a fixed type are always only evaluated as values of this type. Operands with a free type
are dynamically modified to match the type required for the comparison.
An operand has a fixed type if it is prefixed by a type specifier or if it is a string constant. In
particular, numeric constants without a type specifier always have a free type. Constants
such as these are stored as strings and are only interpreted when the type required for the
comparison is known.
When a comparison is performed, both operands are evaluated and assigned values. If an
operand with a free type is a marker property, the data type actually stored in the marker is
used dynamically. The types of the operands are then modified according to the following
rules:
 If both operands have the same type, no adjustment is made.
 If both operands have a fixed type, no adjustment is made.
 If both operands have a free type, they are converted to a common type that makes se-

mantic sense. Thus, one single value and one int value are converted to two single values.
 If only one operand has a fixed type, the other operand is converted to match this type.
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 If the types are incompatible, no adjustment is made.

In this way, the operands should be converted in a way that makes semantic sense. Now the
actual comparison is carried out. The following applies:
 If the operands have the same type, the comparison is performed according to the appro-

priate semantics.
 If the operands have different types, the comparison '<> returns "true", and all other op-

erators return "false".
 One exception is that "is" returns "false" if the second operand is not a string. Otherwise,

"is" returns "true" if the type of the first operand is the type specified by this string.
Example: CURR(*,*).$Position > 5000.5
This example only takes account of markers beyond 5000 points. It works "correctly" because both types are free. The uint on the left is converted to a double before comparison. In
contrast, (int)CURR(*,*).$Position > 5000.5 only works "through the back door".
The double on the right is converted to an int before conversion and information is lost in the
process.

Old and new ABE syntax
The old ABE syntax is still valid. The old syntax is interpreted as a FIRST() expression using
a different syntax. Thus, for instance, Name(100,500) is interpreted as
FIRST(*,Name,100,500). This has no effect on the semantics of "old" individual comparisons, because the comparisons were always only checked for the existence of a marker.
One problem arises if the old individual comparison refers to a marker with the name CURR.
In this case, the "new" ABE regards CURR(100,500) as a "new" expression and checks
whether the segmentation marker has the type "100" and the description "500". Because the
old syntax corresponds to FIRST(*,CURR,100,500), you should in this case either use
the new syntax or you should use '\' to prevent CURR() from being evaluated as a selection
expression: \Curr(100,500).
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Appendix L DirectX 9 for 3D head view and Analyzer Video

To use the 3D head view and the Analyzer Video add-in, you need DirectX 9 and the Managed
DirectX 1.1 libraries. If these libraries are not available, you cannot use the Analyzer components. However, the Analyzer's other functions are not impaired.
The purpose of this appendix is to help you check the functioning of the 3D head view and
Analyzer Video components and prepare for the installation of DirectX 9 if this should prove
necessary. The required installation packages can be obtained from Microsoft free of charge.
The easiest way to check whether the components required for the 3D head view are present
is to select File > Views > Additional View in the ribbon and expand the menu. If the item 3D
Head View is present here then the components required for the 3D head view are installed
on your system and you can use the view.

Checking the DirectX
functionality

Equally, the DirectX libraries required for the Analyzer Video add-in are present if the item
Analyzer Video is present in the ribbon under Add Ins > Plug In. Further conditions must also
be met before you can use the Analyzer Video add-in. As a result, the item might not appear
even though all the DirectX components are present.
The other conditions that must be
met in order to use the video function are set out in Section 9.2 on page 500.
You can also run a detailed analysis to determine whether the required Managed DirectX 1.1
libraries are installed on your system. This is described under "Diagnosing Managed DirectX"
on page 597. In most cases, this detailed analysis is not required. The sections below provide you with a brief overview of the DirectX versions as well as information on why the libraries may not be present even though the current version of DirectX has been installed
correctly.
More recent versions than version 9 of the DirectX libraries are now available. Depending on
your operating system version, a current version of DirectX may come pre-installed as a component of the system. Thus, for example, DirectX 11 is pre-installed on systems running under Windows® 7. The interaction of DirectX 9 with more recent DirectX versions may
therefore be of relevance even if you have never installed a more recent DirectX version yourself.

DirectX versions

The new versions, such as DirectX 11, are managed and updated independently of DirectX 9.
As a result, it is possible that individual DirectX 9 libraries may not be available despite the
fact that DirectX 11 is fully installed and has the most recent updates.
It is still possible to use programs for DirectX 9 on a system equipped with DirectX 11 because a selection of DirectX 9 libraries are installed in addition to DirectX 11. These libraries
can be updated and maintained using normal DirectX 9 installation packages. Please note
that the libraries required for the use of the Analyzer components are not usually present in
a DirectX 11 installation.
In most cases, you can install the DirectX 9 installation packages provided by Microsoft on
your system without having to worry about malfunctions since the installation packages automatically manage the versions of the installed modules. In systems with more recent DirectX versions, such as DirectX 11, for example, only the DirectX 9 libraries that are also
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present on the system are updated during the installation process. However, we cannot guarantee the validity of these statements since responsibility for the DirectX installation lies
with Microsoft.
All current DirectX 9 installation packages (as of October 2006) should contain the libraries
required by the Analyzer. However, we cannot guarantee that any given installation package
will actually contain these libraries. The Analyzer program components have been validated
for use with the DirectX installation package of October 2006 which is available on our website at the link http://www.brainproducts.com/downloads.php?kid=9 as well as in the
\Components folder on the BrainVision program DVD.
Note that the required .NET components for DirectX are only installed if you have a .NET
Framework version between 2.0 and 3.5. One of these versions is installed as standard on
Windows® XP, Windows® Vista and Windows® 7 with their respective service packs. In contrast, the shipped configuration of Windows® 8 does not contain the required Framework
versions.
If you use Windows® 8 then the DirectX installation program may inform you that you need
to install a suitable version of .NET Framework (see Figure L-1). In the dialog box, choose
Download and install this feature.
Installation of DirectX continues while Windows® 8 is downloading .NET Framework 3.5. This
does not install the .NET components for DirectX. To complete installation of DirectX 9, you
must start the DirectX installation program again.
Figure L-1. .NET Framework 3.5, installing under Windows® 8
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To check whether the .NET components required for DirectX are present on your system, open
Windows® Explorer and go to the Windows® system folder, e.g. C:\Windows.
Go to the assembly subfolder to display the globally available .NET components. The following .NET components must be listed here:
Microsoft.DirectX.dll, version 1.0.2902.0
Microsoft.DirectX.Direct3D.dll, version 1.0.2902.0
Microsoft.DirectX.Direct3DX.dll, version 1.0.2904.0
Microsoft.DirectX.AudioVideoPlayback.dll, version 1.0.2902.0
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Appendix M File formats for Generic Data Reader and Generic Data
Export

The Analyzer components Generic Data Reader and Generic Data Export can be used with data files of different formats. In addition
to the data file, there is a header file and, optionally, also a marker file. By using a suitable header file, it is also possible to read
raw data for which no dedicated reader is available.
The header and marker files are usually given the same base name as the raw EEG described in them. The header and marker files
are stored in the raw data folder of the workspace.
In this appendix, we describe the two file formats available for header and marker files: text format (file extensions .vhdr and .vmrk) and XML format (file extensions .xhdr and .xmrk).

GDR-compatible header file in text format (.vhdr)
The format of the header file is based on the Windows® INI format. It consists of various named sections containing keywords/values. Here is an extract from a header file:
Brain Vision Data Exchange Header File Version 1.0
; Data created from history path:
; P300b/Raw Data/Filters/Segmentation/Average

[Common Infos]
DataFile=P300b_Average.dat
MarkerFile=P300b_Average.vmrk
DataFormat=ASCII
; Data orientation: VECTORIZED=ch1,pt1, ch1,pt2..., MULTIPLEXED=ch1,pt1, ch2,pt1 ...
DataOrientation=VECTORIZED
DataType=TIMEDOMAIN
NumberOfChannels=32
The first line identifies the header file and is mandatory.
A semicolon at the beginning of a line identifies a comment. Comments are ignored by the Reader. Blank lines are also ignored.
A section is identified by a line with a heading enclosed in square brackets. The header extract above, for example, contains the
"Common Infos" section. A header file can contain an unlimited number of sections.
The lines that follow contain some of the keywords in this section together with the values assigned to them. A keyword can only
occur once in a section. Its meaning depends on the section in which it occurs. There must not be a space before or after the equals
sign. Most predefined keywords have a predefined value. This is used by the Reader if a keyword is not found.
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If you want to create a header file, export an EEG of your choice using the Generic Data Export component. Choose the Text Format
option under Header and Marker File Format. This creates a header that is compatible with the GDR. Set the parameters in such
a way that the format of the exported file is as close as possible to that of the one to be imported. You can then adapt the header
to meet your specific requirements.
The various predefined sections are listed below together with their keywords, meaning and default values.
Table M-1. "Common Infos" section of the header file
This section contains general information on the EEG file.
Keyword

Meaning

Default value

DataFile

Name of the EEG file. If the name does not contain a path, it is assumed that
the EEG file is in the same folder as the header file. The placeholder $b can
be used in the file name. It is replaced by the base name of the header file
when the file is read in. Example: If the name of the header file is Test.vhdr,
the entry DataFile=$b-EEG.dat is interpreted as DataFile=TestEEG.dat.

None, a value must
be specified.

MarkerFile

Optional marker file. The marker file contains a list of markers assigned to the
EEG. If no path is specified explicitly, the marker file is searched for in the
folder containing the header file. The format of the marker file is explained
below. The placeholder $b can be used in the file name.

-

DataFormat

Data format. Possible values: ASCII, BINARY

ASCII

DataOrientation

Data orientation. Possible values:
VECTORIZED
The file begins with all the data points of the first channel, followed by all the
data points of the second channel, and so on.
MULTIPLEXED
All the channels come one after the other for every data point. In other words,
the data structure is multiplexed.

MULTIPLEXED

DataType

Data type. Possible values:
TIMEDOMAIN
The data is in the time domain.
FREQUENCYDOMAIN
The data is in the frequency domain.
FREQUENCYDOMAIN_COMPLEX
The data takes the form of complex frequency values. Each real value is followed by an imaginary value.
TIMEFREQUENCYDOMAIN
The data exists in several layers, as in the case of the continuous Wavelet
transform, for example. Each channel is represented by a vector of data at a
point in time.
TIMEFREQUENCYDOMAIN_COMPLEX
This type corresponds to TIMEFREQUENCYDOMAIN, except that here each
value takes the form of a complex number.

TIMEDOMAIN

NumberOfChannels

Number of channels in the EEG file.

None, a value must
be specified.
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Table M-1. "Common Infos" section of the header file
This section contains general information on the EEG file.
Keyword

Meaning

Default value

SamplingInterval

Sampling interval. The interval is specified in μs in the time domain and in Hz
in the frequency domain.

None, a value must
be specified.

Averaged

This indicates whether the data set to be read in has been averaged. It is par- NO
ticularly relevant to the enabling and disabling of transforms.
Possible values are:
YES – Yes, the data set represents data that has been averaged.
NO – No, the data set represents data that has not been averaged.

AveragedSegments

Number of segments included in averaging. This value is only evaluated
when "Averaged=YES" is set.

0

SegmentDataPoints

If the data is segmented evenly, the number of data points per segment can
be specified at this point.

0

SegmentationType

Segmentation type. Like Averaged, this variable is relevant to the enabling NOTSEGMENTED
and disabling of the Analyzer transforms.
Possible values are:
NOTSEGMENTED
The data set has not been segmented.
MARKERBASED
The data set has been segmented on the basis of one or more marker positions. All segments have the same length.
FIXTIME
Segmentation was based on fixed times. All segments have the same length.
MANUAL
The segments were specified manually. They may therefore be of different
lengths.

DataPoints

Number of data points in the EEG file. If no predefined value has been specified, the data is read in up to the end of the file. In the case of binary data,
the TrailerSize parameter in the [Binary Infos] section can be set as an
alternative.

0

Layers

Number of layers in a multilayer EEG of the type
TIMEFREQUENCYDOMAIN(_COMPLEX)

1

LayerLowerLimit

Lower limit in multilayer data. In the case of the type
TIMEFREQUENCYDOMAIN(_COMPLEX), the unit is Hz.

0

LayerUpperLimit

Upper limit in multilayer data

0

LayerFunction

Function that describes the intervals between the layers of multilayer data.
Possible values are:
LINEAR
Linear function
LOGARITHMIC
Logarithmic function

LINEAR
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Table M-2. "ASCII Infos" section
This section is only relevant if ASCII is set for "DataFormat" in the "Common Infos" section.
Keyword

Meaning

Default value

DecimalSymbol

Decimal symbol used in the EEG file. This symbol can be either a point or a
comma. In the header file, the decimal symbol is always a point.

Point (.)

SkipLines

Number of header lines to be skipped

0

SkipColumns

Number of columns to be skipped at the beginning of a line.

0

Table M-3. "Binary Infos" section
This section is only relevant if BINARY is set for "DataFormat" in the "Common Infos" section.
Keyword

Meaning

Default value

BinaryFormat

Binary format. Possible values:
IEEE_FLOAT_32
IEEE floating-point format, single precision, 4 bytes per value
INT_16
16-bit signed integer
UINT_16
16-bit unsigned integer
INT_32
32-bit signed integer
UINT_32
32-bit unsigned integer

INT_16

ChannelOffset

Number of bytes to be skipped before the data of a channel is read. Use this
specification if the data file contains a management information block before
each channel. The offset is only used for data saved in vectorized form.
ChannelOffset and DataOffset can be used simultaneously.

0

DataOffset

Size of the offset in the file at which the actual data starts.

0

SegmentHeaderSize

If the data is segmented evenly, the size of the segment header can be
entered here in bytes.

0

TrailerSize

Size of the trailer of the EEG file in bytes. This parameter can be specified as
an alternative to DataPoints in [Common Infos] in order to stop reading in
the data before the end of the EEG file is reached.

0

UseBigEndianOrder

This only applies to integer formats. It specifies whether big endian order is
used, i.e. whether the most significant byte is stored first (Macintosh, Sun).
Possible values are:
YES
Yes, big endian order is used.
NO
No, little endian order is used (corresponds to the Intel specification).

NO
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Table M-4. "User Infos" section
This section contains information on user-defined properties of the data set.
Keyword

Meaning

Default value

Prop<x>

Prop<x>; x stands for the number of the property, i.e. the keyword for the
first user-defined property is Prop1, for the second Prop2, etc.
Individual specifications for the user-defined property are listed separated
by commas: <datatype>,<name>,<value>,<value2>,...,<valueN>.
The permitted data types are bool, byte, int, uint, single, double,
string, color. For each data type, it is also possible to use the corresponding array type, e.g. int-array.
Simple data types have only one value. In the case of array types, the values
are listed separated by commas.
Example:
Prop1=int-array,Test,1,2,3,4
This line defines a property for the data set. The property has the name Test
and is an Int array with the values 1, 2, 3 and 4.

-

Table M-5. "Channel Infos" section
Channel information. This section lists the individual channels and their properties.
Keyword

Meaning

Default value

Ch<x>. x stands for the
channel number. In
other words, the keyword for the first channel is Ch1, for the
second channel Ch2,
etc.

Individual properties for the channel are specified separated by commas:
<channel name>,<reference channel name>,
<resolution in "unit">,[<unit>]
Example:
Ch1=Fp1,,1
The first channel has the channel name "Fp1". The common reference channel is taken as the reference channel because no entry has been made. The
resolution is 1 μV. The resolution is the value by which the value of the data
point is multiplied to convert it to the channel unit (e.g. μV).

<channel number>,
,1,μV, i.e., for channel 1, for example:
Ch1=1,,1
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Table M-6. "Coordinates" section
Coordinates are listed here.
Keyword

Meaning

Default value

Ch<x>
"x" stands for the channel number. In other
words, the keyword for
the first channel is Ch1,
for the second channel
Ch2, etc.

Coordinates of an individual channel in the form:
<Radius>, <Theta>, <Phi>
Example:
Ch1=1,-92,-72
The coordinate system is described in Appendix C on page 563 .

If the value is not
listed here, the Analyzer uses the electrode name of the
channel, searches for
the coordinates in
the 10-10 system and
uses them. If the
channel name is
unknown, the coordinates are set internally to 0,0,0.

Table M-7. "Channel User Infos" section
This section contains information on user-defined channel properties.
Keyword

Meaning

Default value

Prop<x>

Prop<x>; x stands for the number of the property, i.e. the keyword for the
first user-defined property is Prop1, for the second Prop2, etc.
Individual specifications for the user-defined property are listed separated
by commas: Ch<y>,<datatype>,<name>,<value>,<value2>,...,<valueN>.
Here, y is the number of the channel in [Channel Infos] to which the property
refers.
The permitted data types are bool, byte, int, uint, single, double,
string, color. For each data type, it is also possible to use the corresponding array type, e.g. int-array.
Simple data types have only one value. In the case of array types, the values
are listed separated by commas.
Example:
Prop1=Ch5,int-array,Test,1,2,3,4
This line defines a property for the fifth channel from [Channel Infos]. The
property has the name Test and is an Int array with the values 1, 2, 3 and 4.

-
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GDR-compatible marker file in text format (.vmrk)
The marker file has a similar structure to the header file with sections and keywords. It should have the file name extension .vmrk
and the same base name as the associated EEG file.
The first line identifies the marker file, as follows:
Brain Vision Data Exchange Marker File Version 1.0
The various predefined sections are listed below together with their keywords, meaning and default values.
Table M-8. "Common Infos" section of the marker file
This section contains general information on the marker file.
Keyword

Meaning

Default value

DataFile

Name of the EEG file. If the name does not contain a path, it is assumed that
the EEG file is in the same folder as the marker file. This information is not
evaluated by the Generic Data Reader.

-

Table M-9. "Marker Infos" section
Marker information. The individual markers and their properties are listed in this section.
Keyword

Meaning

Default value

Mk<x>: "x" stands for
the marker number. In
other words, the keyword for the first marker
is Mk1, for the second
marker Mk2, etc.

Mk<x>: x stands for the marker number. In other words, the keyword for the first marker is Mk1, for the second marker Mk2, etc. Individual properties for
the marker are specified separated by commas: <type>, <description>, <position>, <points>, <channel number>, <date>
Example:
Mk1=Time 0,,26,1,0
The first marker in this example has the type "Time 0", no description, its position is at data point 26, its length is 1 data point, and the channel number
is 0, which means that this marker applies to all channels.
The date is optional. It is only evaluated if the marker type is "New Segment".
The date has the following format:
4 digits = year
2 digits = month
2 digits = day
2 digits = hour (24-hour system)
2 digits = minute
2 digits = second
6 digits = microsecond
The result is a time resolution of a microsecond.
Specifying a date
19990311140312000000
means 11 March 1999, 14:03:12.003012
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Table M-10. "Marker User Infos" section
This section contains information on user-defined marker properties.
Keyword

Meaning

Prop<x>

Prop<x>; x stands for the number of the property, i.e. the keyword for the
first user-defined property is Prop1, for the second Prop2, etc.
Individual specifications for the user-defined property are listed separated
by commas: Mk<y>,<datatype>,<name>,<value>,<value2>,...,<valueN>.
Here, y is the number of the marker in [Marker Infos] to which the property
refers.
The permitted data types are bool, byte, int, uint, single, double,
string, color. For each data type, it is also possible to use the corresponding array type, e.g. int-array.
Simple data types have only one value. In the case of array types, the values
are listed separated by commas.
Example:
Prop1=Mk5,int-array,Test,1,2,3,4
This line defines a property for the fifth marker from [Marker Infos]. The property has the name Test and is an Int array with the values 1, 2, 3 and 4.

GDR-compatible header file in XML format (.xhdr)
This header format uses the standardized notation as XML. Here is an extract from a header file:
<?xml version="1.0" encoding="utf-8"?>
<HeaderFile xmlns="http://www.brainproducts.com/HeaderFile">
<DataFile>tmp.dat</DataFile>
<MarkerFile>tmp.xmrk</MarkerFile>
<!--Data orientation: VECTORIZED or MULTIPLEXED -->
<DataOrientation>Multiplexed</DataOrientation>
<Properties>
<DataType>TimeDomain</DataType>
<DatasetLength>2500</DatasetLength>
<SamplingInterval>4000</SamplingInterval>
<DatasetUnit>Microvolt</DatasetUnit>
</Properties>

Default value
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<Channels>
...
</Channels>
</HeaderFile>
The header file adheres to the usual format conventions for XML files and consists of a hierarchical sequence of entries ("tags").
Every opening entry, such as <Properties>, must be matched by a subsequent closing entry, such as </Properties>. The
entry may contain either text (the "value" of the entry) or sub-entries.
In the example, the entry <DataType>TimeDomain</DataType> is a sub-entry of the entry <Properties>. Sub-entries
must be closed before the entry they belong to is closed.
Please note that the names of these entries are case-sensitive. There must be no spaces between the angle brackets and the name
of the entry. It is not possible to use special characters such as &, <, > as values in the entries. These must be expressed using
special strings.
More detailed information can be found in the available general documentation relating to the use of XML.
The text between <!-- and --> is a comment and is ignored by the Reader. Blank lines are also ignored. The <HeaderFile>
entry in the second line contains the optional specification xmlns="http://www.brainproducts.com/HeaderFile".
This defines an XML namespace that uniquely identifies the XML format for header files.
The entry encoding="utf-8" in the first line of the file indicates that the characters in the file correspond to the UTF8 encoding
specified in the Unicode Standard. This encoding simplifies the handling of special characters. It is possible to use other types of
Unicode encoding in the header file. However, we recommend that you use UTF8 encoding. If you process the header file in a text
editor, make sure that you save it as UTF8 text.
If you want to create a header file, export an EEG of your choice using the export component Generic Data Export. Choose the XML
Format option under Header and Marker File Format. This creates a header that is compatible with the GDR. Set the parameters
in such a way that the format of the exported file is as close as possible to that of the one to be imported. You can then adapt the
header to meet your specific requirements.
Most predefined keywords have a predefined value. This is used by the Reader if a keyword is not found.
The various predefined sections are listed below together with their keywords, meaning and default values.

Top-level entries
The HeaderFile entry is the topmost level in the file structure and all the other entries are subordinate to it (sub-entries). The
entries in this section are direct sub-entries of the HeaderFile entry. These entries either contain general information on the
EEG file or group together entries relating to the individual topics.
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Table M-11. Top-level entries in the header file
Entry

Meaning

Value

DataFile

Name of the EEG file. If the name does not contain a path, it is assumed that
the EEG file is in the same folder as the header file. The placeholder $b can
be used in the file name. It is replaced by the base name of the header file
when the file is read in. Example: If the name of the header file is Test.vhdr,
the entry DataFile=$b-EEG.dat is interpreted as DataFile=TestEEG.dat.

None, a value must
be specified.

MarkerFile

Optional marker file. The marker file contains a list of markers assigned to the
EEG. If no path is specified explicitly, the marker file is searched for in the
folder containing the header file. The format of the marker file is explained on
page 614 ff. The placeholder $b can be used in the file name.

-

DataOrientation

Data orientation. Possible values:
Vectorized
The file begins with all the data points of the first channel, followed by all the
data points of the second channel, and so on.
Multiplexed
All the channels come one after the other for every data point. In other words,
the data structure is multiplexed.

Multiplexed

BinaryFormat

This entry contains specifications on binary data formats. You should only
use this entry if the data is present in a binary format. The sub-entries for this
entry are described in Table M-13 on page 611.

-

TextFormat

This entry contains specifications on text-based data formats. You should
only use this entry if the data is present in a text format. The sub-entries for
this entry are described in Table M-14 on page 612.

-

Properties

This entry contains specifications on the properties of the EEG data set such
as the sampling rate. The sub-entries for this entry are described in Table M12 on page 609.

-

Channels

This entry contains specifications on the channels. The sub-entries for this
entry are described in Table M-15 on page 612.

-

RecordingInfo

This entry contains text with additional information on EEG recording. This
text can be viewed by opening the context menu of the raw data node. The
header file can contain any number of entries of this type and each entry may
consist of several lines of text.

-

Properties of the data set
This section contains the sub-entries of the Properties entry. The entries describe properties of the data set, such as the sampling rate.
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Table M-12. Properties of the data set
Keyword

Meaning

Default value

DataType

Data type. Possible values:
TimeDomain
The data is in the time domain.
FrequencyDomain
The data is in the frequency domain.
FrequencyDomainComplex
The data takes the form of complex frequency values. Each real value is followed by an imaginary value.
TimeFrequencyDomain
The data exists in several layers, as in the case of the continuous Wavelet
transform, for example. Each channel is represented by a vector of data at a
point in time.
TimeFrequencyDomainComplex
This type corresponds to TimeFrequencyDomain, except that here each
value takes the form of a complex number.

TimeDomain

DatasetLength

Number of data points in the EEG file. If no predefined value has been specified, the data is read in up to the end of the file.

-

SamplingInterval

Sampling interval. The interval is specified in μs in the time domain and in Hz
in the frequency domain.

None, a value must
be specified.

DatasetUnit

Unit of measurement for the channels in the data set. This value is used if no
unit of measurement has been specified for a channel. Possible values are:
Microvolt, MicrovoltPerHertz, MicrovoltPerMeterSquare,
MicrovoltSquared, MicrovoltSquaredPerHertz.

Microvolt

AveragedSegments

This entry indicates whether the data set to be read in has already been aver- 0
aged. It is particularly relevant to the enabling and disabling of transforms.
The number of segments included in the average is specified here.

SegmentationType

Segmentation type. Like Averaged, this variable is relevant to the enabling NotSegmented
and disabling of the Analyzer transforms.
Possible values are:
NotSegmented
The data set has not been segmented.
Marker
The data set has been segmented on the basis of one or more marker positions. All segments have the same length.
MarkerAndABE
This segmentation type corresponds to Marker. However, an Advanced
Boolean Expression was also used.
FixedTime
Segmentation was based on fixed times. All segments have the same length.
Manual
The segments were specified manually. They may therefore be of different
lengths.
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Table M-12. Properties of the data set
Keyword

Meaning

Default value

SegmentationABE

The ABE that was used during segmentation. This entry can only be used if
the value of the SegmentationType entry is MarkerAndABE.

Empty string

SegmentationTime
Based

This entry can be used to indicate whether the values in the SegmentSize
and RefMarkerPosition entries are to be interpreted as time or data
point-based specifications. The entry can have the value True or False.

-

SegmentSize

The length of the segments in the data set can be specified in this entry. The
entry can only be used if the data is uniformly segmented. Depending on the
value specified for the SegmentationTimeBased entry, either the number
of data points per segment or the segment length in milliseconds can be
specified.

-

RefMarkerPosition

The position of the reference marker in the segment can be specified in this
entry. The entry can only be used if the data is segmented on the basis of
markers. Depending on the value specified for the SegmentationTimeBased entry, the position can be specified either in data points or in ms.

-

RefMarkersStimuliOnly

In this entry, it is possible to specify whether all the reference markers are
stimuli. The entry can only be used if the data is segmented on the basis of
markers. This entry can have the value True or False.

-

RefMarkerInfo

This entry contains sub-entries with information on the reference markers in
the segments. The entry can only be used if the data is segmented on the
basis of markers. The sub-entries for this entry are described in Table M-16
on page 613.

-

PeakRefChannels

This entry contains sub-entries with information on the Peak Detection trans- form. The sub-entries for this entry are described in Table M-17 on page 613.

VectorElements

Number of layers in a multilayer EEG of the type
TimeFrequencyDomain(Complex)

1

VectorLowerLimit

Lower limit in multilayer data. In the case of the type
TimeFrequencyDomain(Complex), the unit is Hz.

0

VectorUpperLimit

Upper limit in multilayer data

0

VektorFunction

Function that describes the intervals between the layers of multilayer data.
Possible values are:
Linear
Linear function
Logarithmic
Logarithmic function

Linear

User

This entry describes a user-defined property for a data set. The Properties
entry can contain any number of user-defined properties. User-defined properties are described in Table M-18 on page 614.

-
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Entries relating to binary format
This section contains sub-entries of the BinaryFormat entry.
Table M-13. Entries relating to binary format
Entry

Meaning

Value

Format

Binary format. Possible values:
IEEE_FLOAT_32
IEEE floating-point format, single precision, 4 bytes per value
INT_16
16-bit signed integer
UINT_16
16-bit unsigned integer
INT_32
32-bit signed integer
UINT_32
32-bit unsigned integer

Int16

ChannelOffset

Number of bytes to be skipped before the data of a channel is read. Use this
specification if the data file contains a management information block before
each channel. The offset is only used for data saved in vectorized form.
ChannelOffset and DataOffset can be used simultaneously.

0

DataOffset

Number of bytes to be skipped at the start of the file before the actual data is
read. Use this specification if the data file contains a management information block at the start of the file.

0

SegmentHeaderSize

Number of bytes to be skipped at the start of each segment. Use this specification if the data file contains a management information block before each
segment. The offset is only used for segmented data.

0

UseBigEndianOrder

This only applies to integer formats. It specifies whether big endian order is
used, i.e. whether the most significant byte is stored first (Macintosh, SUN).
Possible values are:
True
Yes, big endian order is used.
False
No, little endian order is used (corresponds to the Intel specification).

False

Entries relating to text format
This section contains sub-entries of the TextFormat entry.
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Table M-14. Entries relating to text format
Keyword

Meaning

Default value

DecimalSymbol

Decimal symbol used in the EEG file. This symbol can be either a point or a
comma. In the header file, the decimal symbol is always a point.

Point (.)

SkipLines

Number of lines to be ignored at the start of the file.

0

SkipColumns

Number of columns to be skipped at the beginning of a line.

0

Channel information
The Channels entry may contain any number of Channel entries. Each of these entries contains information on the properties
of an individual channel. The number of Channel entries determines the number of channels in the data set. Table M-15 indicates the possible entries within a Channel entry.
Table M-15. Channel information
Keyword

Meaning

Default value

Name

Name of channel

Number of channel in
the channel list

RefName

Name of reference channel. If nothing is specified here then the common ref- Empty string
erence channel (Common Reference) is taken to be the reference channel.

DataUnit

Data unit for the channel. Possible values:
Microvolt, MicrovoltPerHertz, MicrovoltPerMeterSquare,
MicrovoltSquared, MicrovoltSquaredPerHertz, UserDefined.

Value of
DatasetUnit from
Properties

UnitString

The value of this entry is a user-defined data unit. This entry can only be used
if the value of the DataUnit entry is UserDefined.

Empty string

Coordinates

Coordinates of the channel. The entry contains the coordinates as values in
the sub-entries Radius, Theta, Phi.

-

SecCoordinates

Coordinates of the reference channel. The entry contains the coordinates as
values in the sub-entries Radius, Theta, Phi.

-

Color

Color of the channel. The value of this entry can take the form of a color name
(e.g. Red) or an RGB specification in hexadecimal notation (0xFF0000).

Black

Resolution

Resolution of the channel data if a binary data file is used. The resolution is
the value by which the value of the data point is multiplied to convert it to the
channel unit (e.g. μV).

1

User

This entry describes a user-defined property of the channel. The Properties entry can contain any number of user-defined properties. User-defined
properties are described in Table M-18 on page 614.

-
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Information on reference markers
If data segmented on the basis of markers is read in, then specifications relating to the reference markers can be made in the
RefMarkerInfo sub-entry of the Properties entry. The RefMarkerInfo entry may contain any number of RefMarker entries. Each of these entries contains information on a reference marker. Table M-16 indicates the possible entries within a
RefMarker entry.
Table M-16. Information on reference markers
Keyword

Meaning

Default value

Type

Marker type of the reference marker

Empty string

Description

Description of the reference marker

Empty string

Information on peak reference channels
The reference channels that were used in the Peak Detection transform are stored in the PeakRefChannels entry. The entry may
contain any number of Channel entries.
Table M-17. Information on peak reference channels
Keyword

Meaning

Default value

Channel

Name of reference channel

Empty string

User-defined properties
User-defined properties can be assigned to the entire data set, a single channel or a marker. In each case, any number of userdefined properties can be used. Each user-defined property is represented by a User entry. This entry contains two mandatory
attributes:
 Name: Name of the user-defined property
 Type: Data type of the user-defined property. The permitted data types are Boolean, Byte, Int32, UInt32, Single,

Double, String, Color. For each data type, it is also possible to use the corresponding array type, e.g. Int32[].
Example: To add a user-defined property named MyProperty with the value 5.0 and an array property named MyOtherProperty to the data set, enter the following specifications:
<Properties>
<DatasetLength>2500</DatasetLength>
<SamplingInterval>4000</SamplingInterval>
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...
<User Name=“MyProperty“ Type=“Single“>5.0</User>
<User Name=“MyOtherProperty“ Type=“Int32[]“>
<Item>1</Item>
<Item>2</Item>
</User>
</Properties>
Table M-18. User-defined properties
Keyword

Meaning

Default value

User

If the user-defined property uses an array type as its data type then this entry
contains an Item entry for each item in the array. Otherwise, the entry contains the actual value of the user-defined property.

-

Item

The value of this entry represents an array item in a user-defined property.

-

GDR-compatible marker file in XML format (.xmrk)
This marker format uses the standardized notation as XML. Here is an extract from a marker file:
<?xml version="1.0" encoding="utf-8"?>
<MarkerSet xmlns="http://www.brainproducts.com/MarkerSet">
<!--This document was created by Generic Data Export-->
<SamplingRate>250</SamplingRate>
<SamplingInterval>4</SamplingInterval>
<Markers>
<Marker>
<Type>Stimulus</Type>
<Description>S1</Description>
<Position>481</Position>
<Points>1</Points>
<Channel>All</Channel>
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</Marker>
</Markers>
</MarkerSet>
The marker file adheres to the usual format conventions for XML files and the same general comments as for header files apply.
The entries in this section are direct or indirect sub-entries of the MarkerSet entry.

Top-level entries
The MarkerSet entry is the topmost level in the file structure and all the other entries are subordinate to it (sub-entries). The
entries in this section are direct sub-entries of the MarkerSet entry. The most important entry is the Markers entry which contains the marker list.
Table M-19. Top-level entries in the marker file
Keyword

Meaning

SamplingRate

Sampling rate of the underlying EEG data set. This specification is optional. It is used if the Import Markers transform is to be used to read the marker file
into a data set which has a different sampling rate from the data set that originally contained the markers.

SamplingInterval

Sampling interval of the underlying EEG data set. This specification is
optional. It is used if the Import Markers transform is to be used to read the
marker file into a data set which has a different sampling interval from the
data set that originally contained the markers.

-

Markers

The entry can contain any number of Marker entries.

-

Marker entries
Each Marker entry describes an individual marker.

Default value
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Table M-20. Marker entries
Keyword

Meaning

Default value

Type

Marker type

Empty string

Description

Description of the marker

Empty string

Position

Position of the marker in the data set in data points. The first data point in the
data set has the number 0.

None, a value must
be specified.

Points

Length of the marker in data points.

None, a value must
be specified.

Channel

Number of the channel in which the marker is located. The first channel has
the number 0. If a marker is not assigned to any channel then -1 should be
entered here.

None, a value must
be specified.

Visible

This entry specifies whether the marker is visible. It can have the value True
or False.

True

Date

This entry contains the recording time assigned to the data point at which the
marker is located. This specification is usually only considered if the marker
is of type New Segment. The time is specified in the internationally
accepted format YYYY-MM-DDThh:mm:ss, for example
2011-03-30T15:30:45
If the time specification contains milliseconds then these can be appended
to the seconds as a decimal value.

-

User

This entry describes user-defined properties of the marker. The same descrip- tion as for the user-defined properties in an XHDR file applies to the userdefined properties of markers.
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List of abbreviations

ABE ......................... Advanced Boolean Expression
AOI .......................... Area of Interest
BCI .......................... Brain Computer Interface
CSD ......................... Current source density
DC ........................... Direct current
ECG ......................... Electrocardiogram
ECG .......................... Electrocardiogram
EDA .......................... Electrodermal activity
EEC .......................... European Economic Community
EMG ......................... Electromyogram
EOG.......................... Electrooculogram
ERD ......................... Event-related desynchronization
ERS .......................... Event-related synchronization
EU ........................... European Union
FFT ........................... Fast Fourier transform
FIR ........................... Finite impulse response
fMRI ......................... Functional magnetic resonance imaging
GDR ......................... Generic Data Reader
GFP .......................... Global field power
HEOG........................ Horizontal electroculogram
ICA .......................... Independent component analysis
IDE .......................... Integrated Development Environment
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IIR ............................ Infinite impulse response
LDR .......................... Linear derivation
LORETA .................... Low Resolution Brain Electromagnetic Tomography
LPT .......................... Line printing terminal ("parallel port")
LRP .......................... Lateralized readiness potential
MDD ........................ Medical Device Directive
MNI ......................... Montreal Neurological Institute
MR ........................... Magnetic resonance
OLE .......................... Object Linking and Embedding
PCA ......................... Principal Component Analysis
RMS ......................... Root mean square
ROI .......................... Region of Interest
SNR ......................... Signal-to-noise ratio
TDC .......................... Template drift compensation
TDD ......................... Template drift detection
TR ............................ Time of repetition
VEOG........................ Vertical electrooculogram
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Glossary

A
Add-in: Add-ins are Analyzer program components that offer additional functions. Add-ins can also be created by users themselves and are freely programmable. While, for
example, they can act as transforms or export components,
they internally use a simplified program mechanism.
Advanced Boolean Expression: ABE is a method of conditional segmentation that is used for segmentation relative
to a marker. The user can specify a formula to define criteria
indicating which markers are to be used for segmentation.
Amplitude: Maximum deflection of the EEG curve in μV
measured from peak to trough.
Artifact: All potential shifts in the EEG recording that do not
have their source in the cortex. Artifacts can be subdivided
into those related to the test subject (physiological artifacts) and technical interference. Technical artifacts can be
caused by faulty electrodes, defects in the apparatus or
technical interference.
Average reference: Reference type in which the average of
all the channels is used as the reference.
Average: Formation of arithmetic mean using segmentation
(total value of the points divided by the number of segments). This is performed separately for each EEG channel.

B

By adding new components it is possible to expand the Analyzer's functionality.

D
Data file: A data file contains digitized EEG data for use by
a reader.
Dongle: Pluggable copy protection device. Analyzer as of
version 2.0.3 can be operated with either HASP HL dongles
or the more recent Sentinel HASP dongles. HASP HL dongles can be converted to Sentinel HASP dongles, for example by purchasing a license for optional program
components (q.v.).
Drift: During the correction of MR scanner artifacts, the
temporal delay between the averaged artifact curve and the
scanner artifact of an artifact interval caused by systematic
differences between the time of repetition (TR) of the scanner and the sampling rate.

E
Export component: Analyzer program element which writes
the content of the current data set to a file so that this can
be used outside of the Analyzer.

G

Bad interval: An interval that is marked in the EEG and
whose data should not be used in subsequent processing
steps, e.g. an interval that contains artifacts.

Generic Data Reader: Reader component in the Analyzer
that reads data in the formats used by Brain Products (.vhdr
for Brain Vision Data Exchange Header and .xhdr for XML
Header File).

Baseline: An assumed horizontal line marking the vertical
zero point in the EEG (voltage = 0).

H

C
Cache file: A cache file stores the EEG data of a history node
so that it can be used at a later time without it being necessary to recalculate it.
Child node: In the history tree, this refers to the EEG data
sets that are subordinate to the current node and represent
the following processing steps.
Component: Analyzer program element that is located outside of the actual program file and is dynamically loaded.
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Header file: File containing general information on the recording, such as the number and names of the channels,
the electrode coordinates, the sampling rate, the number
of data points, etc. The file is created and read automatically. Format: .vhdr or .xhdr.
History file: The file on your computer in which the processing steps applied to an EEG file are stored. Also refers to the
EEG file displayed in the History Explorer.
History Node List: List of the currently open history nodes.
It can be used to sort and filter the nodes.
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History node: Representation of a processing step applied
to an EEG file in the Analyzer user interface.

Montage: Reconnection of the channels in the software
whereby new voltage references are assigned to the channels.

History template: File in which processing steps from the
history tree (q.v.) are stored. The processing steps can be
executed again automatically elsewhere.

N

History tree: The processing steps applied to the EEG and
displayed in the form of a tree.

Network license: Licensing model for operating the Analyzer on multiple workstations in a network environment.

History-Explorer: An element in the Analyzer user interface
which allows users to edit raw data nodes and created history nodes.

O

I
Interactive view: An EEG view that is displayed in order to
accept user input for the execution of a transform. The user
can, for example, mark artifacts in the EEG.
Interval: A section of the EEG signal defined by its starting
point and length or by its starting point and end point within the signal.

L
License for optional program components: Before you can
use certain program components, you must purchase optional licenses. If you use a Sentinel HASP dongle then
these licenses are stored directly in the dongle. If, instead,
you use a HASP HL dongle then the licenses are administered as a separate sub-license file (q.v.).

M
Macro: A BASIC program that is loaded in the Analyzer and
executed within the main program. Users can program their
own macros in the integrated development environment.
Marker file: File listing all the markers present in the data
set together with their position, type, description etc. Format: .vmrk or .xmrk.
Marker: Markers mark a point in time or a period within the
EEG. A marker can be an item of stimulus information that
is used to ascertain evoked potential, but it can also mark
a new segment or indicate that a DC offset correction was
carried out at a certain time. Markers are used for orientation during segmentation.

OLE automation: Interface to Analyzer program functions
that can be used to control the Analyzer. The interface can
be addressed both by BASIC macros in the Analyzer and by
external programs.
Operation Infos: The descriptive text that summarizes the
settings used for the execution of a processing step. The
Operation Infos are saved automatically and can be viewed
again later.
Overlay: The result of overlaying EEG channels of the same
name and data sets of the same data type and, in the case
of segmented data, the same sampling rate with the aim of
carrying out a direct visual comparison of the data.

P
Parameters: Sum of the settings used to perform a processing step applied to the EEG data. The processing step is
uniquely defined by the parameters.
Parent node: In the history tree, the uniquely defined EEG
data set directly above the current node.
Placeholder: Name used for symbols that are replaced by
text on the execution of a transform or export component or
in a view tool; e.g. $h is usually replaced by the name of the
history file that is currently being processed.
Potential: Frequently used as a synonym for "EEG wave".
Primary history file: Primary history files are history files
that are based on the EEG raw data, in contrast to secondary history files (q.v.).
Primary transform: Primary transforms are processing
steps which are applied to an existing data set in a history
file. This leads to the creation of a new data set below the
original data set.
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Properties: Properties are the characteristics of markers,
channels or data sets, such as, for example, the length of a
data set. Properties always consist of a property name and
a value. A distinction is made between properties defined
by the program and user-defined properties (user properties, q.v.).

R
Raw data node: The top-level EEG data set in a history file.
This contains the unmodified EEG data read in from the raw
file.
Raw file: The EEG file obtained directly during recording
without any modifications.
Reader: Analyzer program element that reads in raw data
from a raw file (q.v.) in a given format.
Resolution: Specifies the granularity with which the value
range of the EEG signal is subdivided during digital acquisition. A higher resolution means finer granularity and
more accurate acquisition of the original signal. Unit: μV.

S
Sampling rate: Number of data points measured per second when acquiring an EEG digitally.
Scaling: In the context of displaying the EEG signal, scaling
is the assignment of an amplitude value in μV to an interval.
Secondary history file: Secondary history files are history
files that are based on data compiled as the results of processing steps from multiple history files.
Secondary transform: Secondary transforms are processing steps which read data sets from different history files
and use these to create a new history file.
Segment: A section of the EEG resulting from segmentation
(q.v.).
Segmentation: Subdivision of the EEG into different segments (epochs). Segmentation can be based on a number
of different criteria. On the one hand, segmentation is understood to be a preliminary stage in the analysis of evoked
potentials. Epochs of the same length are generated relative to a reference marker (a stimulus, for example). This results in a data set consisting of a sequence of segments or

epochs. On the other hand, segmentation is understood to
be the preparation of separate processing steps for different sections of an EEG, for example for the analysis of different stages before and after medication.
Semiautomatic mode: Some transforms are able to accept
user input that is dependent on the parent node in interactive EEG views. If a history template is applied ("automatic"
processing) then it is interrupted by an interactive view until the interactive view is closed again.
Solution: Solutions are modular extensions to the Analyzer
used for a variety of tasks. Like macros, solutions use the
SAX BASIC interpreter present in the Analyzer.
Sub-license file: File associated with the HASP HL dongle
and which can be used to enable optional functions.
SyncBox: Hardware accessory from Brain Products for the
BrainAmp (ExG) MR/BrainAmp MR plus which makes it possible to synchronize the sampling rate of the amplifier with
the clock rate of the scanner system.

T
Ten-ten system (10-10 system): One additional electrode
is positioned between each of the electrodes of the 10-20
system (q.v.).
Ten-twenty system (10-20 system): Internationally recognized, standardized method for positioning electrodes on
the head. The skull is measured from defined anatomical
points. The distance between neighboring electrodes is either 10% or 20% of the measured distances.
Time marker: see Marker.
Transform: Transforms are Analyzer program components
that process input data and then output data either in the
form of a new EEG data set or directly for display.
Transient transform: Transient transforms are processing
steps which are only used for visualization purposes. The
data output from a transient transform does not generate a
new data set but is instead displayed directly.
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U
Update: Updates are program files which make it possible
to update existing Analyzer components or add new components.
User Properties: User-defined properties of markers, channels or data sets. These properties are administered in addition to the standard properties defined by the program
and can be assigned values freely by the user. They usually
contain information that is to be used in a subsequent processing step applied to the EEG data.

V
View tool: View tools are graphical tools that can optionally
be added to the EEG display. The view tools add elements
such as maps or text boxes to the display.
View: Method of representing the EEG, such as the grid
view, the head view, and the mapping view. A view determines how the channels are arranged in the window, for example.

W
Workfile: A file containing information on workspaces
(*.wksp2), montages (*.mont2) and other user-defined settings.
Workspace: Configuration file which contains storage locations for raw files, history files and exported data. Extension: .wksp2.

Z
Zero-padding: The method zero-padding consists of appending zeros to an EEG interval until its length (in data
points) is extended to the next power of two. This operation
is performed internally in Analyzer during the FFT computation.
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Subject index

3

C

3D head view 129–130
configuring display 174–175
requirements 129, 597–599
transient 487

cardioballistic artifact
correcting 434–449
Change Sampling Rate (transform) 228
channel
adding 232–245
calculating 212–213, 229–232
changing number 81
comparing 398–404
configuring display 161–162
display 117–118, 190
display in grid view 124–125
displaying individual 117
editing 218–222
in montage 178–179, 182
linear combination 224–225
overall activity 213–214
virtual 229–232, 410–411, 416
channel group 81, 117
Channel Selection 142–145
client view 138
clipboard 80, 535–536, 558
closing an EEG 71
Coherence (transform) 407–410
coherence calculation 407–410
colors
blink markers 292
channel 220
frequency band 168
frequency data 164
History Node List 94
in views 173–174
map 172
marker 567
overlay 135, 169, 446–447
peak 361
pulse peak markers 441
time-frequency data 165–167
transform 192
command line parameters 581–582
comment
adding 90, 91
comparison
channels 398–404
data sets 398–404
Complex Demodulation (transform) 246–247

A
Add Channels (transform) 232–245
add-in 103
additional view 138
Advanced Boolean Expression/ABE 587–595
Analyzer button 65, 77
Analyzer Video (add-in) 502–503
Area Information Export (export component)
520–521
artifact
cardioballistic artifact 434–449
criteria 257–262, 268–272
in non-segmented data 264–274
in segmented data 251–264
ocular artifact 274–295, 295–298
rejecting 251–264, 264–274
scanner artifact 418–434
Artifact Rejection (transform) 251–264
Average (transform) 387–389
averaging 387–389
over multiple averages 371–373
axis display
configuring 167–168

B
band mapping view 488
Band Rejection (transform) 249–251
band-rejection filter 247, 249–251
baseline 161
correcting 81, 191, 389
Baseline Correction (transform) 389
Besa Export (export component) 509
Besa format
exporting 509
importing 527
butterfly view 120–121
Butterworth filter 247
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component analysis
independent component analysis (ICA)
298–314
principal component analysis (PCA) 342–
358
coordinates
for electrodes 194, 565, 585
modifying 585
Covariance (transform) 405–407
covariance calculation 405–407
Create New Dataset (export component) 519
cross correlation 396–398
Cross Correlation (transform) 396–398
Current Source Density
transform 215–217
transient 490–491
current source density 215–217

D
Data Comparison (transform) 398–404
DC Detrend (transform) 391–392
DC trend correction 391–392
Delta Tool 145–147
digitization 111
DirectX 129, 502, 597–599
installing 597
dongle
drivers 54
error message 575
firmware update 63
serial number 61
validity 62
drivers 54

E
EDF Export (export component) 510
Edit Channels (transform) 218–222
Edit Markers (transform) 451–459
Edit User Properties (transform) 482–483
EEGLAB 463–465, 474–475
eigenvalue 302, 348–350
Event-Related Synchronization/Desynchronization (transform) 369–371
evoked potential 99
export

areas 520–521
history nodes 519
ICA matrix 524–525
in ASCII format 513–518
in Besa format 509
in binary format 513–518
in Brain Vision Data Exchange Format
513–518
in EDF format 510
in LORETA format 523
markers 512–513
peaks 521–523
export component
multiple 103
simple 102
export folder 66, 507–508
Export ICA Matrices (export component) 524–
525
Export Markers (export component) 512–513
eye-tracking data 232

F
Fast Fourier Transform 316–322
transient 497
FFT Inverse (transform) 322–325
filter 247–249
fonts 173–174
formula evaluation
Channel Selection 144–145
Delta Tool 147
transform 226–227
Formula Evaluator (transform) 226–227
frequency band
configuring display 168
event-related course 369–371
frequency data
configuring display 163–164
frequency spectrum analysis 325–341

G
Generic Data Export (export component) 513–
518, 601
Generic Data Header (add-in) 504–506
Generic Data Reader 504, 528, 601
Global Field Power/GFP (transform) 213–214
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Grand Average (transform) 371–373
Grand Segmentation (transform) 385–387
graphical tools 96–98, 142–155
grid view 121–123

H
head view 123–126
configuring display 172–173
Help menu 549
high-cutoff filter 247
highlighting 114–117, 142
History Explorer 85–87, 101
history file
closing 88
compressing 88
opening 86, 88
primary 101
secondary 89, 101
history file folder 66
history node
closing 71, 91
deleting 88, 91, 92, 195
exporting 519
opening 69–70, 91
renaming 87, 91
restoring 90, 91, 92–94
sorting 94–96
History Node List 85, 94–96
history template
applying 106–108
canceling 108–109
creating 104–106
history tree 68–69
creating 86–87

I
IIR Filters (transform) 247–249
import
in Besa format 527
in Brain Vision Data Exchange Format 528
proprietary laboratory formats 504–506,
528
Import Markers (transform) 459–462
Independent Component Analysis/ICA (transform) 298–313

installation
DirectX 597
interrupting 47–49
network license 573–574
requirements 43
solutions 545
sub-license 578–580
under Windows® 8 55–58
under Windows® Vista/Windows® 7
44–55
under Windows® XP 43
updates 60
video codec 502
installing updates 60
inverse
FFT 322–325
ICA 314–316
wavelets 334
Inverse ICA (transform) 314–316

K
keyboard shortcuts 569–570
for channel display 118
for macros 544
for montages 185
Ocular Correction ICA 293

L
Lateralized Readiness Potential/LRP (transform) 365–369
Level Trigger (transform) 223–224
license agreement 52
Linear Derivation (transform) 224–225
lines
configuring display 173–174
overlay 135, 169
LORETA
add-in 506
export component 523
transform 410–417
transient 492–496
low-cutoff filter 247
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M
macro
creating 541–543
running 543
magnification 499
Magnifier 148
main menu
opening 77
map
configuring display 170–172
Map Legend 148–149
Mapping (graphical tool) 149–151
mapping view 126–128
transient 498
marker 567–568
color 567
configuring display 161–163
displaying 90, 92
editing 81, 451–459
exporting 512–513
importing 459–462
segmenting on 375, 587–595
showing/hiding 79
marker bar 79
Marker Navigation (add-in) 501
MATLAB® (transform) 463–482
Microsoft .NET Framework 4.0 47–51
montage
calling 185
creating 177
editing 184
reference types 177, 182
saving 184

N
navigation 78–80
using markers 501
navigation bar 75
network license 571
installing 573–574
New Reference (transform) 209–211

O
ocular artifact

correcting 274–295, 295–298
Ocular Correction (transform) 295–298
Ocular Correction ICA (transform) 274–295
online information page
deactivating 195
opening an EEG 69–70
overlay 80
channels 122, 125, 132
colors 135, 169, 446–447
configuring display 168–170
data sets 134–137
in grid view 122–123
in head view 125
in time-frequency view 132
lines 135, 169
removing 136
showing/hiding 135
static (Data Comparison transform) 137,
404

P
parameters
subsequent modification 92
Peak Detection (transform) 358–365
Peak Information Export (export component)
521–523
placeholder
Channel Selection 143
Delta Tool 146
overlay 170
Pooling (transform) 212–213
Principal Component Analysis/PCA (transform) 342–358
program folder 53, 204

Q
Quick Access Toolbar 75
configuring 77–78

R
raw data folder 66
Raw Data Inspection (transform) 264–274
raw file
closing 90
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opening 90
reloading 88
readiness potential, lateralized 365–369
recording information 90
Rectify (transform) 217
rectifying data 217
reference channel
changing 209–211
removable media 563
re-referencing 209–211
ribbon 75, 76–77, 84
displaying macros 543–544
displaying solutions 546–547
view functions 138
Root Mean Square/RMS (transform) 213–214

S
sampling rate
changing 228
scaling
3D head view 129
adjusting 81, 191–192
different channel types 81
logarithmic 164, 339
map 127, 171–172
time 80
time-frequency data 131, 165
voltage 81
Scaling Bar 151–152
scanner artifact
correcting 418–434
search paths 204
for components 206–207
segmentation 99–100
multiple averages 385–387
selecting markers via ABE 587–595
Segmentation (transform) 373–384
signal-to-noise ratio 389
slider bar 80
solution
executing 548
installing 545
solutions folder 204, 545–546
source localization 410–417, 492–496, 506
standard view 128
status bar 75, 82–84, 113

storage locations 66
storage space 92
sub-license
downloading 577–578
installing 578–580
support (contact) 37, 550
switch view 140–141
SyncBox 420
system requirements 43

T
tab bar 71
template drift compensation 419, 420, 429
template drift detection 418, 420
template editor 105, 106
test subject information 89
Text Box (graphical tool) 152–154
threshold 223–224
time constant 247
time interval
changing 80
time-frequency data
configuring display 164–167
time-frequency view 130–133
grid 132
head 133
standard 132
toolbar 80–82
tooltip 77
Topographic Interpolation (transform) 229–
232
transform
applying 72–74
colors 192
primary 102, 209
secondary 102, 209
transient 102, 190, 485–486
transient phenomena in IIR filters 247
troubleshooting 550
t-Test (transform) 393–396
t-value calculation 393–396
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U
update
installing 551–559
user profile 204–206
user-defined properties, modifying
channel 220
data set 482–483
marker 453

V
Value Graphics 154–155
video
playback 502–503
requirements 502, 597–599
view
3D head view 129–130
additional view 138
band mapping view 488
butterfly view 120–121
categories 111–112, 140–141
client view 138
functions 112–113
grid view 121–123
head view 123–126
mapping view 126–128
paired channels view 409
settings 156–160, 203
standard view 128
switch view 140–141
time-frequency view 130–133
view tool 96–98, 142–155
calling/closing 97
highlighting 116

W
Wavelet Extraction (transform) 341–342
wavelets
extracting the frequency level 341–342
Wavelets (transform) 325–341
window function
FFT 318, 320–322
Wavelets 333

windows
arranging 82
workfiles folder 204
workspace 65, 101
creating 65–67
loading 67
modifying 68
refreshing 84

Z
zoom 81, 499

